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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 
 WARNING 

indicates that death or severe personal injury may result if proper precautions are not taken. 
 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 
 NOTICE 

indicates that property damage can result if proper precautions are not taken. 
If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Introduction 1 
1.1 Security information 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept. 

Customer is responsible to prevent unauthorized access to its plants, systems, machines and 
networks. Systems, machines and components should only be connected to the enterprise 
network or the internet if and to the extent necessary and with appropriate security measures 
(e.g. use of firewalls and network segmentation) in place.  

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit 
(http://www.siemens.com/industrialsecurity). 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends to apply product updates as soon as available and to 
always use the latest product versions. Use of product versions that are no longer supported, 
and failure to apply latest updates may increase customer’s exposure to cyber threats.  

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under (http://support.automation.siemens.com). 

1.2 Note on the EU General Data Protection Regulation (GDPR) 
Siemens adheres to the principles of data protection, in particular the principle of data 
minimization (privacy by design). For this product, SIMATIC Energy Manager, this means: The 
product processes/stores the following personal data: 
User name, first name and surname, e-mail address, department, address, country, phone 
number and user role. In addition, relevant changes to the configuration, such as data points, 
MEVAs/KPIs, reports or changes to measured values are logged together with time stamps 
and user information. 
The above data is required for login, internal user administration (the authorized user can see 
the role and status of other users) and audit trail. 
The storage of data is appropriate and limited to what is necessary to identify the authorized 
operators and to meet basic audit trail requirements. 
The above data will not be stored anonymously or pseudonymized, as the purpose 
(identification of the operating personnel) cannot be achieved otherwise. The data will be 
used only within the product and will not be automatically passed on to third parties or 
unauthorized persons. 
Our product does not provide for automatic deletion of the above data. 
Regarding cookies, please refer to the Siemens cookie guidelines 
(http://www.siemens.com/cookie-policy-en). 

http://www.siemens.com/industrialsecurity
http://support.automation.siemens.com/
http://www.siemens.com/cookie-policy-en
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1.3 Why we need energy management 
Energy costs take a substantial slice in the cost balance of many companies. However, it is 
possible to significantly reduce this cost factor by optimizing energy consumption and taking 
advantage of the benefits offered by the liberalized energy market. Investments in this 
optimization process can be amortized on a short-term basis in many cases. Utilization of the 
entire spectrum of energy cost reduction demands integrated system solutions: the range 
covers the monitoring, analysis, and evaluation of the relevant energy and operational data, 
as well as energy forecasts and optimization functions. Under the aspect of a continuous 
adaptation process that is enforced based on requirements of the liberalized energy market, 
it must be possible to adapt the systems used without considerable investment. The 
following sections provide more arguments in favor of energy management. 

• Rising energy costs. 

• Only partial transparency across infrastructure processes, preventing an overall 
assessment of all processes and media. 

• Cost centers or cost units change continuously. 

• The existing heterogeneous system environment poses high demands on interface 
management. 

• Equipment for automatic measurement data recording is not available in the relevant 
areas. 

• Poor transparency prevents further optimization of energy supply contracts. 

• In many cases, energy costs represent an extremely high portion of unmanaged 
production costs. 

1.4 What is Energy Manager capable of doing in the field of energy 
management? 

Energy Manager PRO provides exactly the functionalities that are indispensable for the 
comprehensive analysis of energy management. Thanks to its flexible scalability, B.Data can 
provide solutions for both medium-sized companies and large corporations with location-
spanning requirements.  

Firstly, the customizable interface management function supports current standards such as 
OPC, ODBC, ASCII, or XML. Secondly, the interface management provides direct interfaces to 
Siemens products such as WinCC and PCS 7. which support synchronization of the 
configuration of data points. 

Energy Manager PRO offers a highly diversified Real-time kernel in its interface management. 
The calculation core supports numerous mathematical functions, as well as the mapping of 
non-linear cohesions.  

B.Data provides functions for data plausibility checks and various substitute value strategies 
that enhance database quality.  

Transparency of the energy flows in all types of media in a company is indispensable for 
energy management. Energy Manager PRO is the ideal tool for calculating energy and 
material balances as well as key figures that can be used to compare different processes, 
including different operations. 
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The diversity of the liberalized energy market demands a precise forecast of future energy 
consumption. Use Energy Manager PRO's Schedule Management to make forecasts that are 
derived from basic load profiles and current production plans at company or division level.  

Only the allocation of energy costs based on the cost-by-cause principle generates cost 
transparency and sensitization with regard to energy costs. The Cost Center Management 
tool of Energy Manager PRO maps cost centers and allocates consumption accordingly based 
on distribution codes, area data, employees, or measured data.  

It also enables the mapping of cost center changes during the year, as the calculation logic 
and all changes are recorded. Reproducibility of report results is of particular importance in 
this area. All changes made to the data are also recorded. This means that users can always 
rely on the old data for their evaluations. 

An automatic reporting system that is easy to configure forms a key factor that has 
considerable influence on the reduction of personnel workload. At the same time, the quality 
of the reports is significantly improved. In addition to the fully-fledged client, you can also 
use Energy Manager PRO Web to view the reports and results.  

Energy Manager PRO provides functions for the batch-related recording and evaluation of 
data to support more detailed analyses of the various processes.  

Energy Manager PRO's Document Management enables users to generate links to their 
documents in the system, or to save these to the database in order to make them generally 
available to other users. 

The Energy Manager PRO Task Management enables the time-controlled execution of 
reporting, interfaces, calculations, etc.  

1.5 Areas of application 
Energy Manager acts as a link between the process and office environments, focusing on 
energy management in industry. 

1.6 Preface 

Purpose of this documentation 
This documentation contains information pertaining to the full functionality of Energy 
Manager. Energy Manager Basic is a functionally limited version of Energy Manager Web. The 
section "Energy Manager Web" applies to Energy Manager Basic and Energy Manager PRO. If a 
function described in the section "Energy Manager Web" is not available or only to a limited 
extent for the Energy Manager Basic user, the user will be made aware of this at the 
appropriate place with the help of notes for users. All other sections only apply to Energy 
Manager PRO. The user information a limited function of Energy Manager Basic does not 
apply to the Energy Manager PRO user. 

This documentation is aimed at plant managers, planners, and plant operators as well as 
service and maintenance personnel. 



Introduction  
1.6 Preface 

 SIMATIC Energy Manager PRO V7.2 - Operation 

18 Operating Manual, 12/2020, A5E38952754-AF 

Basic knowledge required 
General knowledge in the fields of IT, automation engineering, as well as general electrical 
engineering is indispensable for comprehension of this manual.  

 

 WARNING 

Working with electrical systems 

Energy Manager does not exempt users from responsibilities with respect to the handling of 
electrical systems. 

 

Moreover, it is presumed that users have appropriate knowledge related to the use of 
computers running on a Windows operating system.  

Scope of this manual 
This manual is valid for Energy Manager. 

Guides in the manual 
The manual contains the following guides that support rapid access to the information you 
require: 

• A complete table of contents and a list of all tables are available in the opening section of 
the manual. 

• An overview of the topical contents is provided at the beginning of each chapter. 
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 Energy Manager PRO Client 2 
2.1 Basics 

2.1.1 Start Energy Manager 

Login 

Requirement 

• Energy Manager Login information is known 

Procedure 

To start Energy Manager, follow these steps: 

1. Double-click the "Energy Manager PRO Client" icon on the Windows Desktop or open the 
program by double-clicking it using [installation 
path]:\EnMPRO\GUI\BData2008\DocLiber.exe. 

 
  Note 

When you start Energy Manager for the first time after installation, the "Energy Manager 
Configuration" dialog is opened.  

 

The login dialog of Energy Manager is opened. 

2. Type in the user name and password. 

If "Single Sign On" is activated for your user account or for the user group to which you 
belong, the user name and password do not have to be entered. Additional information 
about "Single Sign On" is available in sections "Setting up users (Page 672)" and "Creating 
functional groups (Page 687)".  
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For the user name, you can also enter the email address that is stored in your Energy 
Manager user account.  

Select the language, if necessary. The following languages are available: 

– German 

– English 

 
3. Click the "Login" button. If incorrect login data is entered and the defined number of login 

attempts is exceeded, the user will be blocked. 

4. If your user account is blocked, contact the system administrator. 

 
  Note 

The password requirements are set by the administrator in Energy Manager PRO Web 
under "Configuration > Settings > Account settings" in the "Password settings" tab, see 
section "Account settings (Page 311)". The number of login attempts is defined by the 
administrator in Energy Manager PRO Client under "File > Options" in the "Database" tab 
with an entry in the "MAX_ATTEMPTS_TO_LOGIN" field, see section "Options (Page 374)". 
The password can be unlocked by the administrator for the respective user and a new 
password can be set, see section "Creating users (Page 320)". 

 

Result 

Energy Manager is started and the Energy Manager PRO Client is displayed.  
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Change password 
You can change your Energy Manager password in the login dialog. In order to change it, you 
need your existing password or a temporary password.  

Requirement 

• Energy Manager login information is known. 

Procedure 

To change the password in Energy Manager, follow these steps: 

1. Click the "Change Password" button at the bottom of the dialog window. 

The "Change Password" dialog opens. 

2. Enter the required data for "User", "Password", "New Password" and "Confirm Password". 

 
  Note 

If you have been notified by email about a password change without having changed your 
password, this can indicate a hacked user account. Always contact your administrator in 
this case.  

 

 
3. Click the "Change Password" button below the "Confirm Password" entry field. 

Result 

The password is changed. You are notified about the password change by email. 
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Forgot password 
If you have forgotten your password, you can have a temporary password generated. The 
temporary password will be sent by email to the email address that is stored in your Energy 
Manager user account.  

Requirement 

The email address stored in your user account is known. 

Procedure 

1. Click the "Password Lost" button at the bottom of the dialog window. 

The "Password Lost" dialog appears. 

2. Enter the required email address in the "User" entry field. 

 
  Note 

In order for the user to receive a temporary password via email, an SMTP server must be 
entered and accessible. The entry is set by the administrator in "File > Options", "Appl" tab, 
"SOFTWARE\Siemens\EnMPRO\Mail" field. 

 

 
3. Click the "Send E-Mail" button. 

Result 

When you have received the email with the temporary password, click the "Change Password" 
button in the Login dialog and change the password. 

See also 
Client as navigation tool (Page 23) 

Configuration (Page 388) 
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2.1.2 Client as navigation tool 
The Client is the Windows-oriented user interface of Energy Manager. You configure all of 
the objects you need for energy management in your organization in the Client : 

• You configure the objects that contain your operating data, such as datapoints or 
matrices. 

With the object-oriented approach of the Client, you use one object at multiple places, 
such as for the calculation of performance indicators or in reports. Modifications will 
automatically be applied to all points of application and are recorded simultaneously in 
change management to ensure reproducibility of older configurations. 

• You evaluate your operating data or performance indicators with the help of reports or 
charts, or display these data clearly as a Dashboard. 

• You use a wizard to configure the interfaces such as WinCC or OPC, which provide you 
with operating data. 

The Energy Manager PRO Client has the following structure: 

 
① Menu bar 

All buttons for system operation are placed in the menu bar and organized in categories.  
② Navigation bar 

The navigation bar shows the current position in the project tree in text form.  
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③ Project tree 
You create objects that you need for energy management in the predefined "System" root in the 
project tree. 
You can organize the project tree, for example, according to locations or function. Create favor-
ites to frequently required objects in the "Quicklinks" area.  

 
④ Quick search 

The quick search is a simple full-text search. The search result is displayed in the display area ④. 
⑤ Display area 

The display area shows details of the object that you selected in the project tree.  

See also 
Objects in the Client (Page 357) 

Displaying object relations (Page 371) 

Object naming conventions (Page 373) 

Search for object (Page 31) 

Quicklinks for client (Page 676) 

Processing (Page 507) 

Analysis (Page 601) 
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2.1.3 Basic configuration 

Basic configuration of Energy Manager 
A basic configuration of the system is automatically installed with the installation of Energy 
Manager. The basic configuration contains the following objects and structures: 

• 5 pre-configured templates for reports 

• Acquisition object with four previously created interfaces for data acquisition 

• 4 Functional and 4 user groups 

• 5 KPI message lists 

• Several preconfigured units 

• Entry point "Energy Manager - Web" in Energy Manager PRO Web 

 

 Note 

When you update your existing Energy Manager system to the latest version, the new 
acquisition object with the created interfaces is not installed. Instead, your acquisition 
configurations are applied during the update. 
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The following table shows the objects installed with the basic configuration: 
 
Templates • Balance 

• Balance comparing 
• Protocol 
• Protocol with from/to 
• Duration curve 

 
The pre-configured templates are created in the system under the following path: 
"System > Configuration > Templates" 
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Acquisition object 
"h_Local_PC" with four 
created interfaces 

• OPC UA 
• WinCC 
• Energy Suite 
• Modbus TCP 

 
The acquisition object including interfaces is created in the system under the following path: 
"System > Configuration > Data collection" 

Functional groups and 
user groups 

• Administrators 
• Configurators 
• Operators 
• Guests 

 
The functional groups and user groups are created in the system under the following path: 
"System > Configuration > User, Groups, Rights management > User groups or Functional 
groups" 



Energy Manager PRO Client  
2.1 Basics 

 SIMATIC Energy Manager PRO V7.2 - Operation 

28 Operating Manual, 12/2020, A5E38952754-AF 

KPI message lists • All 
• All Warnings 
• All Violations 
• GAP detection not acknowleged 
• All not Acknowledged 

 
The KPI message lists are created in the system under the following path: 
"System > Configuration > KPI message lists" 
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Units 

 
The available units are created in the system under the following path: 
"System > Configuration > Extended configuration > Unit" 
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Entry point "Ener-
gy Manager - Web" 

 
The entry point "Energy Manager - Web" contains the following automatically installed folders: 
• Web configuration 
• Dashboards 
• Reports 
• Charts 
• Manual acquisition of data 
You can redefine the entry point for the respective user groups in the Ener-
gy Manager PRO Client. 

See also 
Report templates (Page 707) 

Configuring units (Page 700) 

Report templates (Page 618) 

Basic information on message lists (Page 722) 

Defining an entry point (Page 685) 

User group (Page 684) 

Functional group (Page 687) 

Message lists (Page 722) 
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2.1.4 Search for object 

Overview 
The Energy Manager search function evaluates the following information: 

• Object name 

• Description of the object 

• Object properties 

• Object ID 

A separate tab with search results is created for each search in the display area of the Client. 
All tabs with search results are deleted when you close the BEnergy Manager PRO Client .  

Procedure 
1. In the project tree of the Client, select the folder in which you want to search. 

2. To limit the search to specific objects, activate one or more object types in the selection 
menu of the search. 

In the following example, the search is limited to reports and measuring variables: 

 
3. Enter your search term in the search field. 



Energy Manager PRO Client  
2.1 Basics 

 SIMATIC Energy Manager PRO V7.2 - Operation 

32 Operating Manual, 12/2020, A5E38952754-AF 

4. Click . 

A tab with the search result is created in the display area. 

 
5. To refine the search result, enter another search term. 

The search results are filtered. 

6. As soon as you use the <Return> key in the search field, another tab is created for the new 
search term. 
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2.1.5 Quicklinks 

2.1.5.1 Create Quicklinks 

Overview 
You can create Quicklinks for objects that are required often as well in the Energy Manager 
PRO Client. 

Requirement 
• You have the functional authorizations "Create Quicklinks" and "Configure Quicklinks". 

Procedure 
1. Select the object for which you want to create a Quicklink in the "Menu" area , for example 

"Costcenter Report". 

2. Click the "Add Quicklink" icon. 

 



Energy Manager PRO Client  
2.1 Basics 

 SIMATIC Energy Manager PRO V7.2 - Operation 

34 Operating Manual, 12/2020, A5E38952754-AF 

3. Click "Yes" and the Quicklink is created. 

 
4. Change from the menu area to the Quicklink area. 

 

Result 
The Quicklink is created as follows: 

• The object name is applied. 

• The preset icon and background color are used. 

 

See also 
Creating Quicklinks in the Web (Page 103) 

Quicklinks for client (Page 676) 
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2.1.5.2 Editing Quicklinks 

Overview 
You can change the order of the Quicklinks in the "Quicklinks" area or delete them if they are 
no longer needed. You can also customize the Quicklinks, for example, by changing the 
background color or the icon. 

Requirement 
• You have the functional authorizations "Configure Quicklinks" and "Delete Quicklinks". 

Change the sequence of the Quicklinks 
1. Open the "Quicklink" area and use drag-and-drop to place it at the required position. 

The Quicklink is placed at the respective location. 

Customize Quicklink 
1. Click the "PencilTool" icon in the "Quicklinks" area above the required Quicklink. 

The "Edit Quicklink" dialog box opens. 

 

2. To rename the Quicklink, enter the desired name in the "Name" input box. 
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3. To change the Quicklink icon, click on "Icon" and select the desired icon. 

There are 18 predefined icons available to you. 

 
4. To change the background color of the Quicklink, click on "Background Color" and select the 

required background color. 
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5. To specify the Quicklink as homepage, select the "Choose Quicklink as homepage" check 
box. 

 
  Note 

If you do not specify any Quicklink as homepage, the first Quicklink in the "Quicklinks" 
area is used as homepage page. 

 

6. If you want to create a Quicklink to the overview of the report, select the "Use report 
overview". 

7. If you want to create a Quicklink to the last result of the report, select the option "Open last 
report" and select the required format, for example, "Excel "or" PDF ". If you select this 
Quicklink, the report opens in the selected format. 

8. Save your changes by clicking "OK". 

See also 
Editing Quicklinks in the Web (Page 106) 

Quicklinks for client (Page 676) 
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2.1.6 Help 

Help  
The Energy Manager Help is displayed web-based in a browser or on a mobile device.  

Open the Help in the Energy Manager PRO Client by clicking the question mark symbol on the 
"Help" tab. 

 
In Energy Manager Web you also open the Help using the question mark icon. 

 

The Operating Manual is opened in the browser and you can navigate through the table of 
contents. 

 
 

 Note 

If you experience display problems in the browser, check the compatibility view settings in 
your browser. These should be deactivated.  
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2.2 Manual acquisition of data 

2.2.1 Matrix 

Overview 
With the matrix you can enter values manually in Energy Manager. 

Data input via matrix 
1. Double-click the matrix object to enter the data in the matrix. 

The configuration dialog of the matrix object opens. 

2. Click "Input Values" to create the matrix based on the time stamps and connected 
datapoints. 

A separate column is generated for each datapoint connected to the matrix node. 

 
3. Enter the values in the fields provided for this purpose. 

Provided the "Plausibility" option has been set in the matrix configuration dialog, the 
bottom area of the input dialog for the active field displays the valid scope along with the 
datapoint name. Value entries outside the valid range are marked in red color (see above). 
A corresponding message notifies you of this situation: "Value 8 must be >= 20!" 

4. Click "Apply" to save your changes to the database. 

The result is displayed below the "Apply" button. Example: "5 values inserted, 0 values 
updated, 0 values removed." 



Energy Manager PRO Client  
2.2 Manual acquisition of data 

 SIMATIC Energy Manager PRO V7.2 - Operation 

40 Operating Manual, 12/2020, A5E38952754-AF 

5. Use the "Page up" and "Page down" keys to modify the monitoring period. The 
corresponding values are loaded from the database. 

6. Assign the value 1 to the name "TimestampsAlignLeft " in "Energy Manager Options > Appl." 
in order to switch the representation in the matrix to the valid range "from-to". 

 
The time stamp representation is setup by default: TimestampsAlignLeft = 0. 

 
These settings are valid for Energy Manager and Energy Manager PRO Web. 

See also 
Manual acquisition with the matrix (Page 505) 
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2.2.2 Energy Manager PRO Mobile 

2.2.2.1 Basics of Energy Manager PRO Mobile 

Definition 
Energy Manager supports in situ manual acquisition of operational or counter values by 
means of a mobile device such as a PDA.  

Energy Manager PRO Mobile is a software interface that enables the acquisition of values on a 
mobile device and their automatic import to Energy Manager. 

Usage 
Use Energy Manager PRO Mobile in the following cases: 

• If automatic measured value acquisition is not possible, e.g. using a counter. 

• If a link or a sensor fails during automatic measured value acquisition. 

Data acquisition on mobile devices 
Set up each mobile device as a separate hardware object in Energy Manager. Copy the data 
points to be acquired by means of the hardware object to the tree below the hardware 
object. Once the mobile device is interconnected with a Energy Manager PRO Client, the data 
point values are synchronized automatically with the Energy Manager PRO Database.  

 

You have the following options of acquiring values on the mobile device:  

• Separate identification of the counters 

Identify a counter from which you only take a manual reading in exceptional situations or 
on rare occasions on the mobile device. You can use a mobile device that features a 
scanner to take an unambiguous reading of the counter's barcode ID. You can access the 
values stored in the data point after you have identified the counter.  

• Defining routes 

If you read off multiple counters at regular intervals, define a route in Energy Manager. A 
route lets you define the order in which the devices are read locally. The mobile device 
guides you through the route and provides you with additional information such as the 
last value, as well as high and low limits. 
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See also 
Synchronizing data (Page 46) 
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2.2.2.2 Navigation structure of Energy Manager PRO Mobile 
The following diagram highlights the navigation structure of the "Energy Manager PRO 
Mobile" application on the mobile device: 

 

 Input field or selection list 

 Display field 

See also 
Synchronizing data (Page 46) 
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2.2.2.3 Entering measured values 

Requirement 
• You are logged on to the "Energy Manager PRO Mobile" application on the mobile device. 

• The "Main" picture is displayed on the mobile device. 

• The synchronization process is concluded. 

Procedure 
1. Identify the meter. 

2. Enter the measured value reading on the mobile device. 

3. Enter the time stamp, if necessary. 

The following figure shows how to enter measured values on the mobile device, based on the 
"Main" picture: 
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① Only available if one or several routes were defined in Energy Manager.  
Acquiring measured values based on the selected route:  
1. Select the route and range and launch routing with "Start". 
2. Enter the measured value reading and confirm your entry with "Next". 

② Separate acquisition of measured values:  
1. Identify the meter using the "List" or the "Scanner" of the mobile device. 

The meter must be equipped with a barcode for identification by the scanner.  
2. Enter the measured value reading and confirm your entry with "OK". 

Result 
The measured value readings are stored on the mobile device.  

If you now connect the mobile device with the Energy Manager PRO Client, the measured 
values are transferred automatically to the Energy Manager PRO Database and stored in the 
data points.  

See also 
Generating barcode (Page 929) 
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2.2.2.4 Synchronizing data 

Overview 
The following occurs when you synchronize data on the mobile device: 

• The routes and data points that you have configured in Energy Manager are mapped to 
the mobile device. 

• The values you have entered on the mobile device are saved to the corresponding data 
points in Energy Manager. 

You can synchronize data on the mobile device as follows: 

• Manually 

Synchronize the data manually when you use Energy Manager PRO Mobile for the first 
time. 

• Automatically 

When you connect the mobile device after the first synchronization to the Energy 
Manager PRO Client, the measurement values are synchronized automatically.  

Requirements 
• Energy Manager PRO Mobile is installed and configured in Energy Manager and on the 

mobile device. 

You will find more detailed information on this topic in the manual "SIMATIC Energy 
Manager - Installation", keyword "Installing Energy Manager PRO Mobile". 

• You are logged on to the mobile device with the Energy Manager access data. 

• The mobile device displays the "Main" screen. 

Synchronizing data manually 
1. Select the "Synchronization" command. 

The data is synchronized. The synchronization status is indicated in the "Synchronization" 
screen. 

Result 
The data on the mobile device and in Energy Manager are synchronized. 

 

 Note 
Ignoring the values 

The current value will be ignored if the Energy Manager database already contains a data 
point value with the same time stamp. 
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See also 
Navigation structure of Energy Manager PRO Mobile (Page 43) 

Configuring a mobile device in Energy Manager (Page 927) 

2.2.3 Parameter 

Overview 
With a Parameter you can acquire a fixed value that is either generally valid, or is limited by 
the entry of a time range in its validity duration. You can, for example, define electricity or 
gas prices for specific periods or specify conversion factors such as a CO2 conversion factor. 

The entry of a parameter value in the Energy Manager PRO Client corresponds to that in the 
Energy Manager PRO Web. 

Procedure 
1. Click the Parameter at which you wish to enter a value. The input dialog is opened. 

2. Enter a value and, if necessary, a period of validity. 

 

3. Confirm with OK. 

See also 
Parameters (Page 519) 

Parameters (Page 146) 
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2.3 Analysis 

2.3.1 Basic information on analysis 

Definition 
"Analysis" denotes the time-independent processing and visualization of measuring values in 
reports. You can use Microsoft Excel or Microsoft Word to visualize the reports.  

You can process the data exported from Energy Manager using the entire functionality of 
Microsoft Excel or Microsoft Word , for example, statistical functions such as correlation or 
regression analysis from Microsoft Excel. You can also process the result data using graphics 
or diagrams. 

Application 
"Analysis" supports you in the following activities: 

• Creation of company-specific reports for all departments and information demands. 

• IT-related, system-wide analysis of different business units for holistic assessments of your 
company. 

• The workflow system of Energy Manager reduces your staff's workload: 

– Automatic and cyclical calculation of performance indicators and accounting results 
(task management). 

– Automatic generation of standard analyses for predefined periods, e.g. day, month, 
shift, year. 

– Automatic sending of evaluations to printers in the company-wide printer network. 

– Automatic dispatch of analyses and accounting bases by means of email attachment to 
internal and external recipients of the business unit. 

When generating reports, you can always access previous configurations (historicization), or 
different measured value versions (versioning).  
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Configuration 
Specify the following when configuring reports: 

• Query type: Time range that is queried in the report. 

• Module: Visualization of the report in Microsoft Excel or Microsoft Word. 

Each module is provided with values from its assigned measuring variables. Once the 
template has been generated, the final report result is stored in the project tree under the 
selected query type, and can be called with a double-click. 

 
① The report employs the module "Comparative accounting" ② and query type "Month" ③ for the 

analysis. 
② The module is supplied with data from two measuring variables that calculate the measured 

values using the "Multiplication" database function. 
③ Results of the report that was generated twice are stored at the query type. 
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2.3.2 Reports 

2.3.2.1 Generating reports 

Overview 
You can generate the configured report at any time. 

Requirement 
• The report is configured. 

• The module and request type are configured for the report. 

• The template is configured for the report. 

• The values for the report have been set. 

Generating reports 
1. Click "Start" in the shortcut menu of the selected report. 

The "Start report" dialog opens.  

The "General" tab is activated in the "Module" area. 

The "Module" area lists modules that you have configured for the report and that require 
additional information for report generation. 

 
2. Select the query type for the report. 

3. Specify a time range for the report. 
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4. Click "Advanced parameters" to specify additional parameters for report generation. 

5. You can edit module start parameters by selecting and editing the selected module in the 
"Module" area. 

You may also click "Next" to select the module. 

6. Click "Start". 

 
  Note 

If you start a report via a Remote Desktop connection and the report is not executed, set 
the "Energy Manager PRO Report Server" service, which normally runs under a local 
Windows user, to the "Local System" user and restart the service. 

 

Specifying additional parameters for the report (optional) 
1. Click "Advanced parameters". 

The advanced parameters are displayed. 

 

2. Disable "Current" and select a date to define the measured value version for evaluation. 
All measured values generated prior to this data are evaluated. 

The current date is activated by default. 
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3. Deactivate "Current" and enter a model date to define a calculation model for evaluation of 
the report. 
The report is evaluated by default based on the current calculation model. 

4. To select a batch, click "…" and select the batch ID from the batch list. 

5. Under "Country", select the country whose time zone you want to use for the calculation. 

Editing module start parameters (optional) 
1. Select the module from the "Module" area. 

2. Specify the query type and time range if you have activated the "Query interval at start" 
option in the module configuration. 

3. You can always edit the interval, as well as the high and low limit of configured module start 
parameters. 

The start parameters are derived from the module configuration. 
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4. Edit the corresponding parameters if you have configured modules that need an interval 
and unit as start parameters. 

The start parameters are derived from the module configuration. 

 

Result 
The report is generated and opened automatically. 

 
Click "Close" to prevent the reports from being opened automatically. 



Energy Manager PRO Client  
2.3 Analysis 

 SIMATIC Energy Manager PRO V7.2 - Operation 

54 Operating Manual, 12/2020, A5E38952754-AF 

Alternative procedure 
You can also start the report by means of the shortcut menu of the respective query type. 

See also 
Assign time zone for acquisition or calculation (Page 662) 

Reports (Page 123) 
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2.3.2.2 Opening report results 

Overview 
Report results are stored in the folder for the configured query type in the structure tree of 
the Client. 

 

You can open the report results as follows: 

• In Microsoft Excel or Microsoft Word 

• As PDF 

Requirement 
• The report is generated. 

• Microsoft Excel or Microsoft Word is installed. 

• PDF-Reader is installed. 

Procedure 
1. To open the report result in the visualization program, click "Open" in the shortcut menu of 

the selected report result. 

2. Open the report in PDF format by clicking "Open as PDF" in the shortcut menu of the report 
result. 
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Result 
The report result is displayed. 

 

Color code of the measured values in the report 
The measured values are color-coded as follows for the following status: 

 

Status Color code 
Result OK Black 
No data available for measuring variable Magenta 
Result of manual correction Orange 
Result from substitute value Light blue 
Result not OK Red 
Missing measured values Light green 
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2.3.3 Charts 

2.3.3.1 Fundamentals 
 

Overview 
You use the Chart to display historical as well as current values. Use the chart for the 
visualization of measurement series. 

The Diagram or Chart functionality is available as a separate tab at the bottom in the display 
area at the following objects: 

• Data point 

• Matrix 

• Measuring variable (MEVA) 

• Chart object 

The following visualization types are available for the visualization of values: 

• Standard chart with line graphs 

• Histogram 

• Bell-shaped curve 

• Box Plot 

• Correlation and regression 

Chart with Chart tab 

In this case the Chart option is available immediately by means of the Chart tab after a click 
on the respective object. Configurations set in the chart, such as the number of displayed 
data points and the query type, are stored automatically for the active user. The configuration 
is saved with the object in the database. The selected time range is not stored. On a renewed 
display of the chart the current time range is always displayed. 

Own chart object 

In addition, an own chart object is available with which you can visualize up to ten data 
points simultaneously. The configuration via the chart object is not referenced to a user. Thus 
it is possible to make a preconfigured chart available to several users. Open an already 
predefined chart object by double clicking on it. 

 
You can also export the displayed chart in the following form: 

• Chart values as a file in "*.csv" format 

• Chart as a graphic in "*.bmp", "*.jpg" or "*.png" format 
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Structure of the chart 
The following figure shows the display of the chart in Energy Manager PRO Client: 

 
① Object that is visualized in the chart. 
② Display of the time range  

Use the arrow keys to scroll back or forth by one period.  
③ Configuration area 
④ Visualization of the data points as line graph 

Current values are read gradually and displayed. The following update cycles apply to the displayed values: 
• 10 seconds in the Energy Manager PRO Client 

⑤ Inserting an additional data point.  
⑥ Legend with the data points represented in the chart. If you click a data point, the configuration dialog ⑨ opens.  
⑦ "Alarms and comments" tab with the alarms and comments that are contained in the selected time range. 
⑧ "Chart" tab with the visualization of data points in the display area. 
⑨ Configuration dialog for the visualization of a data point in ④.  
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Structure of configuration area 
The following figure shows the display of the configuration area in the 
Energy Manager PRO Client: 

 
① Selection of time range, query type, and compression level 
② Selection of the visualization type 
③ Configuration of the x and y axes  
④ Exporting the content that is displayed in the chart 
⑤ Display of the track ball and warning and alarm limits 
⑥ Reset chart settings 
⑦ Full-screen display of the chart in a separate window  
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Display of details in the chart 
The figure below shows which details are displayed for the measured values of a 
measurement series in the chart:  

 
① Measured value with violated high or low limit of plausibility criterion 

Click the measured value to open the "Details" dialog. 
② Measured value with user-defined comment 

Click the measured value to open the "Details" dialog. 
③ Measured value with display of time stamp and value 

Move the mouse pointer across the line graph to display a measured value.  

 
 

 Note 

The view is compressed when the chart includes more than 6,000 measured values in the 
displayed time range. Not all details are displayed in the compressed view.  

In this case, either select a smaller time range or zoom in on the display area in the chart.  
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Missing values 
The line of the corresponding data point is interrupted when the values are missing in the 
measured value series of a data point. 

 

2.3.3.2 Standard Chart 

Displaying the Standard Chart 

Requirement 
Datapoint, matrix or report has been created. 

Procedure 
1. Select the required Energy Manager object whose values you want to analyze in the Chart. 

2. Click on the "Diagrams" tab in the display area. 

The Chart is displayed as the Standard Chart.  

3. The settings of the selected object are generally applied as query type and compression 
level. You can change the query type and the compression level in the configuration area 
under "Period". 

4. Define the axis assignment and the display for each data point under "Axis" in the 
configuration area. The options for the axis assignment apply solely to the Standard Chart. 
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Result 
The values of the object are displayed in the Standard Chart in the form of a line graph. 

 

See also 
Configuring query types (Page 703) 

Show details 

Requirement 
Measured values are displayed in the Chart. 
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Procedure 
1. To enter a comment for a measured value: 

– Click on the measured value. 

The "Details" dialog opens.  

– Go to the "Comments" tab and click "Add". 

– Enter the comment text. 

2. To enlarge the display area: 

– Holding down the mouse button, enlarge the required area in the display area. 

 

The selected area is enlarged.  

– To return to the original view, click "Original size". 

Comparing values of different time ranges 

Introduction 
You can compare the values of one or more datapoints that are displayed in the Chart with 
the values from a different time range. The other time range is displayed as a secondary X 
axis on the upper border of the Chart. Query type and compression were taken from the 
primary X axis.  

The time range of the secondary X axis is either static or dynamic: 

• Static: Fixed starting time in the past or future. Use the calendar to select the time range. 

• Dynamic: Offset in periods relative to the time range of the primary X axis. A negative 
value means an offset in the direction of the past. 

Requirement 
Datapoint is displayed in the Chart.  
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Procedure 
1. In the configuration area, under "Axes", select either "Static" or "Dynamic": 

2. If you have selected "Static", select the desired starting time in the calendar. 

3. If you have selected "Dynamic", enter the desired value for the period offset under "Offset". 

4. In the legend, click the datapoint, whose values should additionally be displayed in the 
secondary X axis. 

The configuration dialog is opened.  

5. If you only want to display the comparison values, select "Secondary axis". 

6. If you want to display the initial and comparison values, select "Both". 

Result 
The datapoint's values are displayed in addition to the time range of the secondary axis.  
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Exporting the Chart 

Introduction 
You can export the values from a Chart that is displayed on the screen: 

• as a file: Values are exported in the "*.csv" format as a comma-separated file, which you 
can edit for example in MS Excel. 

• as an image: The graphics formats "*.bmp", "*.jpg" and "*.png" are supported. 

If you enlarge a section of the Chart, only the measured values that are contained in that 
section are exported. 

Requirements 
• The Chart is displayed. 

• The configuration area is displayed. 

Exporting the Chart's values to a file 
To export a Chart's measured values to a file, follow these steps: 

1. In the configuration area, under "Extras", click "Export values as CSV...". 

The "Save as" Windows dialog is displayed. 

2. Enter a name for the file. 

Result 
The Chart's measured values are saved in a file in "*csv" format. You can open the file, for 
example in MS Excel. Each datapoint contained in the Chart is displayed as a separate 
column. The first column contains the timestamp.  

 

 Note 

The values are exported in UTC time format including a local time stamp. 
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Exporting a Chart as an image 
To export a Chart as an image, follow these steps: 

1. In the configuration area, under "Extras", click "Export chart as image...". 

The "Save as" Windows dialog is displayed. 

2. Enter a name for the image, and select the desired graphics format. 
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Result 
The displayed Chart is saved as a graphic. 

 

2.3.3.3 Histogram 

Overview 
The histogram offers you the possibility of visualizing the occurrence of values. In the process 
all the values of the selected time range is divided into 20 intervals and the number of values 
in each interval is displayed. 
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Procedure 
1. Select the required Energy Manager object whose values you want to evaluate in the Chart. 

2. Click the "Chart" tab at the bottom in the display area. The Standard Chart is always 
displayed initially. 

Click the "Charts" tab on the right in the configuration area. Click "Histogram" to display 
the values as a histogram. 

3. The settings of the selected object are generally applied as query type and compression 
level. You can change the query type and the compression level in the configuration area 
under "Period". 

Result 
The values of the selected object are distributed to 20 intervals. An interval corresponds to a 
bar. In the bar itself the number of values occurring in this interval is displayed. The interval 
limits are applied on the X axis. The first interval in the figure below includes, for example, 
the values from 119760 to 123772, in which one value violates the plausibility limits. The last 
interval contains all the values that exceed 195,988. 

In as far as values exist that violate the plausibility limits, these are displayed as red stacked 
bars. 
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2.3.3.4 Bell-shaped curve 

Overview 
The bell-shaped curve offers you the possibility of displaying values in a normal distribution. 
So, for instance, you can display the distribution of measuring errors.  

The mean value and the standard deviation are specified for the values of the selected time 
range. 

Procedure 
1. Select the required Energy Manager object whose values you want to evaluate in the Chart. 

2. Click the "Chart" tab at the bottom in the display area. The Standard Chart is always 
displayed initially. 

Click the "Charts" tab on the right in the configuration area. Click "Bell-shaped curve" to 
display the values as a normal distribution. 

3. The settings of the selected object are generally applied as query type and compression 
level. You can change the query type and the compression level in the configuration area 
under "Period". 

Result 
The deviation from the mean value is displayed graphically as a result.  

The mean value as well as the standard deviation σ are displayed at the top on the bell-
shaped curve. The interval of the standard deviation ±σ around the mean value acquires 
68.27% of all measured values. 
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2.3.3.5 Boxplot 

Overview 
The boxplot offers you the option to rapidly display the area in which values lie and how 
these values are distributed. In addition to the graphical display the maximum, the minimum, 
the median and the mean value are displayed for the values of the selected time range.  

Procedure 
1. Select the required Energy Manager object whose values you want to evaluate in the Chart. 

2. Click the "Chart" tab at the bottom in the display area. The Standard Chart is always 
displayed initially. 

Click the "Charts" tab on the right in the configuration area. Click the "Boxplot". 

3. The settings of the selected object are generally applied as query type and compression 
level. You can change the query type and the compression level in the configuration area 
under "Period". 

Result 
The values are displayed as a boxplot. 
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2.3.3.6 Correlation and regression 

Overview 
The correlation chart or the scatter chart shows a correlation between two datapoints 
graphically on the basis of value pairs A correlation occurring often between two variables is 
the linear regression.  

The regression analysis offers you the possibility of displaying the relation between a 
dependent and an independent variable. This means that at least two datapoints are required 
for this analysis. The regression analysis can support you, for example, in the prognosis of 
values.  

Procedure 
1. The correlation chart and the regression analysis require at least two datapoints. You can 

create an own chart object under which you can then copy the datapoints. However a 
matrix can also be used. Then click the object under which the data points are located. 

2. Click the "Chart" tab at the bottom in the display area. The Standard Chart is always 
displayed initially. 

Click the "Charts" tab on the right in the configuration area. Click "Correlation and 
regression". 

3. The settings of the selected object are generally applied as query type and compression 
level. You can change the query type and the compression level in the configuration area 
under "Period". 

4. By default the first two datapoints are used and are displayed underlined in the legend. If 
several datapoints are located under the Chart object, a desired datapoint can be selected or 
deselected with a simple click. 



Energy Manager PRO Client  
2.3 Analysis 

 SIMATIC Energy Manager PRO V7.2 - Operation 

72 Operating Manual, 12/2020, A5E38952754-AF 

Result 
The correlation chart shows the relation between the values graphically on the basis of a 
points cloud from value pairs. You can display a value pair when you move the cursor over it. 

The regression analysis shows the linear correlation between the dependent variable x and 
the independent variable y using a red line. The linear relation is displayed as a formula at the 
top in the graphic, just like the coefficient of determination R2 that shows whether and to 
what an extent a linear relationship exists. R2 lies at 0, if a linear relation does not exist. R2 lies 
at 1, if a linear relation does not exist. 
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2.3.4 Dashboards 

Overview 
Once you have created the Dashboard layout and configured the dashboard objects used, you 
can display the Dashboard in full-screen mode. In full-screen mode, the dashboard is updated 
with corresponding data at cyclic intervals.  

 

 Note 
Specifying the Dashboard update cycle 

Specify the update cycle when configuring the Dashboard background. 

The update cycle is set to 5 seconds by default. 
 

Requirement 
• You have created the Dashboard layout. 

• You have configured the dashboard objects used. 

Procedure 
1. Select the desired Dashboard in the project tree of the Client and click "Open" in the shortcut 

menu. 
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Result 
The Dashboard is displayed in full-screen mode. 

 

Alternative procedure 
You can also display the Dashboard in full-screen mode by means of double-click. 

See also 
Creating the dashboard layout (Page 636) 

Configuring dashboard objects (Page 640) 

Example of configuring a dashboard (Page 644) 
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2.3.5 Widget Dashboards in the client 

Overview 
Widget Dashboards are conceived for the display in the web or on mobile devices. For this 
reason, only configure Widget Dashboards in Energy Manager Web. Further details on the 
configuration of Widget Dashboards can be found in the section Configuring a Widget 
Dashboard. Deleting and creating Widget Dashboards is also possible in the 
Energy Manager PRO Client. 

Procedure 
1. Click the "Insert Widget Dashboard" icon in the menu bar under "Analysis > Reporting ". 

 
2. Enter a name and an optional description for the new Widget Dashboard. 

 
3. Save your entries. The Widget Dashboard is created. 

 
4. In order to delete a Widget Dashboard right-click the Widget Dashboard in the project tree 

and select "Delete". 

See also 
Creating Widgets (Page 169) 

Creating Quicklinks in the Web (Page 103) 
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2.4 Energy efficiency measures 

2.4.1 Basics on energy efficiency 
The Energy Manager "Energy Efficiency" module provides company-wide transparency in the 
management of energy efficiency measures. The Energy Manager "Energy Efficiency" module 
was developed in accordance with DIN EN ISO 50001.  

The Energy Manager "Energy Efficiency" module provides the following options for 
management of the energy efficiency measures: 

• You can enter all energy efficiency measures for all locations of your company. 

• You can enter the saving potential and cost of the energy efficiency measure and calculate 
its cost efficiency. 

• You can assign a status that indicates the degree to which the energy efficiency measure 
has been implemented. 

Procedure for managing energy efficiency measures 
1. Create an energy efficiency measure. 

2. Enter the plant and location for which you defined the energy efficiency measure. 

3. Enter the financial saving potential for the plant. 

4. Enter the running costs for the plant and calculate the cost effectiveness of your energy 
efficiency measure. 

5. Define a user responsible for the energy efficiency measure. 

6. Create one or several domains that are permitted to view and edit an energy efficiency 
measure. 

7. Select a status for the energy efficiency measure. 

See also 
Creating energy efficiency measures (Page 77) 

Specifying the financial savings potential (Page 78) 

Calculating cost effectiveness (Page 80) 

Specifying responsibilities (Page 82) 

Specifying domains (Page 83) 

Displaying information (Page 85) 
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2.4.2 Creating energy efficiency measures 

Procedure 
1. Click the "Insert Energy Efficiency Measures View" button in the menu bar under "Analysis > 

Energy Efficiency". 

The "Energy Efficiency Measures View" dialog opens. 

2. Click "New". 

The "Energy Efficiency Measure" dialog opens. 

3. Select a name for the energy efficiency measure under "Project Name" on the "General" tab. 

4. If required, also enter a description of the actual state and target state of the consumption 
situation. 

5. Select the priority of the energy efficiency measure under "Category", for example, "A-
Project" for the top priority. 

6. Enter a region, a plant and a business unit for efficient filtering of the energy efficiency 
measure. 

 
7. Confirm the configuration with "OK". 
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Result 
You created the energy efficiency measure.  

 
You can edit or delete the energy efficiency measure, or create a new one. 

See also 
Configuring the plant (Page 544) 

2.4.3 Specifying the financial savings potential 

Overview 
Enter the financial saving potential of an energy efficiency measure in the "Saving 
Capabilities" tab separately for each consumption medium. The saving potentials comprise: 

• Costs incurred prior to the introduction of the energy efficiency measure 

• Scheduled costs following the introduction of the energy efficiency measure 

• Costs incurred after introduction of the energy efficiency measure 

Requirement 
You created the energy efficiency measure. 

Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Energy Efficiency Measure" dialog opens. 

2. Select the "Saving Capabilities" tab. 

3. Enter a consumption medium. 

4. Select a unit for the consumption medium. 
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5. Select a parameter, or enter a constant value for the costs and the CO2 production per unit. 

6. Enter your values for the post measure state and the planned state of consumption. 

7. Confirm the configuration with "OK". 

Result 
You have successfully entered the financial saving potentials for the energy efficiency 
measure. The total of all savings and the CO2 reduction is calculated in the "Summary" area. 
The difference between the planned and the actual state of consumption is calculated under 
"Diff. Pl." and "Act. Diff.".  

 

You can edit, delete, or enter new financial energy-saving potentials. 

See also 
Creating energy efficiency measures (Page 77) 
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2.4.4 Calculating cost effectiveness 

Overview 
Implementation of an energy efficiency measure is initially subject to costs, e.g. purchase of a 
generator with lower consumption figures. On the "Cost Effectiveness" tab, enter the 
investment costs, the running costs, and the time period for the costs of the energy efficiency 
measure. Continue by calculating the cost efficiency of the energy efficiency measure. 

Requirement 
You created the energy efficiency measure. 

Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Energy Efficiency Measure" dialog opens. 

2. Select the "Cost Effectiveness" tab. 

3. Select a period for which you want to calculate the cost efficiency of an energy efficiency 
measure. 

4. Enter a name and a value for the annual active costs. 

5. Enter the values for the investment costs and for the internal interest rate. 

6. Click "Calculate" to calculate the cost effectiveness of the energy efficiency measure. 

The result is displayed in the "Calculations" area of the following fields. 

– ROI (return on investment): Displays the ID for returns on investments. 

The ROI indicator is calculated using the following formula: 

 
– NPV (net present value): Displays the net present value of capital.  

If the interest rate has a constant value, the capital value is calculated using the 
following formula: 

 

If the interest rate is a parameter, the capital value is calculated using the following 
formula: 

 



 Energy Manager PRO Client 
 2.4 Energy efficiency measures 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 81 

– Amortization time: Displays the amortization period.  

The payback time (amortization) is calculated using the following formula: 

 

 

7. Confirm the configuration with "OK". 

Result 
You have successfully calculated the cost efficiency of the energy efficiency measure. You can 
edit the entries and recalculate the cost efficiency of the energy efficiency measure. 

See also 
Creating energy efficiency measures (Page 77) 
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2.4.5 Specifying responsibilities 

Overview 
On the "Responsibility" tab, you define the responsible person for an energy efficiency 
measure for information purposes.  

Requirement 
• You created the energy efficiency measure. 

• The user has been created. 

Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Energy Efficiency Measure" dialog opens. 

2. Select the "Responsibility" tab. 

3. Select the responsible person. 

The user details are displayed. 

 
4. Confirm the configuration with "OK". 

Result 
You have successfully specified responsibilities for the energy efficiency measure.  
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See also 
Creating energy efficiency measures (Page 77) 

Setting up users (Page 672) 

2.4.6 Specifying domains 

Overview 
Use the "Domains" tab to specify domains that are permitted to view and edit an energy 
efficiency measure. 

By assigning a domain to an energy efficiency measure, you ensure that company employees 
will only be able to view and edit the energy efficiency measures that are implemented at 
their location. 

Requirement 
• You created the energy efficiency measure. 

• The client has been created. 

Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Energy Efficiency Measure" dialog opens. 

2. Select the "Domains" tab. 
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3. Select the required client under"Available" and assign this client to the "Assigned" group. 

 
4. Confirm the configuration with "OK". 

Result 
You have specified the client for use of the energy efficiency measure. You can remove the 
client from the "Assigned" group, or assign a new client to this group.  

See also 
Creating energy efficiency measures (Page 77) 

Authorizations (Page 665) 

2.4.7 Adding documents 

Overview 
On the "Attachments" tab, insert documents that contain additional information for an 
energy efficiency measure, e.g. charts or sketches. These documents are not managed in the 
Energy Manager document management. 

Requirement 
You created the energy efficiency measure. 
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Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Energy Efficiency Measure" dialog opens. 

2. Select the "Attachments" tab. 

 
3. Click "Add" and select the document that you want to insert for the energy efficiency 

measure. 

4. Confirm the configuration with "OK". 

Result 
You have successfully inserted the document for the energy efficiency measure. You can edit 
or delete the document, or add a new one. 

See also 
Creating energy efficiency measures (Page 77) 

2.4.8 Displaying information 

Overview 
The "Overview" tab shows you information on an energy efficiency measure, including: 

• Name 

• Investment costs 

• Saving potentials 
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• Responsible person 

• Location 

You can also assign a status for the energy efficiency measure in the "Overview" tab and 
export the information on the energy efficiency measure to Microsoft Excel. 

Requirement 
You created the energy efficiency measure. 

Procedure 
1. Double-click the relevant energy efficiency measure in the overview of energy efficiency 

measures. 

The "Overview" tab opens in the "Energy Efficiency Measure" dialog. 

2. Under "Status", select the required status to assign it to the energy efficiency measure. 

3. Click "Export" to visualize the information provided on the "Overview" tab in Microsoft Excel. 

 
4. Confirm the configuration with "OK". 

See also 
Creating energy efficiency measures (Page 77) 
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2.5 File management 

2.5.1 Document management basics 

Definition 
With the document management you manage external documents in Energy Manager, for 
example documents in the format PDF, Excel or Word. 

 

 Note 
Applications for external documents 

If you want to open and edit an external document in Energy Manager, the correct 
application must be installed on your PC. 

 

Usage 
You use document management if you require additional application for energy 
management in Energy Manager . 

Using document management, you can manage external documents in Energy Manager as 
follows: 

• Link documents 

This option lets you insert a link for the document that is saved on your PC. Once inserted, 
you can use this link to call up the document in Energy Manager with the respective 
application. Please note that the document is only available to you. Other users do not 
have access to the document.  

 
  Note 

General access to linked documents 

To allow other users access to the linked document, save the document in a folder with 
general access. 

 

• Loading a document into the Energy Manager database 

This option lets you save the document to the Energy Manager database. This means that 
you and all authorized users can access the document. 
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Example 
You want to use Energy Manager to provide an energy requirement forecast for your 
organization for the coming year. To do this, you require the energy tariffs of the current 
year. In order to access the relevant information during configuration, you need to create a 
link in Energy Manager to the document containing the energy tariffs or to save the 
document in the Energy Manager database: 

 

You can open the document from the project tree of the PRO Client with the respective 
application and edit it if required. 

2.5.2 Inserting documents 

Procedure 
1. Change to Windows Explorer and select the corresponding document. 

2. Copy the document to the clipboard. 

3. Return to Energy Manager and select the object at which you want to save the link. 

 
4. Paste the object from the clipboard. 

 
  Note 

Documents to be shared with other clients must be stored in a public directory.  
 

Result 
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2.5.3 Saving documents 

Overview 
You can save files in all standard formats, e.g. image or document files, to the database. In 
this way you enable access of other users to these files.  

Requirement 
• Successful installation of all software components. 

• The user has been assigned the following rights: 

– "viewing existing files" to open files. 

– "editing existing files": to save files to the database. 

The following error messages are output if these rights are missing: 
 
No permissions Error message Remedy 
"viewing existing files" <date><time> 

You are not authorized to open this file. 
Assign the corresponding authorization. 

"editing existing files" 
("File \ Data \ fetch") 

<date><time> 
You are not authorized to add this file. 

Assign the corresponding authorization. 

File size limit exceeded The file may not exceed the size of 
<value>. 

Ask your system administrator to adjust 
the "FILE_MAX_SIZE_KB" in Energy 
Manager options. 

Procedure 
1. Select the folder in which the object is going to be created. 

 
2. Click the "Insert File" button in the menu bar under "Analysis > File". 

 
The file object configuration dialog opens. 
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3. Enter a "Name" and an optional "Description". 

4. Enter the path and file name in the "Path" field. 

5. Save the configuration with "OK". 

Result 
You have successfully created a data object and saved a file to the database.  

 

2.5.4 Editing documents 

Requirement 
• At least one link and one file have been saved to the database. 

• The user is authenticated accordingly. 

Procedure 
1. Double-click the link or the file object. 

Result 
The file opens in the corresponding application on the client. 
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 Energy Manager Web 3 
3.1 Basics 

3.1.1 Introduction 

Overview 
Energy Manager Web is a browser-based user interface for the Energy Manager energy 
management system. Energy Manager PRO Web is used to access Energy Manager PRO via 
the Internet/Intranet.  

The administrator configures the data you may access in Energy Manager. 
 

 Note 
Installation of Energy Manager Web 

You can find information on the installation of Energy Manager Web in the installation 
manual "Energy Manager - Installation", section "Setting up Energy Manager Web". 

 

 NOTICE 

Secure connection between web client and web server 

If you configure the connection between web client and web server, use only secure Cipher 
Suites. 

A list of secure Cipher Suites can be found in the reference under "Cipher Suites". 
 

Login and logout 
In order to work with Energy Manager Web, you need a user name, a password associated 
with it, and rights to the data that you want to view. 

For security reasons, a user is automatically logged out after a period of inactivity. The 
duration of inactivity is configurable globally in the Web.config file or in Microsoft Internet 
Information Services (IIS). 
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User interface of Energy Manager Web 
The following figure shows the user interface of Energy Manager Web: 

 
① Navigation area 

In the navigation area, select the objects you want to view or edit. Use the menu or Quicklinks to navigate. The 
navigation options available depend on your user rights.  

② Detail area 
In the detail area, Widget Dashboards and objects such as reports or charts are displayed. The selection in the navi-
gation area and the selected query type and observation period determine which objects are displayed.  
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Tasks in Energy Manager Web 
Use Energy Manager Web to handle the following tasks: 

• Viewing, configuring and creating: 

– Reports 

– Charts 

– Matrices 

– Widget Dashboards 

– Folder 

• Opening documents and uploading new documents in Energy Manager 

• Viewing and editing energy efficiency measures 

• Manual measurement data value acquisition 

• Creation and configuration of data sources, data points, parameters and key performance 
indicators 

• Configuring the system settings 

 

 Note 
Functionality of Energy Manager Basic 

The configuration of energy efficiency measures and file management is not available in 
Energy Manager Basic. 

 

See also 
Login (Page 94) 

Navigation (Page 99) 

Definition of home page (Page 97) 

Cipher Suites (Page 920) 

Configuration of the analysis objects (Page 158) 

Project configuration (Page 238) 

Settings (Page 306) 

Manual acquisition of data in the Web (Page 144) 

File management in the Web (Page 140) 

Energy efficiency measures in the Web (Page 142) 
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3.1.2 Login 

Overview 
You can open the Energy Manager Web home page at the following URL: 

• http://<Energy Manager Webserver>/EnMPROWeb 

Contact your administrator to obtain the address or name of the Energy Manager Web Server.  

Energy Manager Web supports secure communication with the Energy Manager Web Server 
via https. Your administrator can provide you with all information needed to use https 
communication.  

If you log into Energy Manager Web with Active Directory, check the following settings of the 
web browser, if necessary: 

• Microsoft Internet Explorer: 

– "Internet options > Advanced > Security > Enable Integrated Windows Authentication". 

• Mozilla Firefox: 

– Enable the URL of Energy Manager Web in "about:config" of the web browser. 

– Open Energy Manager Web via "Fully-Qualified Host Name". 

You can find additional information in the section "Setting up Energy Manager Web" in the 
installation manual "Energy Manager - Installation".  

Procedure 
1. Start an Internet browser and enter the appropriate URL . 

The login page of Energy Manager Web opens.  
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2. If the "Single Sign On" option is activated for your user account or your user group, the user 
name and password do not have to be entered. Click the "Windows logon" button instead. 
You are then logged into Energy Manager PRO Web with your Windows user name and your 
Windows password. 

 
  Note 

Functionality of Energy Manager Basic 

The ""Single Sign On" option is not available in Energy Manager Basic. 
 

3. If the option "Single Sign On" is not activated for your user account, enter the user name and 
password. 

To do this, use your login information for Energy Manager. 

4. Activate the "Remember user name" check box to save the login data for the next 
authentication. 

5. Select the language in the "Languages" drop-down list, if necessary. You can select the 
following languages: 

– German 
– English 
– Spanish 
– French 
– Italian 
– Chinese 

6. If you want to change your password, click "Change Password". 

7. If you want to generate a temporary password, click "Password Lost". 

The "Password Lost" page is opened. 

 
8. Click "Login". 
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Result 
You are now logged in to Energy Manager Web .  

Changing passwords 
You can change your Energy Manager password in the login dialog. To change it, you need 
your current password or a temporary password.  

 

 Note 

You will be separately notified via email regarding a password change. If you have received 
such an email, without having changed your password, your user account may have been 
hacked. Please contact your administrator in this case.  

 

Forgot password 
If you have forgotten your password, you can have a temporary password generated. The 
temporary password will be sent by email to the email address that is stored in your 
Energy Manager user account.  

If you have received the email with the temporary password, click "Change password" in the 
login dialog.  

See also 
Introduction (Page 91) 

Creating functional groups (Page 687) 

Setting up users (Page 672) 

Definition of home page (Page 97) 
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3.1.3 Definition of home page 

Home page of Energy Manager Web 
After logging into Energy Manager Web you automatically go to the home page of 
Energy Manager Web. Use the Quicklinks or tree structure for navigation. Quicklinks are links 
to frequently used objects. An overview of existing Quicklinks is available in the navigation 
area under "Quicklinks". With the help of the tree structure you navigate through the object 
and folder structures within your system. You open the tree structure by clicking on "Tree" in 
the navigation area. 

The following figure shows the home page of Energy Manager Web: 

 
① Logo 

The SIEMENS logo is set by default. You can select your own company-specific logo in the "Web Client settings".  
② Menu bar 

The menu bar consists of the following three menus: 
• Home: Navigate through the folder and object structures with the help of the navigation area. Have the corre-

sponding folder contents and objects in the detail area. 
• Configuration: Configure data sources, data points, parameters and MEVAs / KPIs as well as the system settings. 
• Data import: Import measured values of data points from a csv file. 

③ Navigation area 
In the navigation area, select the objects you want to view or edit. Use the menu items or Quicklinks for navigation. 
The folder contents and objects that are available to you in the navigation area depend on your user rights and the 
entry point of the respective user group in Enegry Manager Web.  
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④ "Enable edit mode" 
Click on the Edit icon to enable edit mode. In editing mode you create new objects and configure created objects. 
You also have the option of individually structuring your Energy Manager system. 

⑤ Detail area 
Folder contents and objects are displayed in the detail area. The selection in the navigation area determines which 
objects are displayed. 

⑥ User name and logout 
• Displays the name of the logged in user. 
• To log off from Energy Manager Web, click on the "Logout button". 

⑦ Product name 
The product name "Energy Manager Basic" or "Energy Manager PRO" is set by default. You can enter your individual 
product name in the "Web Client settings".  

⑧ Help and version information 
• Online Help for Energy Manager: Forwards you to the online help of Energy Manager. 
• About Energy Manager: Displays basic information about Energy Manager . 

⑨ "Add Quicklink" 
Create Quicklinks for frequently used objects by clicking on the "Add Quicklink" button. More information about 
Quicklinks and creating Quicklinks can be found in the section "Quicklinks". 

See also 
Web Client settings (Page 316) 

Editing mode (Page 158) 

Defining an entry point (Page 685) 

Login (Page 94) 

Navigation (Page 99) 

Introduction (Page 91) 

Creating Quicklinks in the Web (Page 103) 

Importing measured values (Page 154) 

Quicklinks (Page 103) 
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3.1.4 Navigation 

Navigation via the menu 
All objects enabled for Energy Manager Web are arranged according to the breadcrumb trail 
method in the navigation area. 

The following figure shows the navigation principle in the navigation area: 

 
① Clicking on the menu item itself displays its structure in the navigation area as well as its content in the detail area 

(in the example "Gas consumption OE 05"). All remaining menu commands on the same level are hidden.  
Clicking on the arrow of a menu item opens and closes its structure again in the navigation area without updating 
or reloading the content of the detail area. When you click on the icon of an object in the navigation area, its struc-
ture (e.g. data points used) is also opened and closed again in the navigation area without updating the detail area. 

② You go back to the previous display by clicking on the parent menu command (in the example "Reports"). 
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Navigation via Quicklinks 
Quicklinks work like bookmarks in Internet browsers. Quicklinks gives you access to 
frequently used objects. They are stored as tiles in the "Quicklinks" area.  

You can specify a Quicklink as a home page in Energy Manager Web. The content of the 
object to which the Quicklink refers is then displayed upon the next login. 

Your personal Quicklink settings are stored and linked to your user account. This means that 
your Quicklink settings are available on other PCs.  

 
① Quicklinks 

Design and name are copied by default from the object to which the Quicklink refers. You can edit the Quicklink by 
clicking the Edit icon. You can change the order of the Quicklinks using drag-and-drop.  

② Create a new Quicklink for a selected object. 
③ Scroll through the Quicklink list 

Scroll forward and backward through the Quicklink list using the "<" and ">" buttons. The points show the number 
of pages in the Quicklink list. 

See also 
Creating Quicklinks in the Web (Page 103) 

Editing Quicklinks in the Web (Page 106) 

Introduction (Page 91) 
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3.1.5 Consumers and structured view on the web 

Requirement 
• The Consumer functionality is licensed separately. 

Overview 
In Energy Manager Web, you have the option of having all consumers defined in the 
Energy Manager PRO Client displayed by their location or their organization unit. 

Procedure 
1. If you want to display all consumers of a location, click the menu item "Geographical". 

2. If you want to display all consumers of an organization unit, click the menu item 
"Organisation". 

Result 
1. All consumers of a location are displayed. 
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2. All consumers of an organization unit are displayed. 

 
When you click on the icon of a location or organizational unit, the structure of the object 
opens and closes in the navigation area. When you click on the writing of the object, the 
related Widget Dashboard is displayed in the detail area. The administrator sets the definition 
and configuration of this Widget Dashboard in the consumer templates. 

See also 
Widget Dashboards for consumers (Page 116) 

Consumers and structured view (Page 591) 

Load templates (Page 708) 

Navigation (Page 99) 
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3.1.6 Quicklinks 

3.1.6.1 Creating Quicklinks in the Web 

Overview 
In Energy Manager Web you create Quicklinks to frequently used objects. 

Requirement 
• You have the functional authorizations "Create Quicklinks" and "Configure Quicklinks". 

Procedure 
1. In the navigation area, click the object for which you want to create a Quicklink, for 

example, "Reports". 

2. Click the "Add Quicklink" icon. 
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The "Edit Quicklink" configuration dialog opens. 

 
3. To create the Quicklink, click on the "Save" button. 

Result 
The Quicklink is created as follows: 

• The object name is adopted. 

• The preset icons and background color are used. 

 

Exception: Creating Quicklinks for reports 
1. Select the required report in the navigation area and click the "Add Quicklink" icon. 

The "Create new Quicklink" dialog opens. 

 
2. If you want to create a Quicklink to the overview of the report, activate the option "Create 

Quicklink to current view". 
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3. If you want to create a Quicklink to the latest result of the report, select the option "Create 
Quicklink to latest element". 

4. Select the required format, e.g. Excel or PDF. 

 
If you select the Quicklink, the report opens in the selected format. 

5. Edit the Quicklink as desired and save your entries. 

See also 
Navigation (Page 99) 

Editing Quicklinks in the Web (Page 106) 

Create Quicklinks (Page 33) 

Quicklinks for Web (Page 681) 

Definition of home page (Page 97) 

Widget Dashboards in the client (Page 75) 

Authorizations (Page 665) 

Reports (Page 217) 

Quicklinks (Page 33) 
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3.1.6.2 Editing Quicklinks in the Web 

Overview 
You can change the order of the Quicklinks in the "Quicklinks" area. If you no longer require 
Quicklinks, you can delete the Quicklinks again. You can also customize the Quicklinks, for 
example, by changing the background color or the icon. 

Requirement 
• You have the functional authorizations "Configure Quicklinks" and "Delete Quicklinks". 

Change the sequence of the Quicklinks 
1. Click on the menu item "Quicklinks". 
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2. To move a Quicklink, use drag-and-drop to place it at the required position. 

 
The Quicklink is placed at the respective location. 
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Customize Quicklink 
1. Click the Edit icon in the "Quicklinks" area above the required Quicklink. 

 
The "Edit Quicklink" dialog box opens. 

 
2. To rename the Quicklink, enter the desired name in the "Name" entry field. 

3. To change the Quicklink icon, click on "Icon" and select the desired icon. 

You can choose from 18 predefined icons. 
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4. To change the background color of the Quicklink, click on "Background color" and select the 
required background color. 

 
5. To specify the Quicklink as home page, select the "Choose Quicklink as home page" check 

box. 

 
  Note 

If you do not specify any Quicklink as homepage, the first Quicklink in the "Quicklinks" 
area is used as homepage page. 

 

6. Click on the "Save" button. 

Delete Quicklink 
1. Click the Edit icon icon above the desired Quicklink. 

The "Edit Quicklink" dialog box opens. 

2. Click the "Delete" button. 

The Quicklink is deleted. 

See also 
Navigation (Page 99) 

Creating Quicklinks in the Web (Page 103) 

Editing Quicklinks (Page 35) 

Quicklinks for Web (Page 681) 

Authorizations (Page 665) 
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3.2 Data analysis in the Web 

3.2.1 Folder 

Overview  
In Energy Manager Web you can see all folders and their contents which were defined by the 
administrator as an entry point for you. The available options depend on the user rights of 
the respective user group to which you are assigned. The administrator configures the user 
rights of the user groups in the Energy Manager PRO Client. 

 

 Note 
Functionality of Energy Manager Basic 

In Energy Manager Basic the following entry point is always used for the user: 
"Energy Manager - Web". 

 

View folder contents 
1. Click on the entry point ("Energy Manager - Web") in the navigation area. 

2. Click the folder whose contents you want to see. 

 

Result 
The content of the desired folder is displayed in the detail area. You can learn how to create, 
edit and delete new folders in the section "Configuration of analysis objects" in the section 
"Folder". 

See also 
Defining an entry point (Page 685) 
Creating folders (Page 234) 
Editing folders (Page 236) 
Creating users (Page 320) 
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3.2.2 Widget Dashboards 

3.2.2.1 Overview of Widget Dashboards 
Widget Dashboards allow rapid visualization of a wide variety of plant data on a single page. 
Widget Dashboards are designed for display in the Web or on mobile devices. For this reason, 
only configure Widget Dashboards in Energy Manager Web. In the 
Energy Manager PRO Client you can only create and delete Widget Dashboards. 

 

 Note 

The functional authorization "Widgets/Dashboards - create, remove, configure" is required to 
create, delete and configure a Widget Dashboard. In addition, the "view" authorization is 
available for displaying and "configure" solely for the configuration.  

 

Requirements 
• The Widget Dashboard is created in Energy Manager. 

• The Widget Dashboard is enabled for the user. 

Display of Widget Dashboards 
To open a Widget Dashboard in Energy Manager Web, click in the navigation area on the 
corresponding Widget Dashboard. The Widget Dashboard is displayed in the detail area.  

 
① Name of the dashboard 
② Changing the observation period 
③ Configuration of the Widget Dashboard 
④ Display of the Widget Dashboard as a full screen 

When you click on ④, the Widget Dashboard is displayed as a full screen. 
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When you click on ③, you open the configuration mode of the Widget Dashboard. 

 
① Add new widgets. 
② Edit the settings of the Widget Dashboard. 
③ Close configuration mode. 

To create new widgets in the Widget Dashboard, click on the "Add Widget" button. For more 
information on creating widgets, refer to the section "Creating widgets". 

Click on the "Settings" button to configure the generally valid settings of the Widget 
Dashboard. You can find additional information on configuring widgets in the section "Editing 
Dashboards". 

To close the configuration mode, click on ③. 

Displaying widgets in the Widget Dashboard 
The following figure shows a created and already configured Chart Widget in the 
configuration mode of the Widget Dashboard: 
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• Using the icon in the top left-hand corner, move the widget using drag and drop. 

• Using the Edit icon in the top right-hand corner, open the configuration dialog of the 
widget. 

• Using the icon in the bottom right-hand corner, adjust the size of the widget using drag 
and drop. 

When you close the configuration mode of the Widget Dashboard, the widget is displayed in 
the selected size and position in the Widget Dashboard. The following figure shows the same 
Widget Dashboard in non-configurable mode: 

 

• Using the magnifying glass symbol in the top right-hand corner, open the detail view of 
the widget. 

• With the Dashboard link icon to the right of the magnifying glass icon, change to the 
Dashboard selected in the "General"tab ("Dashboard" drop-down list). 

• With the CSV Export icon to the left of the magnifying glass icon, export the measured 
values for a Chart Widget as a CSV file to the download directory of your Internet browser. 
The export file is saved with the name "EnMPRO_dashboardname.csv". 

With the exception of the following widgets, each completed widget shows the following 
additional information in addition to the actual display. 
• Report 
• Text 
• Image 
• Map 
• Alarmlist 
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You can define the display information via the grey dots in the bottom part of the detail view 
of the widget. The grey dots are also available in the normal view for the following widgets:  

• Chart 

• Duration Curve 

• Sankey 

• MVRA 

In the detail view you can alternatively define the display information using the arrow 
buttons on the right-hand and left-hand side of the widget.  

The following additional information is available: 

• Widget: 

Displays the main information of the widget. 

• History: 

Displays the values of the data points as a chart in the defined observation period. 

• Histogram: 

Displays the values as a histogram with equal intervals. The display corresponds to the 
histogram in the Energy Manager PRO Client. In addition, the statistical values minimum, 
maximum, median, average and standard deviation are displayed. Values outside the 
plausibility limits are not marked in the histogram. 

• Regression: 

Shows the correlation and regression analysis as well as the linear correlation as a 
formula. 

You can find out how to configure the individual widgets via the respective tabs in the 
section "Widget configuration". 

Changing the observation period 
To change the observation period of the dashboard and the widgets contained therein, 
follow these steps: 

1. Click on the date of the Dashboard in the top part of the Dashboard. 

The appointment calendar opens. 

2. Select the (start) date and time. 

3. Click the "Apply changes" button. 

4. Click on the adjacent query type in the top part of the Dashboard. 

A list with the selection of the query type opens.  

5. Select the query type associated with the start time. 
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The observation period of the Dashboard adapts to your settings. If you have selected the 
check box "Use dashboard settings" in the configuration settings of the widgets as the query 
type, the observation period of the widgets changes accordingly. 

 

 Note 

If you have selected a particular date including query type in the configuration settings of a 
widget, the observation period of the widget in question does not change. 

 

See also 
Creating Widgets (Page 169) 

Editing dashboards (Page 165) 

Widget Dashboards for consumers (Page 116) 

Editing widgets (Page 172) 

Setting up dashboards (Page 163) 

Widget Configuration (Page 194) 

Dashboards (Page 163) 

Available Widgets (Page 173) 
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3.2.2.2 Widget Dashboards for consumers 

Requirement 
• The license for the Consumer functionality is available. 

Overview 
You have the option of creating Widget Dashboards for individual consumers as well as for 
entire locations or organization units. The functionality of selecting associated datapoints and 
MEVAs for consumers is available. When you assign a consumer to a consumer template in 
the Energy Manager PRO Client and define a default Widget Dashboard, this Widget 
Dashboard is displayed when you click on the consumer. You can then configure this Widget 
Dashboard. More information about creating a consumer and a consumer template can be 
found in the sections "Consumers and structured view "and "Consumer templates" in the 
complete operating manual of Energy Manager PRO. 

If you want to view the entire consumer structure in Energy Manager Web, copy the 
consumer to the entry point defined for the user group. 

 

Opening the Widget Dashboard for consumers 
To open the Widget Dashboard for consumers, follow these steps: 

1. In the navigation area, click under the menu item "Geographical" or "Organisation" on the 
consumer whose Widget Dashboard you wish to display. 

 

The default Widget Dashboard in the Energy Manager PRO Client is opened.  

2. To open the configuration mode, click on the gear icon. 
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3. In the "Data source" tab, select the check box "Consumer variable". 

Only data points and MEVAs of the consumer are listed. 
 

  Note 

If you create the Widget Dashboard at the geographical or organization unit level, the data 
points and MEVAS of all consumers located below are available for selection. You thus 
have the option of designing a Widget Dashboard as an overview of all consumers of a 
location or an organization unit. 

 

4. Select the data points and MEVAS you want to display in the widget. 

 
5. Complete the configuration of the widget in accordance with section "Widget configuration 

(Page 194)". 

If you have created several Widget Dashboards for a consumer, the Widget Dashboards are 
displayed in the tree structure of the navigation area below the consumer.  

 

If you have selected a Widget Dashboard, change between the individual Widget Dashboards 
by clicking one of the nodes visible at the bottom. 
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Use of placeholders for designations 
When configuring the Widget Dashboard you have the option of using placeholders. These 
placeholders are replaced with specific names or descriptions. You can use the placeholders 
in the title of the dashboard, in the title of a widget and in the widget "text" as well as in the 
text itself. 

You can use the following placeholders: 

• {MACHINE_NAME} corresponds to the name of the consumer 

• {MACHINE_DESCRIPTION} corresponds to the description of the consumer 

• {MACHINE_PRODUCER} corresponds to the producer of the consumer 

• {MACHINE_TEMPLATE} corresponds to the name of the consumer template 

• {MACHINE_LOCATION} corresponds to the location of the consumer 

• {MACHINE_BALANCING_GROUP} corresponds to the organization unit of the consumer 

• {ORG_NAME} corresponds to the name of the organization unit 

• {ORG_DESCRIPTION} corresponds to the description of the organization unit 

• {LOCATION_NAME} corresponds to the name of the location 

• {LOCATION_DESCRIPTION} corresponds to the description of the location 

• {LOCATION_LOCATION} corresponds to the "Location" entry field in Location 

 Use the expressions including the curly brackets. 

See also 
Consumers and structured view (Page 591) 

Load templates (Page 708) 

Consumers and structured view on the web (Page 101) 

Overview of Widget Dashboards (Page 111) 

Setting up dashboards (Page 163) 

Configuring the "Data Source" tab (Page 197) 
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3.2.3 Online Monitoring 
Online Monitoring enables you to display data points of Modbus devices and OPC channels in 
real time. The sections Creating a Modbus TCP channel (Page 264) and Creating OPC DA, OPC 
HDA, OPCUA channels (Page 255) describe how to configure the Online Monitoring for 
Modbus devices and OPC channels.  

You can find all data points with Online Monitoring in the navigation field under the structure 
"Web Konfiguration > Monitoring". 

 

This folder structure is also adopted in the Energy Manager PRO Client. However, in Energy 
Manager PRO Client you cannot make any changes to the objects in the folder "Monitoring". 

To open Online Monitoring, click on the corresponding entry. 

Configuration 
Under "Configuration", configure the Online Monitoring. You can activate the following 
functions for each data point: 

• Display in chart: The corresponding data point is displayed in the Online Monitoring chart. 

You can activate this function for a maximum of 10 data points at the same time. 

• Archive data: The values of the data point are saved for Online Monitoring for 62 days. 
Historical values are displayed in the chart only for these data points. When you deactivate 
this function, already archived data are not deleted. 

 

 Note 

A maximum of 1000 data points per acquisition component and a maximum of 25 data 
points per device can be simultaneously archived. 
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The data points are displayed in tabular form: 

 

The table contains the following six columns: 
 
Column Function 
Name Name of the data point 
Unit Unit of the value of the data point 
Value Current value of the data point 

This value is updated in the acquisition cycle of Online Monitoring. 
Show in chart: If this option is selected, the corresponding data point is shown in the Online Moni-

toring chart: 
Archive data If this option is activated, the values of the corresponding data point is saved for 62 

days. 
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Chart 
The data points selected under "Configuration"are graphically displayed under "Chart". 

 
① Visualizing the data points 

To observe a specific area, keeping the mouse pointer pressed draw a frame around the desired area. 
To reset the display, click on the "Reset zoom" button at the top right-hand corner of the chart. 

② Selection of the displayed time period 
If you select a time period while the online mode is activated, the online mode is deactivated. 

③ Online mode 
While the online mode is activated, the current minute and the past 14 minutes are always displayed in the chart. 

④ Legend 
To hide a data point, click on the corresponding data point in the legend. 
Click on the data point again to display it again. 

 

 Note 
If you select a time period with a large number of measured values, loading the chart make 
take a considerable amount of time. 
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3.2.4 Reports 

Overview 
Energy Manager PRO Web shows you the reports you configured in Energy Manager 
PRO Client. You can also generate new reports in Energy Manager Web . 

 

 Note 
Functionality of Energy Manager Basic 

In Energy Manager Basic you can create reports only with the help of five predefined 
templates. All the settings are predefined in these report templates. 

 

The structure of a report result in Energy Manager Web consists of the following objects: 

 
① Report 
② Report results 
③ "Options" tab 
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The figure below shows the "Options" tab for a report: 

 
① In this area, depending on the time range, you configure the query type and as needed addi-

tional settings, such as the use of a different calculation model.  
② If the report contains configurable modules, each of these modules is displayed as a separate 

area. 

Report creation is based on the configuration for automatic reporting.  
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Requirement 
• The report has been created in Energy Manager . 

• The report has been released for the current Web application. 

• Microsoft Excel and PDF-Reader are installed on the PC. 

Generating a report in the Energy Manager Web 
1. To generate the report in Energy Manager Web , select the desired report and then click the 

"Options" tab in the right window pane. 

The "Options - Start report" dialog opens.  

2. In the "Options" area, select a query type for the report. 

3. Under "Start report - General parameters", specify the time range for the report. 

4. Click "Advanced settings" to set the additional parameters for report generation. 

5. In order to change the starting parameters for the modules that are used, select the desired 
module on the left, and change the starting parameters as desired. 

6. Click "Start". 

The report is generated. 

You can display or open the report. 

Specifying additional parameters for the report (optional) 
1. Click "Options" in the " Advanced Settings" dialog. 

The advanced settings are displayed. 

2. Disable "Current version" and select a date to define the measured value version for 
evaluation. 
All measured values generated prior to this date are evaluated. 

The current date is activated by default. 

3. Deactivate "Current model" and select a model date to define a calculation model for 
evaluation of the report. 
The report is evaluated by default based on the current calculation model. 

4. Select the compression level in a report to evaluate the compression level values. 

5. If necessary, select the required batch under "Batches". 

6. Under "Country", select the desired country. 

7. You can exclude the report from cyclic delete actions by activating "Retain report" option. 
If you do not activate "Retain report", the delete job for evaluations will be performed later. 
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Editing module start parameters (optional) 
1. Select the tab for the desired module. 

2. Specify the query type and time range if you have activated the "Query interval at start" 
option in the module configuration. 

3. You can always edit the interval, as well as the high and low limit of configured module start 
parameters. 

The start parameters are derived from the module configuration. 
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Displaying or opening a report in Energy Manager Web 
1. To display the report as a preview in PDFformat in Energy Manager Web , click the report 

result. 

The report is displayed in the detail area. 

2. To open the report in PDF format, click the "PDF" icon in the row with the report result. 

The report is displayed in Acrobat Reader . 

3. To open the report in Microsoft Excel , click the "EXCEL" icon in the row with the report 
result. 

The report is displayed in Microsoft Excel .  

 
 

  Note 

If you change the result of the report, these changes are not saved in Energy Manager. 
 

See also 
Creating user groups (Page 684) 

Creating reports (Page 217) 

Configuring reports (Page 605) 

Reports (Page 50) 

Report (Page 601) 
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3.2.5 Charts 

3.2.5.1 Overview 
You use the Chart to display historical as well as current values. Use the chart for the 
visualization of measurement series.  

The Diagram or Chart functionality is available as a separate tab for the following objects: 

• Data point 

• Matrix 

• Chart object 

Chart tab for matrices and data points 

With matrices and data points, the Chart tab is available immediately after a click on the 
respective object. Configurations set in the chart, such as the number of displayed data 
points and the query type, are stored automatically for the active user. The configuration is 
saved with the object in the database. The selected time range is not stored. On a renewed 
display of the chart the current time range is always displayed. 

Own chart object 

There is also a separate chart object that you can use to visualize up to ten data points 
simultaneously. The configuration via the chart object is not referenced to a user. Thus it is 
possible to make a preconfigured chart available to several users. Open the chart by clicking 
on the corresponding chart in the navigation area.  
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Structure of the Chart tab 
The following figure shows the display of the chart in Energy Manager Web: 

 
① Selection of the "Chart" tab 
② Selection of the "Alarms" tab  
③ Selection of the "Comments" tab 
④ Selection of the "Values" tab 
⑤ Data point with a warning 
⑥ Name of the chart and displayed time period 
⑦ Selection of the displayed time period 

To change the time period, click on the arrow keys or . When you click , you open the time and date selection. 
You can find more information about time and date selection below.  
When the page is reloaded, the chart once again displays the time period specified by the configuration. 

⑧ Selection of the displayed compression level 
⑨ Exporting the chart 

You can export the displayed chart in the following form: 
• The values of the chart that are displayed at this time are saved as a file in "*.csv" format 

⑩ Configuration of the chart 
To open the "Data sources" tab of the configuration, click on  . 
To open the "General" tab of the configuration, click on  . 
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⑪ Visualizing the data points 
To observe a specific area, keeping the mouse pointer pressed draw a frame around the desired area. 
To reset the display, click on the "Reset zoom" button at the top right-hand corner of the chart. 

⑫ Data points with legend 
⑬ Data points outside of limits 

Date and time selection 
The following figure shows the date and time selection. 

 
① Selection of the displayed month 

To display another month in the calendar, proceed as follows: 
1. Click on the text with the month and year displayed. 
2. Select a year. 
3. Select a month. 
To display the previous or next month, click the arrow buttons. 
To select the current time period, click on . 

② Selection of the displayed time period. 
To display a time period on the chart, click a day in the calendar. The corresponding time period 
is selected automatically. 
If you selected the Ad-Hoc query type, select the start and end of the custom time period. 

③ Selection of the query type 
To display a time period with a user-defined start and end on the chart, select the "Ad-Hoc" 
option. 

④ Selection of the time 
This function is only supported with the "Ad-Hoc" query type. 
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Adding comments 
If you double-click a value in the diagram, the following dialog box opens: 

 
① Time stamp of creation of the comment 
② Comment (details hidden) 

To display the details of the comment, click the comment. 
③ Selected value 

Count value of the selected value. 
④ Time stamp of the selected value 
⑤ "Show all" button 

Click this button to show the details of all comments. 
⑥ "New comment" button 

Click this button to add a new comment to the selected value. 
⑦ "Hide all" button 

Click this button to hide the details of all comments. 
⑧ "Delete" button 

Click this button to delete the comment. 
⑨ Author 

Author of comment 
⑩ Comment 

Edit or write the comment in this input field. 
⑪ "Save" button 

Click this button to leave the dialog box and save the changes. 
⑫ "Cancel" button 

Click this button to leave the dialog box and not save the changes. 
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Display of details in the chart 
The figure below shows which details are displayed for the measured values of a 
measurement series in the chart: 

 
① Details 

Move the mouse pointer over the corresponding measured value to display the details of a 
measured value. The following information is included: 
• Data point name 
• Time stamp 
• Value 
• Comments 

② Measured value with comment 
Measured value with comments are marked with a hash character. 

③ Measured value outside warning levels 
Measured values which have exceeded the warning levels defined in the chart configuration are 
marked with a yellow dot. 

④ Data point outside limits 
Measured values which have exceeded the limits defined in the chart configuration are marked 
with a purple dot. 

 

 Note 

If a value displayed as a column exceeds or falls below a limit or warning value, the entire 
column is colored accordingly.  

 

 Note 

If a series is displayed as a bar chart, the diamonds that show comments are not visible for 
that series. 
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Structure of the Alarms tab  
A list with all the alarms for the shown period is displayed using the "Alarm" tab. 

The display table consists of the following five columns: 
 
Column Function 
Name of the series Name of the data point relating to the message 
Time stamp of 
measuring point 

 The time of measurement 

Time stamp of 
creation 

The time of creation of the message 

Level Message type 
Comment Comment on the message 

This comment is created automatically 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 

When you enter a text in the "Filter" text box, all columns are searched and the corresponding 
entries are displayed in the display table. Delimitation of messages is recommended when 
there is a large number of messages. 
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Structure of the Comments tab 
A list with all the comments for the displayed period is displayed using the "Comments" tab. 

 
① Edit 

To edit the selected comment, click on this button. 
If you selected several comments, this button is disabled. 

② Table with comments of the selected time period. 
③ Filter function 

When you enter a text in the "Filter" text box, all columns are searched and the corresponding entries are displayed 
in the display table. Delimitation of comments is recommended when there is a large number of comments. 

④ Delete 
To delete a comment, select the comment and double-click this button. 
Multiple selection is possible. 

The table contains the following four columns: 
 
Column Function 
Name of the series Name of the data point relating to the comment 
Time stamp of 
measuring point 

Time stamp of the measurement 

Comment Content of comment 
Author Author of comment 

Values tab 
You can find more information on the Values tab in the Matrices (Page 147) section. 
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3.2.5.2 Configuring charts 
Follow these steps to configure a chart: 

1. Click on the chart in the navigation field. 

2. To open the configuration dialog, click on . 

3. Configure the tabs of the configuration dialog as described below. 

4. Click the "Save" button. 

Configuring the "General" tab 
To configure the "General" tab, follow these steps: 

1. Enter the name of the chart in the "Name" text box. 

2. Enter the number of decimal places to be displayed in the detail field of a measuring point in 
the "Decimal format" text box. 

3. If you enable "Current date", the current time is always used as the basis for the query type. 

If you disable "Current date", a defined time is used as the basis for the query type. 

In this case, select the time in the text box "From". 

4. From the "Query type" drop-down list, select the type of the displayed time period. 

5. From the "Compression" drop-down list, select the compression level to be displayed in the 
chart. 

6. If you enter a number other than zero in the "Offset" text box, the chart will not display the 
selected time period. The displayed time period is shifted by offset times the cycle of the 
query type. For example, if you have selected Month as the query type and an offset of -2, 
the chart will display March instead of May. 

7. If you enable "Use initial time stamp", the values at the beginning of your cycle are displayed 
in the chart. 

Background: The end time stamp is always used in the Energy Manager. End time 
stamping means that all values get the time stamp at the end time of their cycle. This 
means, for example, that the first daily value of a month is stamped at midnight on the 
second day of the month. Accordingly, the last daily value of a month has a time stamp of 
midnight of the first day of the following month. These values are also displayed in the 
chart if you have not activated "Use initial time stamp".  

8. To compare the time period displayed in the chart with another time period, enable 
"Comparison", "Static" or "Dynamic". 

If you have enabled "Static", select the start of the period to be compared from the 
calendar under "From". This time period does not change. 

If you have enabled "Dynamic", enter a number in the "Offset" text box. The period to be 
compared is offset from the displayed period by a multiple of the cycle of the query type. 
The function is the same as in step 6. 
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Configuring the "Data sources" tab 
To configure the "Data sources" tab, follow these steps: 

1. To add a data point or MEVA/KPI, select the object from the "Select" drop-down list. When 
you enter a term in the drop-down list, the displayed objects are filtered by that term. 

 The only objects displayed in the drop-down list are of a type enabled under "Filter". 

Alternatively, you can use the structure browser. To open the Structure Browser, click on 
. 

 
  Note 

You can display values in the chart that are stored locally on the acquisition component. 
This data is deleted from the acquisition component 62 days after it is created and can 
then no longer be displayed in the chart. 

 

2. To configure a selected object for the chart, click on the object in the "Currently selected" 
list. 

You can enter an alternative name. If you enabled the option button in the corresponding 
row, the alternative name or description of the object is displayed as the name of the data 
series in the chart. 

Under "Category", select the category of values to be displayed in the chart. The 
conversion between energy/consumption and power/flow is made automatically. 

From the"Function" drop-down list, select the type of values of the object are to be 
displayed in the chart  

3. To delete an object from the chart, click on . 

Configuring the "Display" tab 
To configure the "Display" tab, proceed as follows: 

1. To configure the display of an object in the chart, click on the corresponding object. 

2. From the "Color" drop-down list, select the color with which the values of the object are to 
be displayed in the chart. 

3. From the "Type" drop-down list, select the way in which the values of the object are to be 
displayed in the chart. 

4. From the "Y-axis" drop-down list, select the y-axis to which the object is assigned in the 
chart. 

5. If you disable "Visible", the object is not displayed in the chart. 

6. If you enable "Stacked", all objects where this option is enabled and assigned to the same 
axis are displayed stacked on top of each other. 
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Configuring the "Limits" tab 
To configure the "Limits" tab, follow these steps: 

1. To configure the limits of an object's values on the chart, click on the object. 

2. In the "Upper warning" text box, enter the numeric value of the upper limit. 

3. In the "Upper warning" text box, enter the numeric value of the upper warning limit. 

4. In the "Lower warning" text box, enter the numerical value of the lower warning limit. 

5. In the "Lower limit" text box, enter the numerical value of the lower limit. 

To successfully configure the limits, adhere to the following nonequivalence: Upper limit ≥ 
Upper limit warning ≥ Lower limit warning ≥ Lower limit 

Configuring the "Axes" tab 
To configure the "Axes" tab, proceed as follows: 

1. To add a new y-axis, click on . 

2. To configure an axis, click on the corresponding axis. 

In the "Name" text box, enter the name of the axis. The name of the axis is displayed in 
the chart. 

In the "Lower limit" text box, enter the lowest numerical value on the axis that is displayed 
in the chart. If you leave this box empty, the axis is automatically scaled. 

With the "Area" display type, the chart is always displayed in the zero-point display. 

In the "Upper limit" text box, enter the highest numerical value on the axis that is 
displayed in the chart. This numerical value must be greater than the lowest numerical 
value on the axis. If you leave this box empty, the axis is automatically scaled. 

3. To delete an axis, click on . 
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3.2.6 Dashboards 

Overview 
Energy Manager PRO Web shows you the graphic overviews configured in Energy Manager .  

The structure of a Dashboard in Energy Manager PRO Web consists of the following objects: 

 

Requirement 
• The Dashboard has been created in Energy Manager . 

• The dashboard has been released for the current Web application. 

Opening a dashboard 
1. To display a dashboard, select the required dashboard in the "Menu" area. 

The dashboard is displayed in the right pane of the window. 
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2. To adapt the dashboard to the size of the window, select "Scaling". 

3. Select "Full screen" to display the dashboard in full-screen mode. 

The dashboard is displayed in the separate window in full-screen mode. 

 
 

  Note 

A Dashboard in full screen mode remains open after an automatic logout from Energy 
Manager PRO Web. When you attempt to operate the Dashboard, you must login to 
Energy Manager PRO Web again.  

 

4. In order to print the dashboard: 

For printed output, the browser's print settings are used.  

– For this reason, set the desired settings for page scaling or page orientation before 
printing. 

– Use the browser's preview feature in order to review the result. 

– Click "Print". 

The "Print" dialog for the operating system opens.  
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Editing values 
You can acquire the values of a dashboard manually. To do this, select the required datapoint 
in the "Menu" area and click "Start Value Input" in the "Object" tab in the right window pane. 

You can find additional information on this topic in the "Acquiring data manually" section. 

Using the Chart 
You can display the values of a Dashboard in the Chart. To do this, select the required 
datapoint in the "Menu" area and click on the "Diagram" tab in the right window pane.  

You can find additional information on this topic in the "Using a Chart" section. 

See also 
Creating user groups (Page 684) 

Measurements editor (Page 491) 

Charts (Page 57) 

3.2.7 File management in the Web 

Overview 
In Energy Manager PRO Web , call the documents stored in Energy Manager PRO or upload 
new documents to the Energy Manager PRO Database. 

 
① Document 

Requirement 
• The document is available in Energy Manager PRO . 

• The document has been released for the current Web application. 
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Downloading a document 
1. To load the document from the Energy Manager PRO Database to Energy Manager PRO Web 

, select the required document in the "Menu" area and then click "Download". 

 

The dialog for downloading the document opens.  

2. Click "OK". 

The document is opened in Energy Manager PRO Web .  

3. To upload the document to the Energy Manager PRO Database, select the document with 
"Browse" and then click "Upload". 

The document was uploaded to the Energy Manager PRO Web from the Energy Manager PRO 
Database or downloaded into the Energy Manager PRO Database. 

See also 
Creating user groups (Page 684) 

File management (Page 87) 
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3.3 Energy efficiency measures in the Web 

Overview 
Energy Manager PRO Web shows you the energy efficiency measures configured in Energy 
Manager PRO Client . You can edit the configured energy efficiency measures in Energy 
Manager PRO Web or create new energy efficiency measures. 

 
① Energy efficiency measure 

 

 Note 
Functionality of Energy Manager Basic 

Energy efficiency measures are not included in Energy Manager Basic. 
 

Requirement 
• The filtered overview object for the energy efficiency measures is generated in Energy 

Manager . 

• The filtered overview object for the energy efficiency measure is enabled for the current 
web application. 

Editing an energy efficiency measure 
1. To display the energy efficiency measure in Energy Manager Web, select the required energy 

efficiency measure in the "Menu" area. 

The energy efficiency measure is displayed in the right pane . 
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2. To create a new energy efficiency measure, click "New" and enter the required data. 

 
3. To change the existing energy efficiency measure or delete it, click "Edit" or "Delete". 

You can find more information energy saving measures in the "Energy efficiency measure" 
section of the description for Pro clients. 

See also 
Creating user groups (Page 684) 

Generating a filtered overview object (Page 654) 

Energy efficiency measures (Page 76) 
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3.4 Manual acquisition of data in the Web 

3.4.1 Datapoints 

Overview 
A datapoint serves to store measured values. In Energy Manager PRO Web you can see all the 
data points that were defined in the client under the entry point. Restrictions can exist with 
regard to the user rights. 

Procedure 
1. Click on the data point whose value you want to display. 

 
The detail area opens. 
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2. You can adapt the settings in the detail area. The datapoint values for the selected settings 
are shown in the detail area. 

With datapoints, the Chart tab is available immediately after a click on the respective 
object. 

 
① Selection of the "Chart" tab 
② Selection of the "Alarms" tab 
③ Selection of the "Comments" tab 
④ Selection of the "Values" tab 
⑤ Selection of the displayed time period 

To change the time period, click on the arrow keys or . By clicking on , you open the time and date selection. 
You can find more information on the time and date selection in the Charts (Page 128) section. 

⑥ Selection of the displayed compression level 
⑦ Table with the values of the datapoint and the time stamps of the values. 
⑧ Edit a value. 

Click this button to open the dialog in which you can change the value. You cannot change the entry of the "Sum" 
field in the dialog of a counter value. 

Values tab 
Value changes made in the table are automatically saved in the datapoint. The selected time 
range is not saved.  

On a renewed display of the dialog, the current time range is always displayed.  

Chart, Alarms and Comments tabs 
You can find more information on the Chart, Alarms and Comments tabs in the Charts 
(Page 128) section. 
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3.4.2 Parameters 

Overview 
With a Parameter you can acquire a fixed value that is generally valid, or is limited by the 
entry of a time range in its validity duration. You can, for example, define electricity or gas 
prices for specific periods or specify conversion factors such as a CO2 conversion factor. 

The entry of a parameter value in the Energy Manager PRO Client corresponds to the entry in 
the Energy Manager Web. 

Procedure 
1. Click the parameter for which you want to enter or edit a value in the navigation area. 

In the detail area you can see an overview of the configurable validity periods including 
parameter value. 

2. If you click the info symbol at the end of the line of a validity period, you can edit or delete 
the validity period and the parameter value. 

 

3. To define a new validity period including a parameter value, select the "Options" tab and 
click "New parameter value". 

The "New parameter value" dialog opens. 

4. Select the validity period and enter the parameter value. 

5. Click the "OK" button. 

See also 
Parameter (Page 47) 
Parameters (Page 519) 
Creating parameters (Page 295) 
Parameter (Page 293) 
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3.4.3 Matrices 

3.4.3.1 Overview 
The matrix allows you to display both historical and current values as numbers in a table. 
Besides that,  

 you change the values via the Matrix. 

The matrix or value functionality is available as a separate tab for the following objects: 

• Data point 

• Matrix 

• Chart object 

Configuring the Values tab for data points and chart objects 
In contrast to datapoints and chart objects, the Values tab page in the matrix is available 
immediately after you click on the relevant object. Value changes made in the matrix are 
automatically saved in the data point. The selected time range is not saved. When the matrix 
is displayed again, the current time range is always displayed. You cannot configure the 
matrix of these objects. 
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Layout of the Values tab 
The following figure shows a representation of the matrix in the Energy Manager Web: 

 
① Selection of the "Values" tab 
② Selection of the "Chart" tab 
③ Selection of the "Alarms" tab 
④ Selection of the "Comments" tab 
⑤ Selection of the displayed time period 

To change the time period, click on the arrow keys or . By clicking on , you open the time and date selection. 
You can find more information on time and date selection in the Charts (Page 128) section.  

⑥ Selection of the displayed compression level 
⑦ Configuration of the matrix 

To open the matrix configuration, click on . 
⑧ Table with the values of the data points and the time stamps of the values. 
⑨ Edit a value. 

If you click on this button, the dialog opens where you can change the value. 
You cannot change the entry of the "Sum" field in the dialog of a counter value. 
You cannot change values of MEVAs/KPIs. 

Chart, Alarms and Comments tabs 
You can find more information on the Chart, Alarms and Comments tabs in the Charts 
(Page 128) section. 
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3.4.3.2 Configuring matrices 
To configure a matrix, proceed as follows: 

1. Click on the matrix in the navigation field. 

2. To open the configuration dialog, click on . 

3. Configure the tabs of the configuration dialog as described below. 

4. Click the "Save" button. 

Configuring the "General" tab 
To configure the "General" tab, follow these steps: 

1. In the "Name" text box, enter the name of the matrix. 

2. Enter the description of the matrix in the "Description" text box. 

3. In the "Decimal places" text box, enter the number of decimal places displayed in the matrix. 

4. If you enable "Allow only data view", you cannot change any values in the matrix. 

5. If you enable "Plausibility check", the values in the matrix that violate the plausibility limits 
configured in the data point are highlighted accordingly. 

6. If you enable "Transposed data presentation", the time stamps are displayed above the 
columns and the data points above the rows. 

7. If you enable "Current date", the current values are always displayed in the matrix. 

8. If the "Current date" is not enabled, enter the time from which values are displayed in the 
matrix in the "From" box. 

9. From the "Query type" drop-down list, select the period to be displayed. 

10.From the "Compression" drop-down list, select the compression level to be displayed. 

11.If you enter a number other than zero in the "Offset" text box, the matrix will not display the 
selected time period. The displayed time period is shifted by offset times the cycle of the 
query type. For example, if you have selected the Month query type and an offset of -2, the 
matrix displays March instead of May. 

12.If you enable "Acyclic", the values are not assigned to a cycle. This option is useful for 
matrices with data points without an acquisition cycle. 

13.If "Acyclic" is disabled, select the cycle in which the values of the data points are displayed 
from the "Cycle" drop-down list. 
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Configuring the "Data Source" tab 
To configure the "Data source" tab, follow these steps: 

1. To add a data point, select the object from the "Select" drop-down list. When you enter a 
term in the drop-down list, the displayed objects are filtered by that term. 

 The only objects displayed in the drop-down list are of a type enabled under "Filter". 

Alternatively, you can use the structure browser. To open the Structure Browser, click on 
. 

 
  Note 

You can display values in the matrix that are stored locally on the acquisition component. 
This data is deleted by the acquisition component 62 days after its creation and can then 
no longer be displayed in the matrix. 

 

2. To configure a selected object for the matrix, click on the object in the "Currently selected" 
list. 

You can enter an alternative name. If you enable the option button in the corresponding 
row, the alternative name or description of the object is displayed as the name of the data 
series in the matrix. 

3. To delete an object from the chart, click on . 
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3.4.4 Setting up mobile data acquisition with the SIMATIC Energy Manager app 
for iOS and Android 

Overview 
In addition to manual data acquisition in Energy Manager and Energy Manager Web, you can 
acquire data manually using the SIMATIC Energy Manager App. With the Energy Manager App 
you manually acquire measured values (e g. energy data),which are then transferred to 
Energy Manager for further analyses. The measured values are synchronized via encrypted 
communication (https) with Energy Manager. To acquire count values in the Energy Manager 
App, you need a configured reading route. You configure this reading route in Energy 
Manager. After logging into the Energy Manager App, the app downloads the approved 
reading routes from Energy Manager and displays these reading routes. In addition to the 
reading route, the app also applies the appropriately configured data points as well as their 
main plausibility settings. 

 

 Note 
Functionality of Energy Manager Basic 

Mobile data acquisition is not available for Energy Manager Basic. 
 

Requirements 
• The user has the functional right "Matrix". 

• The user has the functional right "Measurement". 

Procedure 
To configure a reading route for manual acquisition with the Energy Manager App, follow 
these steps:  

1. Create a Matrix object with a meaningful name. 

You can find more information in the section "Manual acquisition with the matrix". 

2. Create a data point of the "Counter" category below the matrix object: 

You can find more information in the section "Creating a data point". 

3. Create a valid counter for the data point. 

You can find more information in the section "Configuring counters".  

4. Define your limits below the plausibility settings of the data point. 
You can find more information in the section "Configuring the plausibility". 

5. Add the matrix object as a Quicklink. 
You can find more information in the section "Quicklinks". 
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Result 
The reading route for manually entering the counter values in the Energy Manager App is 
configured. Quick links of the "Route" data type are available in the "Mobile acquisition" 
interface of the app. If no Quicklinks have been created in Energy Manager yet, a message 
appears in the app. 

The following figure shows four Quicklinks from the Energy Manager App: 

 

You can find additional information on the Energy Manager App including data acquisition 
using the app in the "SIMATIC Energy Manager V1.0" manual. 
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See also 
Manual acquisition with the matrix (Page 505) 

Creating data points (Page 458) 

Configuring counters (Page 479) 

Configuring the plausibility (Page 482) 

Creating Quicklinks in the Web (Page 103) 

Creating data points (Page 277) 

Configuring counters (Page 282) 

Configuring the plausibility settings (Page 283) 

Creating matrices (Page 230) 

Quicklinks (Page 103) 
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3.4.5 Importing measured values 

Overview 
In Energy Manager Web you have the option of importing measured values for one or more 
data points in CSV format. A wizard guides you through the import procedure.  

 

 Note 

If a timestamp is already present in a datapoint, the time stamp and its value are overwritten 
during the import.  

 

 Note 
• The decimal delimiter between the individual numbers in the import file depends on the 

language with which you logged in to Energy Manager Web: 
– German: The decimal places are separated from the integer with ","; "." is ignored. 
– English: The decimal places are separated from the integer with "."; "," is ignored. 
Login to Energy Manager Web in the language in which the import file was generated.  

• The time stamp in the import file depends on the language with which you logged in to 
Energy Manager Web: 
– German: dd.MM.yyyy hh:mm:ss - 24-hour format 
– English: MM/dd/yyyy hh:mm:ss - 12-hour format 

The columns in the import file are separated by ";" in German and in English. 
 

Requirements 
• The data points are set up in Energy Manager . 

• The measured values are available in a CSV file. 

• The measured values are available in UTC time format. 

• The interval between timestamps corresponds to the configured acquisition cycle of the 
data point. 
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Procedure 
To import measured values for one or more data point(s) in Energy Manager Web, follow 
these steps: 

1. Click on the icon for data import in the menu bar. 

 
 

  Note 

The icon for data import is only available in the home area. 
 

2. Click on the "Browse..." button in the detail area. 
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3. Select the required file. 

The following figure shows the content of a valid import file. 

 
 

  Note 

Make sure that the name of the data point in the CSV file and the name of the data point 
in Energy Manager match. 

 

The content of the selected file is automatically checked. The result of the check is 
displayed. 

4. To start the data import, click on the "Import data" button. 

 
The result of the data import is summarized. 
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5. If you want to view the imported data, click on the "Show imported data" button. 

The values are displayed graphically on a separate web page. 

6. If you want to save the summary as a file, click on the "Save Logfile" button. 

 

Result 
The measured values for the corresponding data point are imported. 

See also 
Login (Page 94) 

Creating data points (Page 277) 
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3.5 Configuration of the analysis objects 

3.5.1 Editing mode 

Overview 
Manage your system structure in Energy Manager Web with the help of the editing mode. 
The editing mode includes the shortcut menu and the configuration tools. In a similar way as 
in the Energy Manager PRO Client, you create and configure folders and analysis objects 
using the shortcut menu. The following objects, including folders, are analysis objects: 

• Dashboards 

• Reports 

• Charts 

• Matrices 

• Folder 

Move and rearrange the objects as you wish using the configuration tools. 

Enable edit mode 
To enable the editing mode, follow these steps: 

1. Log in with your user name in Energy Manager Web. 

The start screen of Energy Manager Web is displayed. 

2. Click the navigation header "Tree" in the navigation area. 

The Quicklink view changes to the tree view. 

3. Click the edit icon ("Enable edit mode") in the navigation header of the navigation area. 
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Result 
The editing mode is enabled. Instead of the edit icon, the configuration tools of the editing 
mode are displayed in the navigation header.  

 
 

 Note 

You can only enable the editing mode in the home area of Energy Manager Web . 
 

Disable edit mode 
To close the editing mode, click on the "Disable edit mode" icon in the navigation area. 

 

See also 
Shortcut menu (Page 161) 

Configuration tools (Page 160) 

Setting up dashboards (Page 163) 

Creating reports (Page 217) 

Creating charts (Page 226) 

Creating matrices (Page 230) 

Creating folders (Page 234) 

Definition of home page (Page 97) 

Dashboards (Page 163) 

Reports (Page 217) 

Charts (Page 226) 

Matrices (Page 230) 

Folder (Page 234) 
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3.5.2 Configuration tools 

Overview 
The configuration tools enable you to restructure objects in the navigation area within a 
folder or to move objects to a different folder. Structural changes in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa.  

Using configuration tools 
To use the configuration tools, follow these steps: 

1. Enable the editing mode. 

2. Click in the navigation area on the object you wish to rearrange. 

3. Click on the corresponding configuration tool in the navigation header. 

 
The following table shows an overview of the existing configuration tools and their function: 

 
Configuration tool Function 
Move down Moves the selected object one position down in the navigation area. Move down is only pos-

sible within a folder. 
Move up Moves the selected object one position up in the navigation area. Moving upward is only 

possible within a folder. 
Cut Cuts the selected object from the current folder. You then insert the cut object at a different 

position in the navigation area.  
Copy Copies the selected object to the clipboard. You then insert the selected object at a different 

position in the navigation area. 
Paste Inserts the selected object at the last position of the new folder in the navigation area. Before 

you insert the selected object in the new folder, you first have to select the new folder in the 
navigation area. 

Disable edit mode Closes the editing mode. 
 

 

 Note 

Clicking the icon of an object in the navigation area opens the corresponding object 
structure. To use an additional data point in a chart, for example, you thus open the object 
structure of the chart and insert the data point below the chart.  

 

See also 
Editing mode (Page 158) 

Shortcut menu (Page 161) 
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3.5.3 Shortcut menu 

Overview 
Using the shortcut menu of the editing mode, create new objects and configure already 
existing objects in Energy Manager Web. Newly created objects and object configurations in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa. 
The shortcut menu of the editing mode consists of the following menu commands: 

• Edit 

• Add dashboard 

• Add report 

• Add chart 

• Add matrix 

• Add folder 

Open shortcut menu 
To open the shortcut menu of the editing mode, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over a folder in the navigation area. 

The shortcut menu is displayed on the right-hand side of the menu item. 
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3. Click on the shortcut menu icon. 

The shortcut menu of the editing mode opens. 

 
 

 Note 

When you move the mouse pointer over a dashboard, a report, a chart or a matrix in edit 
mode, an Edit icon is displayed on the right-hand side of the menu item instead of the 
shortcut menu icon. When you click on the Edit icon, you open the corresponding 
configuration dialog in which you configure the selected object. 

 

See also 
Editing mode (Page 158) 

Setting up dashboards (Page 163) 

Creating reports (Page 217) 

Creating charts (Page 226) 

Creating matrices (Page 230) 

Creating folders (Page 234) 

Editing folders (Page 236) 

Configuration tools (Page 160) 
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3.5.4 Dashboards 

3.5.4.1 Overview 
To visualize various measurement and plant data in a clear manner in Energy Manager Web, 
you can create Widget Dashboards with the help of the shortcut menu. The data is visualized 
in the dashboards via widgets. Widget Dashboards are designed for display in Energy 
Manager Web or on mobile devices. For this reason, only configure Widget Dashboards in 
Energy Manager Web. 

3.5.4.2 Setting up dashboards 

Requirements 
• The folder has been created. 

• The user has the functional right "Widgets/Dashboards - create, remove, configure". 

Procedure 
To create a new Widget Dashboard, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area in which you would like to set 
up the Widget Dashboard. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens. 

4. Click on the menu command "Add dashboard". 

Result 
The new Widget Dashboard is set up in the selected folder of the navigation area. 
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See also 
Creating Widgets (Page 169) 

Widget Dashboards in the client (Page 75) 

Shortcut menu (Page 161) 

Editing mode (Page 158) 

Editing dashboards (Page 165) 

Overview of Widget Dashboards (Page 111) 

Create dashboard (Page 632) 
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3.5.4.3 Editing dashboards 

Requirements 
• The Widget Dashboard has been set up. 

• The user has the functional right "Widgets/Dashboards - create, remove, configure" or the 
functional right "Widgets/Dashboards - configure". 

Procedure 
To edit Widget Dashboards, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the Widget Dashboard in the navigation area that you would 
like to edit. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit Dashboard" opens. 

 
4. Enter the name of the Widget Dashboard in the "Name" entry field. 

5. If required, enter an additional title of the Widget Dashboard in the "Title" entry field. 

6. Select a "Background color", a "Header background color" and a "Header font color". 

7. In order to use a custom background image, if required, click on the "Select file" button and 
select the corresponding image. 

The background image is positioned centrally and displayed unscaled. The maximum size 
of the image is 2 MB. 
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8. To display the current date of the widgets in the dashboard, select the "Current Date" check 
box. 

 
9. If you want to display a specific time period of the widgets in the dashboard, clear the 

"Current Date" check box. Select the required date and time from the selection boxes. 

10.Select the observation period of the data in the Widget Dashboard from the drop-down list 
"Query type". 

11.To save the configuration, click on the "Save" button. 

Result 
The configured settings generally apply for the entire dashboard. You can subsequently add 
different widgets to the dashboard. More information on adding widgets to a dashboard can 
be found in the section "Creating widgets". Settings which you configure in the configuration 
dialog of the individual widgets are only valid for the widget in question. 

See also 
Overview of Widget Dashboards (Page 111) 

Setting up dashboards (Page 163) 

Cloning dashboards (Page 167) 

Creating Widgets (Page 169) 

Deleting dashboards (Page 168) 
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3.5.4.4 Cloning dashboards 

Requirements 
• The Widget Dashboard has been set up. 

• The user has the functional right "Widgets/Dashboards - create, remove, configure". 

Procedure 
To clone Widget Dashboards, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the Widget Dashboard in the navigation area that you would 
like to clone. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit Dashboard" opens. 

4. Click on the "Clone" button. 

 

Result 
The Widget Dashboard is cloned with the general settings of the dashboard and all associated 
widgets. The cloned Widget Dashboard is set up in the same folder in the navigation area as 
the original Widget Dashboard. The name of the cloned Widget Dashboards is made up of the 
name of the original Widget Dashboard and the ending "Copy_0". When you clone a Widget 
Dashboard several times, the number at the end of the name is incremented by 1, for 
example, from "Copy_0" to "Copy_1". You can then move the cloned Widget Dashboard to the 
required position in your navigation structure with the configuration tools. 

See also 
Editing dashboards (Page 165) 
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3.5.4.5 Deleting dashboards 

Requirements 
• The Widget Dashboard has been set up. 

• The user has the functional right "Widgets/Dashboards - create, remove, configure". 

Procedure 
To delete Widget Dashboards, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the Widget Dashboard in the navigation area that you would 
like to delete. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit Dashboard" opens. 

4. Click on the "Delete Dashboard" button. 

 

Result 
The Widget Dashboard is deleted from the system. 

See also 
Editing dashboards (Page 165) 
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3.5.4.6 Widgets 

Creating Widgets 

Overview 
With the help of widgets you display your plant and measurement data in a different way 
depending on the widget. You have the option of inserting up to 32 widgets in a dashboard. 
You can freely position the widgets within the Widget Dashboard and adjust their size. The 
displayed values are updated in accordance with their cycle time and the query type of the 
Widget Dashboard.  

Requirement 
• The user has the functional right "Widgets/Dashboards - configure" or 

"Widgets/Dashboards - create, remove, configure". 

Basic procedure 
To create a widget in the Widget Dashboard, follow these steps: 

1. Click in the navigation area on the Widget Dashboard in which you want to add a new 
widget. 

The Widget Dashboard is displayed in the detail area. 

2. To enable configuration mode, click on the gear icon in the top right-hand part of the detail 
area. 

3. To add a widget, click on the "Add Widget" button. 

 
① Add new widgets. 
② Edit settings of the Widget Dashboard. 
③ Close configuration mode. 

The "Available Widgets" dialog window opens. 

4. Click on the widget you wish to create. 

The configuration dialog "Configure Widget" opens. 



Energy Manager Web  
3.5 Configuration of the analysis objects 

 SIMATIC Energy Manager PRO V7.2 - Operation 

170 Operating Manual, 12/2020, A5E38952754-AF 

5. Enter a meaningful name for the widget in the "Title" entry field in the "General" tab. 

 
The input of a name is required. 

6. From the drop-down list "Select a data point" in the "Data source" tab select the data points 
that you want to use or display in the widget. You can enter the data points in the entry 
field. After the first three letters, a corresponding selection list is proposed. By selecting or 
clearing the check boxes "Data point", "Measuring Variable", "Parameter" and "Consumer 
Variable" you further refine the search. 

 
Selected data points are displayed in the "Currently selected" list. 
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7. Click on the "Add Widget" button. 

 
The "Edit" configuration dialog opens. 

 
  Note 

When you have added the widget to the Widget Dashboard, you can configure the 
remaining tabs of the widget. You can find out how to configure the tabs of the individual 
widgets in the section "Widget configuration". 

 

8. Click on the "Save Widget" button. 

 

Result 
The corresponding widget is created in the selected Dashboard.  

See also 
Overview (Page 173) 

Setting up dashboards (Page 163) 

Editing dashboards (Page 165) 

Editing widgets (Page 172) 

Overview of Widget Dashboards (Page 111) 

Configuring the General tab (Page 195) 

Configuring the "Data Source" tab (Page 197) 

Widget Configuration (Page 194) 

Available Widgets (Page 173) 
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Editing widgets 

Requirements 
• The Widget Dashboard including widget has been set up. 

• The user has the functional right "Widgets/Dashboards - create, remove, configure" or the 
functional right "Widgets/Dashboards - configure". 

Procedure 
To edit widgets in a Widget Dashboard, follow these steps: 

1. Click in the navigation area on the Widget Dashboard which contains the widget to be 
edited. 

2. Click on the gear icon in the top right-hand corner of the Widget Dashboard. 

The configuration mode of the Widget Dashboard opens. 

3. Then click on the edit icon in the top right-hand corner of the widget to be edited. 

The widget configuration dialog opens. 

4. Configure the widget via the individual tabs. 

You can find out how to configure the individual tabs in the section "Widget 
Configuration". 

5. Click on the "Save Widget" button. 

See also 
Overview of Widget Dashboards (Page 111) 

Creating Widgets (Page 169) 

Widget Configuration (Page 194) 
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Available Widgets 

Overview 
In the dialog window "Available widgets" you can create 15 different widgets. You can find 
out how to open the dialog window "Available widgets" and add individual widgets to a 
Widget Dashboard in the section "Creating Widgets". 

The following image shows you the available widgets: 
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Depending on the widget, you can use one or more data points. The following table provides 
an overview of the available widgets and the number of data points that you can use in the 
respective widget. 

 
Widget Individual data point Multiple data points 
Gauge x - 
Chart - x 

Traffic Light x - 
Value - x 

Pie - x 
Matrix - x 
Image - - 
Report x - 
Text - - 

Heat Map x - 
Map - x 

Sankey - x 
Alarm list - - 

MultiRegression - x 
Duration curve x - 

The "Image", "Text" and "Alarmlist" widgets are special cases and do not require any data 
points.  

See also 
Creating Widgets (Page 169) 

Available tabs (Page 194) 

Widget Configuration (Page 194) 
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Gauge 
The "Gauge" widget shows the value of the data point in a speedometer and displays the 
configured warning limits, upper and lower limits in color.  
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Chart 
The "Chart" widget displays the data points in different graphs during the observation period. 
If you are in the configuration mode of the dashboard, you can change the display (bar, line, 
etc.) by clicking on a data point in the legend. You can change the color of the graph to be 
displayed if a second X-axis exists. When you have configured the y-axes, you can adapt the 
axis assignment of the y-axes.  
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The second field shows different performance indicators and a histogram with the 
distribution of values. 

 

If you are not in configuration mode, you can highlight the data point by clicking on a data 
point in the legend. If you have configured plausibility limits in the widget, these limits are 
displayed in the graph. Warning levels are displayed as yellow lines, high and low limits are 
displayed as red lines. Plausibility limits are not displayed in the histogram. 

Traffic Light 
The "Traffic Light" widget shows the values of the data points in one of the three traffic light 
colors, depending on the defined limits. If you do not define any limits in the widget, the 
traffic light always displays green or red. 
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Value 
The "Value" widget shows the name of the data points, their overall value and the associated 
unit over the selected observation period. 

 

Pie 
The "Pie" widget shows the complete value of all data points of the observation period within 
the semicircle. The individual sections of the pie chart show the percentage of the respective 
data points. Clicking an individual section of the pie chart shows the value of the individual 
data point within the semicircle. When you click on a data point in the legend, you can 
change the display color of the corresponding data point.  
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Matrix 
The "Matrix" widget displays the values of the data points as a matrix with the corresponding 
cycle time or time stamp. If you configure plausibility limits in the data point, violations of 
warning levels are displayed in yellow, while violations of high and low limits are displayed in 
red. 

 

Image 
Depending on the configuration, the "Image" widget shows the selected image either 
centered in the original size or stretched across the entire length of the widget. 



Energy Manager Web  
3.5 Configuration of the analysis objects 

 SIMATIC Energy Manager PRO V7.2 - Operation 

180 Operating Manual, 12/2020, A5E38952754-AF 

Report 
The "Report" widget displays the selected report. You can scroll forwards or backwards in 
defined intervals in order to also have past periods or future periods displayed. 

If there is no report available for the displayed period, the displayed image is grayed out. Click 
on the image to create the report. 

 Two icons are available for downloading the report as an EXCEL or PDF file.  

 

Text 
The "Text" widget shows you the entered text in the widget. When you click on a link in the 
widget, either the URL opens in the Internet browser or the e-mail program opens depending 
on the link. 
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Heat Map 
The "Heat Map" widget shows you a graphical overview of the acquired measurement values 
at specific times of the day. You can individually configure the lower and upper limits. In this 
way, you can track the time at which your defined limits were exceeded or undershot. When 
displaying data, you can choose between display over 24 hours or over a week. 

The figure below shows an example of a "Heat Map" widget. The measurement data between 
noon and 6 p.m. lie for the most part in the lower value range. 

 

See also 
Configuring the Heat Map tab (Page 206) 
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Map 
 

 Note 
Functionality of Energy Manager Basic 

The "Map" widget is not available in Energy Manager Basic. 
 

The "Map" widget is ideal when you are managing several locations in one system. With the 
"Map" widget you can see the geographical position of the locations on a map and view the 
main, location-specific KPIs. You can also open two created, location-specific Widget 
Dashboards. The focus of the map is always selected in such a way that all locations are 
available. When you click on the Plus or Minus icon, you zoom into or out of the map.  

 

 Note 

Open Street Map is used as the map. You therefore require an appropriate Internet 
connection. 

 

The figure below shows a "Map" widget of a Energy Manager system with several locations in 
Germany: 

 

To display your created locations in the widget, you have to enter the geographical 
coordinates of the location in the location object in the Energy Manager PRO Client. Only 
locations with valid coordinates are available for selection in the widget. You can determine 
the coordinates using Google Maps, for example and copy them to the location object. Enter 
the coordinates in the "Location" entry field. You must separate the two coordinates with a 
blank space. 
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Move your location objects (e.g. Berlin and Munich) under a higher-level location object 
which represents your country. 

 

You then have to assign the location object to the corresponding user group in the "Location" 
text field using drag and drop. 

 

See also 
Configuring the Locations tab (Page 207) 

Inserting the location or country (Page 659) 

Defining an entry point (Page 685) 
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Sankey 
The Sankey diagram can be used to show an energy flow diagram for a quick overview of the 
overall energy situation. You define nodes in the Sankey diagram. You connect these nodes 
with links (data points). You configure the color of the nodes in the settings. When you click 
on a link, a tooltip shows you the consumption value of the corresponding link. If you display 
different types of energy (media) in an energy flow diagram, you have to recalculate the 
energy consumption of the medium to the primary energy which is needed for generation of 
the medium. If a plant consumes, for example, electrical energy and compressed air, you 
have to calculate the consumption of compressed air to the electrical energy required for 
generating consumption. This correlation is defined via the scaling factor. 

The figure below shows a Sankey diagram in which the total consumption of an example hall 
is shown: 

 

In addition to the graphical overall display, you see an overview of all the links in the 2nd tab 
(Links). The values and the primary energy and the interconnection of the links are shown in 
this view. 
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You see an overview of all the nodes in the 3rd tab (Nodes). The corresponding balance sums 
of input, output, difference and the relative deviation are displayed in this view. 

 

When you click on the Info icon next to the numerical value, details of the scaling factor, for 
example, are displayed. If several links go into or out of a node, the calculation of the value is 
displayed.  

See also 
Configuring the Sankey tab (Page 209) 

Alarm list 
The "Alarm list" widget displays KPI breaches. The data points whose limits have been violated 
in the selected time window are listed in the overview display. In addition to the name of the 
data point, the number of warnings and the number of violations are also displayed. You can 
acknowledge all messages in this overview.  

The figure below shows the overview of an alarm list with three limit violations: 
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When you click on the data point, the detail window opens. The detail window contains an 
overview of the individual messages.  

 

You can acknowledge each individual message or all messages at the same time in the detail 
window.  

See also 
Configuring the Alarms tab (Page 211) 
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MultiRegression 
 

 Note 
Functionality of Energy Manager Basic 

The "MultiRegression" widget is not available in Energy Manager Basic. 
 

With the "MultiRegression" widget you determine the Baseline (theoretically calculated value) 
of a specific value, for example, the theoretical energy consumption of a plant. If the energy 
consumption is dependent on known variables, you can determine the theoretical energy 
consumption. The correlation is determined via a linear regression analysis . In addition to the 
pure calculation of the theoretical energy consumption, you can also display the deviation of 
the actual energy consumption from the theoretical energy consumption. This means you 
can evaluate the current energy situation taking into account the ambient conditions and 
take appropriate measures in case of deviations. You can also forecast future energy 
consumption with the model by integrating the influencing factors into the system in the 
future. If the energy consumption strongly depends on the outdoor temperature, for 
example, you have to integrate the outdoor temperature into the system in the future.  

The "MultiRegression" widget is essentially an extension of the Chart widget. The first three 
tabs correspond to the Chart widget. The actual and theoretical consumption is shown in the 
4th tab (Baseline vs. Actual). When you enable the Forecast function, the Forecast is also 
displayed based on the forecasted data of the influencing factors. 
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The deviation between the theoretical and the actual energy consumption is shown in the 
5th tab (Deviation). When you enable the Forecast function, the deviation of the Forecast 
from the actual consumption is displayed.  
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In the 6th tab (Cumulative deviation) the deviation of the Baseline and the Forecast is shown 
cumulatively.  

 

If the Forecast function is enabled and the data points are assigned, the calculated model is 
saved twice. Once for the Baseline Management and again for the Forecast. When the first 
model is saved, data points derived in the Energy Manager PRO Client are created with a 
measuring variable below the dashboard. The derived data points contain the following data: 

• Measurement data for the baseline 

• Deviation from actual consumption 

• Forecast and deviation of the Forecast from the actual consumption 

In the following example, the Y data point is called "e_MVRA_y". The MEVAs used and derived 
data points are automatically derived from the name.  

 

For Baseline and Forecast, a separate derived data point is created with the ending 
"baseline_deviation" and "forecast_deviation". This data point represents the deviation of the 
actual values from the Baseline or the Forecast. When you subsequently change the name of 
the Y data point, the names of the derived data points or measuring variables do not change. 
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You can also use the derived data points in other widgets, for example, in the "Traffic Light" 
widget. If the deviation from the Baseline exceeds a particular value, the traffic light changes 
to red.  

See also 
Configuring the Model Definition tab (Page 212) 

Configuring the Model Overview tab (Page 215) 

Duration curve 
The "Duration Curve" widget shows you measurements for a particular time period in a 
duration curve. The widget shows three types: 
• Value-sorted duration curve 
• Value-sorted duration curve of the n-highest values 
• Hour-based representation of the n-highest values 
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In the 1st tab (Widget), the duration curve is shown from the highest to the lowest values in 
the observation period. The values are shown via the Usage hours. The statistics are displayed 
at the top of the tab. In addition to the standardized statistics, Consumption and Usage hours 
are also calculated. The Consumption includes the entire consumption in the observation 
period. The Usage hours describe the relationship of the total consumption to the maximum 
measured value.  
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In the 2nd tab (Section) the duration curve of the n-highest values is shown in the 
observation period. The number of measured values which you set in the "Display options" 
tab determines the number n. The measured values are displayed via the number of 
measured values n. 
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In the 3rd tab (Scatter Plot), the n-highest values are shown hour-based on a daily cycle. The 
time stamp of the measured values correlates with the hour-based x-axis. The measured 
values are shown over 24 hours. The number of measured values which you set in the 
"Display options" tab determines the number n.  

 

See also 
Configuring the Display options tab (Page 216) 
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Widget Configuration 

Available tabs 
You configure your created widgets using the available tabs. 

 

 Note 

To configure the tabs, you need either the functional right "Widgets/Dashboards - Configure" 
or the functional right "Widgets/Dashboards - Create, remove, configure". 

 

Overview 
The following table shows an overview of the configurable tabs per widget: 

 
Widget Gen-

eral 
Data 

source 
Lim-
its 

Y-
Axis 

I
m
a
g
e 

Te
xt 

Heat 
map 

Loca-
tions 

San-
key 

Alar
ms 

Model 
Definition 

Model 
Overview 

Display 
options 

Gauge x x x - - - - - - - - - - 
Chart x x x x - - - - - - - - - 
Traffic 
Light 

x x x - - - - - - - - - - 

Value x x - - - - - - - - - - - 
Pie x x - - - - - - - - - - - 

Matrix x x x - - - - - - - - - - 
Image x - - - x - - - - - - - - 
Report x x - - - - - - - - - - - 

Text x - - - - x - - - - - - - 
Heat Map x x - - - - x - - - - - - 

Map x x - - - - - x - - - - - 
Sankey x x - - - - - - x - - - - 

Alarm list x - - - - - - - - x - - - 
MultiRe-
gression 

x x x x - - - - - - x x - 

Duration x x - - - - - - - - - - x 

See also 
Overview (Page 173) 
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Configuring the General tab 
The "General" tab is available to all widgets to a similar scope. In the tab you configure the 
basic information of the widget as well as the date and query type of the display range. The 
area "Date & Querytype" is not required with the widgets "Text", "Image" and "Report". 
Instead, these widgets have corresponding tabs for entering a text or for selecting an image 
or a report. 

Procedure 
To configure the "General" tab, follow these steps: 

1. Enter the name of the widget in the "Title" entry field. 

The input of a name is required. 

2. If you have created several Widget Dashboards, you can select a dashboard link from the 
drop-down list "Dashboard". When you close the configuration mode of the dashboard, the 
following icon is displayed in the top right-hand corner: 

 
When you click on the icon, you change to the selected Widget Dashboard. 

3. Enter the number of decimal places for displaying the data point values in the "Decimal 
places" entry field. 

Entry of the number of decimal places is required. 

 
4. To adopt the date and the query type of the configured Widget Dashboard, select the "Use 

dashboard settings" check box. 

The selection of a particular timespan and the selection of a query type are deactivated. 

5. To use a specific date and a specific query type, clear the "Use dashboard settings" check 
box. 

6. To display the current date, select the "Current Date" check box. 

7. If you want to display a specific time, select the required start date with the associated time 
from the "From" list. 
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8. Select the required observation period linked to the date from the drop-down list "Query 
type". 

 
9. If required, enter the time offset for the start of the measured value series, for example, 

change 00:00 to 08:00 in the "Offset" entry field. 

10.Select the compression level of the measured values from the drop-down list "Compression". 
By selecting the compression level you can compress, for example, the cyclically recorded 
15-minute values to hourly values. 

11.If you enter a numerical value in the "Offset [s]" entry field, the measured values are only 
updated after the duration entered has expired. 
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12.When you select the "Timestamps left aligned" check box, the start time (timestamp) of the 
measured values is displayed. 

 
13.The "Comparison" area is only available in the "Chart" widget; you use it to display the time 

comparison of the selected data point graphically. When you select the "Static" check box, 
you set a fixed time range with the help of the entry field. When you select the "Dynamic" 
check box, enter the time offset with regard to the query type for which the comparison is 
used in the "Offset" entry field. A negative value jumps back to the past by one time offset, a 
positive value jumps to the future. 

 

Configuring the "Data Source" tab 
You configure the "Data source" tab for almost all available widgets. In the tab, select the data 
points you want to visualize in the corresponding widget. 

Requirement 
• The data points have been created. 



Energy Manager Web  
3.5 Configuration of the analysis objects 

 SIMATIC Energy Manager PRO V7.2 - Operation 

198 Operating Manual, 12/2020, A5E38952754-AF 

Procedure 
To configure the "Data source" tab, follow these steps: 

1. From the drop-down list "Select a data point" select the data points that you want to use in 
the widget. You can enter the data points in the entry field. After the first three letters, a 
corresponding selection list is proposed. By selecting or clearing the check boxes "Data 
point", "Measuring Variable", "Parameter" and "Consumer Variable" you further refine the 
search. Depending on the widget, you can select one or more data points for the display. 

 
Selected data points are displayed in the "Currently selected" list.  
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2. To configure further information of the selected data points, click on the corresponding data 
point. 

A drop-down list with additional setting options opens. 

 
3. Select the "Title" check box to use the name of the data point in the display. 

It is not possible to change the name in the adjacent entry field. 

4. Select the "Alternative title" check box if you want to use an alternative name of the data 
point in the display. Enter the name in the adjacent entry field. 

5. Select the "Description" check box if you want to use the description of a data point in the 
display. 

It is not possible to enter a description. You enter the description text when creating a 
data point. 
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6. Select the display type of the values in the widget from the drop-down list "Category". The 
drop-down list is only available for data point types of the category "Energy", "Power" or 
"Count value". 

You can choose between the following display types: 

– Energy / consumption 

– Power / Flow 

– Counter (only available for acquisition category "Count value") 

If you use a data point of the acquisition category "Energy / Consumption", for example, 
and set the display type in the widget to "Power / Flow" the original energy values change 
to the corresponding power values. The unit in the display of the widget also changes 
accordingly, for example, from kWh to kW.  

 
  Note 

If you change the display type, the unit of the y-axis does not change. The unit of the y-
axis is initialized with the first data point added. You set the unit of the y-axis in the "Y-
Axis" tab. 

 

The conversion of the unit is always hour-related, for example, from J to J/h or from W to 
Wh. 

7. Select the information type which you would like to display from the drop-down list 
"Function". You can choose from the following information types: 

– sum: Shows the values from the "Sum" column of the measured value editor in the 
defined observation period. 

– min: Shows the values from the "Minimum" column of the measured value editor in 
the defined observation period. 

– max: Shows the values from the "Maximum" column of the measured value editor in 
the defined observation period. 

– avg: Shows the values from the "Average" column of the measured value editor in the 
defined observation period. 

– last value: Shows the values from the "Last value" column of the measured value editor 
in the defined observation period. 

The information type "avg" is automatically and unalterably enabled for the category 
"Power / Flow" selected in step 6. The default setting for the "Energy / consumption" 
category is the information type "sum"; the default setting for the "Counter" category is 
the information type "last value". You can change both information types later. 

See also 
Creating data points (Page 277) 
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Configuring the Limits tab 
The "Limits" tab is available in the following widgets: 
• Gauge 
• Chart 
• Traffic Light 
• Matrix 
• MultiRegression 

In the tab, define a validity range for the measurement data by setting limits.  

Procedure 
To configure the "Limits" tab, follow these steps: 
1. Enter the limits for the alarm range in the "Lower limit" and "Upper limit" entry fields. 
2. Enter the limits for the warning range in the "Lower limit warning" and "Upper limit warning" 

entry fields. 
 

  Note 
If you have already configured plausibility for a data point and have defined the limits for 
the alarm and warning range, these entries are automatically adopted in the tab. 

 
3. Select the corresponding colors for the areas "Violation", "Warning" and "Value". 
4. In the case of a Gauge widget, enter the start of display or end of display in the "Min-Range" 

and "Max-Range" entry field, respectively. 

 
 

 Note 
The entries configured in the widget only apply to this widget and are not updated in the 
data point. A change in the limits in the widget does not trigger a change in the plausibility 
settings in the data point. 

 

See also 
Configuring the plausibility (Page 482) 
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Configuring the Y-Axis tab 
The "Y-Axis" tab is available in the "Chart" and "MultiRegression" widgets. In the tab, add 
additional y-axes in the chart. You can add up to five additional Y-axes. If you have added 
more than one y-axis, you can delete y-axes that are no longer required by clicking on the 
"Delete Y-Axis" button.  

Procedure 
To configure the "Y-Axis" tab, follow these steps: 

1. Enter the name for the y-axis in the "Title" entry field. The unit of the data point measured 
values is usually entered. 

2. Enter the limits of the y-axis in the "Lower Limit" and "Upper Limit" entry fields. 

3. Click on the "New Y-Axis" button to add an additional Y-axis. 

A new Y-axis is created in the list. 

4. Enter the title and limits again for the new Y-axis. 

 
 

 Note 

In the widget, the title or the unit of the y-axis is initialized with the first added data point. 
 

 Note 

When you do not enter any limits in the "Lower Limit" and "Upper Limit" entry fields, the y 
axis is automatically adapted. 

 

See also 
MultiRegression (Page 187) 
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Configuring the Image tab 
The "Image" tab is available in the "Image" widget. With the tab you display a custom image in 
the Widget Dashboard. 

Procedure 
To configure the "Image" tab, follow these steps: 

1. Click on the "Select file" button. 

2. Select the image you wish to upload. 

3. In the right-hand side of the tab, select whether you want to display the image "Centered" 
and in the same size or "Stretched". 

 

Configuring the Text tab 
The "Text" tab is available in the "Text" widget. With the tab you compose a custom text that 
is displayed in the widget. You can also insert a URL link or an e-mail address with a particular 
message text as text. When you click on the URL link after configuration, the page is opened 
in your Internet browser. When you click on the e-mail link, your default e-mail program 
opens to which the entered texts are copied. 
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Procedure 
To configure the "Text" tab, follow these steps: 

1. Enter the required text in the text field. When entering the text you can choose from the 
following functions for editing the text: 

– Font 

– Font size 

– Text color 

– Background color 

– Bold 

– Italic 

– Strikethrough 

– Delete formatting 

– Insert/edit link 

– Delete link 

– Numbered list 

– List 

 
2. When you click on the "Insert link" icon, the dialog window "Link" opens. 

3. To display a URL in the text field, select the menu command "URL" from the drop-down list 
"Link type". 

4. Select one of the available transfer protocols from the drop-down list "Protocol". 

5. Enter a valid URL in the "URL" entry field. 

 
6. To send a text via e-mail, select the menu command "E-mail" from the drop-down list "Link 

type". 

7. Enter the recipient's-mail address in the "E-mail address" entry field. 
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8. Enter the subject in the "Subject line" entry field. 

9. Enter the text message in the "Message text" entry field. 

 

Configuring the Data Source Report tab 
A special view of the "Data source" tab with the area "Reports" is available for the "Report" 
widget. In the tab, select the report that is generated in the widget. 

Requirement 
• The report has been created. 

Procedure 
To configure the "Data source" tab of the "Report" widget, follow these steps: 

1. Enter the report you wish to use in the widget in the "Select report" entry field. When you 
enter a text in the entry field, a corresponding list of the reports is displayed. 
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Configuring the Heat Map tab 
The "Heatmap" tab is available in the "Heat Map" widget. With the tab you set the limits and 
the display of the measured values. 

Procedure 
To configure the "Heatmap" tab, follow these steps: 

1. Enter your individual limits for the measurement data in the "Lower limit" and "Upper limit" 
entry fields. In this way you define a valid range for your measurement data. If you do not 
enter any values in the entry fields, the maximum and minimum measured value is used as 
the limit. 

2. Select the display color of the measured values for the settings "Min values", "Normal values" 
and "Max values". 

3. If you want a daily display of the measurement data, select the "Day view" check box. For a 
weekly display of the measured data, select the check box "Week view". With the "week 
view" you can choose between display beginning on Monday or on Sunday. 

 

See also 
Heat Map (Page 181) 
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Configuring the Locations tab 
The "Locations" tab is available in the "Map" widget. With the tab you configure the location-
specific KPIs and dashboards you want to view from your system. 

Requirements 
• The location object with valid GPS coordinates has been created. 

• The location object is assigned to the corresponding user group. 

• The dashboards have been created. 

• The KPIs have been created. 

Procedure 
To configure the "Locations" tab, follow these steps: 

1. Select the locations for which you want to display the location-specific dashboards and KPIs 
from the drop-down list "Select location". 

 
 

  Note 

To display your created locations in the widget, you have to enter the geographical 
coordinates of the location in the location object in the Energy Manager PRO Client. Only 
locations with valid coordinates are available for selection in the widget. You can 
determine the coordinates using Google Maps, for example, and copy them to the 
location object. You must separate the two coordinates with a blank space. 

In addition, you have to assign the location object to the corresponding user group. 

You can find more detailed information on location selection in the "Map" paragraph of 
the "Extended widgets" section. 

 

The selected locations are displayed in the "Currently selected" list. 

2. To select the location-specific dashboards and KPIs, click the corresponding location. 

3. Select up to two dashboards to which you want to jump directly from the location tooltip for 
each location in the drop-down list "Add dashboard". 

4. Enter the name of the dashboard in the adjacent entry field. 

5. Select up to five KPIs you want to display for each location from the drop-down list "Add 
KPI". 
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6. Click on the "Add KPI" button. 

 
 

  Note 

You can configure up to 50 data points or KPIs in the "Map" widget. 
 

7. When you click on the Delete icon, you remove KPIs which are no longer required. 

See also 
Map  (Page 182) 
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Configuring the Sankey tab 
The "Sankey" tab is available in the "Sankey" widget. With the tab you configure the nodes 
and data points which you use in the Sankey diagram. 

Requirement 
• The data points have been created. 

Procedure 
To configure the "Sankey" tab, follow these steps: 

1. Enter the name of the node (media) you want to show in the Sankey diagram in the "Add a 
node" entry field. 

Use meaningful names for the corresponding nodes. 

2. Click on the "Add node" button. 

 
The node is added to the list "Current nodes". 

3. Click on the name of a node and select a color. 

4. From the drop-down list "Add a link" select the data points that you want to use in the 
Sankey diagram. 

5. To incorporate the data points in the Sankey diagram, click on the "Add link" button. 

 
  Note 

You can configure up to 50 nodes and data points in the Sankey diagram. 
 

The data points are displayed in the list "Current links". 
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6. To link the data points with the corresponding nodes, click on the data points. 

 
7. Select the incoming quantity flow of the respective data points from the drop-down list 

"Source", and the outgoing quantity flow of the respective data points from the drop-down 
list "Target". 

 
  Note 

When linking the data points with the nodes you have to assign the "source" and "target" 
of a data point to different nodes. 

 

8. Enter a scaling factor in the "Scaling" entry field. The scaling factor is required for 
recalculation to the primary energy in an energy flow diagram with different media. 

9. You can remove nodes or data points which are no longer required from the Sankey 
diagram with the help of the delete icon. 

See also 
Sankey  (Page 184) 
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Configuring the Alarms tab 
The "Alarms" tab is available in the "Alarm list" widget. With the tab you manage the display 
of message lists. 

Procedure 
To configure the "Alarms" tab, follow these steps: 

1. Select the type of messages you wish to display from the drop-down list "Message type". You 
can choose between "All", "Violation" and "Warning". 

2. To only show unacknowledged messages, select the "All not acknowledged" check box. 

3. To filter messages by a particular designation, enter the corresponding text in the "Free text" 
entry field. 

 

See also 
Alarm list  (Page 185) 
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Configuring the Model Definition tab 
The "Model Definition" tab is available in the "MultiRegression" widget. With the "Model 
Definition" tab you define the data points to determine the Baseline and Forecast.  

Requirement 
• The data points have been created. 

Procedure 
To configure the "Model Definition" tab, follow these steps:  

1. Select the data point whose Baseline you want to determine, for example, energy 
consumption of a plant, from the drop-down list "Y-Values". 

2. Select the data points which influence the y data point from the drop-down lists "X-Values". 
You can select up to five data points. 

3. If you want to use the Forecast function, select the "Model Parameters - Forecast" check box. 

4. In turn, select the corresponding x values from the drop-down lists. 

The same number of parameters is required for the Baseline and the Forecast.  
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5. With the help of the corresponding selection boxes, select the analysis time window in 
which you want to analyze the selected data. 

 
 

  Note 

No one-time special effects should exist in this time window, because they would 
influence the result. 

 

6. To eliminate spikes in the values from the calculation, select the "Ignore spikes" check box. 

The entry field in which you can enter a value is activated. The value 100% means that a 
deviation greater than 100% between the calculated and actual y value is not included in 
the calculation. 
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7. Click on the "Calculate formula" to start the analysis. 

The result is output with the "coefficient of determination" and the "F-Ratio". The 
coefficient of determination specifies the correlation between the values. The coefficient 
of determination lies between the value 0 and the value 1. In addition, the color adjusts to 
the coefficient of determination: 

– 0 - 0.3 No or little correlation (red) 

– 0.3 - 0.6 Medium correlation (yellow) 

– 0.6 - 1: Good or full correlation (green) 

8. If the result shows a corresponding correlation, you can set the validity time of this model. 

9. Click on the "Save event" button. 

10.If the result shows a corresponding correlation, you can load a previously calculated analysis 
by clicking on the "Load result" button. 

 

See also 
MultiRegression (Page 187) 
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Configuring the Model Overview tab 
The "Model Overview" tab is available in the "MultiRegression" widget. With the tab you see 
an overview of the models defined in the "Model Definition" tab. 

Procedure 
In the "Model Overview" tab you cannot configure any parameters, but only delete models. 
You delete models by clicking on the delete icon. Only the defined models are displayed in 
the model overview. The date specifies the validity time of the model.  

 

See also 
MultiRegression (Page 187) 
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Configuring the Display options tab 
The "Display options" tab is available in the "Duration Curve" widget. With the tab, enter the 
number of measured values you want to use for displaying the duration curves. 

Procedure 
To configure the "Display options" tab, follow these steps: 

1. Enter the number of measured values you want to use for displaying the duration curves in 
the "Amount of data for detail view" entry field. 

The number of measured values is used for the display of the 2nd and 3rd tab in the 
"Duration Curve" widget.  

See also 
Duration curve (Page 190) 
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3.5.5 Reports 

3.5.5.1 Overview 
To evaluate measurement data in Energy Manager Web, you can create and configure reports 
with the help of the shortcut menu. The creation of reports in Energy Manager Web is based 
on report templates. You cannot configure these report templates in Energy Manager Web, 
but only in the Energy Manager PRO Client. Newly created reports and configurations on 
already existing reports in Energy Manager PRO Web are also adopted in the 
Energy Manager PRO Client and vice versa. 

3.5.5.2 Creating reports 

Requirements 
• The folder has been created. 

• The data points, measuring variables and parameters have been created. 

• The report templates have been configured. 

• Users have been created. 

• The user has the functional right "Report - create, remove, configure". 

Procedure 
To create reports, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area in which you would like to 
create the report. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens.  

4. Click on the "Add report" menu command. 

The configuration dialog "New - Report" is opened.  
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Configuring the "General" tab 
1. Enter a meaningful name for the report in the "Name" text box. 

The input of a name is required. 
 

  Note 

Do not use Excel-specific expressions such as A1 or =FG14 during the report creation. 

The report name cannot contain any special characters. The following characters are 
permitted: 
• A to Z 
• a to z 
• 0 to 9 
• _ 
• Space 

 

2. If required, enter a description of the report in the "Description" text box. 

3. Select the display type of the name in the report from the drop-down list "Text type". 

4. Select the appropriate country from the drop-down list "Country". 
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5. Select the required report template from the drop-down list "Template". The following report 
templates are available: 

– Balance Calculates the total value of the selected data points, measuring variables and 
parameters over the entire observation period of the report. 

– Balance comparing In addition to the "Balance" template, it calculates the total value of 
the previous observation period and that of the previous year. 

– Protocol Returns the values of the selected objects in the selected interval within the 
observation period. 

– Protocol with from/to In addition to the "Protocol" template, it specifies the timestamp 
with the start and end of the interval. 

– Duration curve Sorts the values (from the largest to the smallest) of the selected 
objects in the selected interval within the observation period. 

 
The selection of a report template is required. The query types which you configured in 
the report template are automatically adopted as query types.  
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6. You have the option of selecting further query types from the drop-down list "Select query 
type". 

The selected query types are displayed in the overview list. The query type which you 
configured in the report template is marked with the compression level "Entry values". 
Added query types are displayed with "Dynamic values". 

 
  Note 

The compression level "Dynamic Values" means that the calculation logic automatically 
uses the best possible compression level for calculation.  

 

7. To remove query types that are no longer required, click on the Delete icon. 
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Configuring the "Data Source" tab 
1. In the event of an interval configuration, select the corresponding time interval for each 

existing query type on the left-hand side. Using the time interval you divide the observation 
period into equally sized intervals. 

 
2. Select the data points, parameters and MEVAs that you want to use in the report from the 

drop-down list "Select a data point". You can enter the data points in the text box. After the 
first three letters, a corresponding selection list is proposed. By selecting or clearing the 
check boxes "Datapoint", "Measuring Variable" and "Parameter" you further refine the search. 

Selected data points are displayed in the "Currently selected" list.  
 

  Note 

Object descriptions of Data points, Measuring variables and Parameters must not contain 
Excel-specific expressions such as A1 or =FG14. 

If you output the properties of objects in reports, do not use Excel-specific expressions in 
the output properties. 

 

3. You can change the sequence of the data points using drag and drop of the Move icon. 

You must observe the sequence of the data points for module types. 
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4. You can remove data points which are no longer required from the list by clicking the Delete 
icon. 

 
5. Repeat steps 1 to 4 for each selected module. 

Configuring the "Automation" tab 
1. To enable automatic report generation, select the "Start" check box. 

2. To delay automatic report generation, enter the desired delay in the text box "Start report 
after". Select the associated unit from the "Unit" drop-down list. 

 
3. To automatically send the generated report to selected users via e-mail, select the "Send per 

mail" check box. 

4. Select the format of the report: You can choose between PDF and Excel format. 

5. When you select the "Mail link to recipient" check box, a link with a URL is sent to the 
recipient. When the recipient clicks on the link, the corresponding report is opened in the 
Internet browser. 

6. Select the users who will receive the report from the drop-down list "Select user". Only users 
with an assigned e-mail address are displayed. 

The recipients of the report are displayed in an overview list.  
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7. To remove users from the list again, click on the Delete icon. 

 
8. Repeat steps 1 to 6 for each selected query type. 

9. Click on the "Save" button. 

Result 
The report has been created. 

See also 
Shortcut menu (Page 161) 

Creating users (Page 320) 

Editing mode (Page 158) 

Editing reports (Page 224) 

Deleting reports (Page 225) 

Reports (Page 123) 

Creating MEVAs / KPIs (Page 301) 

Creating parameters (Page 295) 

Creating data points (Page 277) 

Creating a report (Page 603) 
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3.5.5.3 Editing reports 
Instead of selecting a report template when editing a report, you can export and import 
report templates. You can edit and then reimport report templates which you export. You can 
also import other saved report templates. The imported report template is used for the next 
report generation. 

Requirements 
• The report has been created. 
• The data points, measuring variables and parameters have been created. 
• The report templates have been configured. 
• Users have been created. 
• The user has the functional right "Report - configure" or the functional right "Report - 

create, remove, configure". 

Procedure 
To edit reports, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the report in the navigation area which you want to edit. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Report" opens. 

4. You can configure all the settings again which you defined on creation of a report. 

The input of a name is required. 

5. To export report templates, click the "Export" button. You can open the report templates 
directly or save the report templates. Saved report templates are exported to the standard 
download directory of your browser as an .xlsm file. 

6. To import report templates, click the "Import" button. 

7. Select the report template you want to import. 

The settings in the report template are adopted for the selected report. 
 

  Note 

When you import a new report template for an existing report, the current configurations 
are deleted and instead the configuration of the new report template is used.  

 

8. Click on the "Save" button. 

See also 
Creating reports (Page 217) 
Deleting reports (Page 225) 
Configuring reports (Page 605) 
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3.5.5.4 Deleting reports 

Requirements 
• The report has been created. 

• The user has the functional right "Report - create, remove, configure". 

Deleting a report 
To delete reports, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the report in the navigation area which you want to delete. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Report" opens. 

4. Click the "Delete" button. 

5. Click the "Delete" button again to confirm the deletion process. 

Result 
The report is deleted from the system. 

See also 
Editing reports (Page 224) 
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3.5.6 Charts 
To graphically display measurement data in Energy Manager Web, you can create new charts 
and configure existing charts with the help of the shortcut menu. Newly created charts and 
configurations on already existing charts in EnergyManagerPROWeb are also adopted in the 
Energy Manager PRO Client and vice versa. 

3.5.6.1 Creating charts 

Requirements 
• The folder has been created. 

• The data points have been created. 

• The user has the functional right "Chart Object - create". 

Procedure 
To create charts, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area in which you want to create 
the chart. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens.  

4. Click on the menu command "Add chart". 

The configuration dialog "New - Chart" opens.  

5. Enter a meaningful name for the chart in the "Name" entry field. 

The input of a name is required. 

6. If required, enter a description of the chart in the "Description" entry field. 

 
7. Click the "Save" button. 
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Result 
The chart has been created. 

See also 
Shortcut menu (Page 161) 

Editing mode (Page 158) 

Creating data points (Page 277) 

Editing charts (Page 228) 

Deleting charts (Page 229) 

Creating a Chart (Page 627) 
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3.5.6.2 Editing charts 

Requirements 
• The chart has been created. 

• The data points have been created. 

• The user has the functional right "Chart Object - configure". 

Procedure 
To edit charts, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the chart in the navigation area which you want to edit. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Chart" opens. 

4. As with creating a chart, you can configure the name and description again. 

The input of a name is required. 

5. Click on the "Save" button. 

See also 
Creating charts (Page 226) 
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3.5.6.3 Deleting charts 

Requirements 
• The chart has been created. 

• The user has the functional right "Chart Object - delete". 

Procedure 
To delete charts, follow these steps: 

1. Enable the editing mode. 

2. In the navigation area, place the mouse pointer over the chart which you want to delete. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Chart" opens. 

4. Click the "Delete" button. 

5. Click the "Delete" button again to confirm the deletion process. 

Result 
The chart is deleted from the system. 

See also 
Editing charts (Page 228) 
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3.5.7 Matrices 

3.5.7.1 Overview 
To manually acquire measurement data in Energy Manager Web or define a reading route for 
mobile data acquisition using the Energy Manager App, you need matrices. You create 
matrices and configure them in Energy Manager Web. Newly created matrices and 
configurations on already existing matrices in Energy Manager PRO Web are also adopted in 
the Energy Manager PRO Client and vice versa. 

3.5.7.2 Creating matrices 

Requirements 
• The folder has been created. 

• The data points have been created. 

• The user has the functional right "Matrix - create, remove, modify". 

Procedure 
To create matrices, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area in which you would like to 
create the matrix. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens.  

4. Click on the menu command "Add matrix". 

The configuration dialog "New - Matrix" opens.  

5. In the "Name" text box, enter the name of the matrix. 

6. Enter a description of the matrix in the "Description" text box. This entry is optional. 

7. Click on the "Save" button. 

Result 
The matrix has been created. 
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See also 
Shortcut menu (Page 161) 

Editing mode (Page 158) 

Editing matrices (Page 232) 

Deleting matrices (Page 233) 

Creating data points (Page 277) 

Setting up mobile data acquisition with the SIMATIC Energy Manager app for iOS and Android 
(Page 151) 

Configuring matrices (Page 149) 
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3.5.7.3 Editing matrices 

Requirements 
• The matrix has been created. 

• The data points have been created. 

• The user has either the functional right "Matrix - create, remove, modify" or the functional 
right "Matrix - modify". 

Procedure 
To edit matrices, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the matrix in the navigation area which you want to edit. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Matrix" opens. 

4. You can configure all the settings again which you defined on creation of a matrix. 

The input of a name is required. 

5. Click on the "Save" button. 

See also 
Creating matrices (Page 230) 
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3.5.7.4 Deleting matrices 

Requirements 
• The matrix has been created. 

• The user has the functional right "Matrix - create, remove, modify". 

Procedure 
To delete matrices, follow these steps: 

1. Enable the editing mode. 

2. In the navigation area, place the mouse pointer over the matrix which you want to delete. 

The Edit icon is displayed in the right-hand area of the menu item. 

3. Click on the editing icon. 

The configuration dialog "Edit - Matrix" opens. 

4. Click the "Delete" button. 

5. Click the "Delete" button again to confirm the deletion process. 

Result 
The matrix is deleted from the system. 

See also 
Editing matrices (Page 232) 
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3.5.8 Folder 

3.5.8.1 Overview 
To create a custom navigation structure in Energy Manager Web, create new folders and 
configure existing folders with the help of the shortcut menu. Newly created folders and 
configurations on already existing folders in Energy Manager PRO Web are also adopted in 
the Energy Manager PRO Client and vice versa. 

3.5.8.2 Creating folders 

Requirement 
• The user has the functional right "Folder - create, delete" 

Procedure 
To create folders, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area in which you want to create a 
new folder. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens.  

4. Click on the "Add folder" menu command. 

The configuration dialog "New - Folder" opens. 

5. Enter a meaningful name for the folder in the "Name" entry field. 

 
The input of a name is required. 
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6. If required, enter a description of the folder in the "Description" entry field. 

7. Enter the authority level for the folder in the "Authority level" entry field. 

8. Click on the "Save" button. 

Result 
The folder has been created. 

See also 
Shortcut menu (Page 161) 

Folder (Page 110) 

Editing mode (Page 158) 

Editing folders (Page 236) 

Deleting folders (Page 237) 
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3.5.8.3 Editing folders 

Requirements 
• The folder has been created. 

• The user has the functional right "Folder - configure". 

Procedure 
To edit folders, follow these steps: 

1. Enable the editing mode. 

2. Place the mouse pointer over the folder in the navigation area which you want to edit. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens. 

4. Click on the menu command "Edit". 

The configuration dialog "Edit - Folder" opens. 

5. Configure the name, the description, if required, and the authorization level of the folder. 

The input of a name is required. 

6. Click on the "Save" button. 

See also 
Shortcut menu (Page 161) 

Folder (Page 110) 

Creating folders (Page 234) 
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3.5.8.4 Deleting folders 

Requirements 
• The folder has been created. 

• The user has the functional right "Folder - create, delete". 

Procedure 
To delete folders, follow these steps: 

1. Enable the editing mode. 

2. In the navigation area, place the mouse pointer over the folder which you want to delete. 

The shortcut menu icon is displayed in the right-hand area of the menu item. 

3. Click on the shortcut menu icon. 

The shortcut menu opens. 

4. Click on the menu command "Edit" 

The configuration dialog "Edit - Folder" opens. 

5. Click the "Delete" button. 

6. Click the "Delete" button again to confirm the deletion process. 

Result 
The folder is deleted from the system. 

See also 
Editing folders (Page 236) 
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3.6 Project configuration 

3.6.1 Overview 
In the "Project configuration" folder you create new data sources and data channels as well as 
their processing calculations in Energy Manager Web. You can also configure already existing 
objects. 

You can configure the following acquisition and processing objects: 

• Data sources 

• Data points 

• Parameter 

• MEVAs / KPIs 

Opening the project configuration 
To open the "Project configuration" folder, follow these steps: 

1. Click in the menu bar on "Configuration". 

 
2. Click the menu item "Project configuration" in the navigation area. 
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In the detail area you see an overview of the configurable objects in tile form. 

 
The number of available objects is displayed in the bottom part of the tiles. 

 
  Note 

 Data points, Parameter and MEVAs / KPIs are only available in the configuration area in 
Energy Manager Web if the following criteria are met: 
• The object is linked at least once in the entry point of the user in the Web. 
• The authority level of the object is lower than or the same as the authority level of the 

user. 
• The object and the user are assigned to the same domain. 

 
3. To configure the respective object, click on the corresponding tile in the detail area. As an 

alternative, you can click on the corresponding menu item in the navigation area. 
 

 Note 

The folder structures are automatically created after the installation of Energy Manager and 
cannot be deleted by the user. The structure of the configuration area is created in the 
Energy Manager PRO Client under the path "System > Configuration > Web Configuration". 

 

See also 
Data source (Page 242) 
Data point (Page 275) 
Parameter (Page 293) 
MEVA / KPI (Page 299) 
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3.6.2 Creating subfolders 
In Energy Manager Web you can create new subfolders in the "Data point", "Parameter" and 
"MEVA / KPI" folders. When you create a new data point, parameter or KPI, you can select the 
folder in which you want to create the object from the "Structure" drop-down list.  

Requirement 
• The user has the functional right "Folder - create, delete" 

Procedure 
To create a new subfolder, follow these steps: 
1. Click on the "Configuration" icon in the menu bar. 
2. Click the menu item "Project configuration" in the navigation area. 
3. Place the mouse pointer in the navigation area either over the menu item "Data point", 

"Parameter" or "MEVA / KPI". 
The shortcut menu icon is displayed on the right-hand side of the corresponding menu 
item. 

4. Click on the shortcut menu icon. 
The shortcut menu is opened with the menu commands "Edit" and "New". 

 
5. Click on the menu command "New". 

The configuration dialog "New - Folder" opens. 

 
6. Enter a meaningful name for the folder in the "Name" entry field. 

The input of a name is required. 
7. If required, enter a description of the folder in the "Description" entry field. 
8. Click on the "Save" button. 
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Result 
The new folder is created under the selected folder. You can create an additional folder in the 
new folder using the same procedure. You can therefore create a structure of up to five 
levels. Click on the menu command "Edit" in the shortcut menu to edit already created 
folders. 

 

 Note 

You cannot edit the automatically created "Data points", "Parameter" and "MEVAs / KPIs" 
folders in this way. 

 

See also 
Creating MEVAs / KPIs (Page 301) 

Creating parameters (Page 295) 

Creating data points (Page 277) 
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3.6.3 Data source 

3.6.3.1 Overview 
When configuring data sources you create new acquisition objects and data channels in 
Energy Manager PRO Web. From these data channels you can create new data points per data 
channel. Newly created data sources and changes to already existing objects in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa. 

 

 Note 
Functionality of Energy Manager Basic 

The creation of new data sources is not available in Energy Manager Basic. Only the 
automatically installed data source is available. 

 

When you click on the menu item "Data source" in the navigation area in the "Project 
configuration" folder, the detail area "Acquisition - Administration" opens. The following 
figure shows the detail area "Acquisition - Administration": 

 
① "New" and "Edit" buttons: Creating and editing new data sources. 
② Display table of existing data sources. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and displayed accordingly 

in the display table. Delimitation of the data sources is recommended when a large number of data sources exist in 
the system. 

④ "Delete" button: Deleting created data sources from the system. 
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Newly created data sources and already existing data sources in the system are displayed in 
tabular form in Energy Manager Web. The display table consists of the following seven 
columns: 

 
Column Function 
Selection You can select individual data sources and any number of data sources with the help of the check boxes. 

Clicking on the check box in the column header selects all data sources. Clicking on the check box again in 
the column header deselects all data sources again. 

Name  Shows the name of the data source. 
Description Shows the description of the data source. 
Status Shows the status of the data source. If the status of the data source shows "Active", data acquisition is ena-

bled. If the status of the data source shows "Inactive", data acquisition is not enabled. 
Host name Shows the host name of the data source. 
IP address Shows the IP address of the data source. Is assigned by the system itself. 
GUID Shows the acquisition ID of the data source. Is assigned by the system itself. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order.  

See also 
Creating data sources (Page 244) 

Editing data sources (Page 246) 

Deleting data sources (Page 247) 

Overview  (Page 238) 

Overview (Page 249) 

Data channels  (Page 249) 
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3.6.3.2 Creating data sources 
 

 Note 
Functionality of Energy Manager Basic 

The creation of new data sources is not available in Energy Manager Basic. 
 

Procedure 
To create a new data source, follow these steps: 

1. Click on the "New" button in the detail area "Acquisition - Administration" . 

The configuration dialog "New - Acquisition" opens. 

 

2. Enter a meaningful name for the data source in the "Name" entry field. 

The input of a name with the prefix "h_" is required. 

3. If required, enter a description of the new data source in the "Description" entry field. 

4. Enter a meaningful host name in the "Hostname" entry field. 

The input of a host name is required.  

5. To acquire measurement data from the data source, enable the option "Active". The status of 
the data source is therefore set to "Active" in the display table. 

6. Click on the "Restart Kernel" button to restart the kernel. 

7. Click on the "Save" button. 
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Result 
The data source is created under the "Data source" folder in the navigation area. The 
corresponding object can be found in the Energy Manager PRO Client under the following 
path: "System > Configuration > Web Configuration > Data sources". However, to acquire 
measurement data from this data source and create data points, you must create data 
channels for every data source afterwards. How to create data channels is described in the 
section "Creating data channels". 

 

 Note 

As soon as you create an additional data source or the data source runs on a different 
computer than the Energy Manager Server, you have to connect the data source with the 
server. You set up the connection via the 'Acquisition' user interface. 

 

See also 
Editing data sources (Page 246) 

Creating hardware (Page 398) 
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3.6.3.3 Editing data sources 

Requirement 
• The data source has been created. 

Procedure 
To edit an already created data source, follow these steps: 

1. Click on the data source to be edited in the display table. 

2. Click the "Edit" button. As an alternative, place the mouse pointer in the navigation area over 
the data source to be edited and click on the Edit icon. 

The configuration dialog "Edit - Acquisition" opens.  

3. Edit names, description and host names. 

The input of a name with the prefix "h_" and the input of a host name is required. 

4. Data acquisition is enabled when you enable the option "Active". 

5. Click on the "Save" button. 

 

 Note 

You can only edit single selected data sources. 
 

See also 
Creating data sources (Page 244) 

Deleting data sources (Page 247) 

Overview (Page 242) 
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3.6.3.4 Deleting data sources 

Requirement 
• The data source has been created. 

Procedure 
To delete one or more data sources from the system, follow these steps: 

1. Click on the data source to be deleted in the display table. You can also select one or more 
data sources to be deleted with the help of the check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete individual data sources from the system in the configuration dialog "Edit - Acquisition" 
by clicking the "Delete" button twice. 

Result 
The data source is deleted from the system. 

 

 Note 

When you delete a data source, all the lower-level object links are deleted from the system. 
 

See also 
Editing data sources (Page 246) 

Overview (Page 242) 
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3.6.3.5 Manual acquisition 
When installing Energy Manager, the "Manual acquisition" folder is automatically created in 
the project folder "Data source", in which you can create, edit and delete manual data points. 
The folder is not an acquisition object as such, but rather contains only an overview of all 
manual data points. In the Energy Manager PRO Client you can find the folder under the 
following path: "System > Configuration > Web Configuration> Data sources".  

To open the "Manual acquisition" folder, click on the menu item "Manual acquisition" in the 
navigation area under the "Data source" project folder. The following figure shows the detail 
area "Data point - Administration" with an overview of all manual data points in the "Manual 
acquisition" folder: 

 

The display table with the columns contained there corresponds to the display table of the 
other data sources. 

3.6.3.6 Derived data points 
When installing Energy Manager, the "Derived data points" folder is automatically created in 
the project folder "Data source". You can create, edit and delete derived data points in this 
folder. The folder is not an acquisition object as such, but rather contains only an overview of 
all derived data points. In the Energy Manager PRO Client you can find the folder under the 
following path: "System > Configuration >Web Configuration > Data sources". 

To open the "Derived data points" folder, click on the menu item "Derived data points" in the 
navigation area under the "Data source" project folder. 

The display table with the columns contained there corresponds to the display table of the 
other data sources. 
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3.6.3.7 Data channels 

Overview 
To create data points in Energy Manager Web, and hence acquire measurement data, you 
need data channels. You can create different data channels for each data source created. 
Newly created data channels and changes to already existing channels in Energy Manager 
PRO Web are also adopted in the Energy Manager PRO Client and vice versa. You can only 
create the following channel types for data acquisition in Energy Manager PRO Web: 

• OPC UA, DA, HDA 

• WinCC 

• Energy Suite 

• Modbus / TCP 

 

 Note 
Functionality of Energy Manager Basic 

Only the automatically installed data channels are available in Energy Manager Basic. 
 

When you click on a data source in the navigation area, the associated data channels are 
displayed in the detail area in tabular form and in the navigation area under the data source. 
The following figure shows the detail area "Channel management" with an overview of the 
existing data channels of a data source: 
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① "New" and "Edit" buttons: Creating and editing new data channels. 
② Display table of existing data channels per data source. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of the data channels is recommended 
when a large number of data channels exist per data source. 

④ "Delete" button: Deleting created data channels from the system. 

Newly created channels and channels available per data source are displayed in tabular form 
in Energy Manager Web. The display table consists of the following three columns: 
 
Column Function 
Selection You can select individual data channels and any number of data channels with the 

help of the check boxes. By clicking on the check box in the column header you select 
all data channels. Clicking on the check box again in the column header deselects all 
data channels again. 

Name  Shows the name of the data channel 
Type Shows the channel type. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 

See also 
Overview (Page 242) 

Creating data channels (Page 251) 

Editing data channels (Page 270) 

Deleting data channels (Page 271) 

Data point - Administration (Page 272) 
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Creating data channels 

Requirement 
• The data source has been created. 

Procedure 
To create a new data channel, follow these steps: 

1. Click on the data source in which you want to create a new data channel in the navigation 
area under the "Data source" folder. 

The detail area "Channel management" is displayed. 

2. Click the "New" button. 

The configuration dialog "New - Channel" opens. 

 
3. Select the channel type from the "Source" drop-down list. You can choose from the 

following channel types: 

– Energy Suite 

– Modbus / TCP 

– OPC DA 

– OPC HDA 

– OPC UA 

– WINCC 

– ASCII 

– Desigo CC 

Depending on the channel type, you have to configure different settings.  
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See also 
Overview (Page 249) 

Configuring interfaces (Page 279) 

Editing data channels (Page 270) 

Data point - Administration (Page 272) 

Create OPC DA, OPC HDA, OPC UA channel (Page 255) 

Creating an Energy Suite channel (Page 259) 

Creating a WinCC channel (Page 262) 

Creating a Modbus TCP channel (Page 264) 

Creating an ASCII channel 
With an ASCII channel you read data from ASCII file of a local system or an FTP server. After 
successful configuration, transfer of the ASCII files from the directory to the Energy Manager 
acquisition component is carried out automatically.  

Requirements 
If you obtain ASCII data from an FTP server, the following requirements apply:  

• The acquisition component is logged in to the Energy Manager. 

• The FTP server can be accessed. 

• You have the access data for the FTP server. 

Procedure 
To create an ASCII channel, proceed as follows: 

1. Enter a meaningful name for the new channel in the "Name" entry field. 
The input of a name is required. 

2. Select the entry "Ascii" from the "Source" drop-down list. 
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3. Select one of the following entries from the "Type“ drop-down list: 

– FTP 

– SFTP (secure FTP) 

– File (direct entry) 

 

4. Enter the directory of the file in the "Path" entry field. 

The source directory has to be specified. 
 

  Note 

Ensure that there are no blank spaces in the source directory. Data acquisition is only 
possible with a source directory without blank spaces.  

 

5. Select the format of the file from the "Format" drop-down list. 

6. If you have selected the type "FTP" or "SFTP", enter your access data in the entry fields "User 
name" and "Password". 
The access data is required. 

7. Select the time interval in which the data is transmitted from the "Data transmission 
interval" drop-down list. This selection corresponds to the cycle time of the IO buffer in the 
Energy Manager PRO Client. 
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8. Select the required data points in the navigation field. 

9. Click the "Save" button. 

To add a data point to the navigation field, proceed as follows: 

 

1. Enter the name of the data point in the "Data point" entry field. 

2. Enter the address of the data point in the ASCII file in the "Address" entry field. 

You can find additional information on this in the entry on the corresponding file format 
in the section ASCII FTP formats. 

3. In the "Data type" drop-down list, select the data type. 

4. Click the "Add" button. 

Result 
The ASCII channel with the selected data points is created under the data source. 

See also 
ASCII FTP formats (Page 845) 
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Create OPC DA, OPC HDA, OPC UA channel 
You use the channel type "OPC" to retrieve the data provided by an OPC server. The data 
channel "OPC UA" ("OPC Unified Architecture") is a specification for the transmission of 
process values and archive data.  

Security concept 
The OPC UA server uses the TCP/IP protocol for data exchange. For authorization, certificates 
are exchanged between server and client. In addition, you can encrypt the data traffic. 

Requirements 
• The data source is logged in to the Energy Manager Server and activated. 

• An OPC Server and/or an OPC Client is installed on the data source. 

• An understanding of addressing and communication with OPC. 

• The certificate exchange is provided for at the time that the interface is configured. 

Procedure 
To create an OPC channel, follow these steps: 

1. Enter a meaningful name for the new channel in the "Name" text box. 

The input of a name is required. 

2. Select one of the following entries from the "Source“ drop-down list: 

– OPC DA 

– OPC HDA 

– OPC UA 

3. Enter the address of the OPC Server in the "OPC server name" text box. 
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4. Click the "Connect" button. 
The system checks whether there is a server connection. If a server connection exists, the 
available servers are loaded to the "Data source" drop-down list. If there is no connection, 
check your entries. 

5. Depending on the selected OPC type, a distinction is made between the following three 
cases for the option "Acquire historical data (HDA)": 

– OPC DA: The option is not available. 

– OPC HDA: The option is automatically enabled. 

– OPC UA: You can enable the option. When you enable the option, you use the 
functionality of an HDA channel. When you disable the option, you use the 
functionality of a DA channel. 

6. Select the aggregation function for an HDA channel or a UA channel with HDA functionality 
from the "Aggregation" drop-down list. 

The acquired values are aggregated depending on the selection. For example, if "Average" 
is selected, the arithmetic mean of the reading interval is formed. 

7. Select the time interval with which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. This selection corresponds to the cycle time of the IO 
buffer in the Energy Manager PRO Client. 

8. If you want to use Online Monitoring, activate the option "Enable power monitoring". The 
Online Monitoring is only available for OPC UA servers. 

 
If you use Online Monitoring, you can create data points of the OPC server in a separate 
folder structure for real-time monitoring. 

Select the time interval in which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. 

Select the folder structure in which the data points are saved from the "Structure" drop-
down list. The folders must already exist and be part of the "Monitoring" structure. 

For more information, refer to Online Monitoring in section "Online Monitoring 
(Page 119)". 
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9. If the "Acquire historical data (HDA)" option is enabled, you can reload measurement data as 
of a specific date. Enable the option "Override TSP settings" and select the date in the 
"Retrieve data since" text field. 

 
10.Select the server with the required data points from the "Data source" drop-down list You 

have to select a "Siemens OPC UA" server. 

11.Click the "Browse" button. 

 
 

  Note 

When configuring the OPC UA server, activate at least one "Security policy" and its 
associated "Security mode". Otherwise, the OPC UA server and the clients will 
communicate insecurely. 

During the first access to an encrypted OPC UA server instance a certificate for encrypting 
the data is created. You have to accept this certificate individually in the respective server 
product. You may have to perform this operation twice. 
• Siemens SIMATIC NET V15: With the help of the "Siemens Communication Settings" 

software in the "OPC UA certificates" menu command. 
• Siemens WinCC TIA V15: Moving of the new certificates from the path "C:\Program 

Files (x86)\SIEMENS\Automation\SCADA-
RT_V11\WinCC\opc\UAServer\PKI\CA\rejected\certs'" to "'C:\Program Files 
(x86)\SIEMENS\Automation\SCADA-RT_V11\WinCC\opc\UAServer\PKI\CA\certs" 

 

The available data points are loaded to the overview list. 

12.Select the required data points from the available data points. 
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13.If you have activated Online Monitoring, click the "Online Monitoring" tab. Select the data 
points for Online Monitoring. 

You can use these data points only for Online Monitoring. To be able to use the other 
functions of Energy Manager with the data points of this server, create separate data 
points in the usual folder structure. 

14.Click on the "Save" button. 

Result 
The OPC channel with the selected data points is created under the data source. 

 

 Note 

If you change the server address for an existing OPC UA server connection, restart the KERNEL 
service via the Service Cockpit. 

 

See also 
Creating data channels (Page 251) 

Data acquisition via the "OPC-DA / OPC-HDA" interface (Page 441) 

Data acquisition via the "OPC UA" interface (Page 443) 



 Energy Manager Web 
 3.6 Project configuration 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 259 

Creating an Energy Suite channel 
Data acquisition over the "Energy Suite" interface corresponds to the "OPC UA" interface. The 
channel type "Energy Suite" also offers the advantage that information from the WinCC 
archive of the Energy Suite is copied to Energy Manager. You therefore no longer have to 
configure this information in the data points.  

Security concept 
The OPC UA server uses the TCP/IP protocol for data exchange. For authorization, certificates 
are exchanged between server and client. In addition, you can encrypt the data traffic. 

Requirements 
• The data source is logged in to the Energy Manager Server and activated. 

• An OPC Server and/or an OPC Client is installed on the data source. 

Procedure 
Follow these steps to create an Energy Suite channel: 

1. Enter a meaningful name for the new channel in the "Name" entry field. 
The input of a name is required. 

2. Select the entry "Energy Suite" from the "Source" drop-down list. 

 
3. Enter the URL of the WinCC Professional OPC UA Server in the "Discover URL" entry field. 

4. Click the "Browse" button. 
The system checks whether there is a server connection. If a connection to the server exists, 
the existing archives are loaded to the "Data points" drop-down list. If there is no 
connection, check your entries. 

5. Select the time interval with which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. This selection corresponds to the cycle time of the IO 
buffer in the Energy Manager PRO Client. 
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6. When you select the option "Override TSP settings", you can transmit the measurement data 
again as of a specific date. Select the date in the "Retrieve data since" text field. 

 
7. Select the required archive from the "Data points" drop-down list. You have to select a 

"Siemens OPC UA" server. 

 
8. Click "Connect". 

 
  Note 

When configuring the OPC UA server, activate at least one "Security policy" and its 
associated "Security mode". Otherwise, the OPC UA server and the clients will 
communicate insecurely. 

During the first access to an encrypted OPC UA server instance a certificate for encrypting 
the data is created. You have to accept this certificate individually in the respective server 
product. You may have to perform this operation twice. 
• Siemens SIMATIC NET V15: With the help of the "Siemens Communication Settings" 

software in the "OPC UA certificates" menu command. 
• Siemens WinCC TIA V15: Moving of the new certificates from the path "C:\Program 

Files (x86)\SIEMENS\Automation\SCADA-
RT_V11\WinCC\opc\UAServer\PKI\CA\rejected\certs'" to "'C:\Program Files 
(x86)\SIEMENS\Automation\SCADA-RT_V11\WinCC\opc\UAServer\PKI\CA\certs" 

 

All available data points are loaded from the archive to the overview list. 
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9. Select the required data points. 

10.Click on the "Save" button. 

Result 
The Energy Suite channel with the selected data points is created under the data source. 

See also 
Creating data channels (Page 251) 

Data acquisition via the "Energy Suite Import" interface (Page 451) 
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Creating a WinCC channel 
You use the "WinCC" interface to retrieve values from a process value log or compressed log. 
You need a separate data channel for each log. 

 

 Note 
Functionality of Energy Manager Basic 

In Energy Manager Basic you can click the automatically installed WinCC channel directly in 
the navigation area under the data source that was also automatically installed. To add a new 
WinCC archive including the data points contained therein, click on the "Add archive" button 
in the detail area. The configuration dialog "New - Channel" opens in which you define the 
archive settings. For more information on creating a WinCC archive, refer to the sections 
"Creating a WinCC channel" and "Data point - Administration". 

 

Requirements 
• The data source is logged in to the Energy Manager Server and activated. 

• An WinCC Server and/or a WinCC Client is installed on the data source. 

• WinCC projects are activated. 

Procedure 
To create a WinCC channel, follow these steps: 

1. Enter a meaningful name for the new channel in the "Name" entry field. 
 The input of a name is required. 

2. Select the entry "WINCC" from the "Source" drop-down list. 

 
3. Click the "Connect" button. 

The system checks whether there is a server connection. If a connection to the WinCC server 
exists, the WinCC archives are loaded to the "Select archive" drop-down list. 

4. Select the time interval with which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. This selection corresponds to the cycle time of the IO 
buffer in the Energy Manager PRO Client. 
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5. When you select the option "Override TSP settings", you can transmit the measurement data 
again as of a specific date. Select the date in the "Retrieve data since" text field. 

 
6. Select the WinCC archive from which you want to create the data points from the "Select 

archive" drop-down list. 

7. Click the "Browse" button. 

 
All available data points are loaded from the archive to the overview list. 

8. Select the required data points. 

9. Click on the "Save" button. 

Result 
The WinCC channel with the selected data points is created under the data source. 

See also 
Creating data channels (Page 251) 

Data point - Administration (Page 272) 

Data acquisition via the "WinCC / PCS 7" interface (Page 423) 
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Creating a Modbus TCP channel 
You use the "Modbus" interface to retrieve data from measuring devices with Modbus support 
and Ethernet interface, for example, SENTRON PAC measuring devices. The "Modbus" 
interface supports the following two types: 

• Modbus TCP 

• Modbus RTU 

Datapoints acquired by the following measuring devices are pre-configured in Energy 
Manager. 

• SENTRON PAC 2200 CLP 

• SENTRON PAC 3200 

• SENTRON PAC 4200 

• ET 200SP MF HF 

• Janitza UMG64 

 

 Note 
Devices for separate listing of third-party consumption values 

The SENTRON PAC 2200 CLP and Janitza UMG64 devices are required for separate listing of 
third-party consumption values. 

 

 Note 
Supported modules 

The ET device  
 

 Note 
Functionality of Energy Manager Basic 

In Energy Manager Basic you can click the automatically installed Modbus TCP channel 
directly in the navigation area under the also automatically installed data source. To add a 
new device including the data points contained therein, click on the "Add device" button in 
the detail area. The configuration dialog "New - Channel" opens in which you define the 
device settings. For more information on creating a device, refer to the sections "Creating a 
Modbus TCP channel" and "Data point - Administration". 

 

Requirements 
• The data source is logged in to the Energy Manager Server and activated. 

• The TCP/IP connection data of the measuring device is known. 

• The operating instructions of the measuring device are available. 
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Procedure 
Follow these steps to create a Modbus TCP channel: 

1. Enter a meaningful name for the new channel in the "Name" entry field. 
The input of a name is required. 

2. Select the entry "Modbus/TCP" from the "Source" drop-down list. 

 
3. Enter a meaningful device name in the "Device name" entry field. 

The input of a device name is required. The device name is used on creation of the channel 
for the IO buffer. 

4. Enter the IP address and the associated port of the device in the in "IP address" and "Port" 
entry fields. 

5. Click the "Test connection" button. 
The system checks whether there is a connection to the IP address entered. If there is no 
connection, check your entries. 

6. If this is a device with Modbus TCP interface, select the "TCP" check box. If the device is of 
the Modbus RTU type, select the "RTU device" check box. 

7. In the case of an RTU device, you have to enter the address of the RTU device in the "Slave 
address" entry field. 

8. For an ET 200SP MF HF, enter the offset in the "Register Offset" field. 

 
  Note 

Register offset 

The pre-configured datapoints correspond to the EE@Industry E3 profile. The length of the 
profile for the AI Energy Meter is 53 Modbus registers.  

With an additional AI Energy Meter module, the register offset starts at 54.  

Via the register offset, you define the module from which data is acquired. 
 

9. Select the time interval with which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. This selection corresponds to the cycle time of the IO 
buffer in the Energy Manager PRO Client. 
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10.If you want to use Power Monitoring, select the check box "Enable power monitoring". 

 
If you use Online Monitoring, you can create data points of the Modbus device in a 
separate folder structure for real-time monitoring. 

Select the time interval in which the data is cyclically transmitted from the "Data 
transmission interval" drop-down list. 

Select the folder structure in which the data points are saved from the "Structure" drop-
down list. The folders must already exist and be part of the "Monitoring" structure. 

For more information on Online Monitoring, refer to the section "Online Monitoring 
(Page 119)".  

11.If you want to use data points from a device template, select the "Template" check box. The 
measuring devices PAC 3200 / 4200 are available in the template. If the template does not 
contain your measuring device, select the "User defined" check box. 
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12.If you use a measuring device from the template, select the corresponding device from the 
"Template" drop-down list.  
All available data points from the template are loaded to the overview list. 

13.Select the data points you want to create. 

14.You have to configure the following settings for the user-defined case: 

– Select the type of data point from the "Data type" drop-down list. 

– Enter the address of the data point using the operating instructions of the measuring 
device in the "Register", "Count" and "Subregister" entry fields. 

– If you want to acquire only positive measured values, enable the option "unsigned ". 

– If the device uses big endian encoding, enable the option "Big Endian". 

– To create the data points, click the "Add" button. 
The data points are displayed in the overview list. 

15.If you have activated Online Monitoring, click the "Online Monitoring" tab. Select the data 
points for Online Monitoring. 

You can use these data points only for Online Monitoring. To be able to use the other 
functions of Energy Manager with the data points of this server, create separate data 
points in the usual folder structure. 

16.Click on the "Save" button. 

Result 
The Modbus TCP channel with the selected data points is created under the data source. 

See also 
Creating data channels (Page 251) 

Data point - Administration (Page 272) 

Data acquisition via the "Modbus" interface (Page 428) 
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Creating a Desigo CC channel 
Use the interface "Desigo CC" to read out the data saved on a Desigo CC system via the Desigo 
CC web service. Energy Manager supports Desigo CC V3.0.  

Requirement 
• The data source is logged in to the Energy Manager Server and activated. 

• The Desigo CC web server is online and can be accessed. 

Procedure 
To create a Desigo CC channel, follow these steps: 

1. Enter a meaningful name for the new channel in the "Name" entry field. 

 
2. Select the entry "Desigo CC" from the "Source" drop-down list. 

3. Enter the URL of the Desigo system in the "Desigo Server" entry field. 

 
4. Enter your access data in the entry fields "User name" and "Password". 

5. Select the interval in which the acquisition component acquires the values from the drop-
down list "Data transmission interval". This selection corresponds to the cycle time of the IO 
buffer in the Energy Manager PRO Client. 

6. In the entry field "Retrieve data since" you can define the time from which historical data is 
retrieved. 

7. Click "Connect". 

The system attempts to establish a connection. If a connection to the Desigo server exists, 
the possible data sources of the server are loaded to the "System IDs" drop-down list. 

If a connection exists, the color of the plug on the "Connect" button is green. 
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8. Select the desired system ID from the "System IDs" drop-down list. 

9. Click the "Browse" button. 
All available data points from the data source are loaded to the navigation field. 

 
10.Select the desired data points for the data acquisition. 

11.Click the "Save" button. 

Result 
The Desigo CC channel with the selected data points is created under the data source. 

See also 
Data acquisition via the "Desigo CC" interface (Page 454) 
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Editing data channels 

Requirements 
• The data source has been created. 

• The data channel has been created. 

Procedure 
To edit an already created data channel, follow these steps: 

1. In the navigation area under the "Data source" folder, click on the data source in which you 
want to edit the created data channel. 

The detail area "Channel management" is displayed.  

2. Click on the data channel to be edited. 

3. Click the "Edit" button. 

The configuration dialog "Edit - Channel" opens. 

4. Edit all configurations which you selected on creation of a data channel. 

 
  Note 

When editing a data channel you can no longer change the channel type. 
 

  Note 

When adding new data points of already existing data channels, the data points which are 
already used in Energy Manager are grayed out. You can only create data points which do 
not yet exist in the system. 

 

5. Click on the "Save" button. 

See also 
Creating data channels (Page 251) 

Overview (Page 249) 
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Deleting data channels 

Requirements 
• The data source has been created. 

• The data channel has been created. 

Procedure 
To delete a data channel of a data source, follow these steps: 

1. Click on the acquisition component from which you want to delete the created data channel 
in the navigation area under the "Data source" folder. 

The detail area "Channel management" is displayed. 

2. Click on the data channel to be deleted. You can select several data channels with the help 
of the check boxes. 

3. Click the "Delete" button. 

4. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete individual data channels from the system in the configuration dialog "Edit - Channel" 
by clicking the "Delete button twice". 

Result 
The data channel including the substructures (process, driver source, driver, IO buffer, data 
points) is deleted from the system. 

 

 Note 

If the data points are linked to other objects in the system. you cannot delete the data 
channel. To delete the data channel, you must first disconnect all data point links with other 
objects in the system. 

 

See also 
Overview (Page 249) 
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Data point - Administration 

Introduction 
Channel-specific data points are displayed in tabular form in Energy Manager Web. You can 
create channel-specific data points from this overview table and configure existing data 
points. Newly created data points and configurations on already existing data points in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa. 

Overview of data point - Administration 
To display the data points of a data channel, click on the corresponding data channel in the 
navigation area under the data source. The following figure shows the detail area "Data point 
- Administration" over the data points created in an OPC channel: 

 
① "New" and "Edit" buttons: Creating and editing new data points. 
② Display table of existing data points per data channel. 
③ Filter function: When you enter a text in the "Filter" entry field, all the columns are searched and 

displayed accordingly in the display table. Delimitation of the data points is recommended 
when a large number of data points exist per channel. 

④ "Delete" button: Deleting created data points from the system. 
⑤ "Clone" button: When you clone a data point, an exact copy of the data point with the name 

ending in "Copy_0" is created. If you create several copies of a data point, the number at the 
end of the name is incremented by one, for example, from "Copy_0" to "Copy_1". You can also 
clone several data points at the same time with the help of the check boxes. 
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The display table consists of the following eight columns: 
 
Column Function 
Selection You can select individual data points and any number of data points with the help of the check boxes. Click-

ing on the check box in the column header selects all data points. Clicking on the check box again in the 
column header deselects all data points again. 

Name Shows the name of the data point. 
Description Shows the description of the data point. 
Structure Shows the folder in which the data point is created. 
Unit Shows the unit of the data point. 
Category Shows the acquisition category of the data point. 
Cycle Shows the cycle time of the data point. 
Status Shows the status of the data point. If the status is set to "Active", the measurement data of the data point is 

acquired. If the status is set to "Inactive", no measurement data is acquired. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 

To create a new channel-specific data point, click on the "New" button. You can find out how 
to create a new data point in the section "Creating data points". 
To edit a data point, click on the corresponding data point and then click the "Edit" button. 
You can find out how to edit a data point in the section "Editing data points". 
To delete one or more data points, select the data points and then click the "Delete" button. 
Confirm the deletion process by clicking on the "Delete" button again.  

Special feature of Modbus TCP 
There are two display tables for Modbus TCP channels. The display table "Device view" shows 
a list of all Modbus devices of the channel.  

The table "Device view" consists of the following columns: 
 
Column Function 
Selection You can select individual devices and any number of devices with the help of the check boxes. Clicking on 

the check box in the column header selects all devices. Clicking on the check box again in the column 
header deselects all devices again. 

Name Shows the name of the device. 
Cycle Displays the cycle time of the device. 
Monitoring 
structure 

Displays the folder structure of the device in the Monitoring area of the navigation area. 
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You can also add a new device. A separate IO buffer is used for each device. Click the "New" 
button to create a new device. 

 
You can find out how to create a new device with the corresponding data points in the 
section "Creating a Modbus TCP channel".  

If you want to edit an existing device in the display table, select the appropriate device and 
click the "Edit" button. 

The display table "Data point view" has the same functionality as the view table of the other 
channels. The table "Datapoint view" is only extended by the column "Device". The "Device" 
column shows the device name in which the data point is saved.  

Special feature of WinCC 
In a similar way to the Modbus data channel, there are two display tables in the display table 
of WinCC channels. The table "Archive view" shows a list of the WinCC archives.  

You can also add a new archive including data points. To add a new archive, click on the 
"New" button. You can find out how to select a new archive with the corresponding data 
points in the section "Creating a WinCC channel". 

If you want to edit an existing archive in the display table, select the appropriate archive and 
click the "Edit archive" button. 

The display table "Data point view" has the same functionality as the view table of the other 
channels. The display table "Data point view" is only extended by the column "Archive". The 
"Archive" column shows the name of the WinCC archive in which the data point is archived. 

See also 
Overview (Page 249) 

Creating data channels (Page 251) 

Creating a WinCC channel (Page 262) 

Creating a Modbus TCP channel (Page 264) 

Creating data points (Page 277) 

Manual acquisition (Page 248) 

Configuration of the data points (Page 278) 
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3.6.4 Data point 

3.6.4.1 Overview 
In the configuration of data points, create new data points in the Energy Manager Web client 
and configure existing data points. The creation of new data points in the Energy Manager 
Web client is only possible for manual and external data points. Newly created data points 
and changes to already existing data points in the Energy Manager PRO Web client are also 
adopted in the Energy Manager PRO Client and vice versa. 

When you click on the menu item "Data point" in the navigation area under the "Project 
configuration" folder, the detail area "Data point - Administration" opens. The following figure 
shows the detail area "Data point - Administration": 

 
① "New" and "Edit" buttons: Creating and editing new data points. 
② Display table of existing data points. 
③ Filter function: When you enter a text in the "Filter" entry field, all the columns are searched and displayed accord-

ingly in the display table. Delimitation of the data points is recommended when a large number of data points exist 
in the system. 

④ "Delete" button: Deleting created data points from the system. 
⑤ "Clone" button: When you clone a data point, an exact copy of the data point with the name ending in "Copy_0" is 

created. If you create several copies of a data point, the number at the end of the name is incremented by one, for 
example, from "Copy_0" to "Copy_1". You can also clone several data points at the same time with the help of the 
check boxes. 

 

 Note 

In the "Data point" folder not all the data points in the system are displayed, but only the data 
points contained in the folder. 
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The data points are displayed in tabular form in Energy Manager Web: The display table 
consists of the following ten columns: 
 
Column Function 
Selection You can select individual data points and any number of data points with the help of 

the check boxes. Clicking on the check box in the column header selects all data 
points. Clicking on the check box again in the column header deselects all data points 
again. 

Name  Shows the name of the data point. 
Description Shows the description of the data point. 
Structure Shows the folder in which the data point is created. 
Unit Shows the unit of the data point. 
Category Shows the acquisition category of the data point. 
Cycle Shows the cycle time of the data point. 
Source Shows the data channel of the data point. Data points of the type "Generic", "Con-

stant" and "Derived" are marked with the entry "-". 
Active Shows the status of the data point. If the status is set to "Active", the measurement 

data of the data point is acquired. If the status is set to "Inactive", no measurement 
data is acquired. 

Device/Archive Shows the device name or the archive from which the data point originates. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order.  

See also 
Creating data points (Page 277) 

Editing data points (Page 288) 

Deleting data points (Page 291) 
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3.6.4.2 Creating data points 

Requirements 
• The data source has been created. 

• The data channel has been created. 

• The user has the functional right "Measurement - create, remove, configure". 

Procedure 
To create a new data point, follow these steps: 

1. Click on the "New" button in the detail area "Data point - Administration". 

The configuration dialog "New - Data point" opens. 

2. Configure the data point using the following tabs: 

– General 

– Interface 

– Counter 

– Plausibility 

– Compression 

– Replacement 

– MindSphere 

You can find out how to configure the individual tabs in the section "Configuration of data 
points".  

3. When you have configured the tabs, click the "Save" button. 

Result 
The data point has been created in the selected folder. In the Energy Manager PRO Client the 
data point is created under the IO buffer of the corresponding data channel. 

See also 
Creating subfolders (Page 240) 

Overview (Page 275) 

Editing data points (Page 288) 

Data point - Administration (Page 272) 

Creating data points (Page 458) 

Configuration of the data points (Page 278) 
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3.6.4.3 Configuration of the data points 

Configuring general settings 
Enter the basic information of the data point under "General". 

Procedure 
To configure the basic information, follow these steps: 

1. Enter a meaningful data point name in the "Name" entry field. 

2. If required, enter a description of the data point in the "Description" entry field. 

3. If required, enter a KKS/AKS number or free text in the "Inventory number" check box. 

 
If you select "KKSText" as a text type in a report, for example, the text from the entry field 
is output in the report result. 

4. Select the unit of the data point from the "Unit" drop-down list. 

5. Select the cycle time with which the measured values are acquired from the "Cycle" drop-
down list. 

 
  Note 

If you select a cycle time that does not match a compression level, only the values which 
were acquired while this cycle time was configured are displayed.  

If a cycle time is then selected which matches a compression level, a gap in the values 
arises. The gap corresponds to the data which was acquired with the cycle time that did 
not correspond to a compression level. 

Configure a compression level before you select the corresponding cycle time. 

Configure compression levels in the "Compression" tab.  
 

Select the category of the data point from the "Acquisition category" drop-down list. 

The input of an acquisition category is required. 
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6. Select the folder in which you want to create the data point from the "Structure" drop-down 
list. 

 
7. Select the country in which the data point is valid from the "Country" drop-down list. 

8. When you select the option "Activate data collection", the measurement data of the data 
source is acquired. 

9. When you select the option "Use data point only for pre-processing", the measurement data 
is only taken into account during pre-processing of the data. 

10.When you enable the option "Priority high", you cannot change the values of the data point 
in a matrix. 

11.When you enable the option "Activate versioned data collection" the measurement data is 
entered versioned in the data point. 

 

Configuring interfaces 
Under "Interface" select the data channel from which the measured values of the data point 
are acquired. Also create manual data points via the tab. More information on the data 
channels is available in the section "Creating data channels". 

Procedure 
To configure a data channel, proceed as follows: 

1. Select the data channel from which you want to create the data point from the "Channel" 
drop-down list. 

Only the data channels created in the system are available for selection for creating 
external data points. The entry "manual" is available for creating manual data points. The 
settings of the tab are adapted accordingly to the selected data channel.  

2. Configure the remaining settings in accordance with the selected channel type. 
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Configuring a Modbus or WinCC channel 
To create a Modbus or WinCC channel, configure the settings as follows: 

1. Select the device/archive in which the data point is archived from the "Device" or "Archive" 
drop-down list. 

Only already created devices/archives are available for selection in the drop-down list. 

2. Browse the corresponding device/archive. 

3. Select the desired data point from the overview list. 

The address of the data point in the device/archive is automatically copied to the text field 
"Address". 

4. Select the type of data point from the "Data type" drop-down list. 

 

Configuring an OPC, Energy Suite, or Desigo CC channel 
To create an OPC, Energy Suite or Desigo CC channel, configure the settings as follows: 

1. Click the "Browse" button. 

2. Select the desired data point from the overview list. 

The address of the data point on the server is copied to the entry field "Address". 

3. Select the type of data point from the "Data type" drop-down list. 

Configuring an ASCII channel 
To create an ASCII channel, configure the settings as follows: 

1. In the "address" entry field, enter the address of the data point. 

2. Select the type of data point from the "Data type" drop-down list. 
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Creating a manual data point 
To create a manual data point, configure the settings as follows: 

1. Select the entry "Manual" from the "Channel" drop-down list. 

2. Select the type of data point from the "Data type" drop-down list. 

Only the data types "Number" and "String" are available in the drop-down list. These data 
types correspond to the data types "Measurement" and "Text" from the Energy Manager 
PRO Client.  

 
  Note 

If a different data type is selected in the Energy Manager PRO Client, no entry is shown in 
the "Data type" drop-down list. 

 

Creating derived data point 
To create a derived data point, proceed as follows: 

1. Select the entry "Derived" from the "Channel" drop-down list. 

2. Select the time from which the data point is automatically recalculated from the calendar 
"Calculated until". 

If you have not edited this field, the time up to which the data point is calculated is 
displayed here. 

This field is automatically updated whenever the data point is calculated. 

3. Select the category of the data point from the "Category" drop-down list. 

If you select "Future values", the current compression interval of the data point is 
recalculated for every value. 

If you select "real value", the current compression interval of the data point is calculated 
after all values are available. 

4. Select the compression level of the MEVA/KIP used from the drop-down list "Compression". 

5. In the entry field "Offset", enter the numerical value of the duration with which the start of 
the daily interval deviates from midnight. 

The daily values are calculated taking this deviation into consideration. If an Offset of 6 
hours is configured, for example, the daily values from 6 am to 6 am are calculated. 

6. Select the time unit of the offset from the "Offset unit" drop-down list. 

7. To automatically recalculate the data point for new or updated values, activate the option 
"Calculate automatically". 

8. Select the value MEVA/KPI whose values are saved in the data point from the "KPI element" 
drop-down list. 

Alternatively, you can use the structure browser. 

See also 
Creating data channels (Page 251) 
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Configuring counters 
If you select "Count value" as the acquisition category, you must additionally create a counter. 
The created counters are displayed in the list with their validity.  

Click on the "Expand all" to display the detailed information of all counters, select the "Hide 
all" icon to hide the detail information again. To create a new counter, click on the "Add new" 
icon. To delete a counter, click the "Delete" icon and confirm the deletion process by clicking 
on the icon again. 

Procedure 
 To configure a counter, follow these steps: 

1. Click on the "Add new" icon. 

 
A new counter with the current date or with current validity is created. 

2. Enter a counter number for the counter in the text box under validity. 

3. From the "Installation date" drop-down list select the date of the commissioning of the 
counter. 

 
The validity range of the counter changes accordingly. If the installation date of a newly 
created counter is reached, the current counter is replaced by the new counter. The 
installation date of the new counter must be prior to the acquisition of the last measured 
value of the current counter. Otherwise, the result could be an overflow error.  

4. Enter the counter constant in the "Constant" text box. 

The default setting of the counter constant is "1". The counter difference is multiplied by 
this constant. 

5. Enter the start of the counting range in the "Range start" text box. 

6. Enter the end of the counting range in the "Range end" text box. 

7. If you enable "Cyclic reset", the counter is reset to zero if a value is less than the previous 
value. In this case, the difference is calculated as follows: 0 + current counter state 

8. Enter the start value of the counter on installation in the "Value at installation" text box. 

The start value and end value are of importance for the proper calculation of differences 
upon overflow. 

9. Enter the end value of the counter on replacement in the "Value at replacement" text box. 

10.If you select "Only count up" from the "Counter type" drop-down list, all valid counter values 
are in ascending order. If a negative counter difference is calculated, the situation is treated 
as a counter overflow. 

11.If you select "Count up and down", valid counter values may be greater or less than the 
previous value. This option is suitable for level measurements, for example. 
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12.If you enable "Filtering criteria", enter the value in the "Lower limit" text box. Any counter 
values below this value are treated as invalid. 

13.If you enable "Counter difference", enter the value in the "Lower limit" text box. If the most 
recently calculated difference is less than this value, the current counter value is treated as 
invalid. 

14.If you activate "Counter difference", enter a value in the "Upper limit" text box. If the most 
recently calculated difference is greater than this value, the current counter value is treated 
as invalid. 

See also 
Configuring counters (Page 479) 

Configuring the plausibility settings 
Under "Plausibility" you configure, for example, the setting of limits, the monitoring of the 
data point. 

Procedure 
To configure plausibility settings, proceed as follows: 

1. Enter the limits for the alarm range in the "Upper limit" and "Lower limit" text boxes. 

2. Enter the limits for the warning range in the "Upper limit warning" and "Lower limit warning" 
text boxes. 

3. If you select the respective option "Notification", you will be informed of any violations of 
limits. 

 
4. To determine gaps in measured value series of the data point, enter a numerical value in the 

"Gap" text box. Select the associated time from the "Unit" drop-down list. The system checks 
whether there are gaps in the measured value series after the entered time has elapsed. If 
you select the adjacent option "Notification", you will be informed of any existing gaps. 
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5. To compare the data point with itself in a different time period, select the "Another time 
period" check box in the "Compare with" area. Enter the numerical value in the text box and 
select the associated time period from the "Unit" drop-down list. If you select the value "1" 
and the unit "1 month", for example, the current month is compared with the previous 
month. 

 
6. To compare the data point with a different data point, select the "Reference object" check 

box. Select the data point to be compared from the text box. 

 
7. Enter the upper or lower limits for the comparison in the "Upper limit" and "Lower limit" text 

boxes. The limits can be exceeded or undershot by the values entered (acquisition value + 
limit) before a message is generated. 

8. Select the type of limit comparison from the "Compare type" drop-down list. You can choose 
between "Absolute" and "Relative". "Absolute" means a numerical comparison, "Relative" 
means a percentage comparison of the limits. 

9. Select the "Notification" option to receive a violation message on comparison of the limits. 

 

See also 
Configuring the plausibility (Page 482) 

Mail settings (Page 309) 

Configuring the compression settings 
Configure the compression levels of the measured values under "Compression". The defined 
compression levels are displayed in an overview list.  

Click on the "Expand all" to display the detailed information of all compression levels, select 
the "Hide all" icon to hide the detail information again. To create a new compression level, 
click the "Add new" icon. To delete a compression level, click on the "Delete" icon and confirm 
the delete process by clicking on the icon again. 
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Procedure 
To configure compression levels, proceed as follows: 

1. To create a new compression level, click the "Add new" icon. 

 
A new compression level is created. 

2. From the "From" drop-down list select the cycle whose values you want to compress. 

3. From the "To" drop-down list select the cycle to which the values are compressed. 

4. From the "Compressed until" drop-down list select the time in the past from when the values 
are compressed. 

The "Compressed until" field shows the time up to which the compression level is 
calculated. To update this field, reload the page. 

To recalculate the compression level, from the "Compressed until" drop-down list select 
the time in the past from when the compression value is recalculated. 

 

Configuring replacement value strategies 
Define the substitute value strategies for measured value gaps under "Replacement". 

Procedure 
To configure substitute value strategies, proceed as follows: 

1. Select the replacement value strategy from the "Replacement" drop-down list. You can 
choose between the following replacement value strategies: 

– NONE 

– LRU (last recently used) 

– FIS 

– Replacement value 

– Historical value 
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2. If you select the replacement value strategy "NONE", gaps in the measured value series of 
the data point are not replaced. 

3. If you select the replacement value strategy "LRU", gaps are replaced in the measured values 
series of the data point by the last valid value. 

4. If you select the replacement value strategy "AKS", gaps in the measured values series of the 
data point are replaced by the measured values of a different data point. In the "Source 
datapoint" text box enter the data point whose values replace the gaps. 

5. If you select the replacement value strategy "Replacement value", gaps in the measured 
values series of the data point are replaced by a constant value. Enter the replacement value 
used to close the gap in the "Value" text box. 

 
6. If you select the replacement value strategy "Historical value", gaps in the measured values 

series of the data point are replaced by a comparison value in the past. Enter the numerical 
value in the "Value" text box and select the associated time period from the "Unit" drop-
down list. The system jumps back to the past by the period entered and adopts the value 
from the past. This strategy can be used if the data point has a recurring pattern. 

 

7. From the "Corrected until" list you select the time in the past up to which the gaps are 
replaced by the selected replacement value strategy. 

8. To enable the selected replacement value strategy, select the option "Replace invalids". 

See also 
Configuring replacement value strategies (Page 477) 
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Configuring MindSphere settings 
Under "MindSphere" you manage the transfer of the data point to MindSphere. 

Procedure 
To configure MindSphere settings, proceed as follows: 

1. As soon as the data point is created in MindSphere, the "Data point ID" text box is 
automatically filled with the associated ID of the data point in MindSphere. 

2. To select the synchronization time of the data point measured values with MindSphere, click 
on the upload icon. Confirm the process by clicking on the upload icon again. 

 
3. In the "Next upload" text box select the start time of the export to MindSphere. You can also 

place the start time in the past. The synchronization date only applies to the selected data 
point. 

From the selected date, the values of the data point are exported with the corresponding 
timestamps to MindSphere. You can thus also start export of historical values again. 
During a new export, the data overwrites already existing data.  

4. To enable the export of the data points measured values to MindSphere, select the option 
"Mark as cloud relevant". 

 

See also 
Account settings (Page 311) 
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3.6.4.4 Editing data points 

Requirements 
• The data point has been created. 

• The user has the functional right "Measurement - create, remove, configure" or the 
functional right "Measurement - configure". 

Procedure 
To edit an already existing data point, follow these steps: 

1. Click on the data point to be edited in the display table. 

2. Click the "Edit" button. As an alternative, you can double-click the data point to be edited. 

The configuration dialog "Edit - Data point" opens.  

3. You can configure all the settings again in the tabs which you defined on creation of a data 
point. 

4. Click on the "Save" button. 

Editing multiple data points 
You can edit multiple data points at one time. If you select multiple data points from the 
display table with the help of the check box, the "Edit" button is extended. If you then click on 
the "Edit" button, a drop-down list opens from which you can edit the following properties: 

• Status 

• Unit 

• Category 

• Cycle time 

• Compression 

• Structure 
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The following figure shows the drop-down list with the configurable properties. 

 
If you click on one of the entries, a new dialog window opens. In this dialog window you can 
change the corresponding property for the selected data points. The following figure shows 
the window in which the unit is changed for multiple data points. 

 

When you click on the "Save" button, the changes are applied. 
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Changing the data source 
You can change the data source of existing data points. To change the data source, select the 
new data source under "Interface" from the "Channel" drop-down list. When you select a new 
data source, the settings are adapted to the new data source. In the event of a change to the 
data source, the following settings are automatically adopted: 

• The data point is deleted from the list of the last data source and created in the list of the 
new data source. 

• The prefix of the data point name is adapted to the new data channel ("e_" to "d_") and 
vice versa when changing from a manual to an external data point. 

• The historical data point values are retained in the new data source. 

When you change the data source, check the settings in the other tabs and adapt the settings 
to the new data source. 

 

 Note 
Change to the data source 

Changing a data source to a different data source is only possible from the "Data point" 
project folder. 

 

See also 
Creating data points (Page 277) 

Overview (Page 275) 

Deleting data points (Page 291) 
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3.6.4.5 Deleting data points 

Requirements 
• The data point has been created. 

• The user has the functional right "Measurement - create, remove, configure". 

Procedure 
To delete one or more data points from the system, follow these steps: 

1. Click on the data point to be deleted in the display table. You can also select one or more 
data points to be deleted with the help of the check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete a data point from the system in the "Edit - Data point" configuration dialog by clicking 
the "Delete" button twice. 

Result 
The data point is deleted from the system. 

See also 
Overview (Page 275) 
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3.6.4.6 Recalculating derived data point 
To recalculate the values of a derived data point, follow these steps: 

1. Open the "Interface" tab of the configuration dialog of the derived data point. 

2. Select the beginning of the time period to be calculated from the calendar "From". 

3. Select the beginning of the time period to be calculated from the calendar "From". 

4. To recalculate the values of the selected period, click on the "Start" button and confirm your 
entry. 

 
  Note 

When you have confirmed the entry, the values are recalculated in the background 
without delay. The existing values are thus lost. The "Save" button has no effect on the 
recalculation of the derived data point. 
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3.6.5 Parameter 

3.6.5.1 Overview 
In the configuration of parameters you create new parameters and configure already existing 
parameters in Energy Manager Web. Newly created parameters and changes to already 
existing parameters in Energy Manager PRO Web are also adopted in the Energy Manager 
PRO Client and vice versa. 

When you click on the menu item "Parameters" in the navigation area under the "Project 
configuration" folder, the detail area "Parameter - Administration" opens. The following figure 
shows the detail area "Parameter - Administration": 

 
① "New" and "Edit" buttons: Creating and editing new parameters. 
② Display table of existing parameters. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of parameters is recommended when a 
large number of parameters exist in the system. 

④ "Delete" button: Delete created parameters from the system. 
⑤ "Clone" button: When you clone a parameter, an exact copy of the parameter with the name 

ending in "Copy_0" is created. If you create several copies of a parameter, the number at the 
end of the name is incremented by one, for example, from "Copy_0" to "Copy_1". You can clone 
several parameters at the same time with the help of the check boxes. 

 

 Note 

In the "Parameters" folder not all the parameters in the system are displayed, but only the 
parameters contained in the folder. 
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The parameters are displayed in tabular form in Energy Manager Web. The display table 
consists of the following six columns: 

 
Column Function 
Selection You can select individual parameters and any number of parameters with the help of the check boxes. 

Clicking on the check box in the column header selects all parameters. Clicking on the check box again 
in the column header deselects all parameters again. 

Name  Shows the name of the parameter. 
Description Shows the description of the parameter. 
Structure Shows the folder in which the parameter is created. 
Unit Shows the unit of the parameter. 
Constant Shows the replacement value of the parameter. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order.  

See also 
Creating parameters (Page 295) 

Editing parameters (Page 297) 

Deleting parameters (Page 298) 
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3.6.5.2 Creating parameters 

Requirement 
• The user has the functional right "Parameter - Common - create, remove, configure". 

• The user has the functional right "Parameter - Values - create, remove, configure". 

Procedure 
To create a new parameter, follow these steps: 

1. Click on the "New" button in the detail area "Parameter - Administration". 

The configuration dialog "New - Parameter" opens. 

2. Enter a meaningful name for the chart in the "Name" text box. 

The input of a name with the prefix "t_" is required. 

3. If required, enter a description of the parameter in the "Description" text box. 

4. Select the unit of the parameter from the "Unit" drop-down list. 

5. Enter the constant replacement value in the "Replacement value" text box. 

6. From the "Structure" drop-down list select the folder in which you want to create the 
parameter. 

 
7. If you want to define a constant value for the parameter from a specific time period, click 

the "Add new" icon. 

A new validity is created. 

8. Select the validity date. 
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9. Enter the constant parameter value in the "Value" text box. 

 
The value entered is valid from the selected validity time. When you define a further 
validity, the parameter value applies from the current validity until the start of the new 
validity. If the date of the new validity is reached, the parameter value applies from this 
validity. If you do not define a validity period, the parameter adopts the value at any time 
from the "Replacement value" text box. 

10.Click on the "Save" button. 

Result 
The parameter is created in the selected folder. If you have defined a validity period including 
the value, the validity period is activated. You can only deactivate the validity period by 
deleting the corresponding validity period. You can delete validity periods that are no longer 
required by clicking the "Delete" icon twice. If you click on the "Expand all" icon, the 
information of all validity periods is displayed. If you click on the "Collapse all" icon, the 
information is hidden again.  

See also 
Parameters (Page 146) 

Creating subfolders (Page 240) 

Overview (Page 293) 

Editing parameters (Page 297) 

Parameters (Page 519) 
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3.6.5.3 Editing parameters 

Requirements 
• The parameter has been created. 

• The user has the functional right "Parameter - Common - create, remove, configure" or the 
functional right "Parameter - Common - configure". 

• The user has the functional right "Parameter - Values - create, remove, configure". 

Procedure 
To edit an already existing parameter, follow these steps: 

1. Click on the parameter to be edited in the display table. 

2. Click the "Edit" button. As an alternative, you can double-click the parameter to be edited. 

The configuration dialog "Edit - Parameter" opens.  

3. You can configure all the settings again which you defined on creation of a parameter. 

The input of a name with the prefix "t_" is required. 

4. Click on the "Save" button. 

Editing multiple parameters 
You can select multiple parameters at one time. If you select multiple parameters from the 
display table with the help of the check box, the "Edit" button is extended. If you then click on 
the "Edit" button, a drop-down list opens from which you can edit the following properties:  

• Unit 

• Structure 

If you click on one of the entries, a new dialog window opens. In this dialog window you can 
change the corresponding property of the selected parameters. When you click on the "Save" 
button, the changes are applied. 

See also 
Overview (Page 293) 

Creating parameters (Page 295) 

Deleting parameters (Page 298) 
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3.6.5.4 Deleting parameters 

Requirements 
• The parameter has been created. 

• The user has the functional right "Parameter - Common - create, remove, configure". 

Procedure 
To delete one or more parameters from the system, follow these steps: 

1. Click on the parameter to be deleted in the display table. You can also select one or more 
parameters to be deleted with the help of the check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete a parameter from the system in the "Edit - Parameter" configuration dialog by clicking 
the "Delete" button twice. 

Result 
The parameter is deleted from the system. 

See also 
Overview (Page 293) 

Creating parameters (Page 295) 

Editing parameters (Page 297) 
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3.6.6 MEVA / KPI 

3.6.6.1 Overview 
In the configuration of KPIs (MEVAs / KPIs) you create new KPIs and configure already existing 
KPIs in Energy Manager Web. Newly created KPIs and changes to already existing KPIs in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa. 

 

 Note 

A KPI object in Energy Manager Web corresponds to a MEVA from the 
Energy Manager PRO Client. In the following the term "KPI" is used for the expression 
"MEVA / KPI". 

 

When you click on the menu item "MEVA / KPI" in the navigation area under the "Project 
configuration" folder, the detail area "MEVA / KPI - Administration" opens. The following 
figure shows the detail area "MEVA / KPI - Administration": 

 
① "New" and "Edit" buttons: Creating and editing new KPIs. 
② Display table of existing KPIs. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of KPIs is recommended when a large 
number of KPIs exist in the system. 

④ "Delete" button: Deleting created KPIs from the system. 
⑤ "Clone" button: When you clone a KPI, an exact copy of the KPI with the name ending in 

"Copy_0" is created. If you create several copies of a KPI, the number at the end of the name is 
incremented by one, for example, from "Copy_0" to "Copy_1". You can clone several KPIs at the 
same time with the help of the check boxes. 
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 Note 

In the "MEVA / KPI" folder not all the KPIs in the system are displayed, but only the KPIs 
contained in the folder. 

 

The KPIs are displayed in tabular form in Energy Manager Web. The display table consists of 
the following six columns: 
 
Column Function 
Selection You can select individual KPIs and any number of KPIs with the help of the check 

boxes. Clicking on the check box in the column header selects all KPIs. Clicking on the 
check box again in the column header deselects all KPIs again. 

Name  Shows the name of the KPI. 
Description Shows the description of the KPI. 
Structure Shows the folder in which the KPI is created. 
Unit Shows the unit of the KPI. 
Function Shows the function type of the KPI. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order.  

See also 
Creating MEVAs / KPIs (Page 301) 

Editing MEVAs / KPIs (Page 304) 

Deleting MEVAs / KPIs (Page 305) 
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3.6.6.2 Creating MEVAs / KPIs 

Requirement 
• The user has the functional right "Measuring Variable - create, remove, configure". 

Procedure 
To create a new KPI, follow these steps: 

1. Click on the "New" button in the detail area "MEVA / KPI - Administration". 

The configuration dialog "New - MEVA / KPI" opens. 

Configuring the "General" tab 
To configure the "General" tab, follow these steps: 

1. Enter a meaningful name for the KPI in the "Name" text box. 

The input of a name with the prefix "m_" is required. 

2. If required, enter a description of the KPI in the "Description" text box. 

3. Select the unit of the KPI from the "Unit" drop-down list. 

4. From the "Structure" drop-down list select the folder in which you want to create the KPI. 
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5. Select the compression level for the calculation of the KPI. You can choose between two 
calculation types: 

– Inherit from the higher level 

– Always use a particular type of compression 

If you select the "Inherited from the higher level" check box, the compression level is taken 
from the higher level. 

If you select the "Always use compression" check box, you can select the desired 
compression level from the drop-down list. The selected compression level is used for all 
further calculations. 

 

Configuring the "Formula" tab 
To configure the "Formula" tab, follow these steps: 

1. Select the function type of the KPI from the "Function" drop-down list. 

2. Selecting the "Configurable Meva" function activates the formula editor. In the formula 
editor you can enter a custom formula for calculating the KPI with the help of the adjacent 
buttons. The syntax of the formula is automatically checked. In the formula editor, 
placeholders are used for the selected objects. If you select the option "Show name", the 
names of the selected objects are displayed in the formula editor instead of the 
placeholders. 

3. From the drop-down list "Select object" select the objects that you want to use for 
calculating the KPI. You can use data points, parameters and other KPIs when creating a new 
KPI. By selecting or clearing the "Datapoint", "MEVA / KPI" and "Parameter" check boxes you 
can refine the search accordingly. 

Alternatively, you can use the structure browser. To open the Structure Browser, click on 
.  

Selected objects are displayed with the corresponding position number in the "Currently 
selected" list. 

4. You can change the sequence of the objects in the list using drag and drop. You can also 
delete objects that are no longer required by clicking the Delete icon. 

 
  Note 

Observe the sequence of the objects. The correct sequence of the objects is required when 
calculating the KPIs.  
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5. If you have selected the function "Configurable Meva", you can insert the corresponding 
object in the formula editor by double-clicking an object. The position number of the object 
is copied to the formula editor with the corresponding placeholder. 

 
Figure 3-1 KPI formula editor 

6. Click on the "Save" button. 

Result 
The KPI is created in the selected folder. 

See also 
Creating subfolders (Page 240) 

Overview (Page 299) 

Editing MEVAs / KPIs (Page 304) 

Measuring variable (Page 517) 



Energy Manager Web  
3.6 Project configuration 

 SIMATIC Energy Manager PRO V7.2 - Operation 

304 Operating Manual, 12/2020, A5E38952754-AF 

3.6.6.3 Editing MEVAs / KPIs 

Requirements 
• The KPI is created. 

• The user has the functional right "Measuring Variable - create, remove, configure" or the 
functional right "Measuring Variable - configure". 

Procedure 
To edit an already existing KPI, follow these steps: 

1. Click on the KPI to be edited in the display table. 

2. Click the "Edit" button. As an alternative, you can double-click the KPI to be edited. 

The configuration dialog "Edit - MEVA / KPI" opens.  

3. You can configure all the settings again which you defined on creation of a KPI. 

The input of a name with the prefix "m_" is required. 

4. Click on the "Save" button. 

Editing multiple KPIs 
You can select multiple KPIs at one time. If you select multiple KPIs from the display table 
with the help of the check box, the "Edit" button is extended. If you then click on the "Edit" 
button, a drop-down list opens from which you can edit the following properties:  

• Unit 

• Structure 

If you click on one of the entries, a new dialog window opens. In this dialog window you can 
change the corresponding property of the selected KPIs. When you click on the "Save" button, 
the changes are applied. 

See also 
Overview (Page 299) 

Creating MEVAs / KPIs (Page 301) 

Deleting MEVAs / KPIs (Page 305) 



 Energy Manager Web 
 3.6 Project configuration 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 305 

3.6.6.4 Deleting MEVAs / KPIs 

Requirements 
• The KPI is created. 

• The user has the functional right "Measuring Variable - create, remove, configure". 

Procedure 
To delete one or more KPIs from the system, follow these steps: 

1. Click on the KPI to be deleted in the display table. You can also select one or more KPIs to be 
deleted with the help of check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete a KPI from the system in the "Edit - MEVA / KPI" configuration dialog by clicking the 
"Delete" button twice. 

 

See also 
Overview (Page 299) 

Editing MEVAs / KPIs (Page 304) 
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3.7 Settings 

3.7.1 Overview of settings 
In the "Settings" folder you configure the key settings of your Energy Manager system in 
Energy Manager Web. Only the administrator can define the settings. Configurations of the 
settings in Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and 
vice versa. 

You can configure the following settings: 

• Mail settings 

• Account settings 

• Web Client settings 

• User management 

• Units 

• Alarm lists 

• Backup 

• Regional settings 

• Modbus device templates 

• Data provider 
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Opening settings 
To open the "Settings" folder, follow these steps: 
1. Click in the menu bar on "Configuration". 

 
2. Click the menu item "Settings" in the navigation area. As an alternative, you can click the 

"Settings" tile in the detail area. 

 
In the detail area you see an overview of the configurable settings in tile form. 
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3. To configure the respective settings, click on the corresponding tile in the detail area. As an 
alternative, you can click on the corresponding menu item in the navigation area. 

 

 Note 

The folder structures are automatically created after the installation of Energy Manager and 
cannot be deleted by the user.  

 

See also 
Mail settings (Page 309) 

Account settings (Page 311) 

Web Client settings (Page 316) 

Backup (Page 332) 

Regional settings (Page 334) 

User Management (Page 318) 

Units (Page 324) 

Alarm lists (Page 329) 
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3.7.2 Mail settings 

Overview 
In the "Mail settings" you manage the notifications in Energy Manager Web which inform the 
user by e-mail about different situations. You can find the corresponding settings in the 
Energy Manager PRO Client under the path "File > Options > Appl.". Changes to the settings in 
Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and vice versa. 

Configuring mail settings 
To configure the setting "Mail settings", follow these steps: 

1. In the "Sender e-mail address" text box, enter the sender address which is used by Energy 
Manager for sending e-mails automatically. 

The specified sender e-mail address is checked for correctness. 

2. In the "STMP server" text box enter the address of the STMP server that is used for sending e-
mails automatically. 

 
3. If you select the option "Use server login credentials", you have to enter the user name, 

password and the port number of the SMTP server in the corresponding text boxes. If you 
select the "SSL" check box, the data is transmitted in encrypted form. 

 
4. Enter the URL of the Energy Manager Web Server in the "Web server" text box. 

5. In the "Mail text" text box enter the sample text for automatic sending of e-mails. 

6. In the "Mail text link" text box enter the sample text for automatic sending of e-mails with 
URL link. 
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7. In the "Mail text alarm" text box enter the sample text of alarm messages for automatic 
sending of e-mails. 

 
8. Click on a different entry in the navigation area to save the settings. 

 

 Note 

A maximum of 10 alarm messages are sent in one e-mail. If more than 10 alarm messages 
are present, Energy Manager send 10 alarm messages in one e-mail. The number of pending 
alarms is specified in this e-mail. Energy Manager does not send any further e-mail for the 
other alarm messages. 

 

See also 
Overview of settings (Page 306) 

Options (Page 374) 
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3.7.3 Account settings 

Overview 
In the "Account settings" you configure account settings in Energy Manager Web. You can 
find the corresponding settings in the Energy Manager PRO Client under the path "File > 
Account settings". Configurations of the settings in Energy Manager PRO Web are also 
adopted in the Energy Manager PRO Client and vice versa. 

Configure the account settings using the following tabs: 

• General 

• Password settings 

• Data storage 

• Delete options 

• MindSphere 

 

 Note 

If you change the text boxes of the respective tab and change the tab, for example, from 
"General" to "Delete options", the changed text boxes are automatically saved. If you change 
to a different object in the navigation area, the changed text boxes are also saved. 

 

"General" tab 
Enter the path in which the Account settings are stored in the "Archive base directory" text 
box. 
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"Password settings" tab  
Manage your password requirements in the "Password settings" tab. For the text boxes 
"Admin password expires after (days)"" andPassword expires after (days)", you can enter a 
one to five-digit number. For all other numeric text boxes you can enter a one to two-digit 
number. 

 

"Data storage" tab  
In the "Data storage" tab you manage the duration with which you save the measured values 
of the corresponding cycle times in the system. You also set the archiving behavior on expiry 
of the entered time. The archive directory displays the path under which the measured values 
of the cycle times are saved. You can only change the archive directory in the "General" tab. 
To remove the cycle times from the list, click the "Delete" icon. Click on the icon again to 
confirm the deletion process. If you click on the "Expand all" icon, the details of all cycle times 
are displayed. If you click on the "Collapse all" icon, the details are hidden again.  

To save measured values of a new cycle time, follow these steps: 

1. Click on the "Add new" button. 

 
A new cycle time is added to the list. 

2. From the "Cycle time" drop-down list select the cycle time you want to save. 

3. Enter a one to six-digit number in the "Keep values" text box. 

The input of a value is required. 

4. Select the associated desired duration from the "Unit" drop-down list. 
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5. In order to archive the measured values of the cycle time after expiry of the entered duration 
and then delete them, select the option "Archive after deletion". 

 
6. In order to not archive the measured values of the cycle time after expiry of the entered 

duration, but only to delete them, deselect the option. 

7. Click on a different entry in the navigation area or a different tab to save the settings. 

"Delete options" tab  
In the "Deletion options" tab you manage the duration after the expiry of which messages 
and alarms are deleted from the system. To enable the deletion process, select the respective 
option. In the "Older than [days]" text box enter the time in days for the respective message 
type after the expiry of which the messages are deleted. You can enter a one to six-digit 
number in the respective text box. The adjacent archive paths show you where the 
corresponding messages are stored before the messages are deleted. 
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"MindSphere" tab  
You manage your MindSphere connection in the "MindSphere" tab. You can configure the 
following settings: 

• Uuid 

In the "Uuid" text box enter your personal MindSphere login data which you receive on 
activation of your MindSphere access. To receive your MindSphere login data you have to 
create a "Mindconnect Lib Asset" with your MindSphere access data on the MindSphere 
website. You then manually generate a connection key on the Internet for the 
"Mindconnect Lib Asset". The connection key is used as a replacement for your user name 
and your password. Enter the generated connection key in the "Uuid" text box.  

• Upload configuration 

Use the "Upload configuration" icon to export your MindSphere configuration to 
MindSphere. Click on the icon to start the export. Confirm the process by clicking the icon 
again. Existing configurations are overwritten by a new export. 

• Server certificate 

In the "Server certificate" text field only the certificate for MindSphere is displayed. 

 
• Proxy settings 

If you select the option "Use proxy", you can configure certain proxy server settings. You 
have the choice between a manual proxy configuration and a configuration with specific 
user login information.  

To use a manual proxy configuration, select the option "Manual proxy configuration". 
Enter the host name and the port of your proxy server in the corresponding text boxes.  

To use specific user login information, select the option "Use specific user credentials". In 
the "User name" text box enter the user name you want to use. Enter the password of the 
user name in the adjacent text box "Password".  

• Activate export 

To enable the export of the data points to MindSphere, select the option "Export active". 
The data points marked for MindSphere are only exported to MindSphere if this option is 
set to active. 
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• Set synchronization date 

Select the "Globally set synchronization date" button to set the date for the 
synchronization of all data points with MindSphere. If you select your own 
synchronization data when configuring a data point in the "MindSphere" tab, the 
synchronization data only applies for the corresponding data point. If you click on the 
"Globally set synchronization date" button, a dialog opens in which you set the 
synchronization date. If the option "Mark as cloud relevant" is selected, the measured 
values including timestamps of all data points are exported to MindSphere from this time 
onwards. If you start a new export of historical data, already existing values are 
overwritten by new values with the same timestamps.  

• Export start time 

From the "Minimum cycle" drop-down list select the measured values of the cycle time 
you want to export. Only measured values with the selected cycle time are exported. If 
there are no measured values with appropriately selected cycle time, the values of the 
next higher cycle time are exported. If you want to export 15-minute values, for example, 
but the data point is a daily cycle, the daily values are exported.  

Select the cycle time with which the measured values are exported to MindSphere from 
the "Export cycle" drop-down list. 

 

See also 
Overview of settings (Page 306) 

Data storage (Page 392) 

General (Page 390) 

Delete options (Page 393) 

Password settings (Page 391) 

Job queue (Page 731) 

Configuring MindSphere settings (Page 287) 

Account settings (Page 390) 



Energy Manager Web  
3.7 Settings 

 SIMATIC Energy Manager PRO V7.2 - Operation 

316 Operating Manual, 12/2020, A5E38952754-AF 

3.7.4 Web Client settings 

Overview 
In the "Web Client settings" you set the display of the Energy Manager Web user interface for 
specific companies and products. You can configure the following objects: 

• Product name: Title of product 

• Logo: Custom logo 

• Login: Custom background image of the login page of Energy Manager Web 

The image for "Logo" and "Login" is adjusted automatically to the size of the user interface 
during upload. 

The following figure shows the detail area "Web client settings": 
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Configuring Web Client settings  
To configure the setting "Web client settings", follow these steps: 

1. To use an alternative name for the product, enter the desired title of the product in the 
"Product Name" text box. The name "Energy Manager PRO" or "Energy Manager Basic" is 
defined by default. 

The changed product name is adopted throughout the entire Web area and is displayed in 
the title bar.  

2. To use a company-specific logo, click the "Browse..." button under the "Logo" text field. 

A dialog for selection of an image opens.  

3. Select a suitable image as the logo. 

The changed logo is adopted throughout the entire Web area and is displayed in the title 
bar. The SIEMENS logo is set by default and by clicking the "Use default logo" button. 

4. To use an alternative background image, click on the "Browse..." button under the "Login" 
text field. 

A dialog for selection of an image opens. 

5. Select a suitable image as the background image on the login page. 

The changed image is adopted as the background image on login. The SIEMENS login 
screen is set by default and by clicking the "Use default login" button. 

6. Click on a different entry in the navigation area to save the settings. 

See also 
Overview of settings (Page 306) 

Definition of home page (Page 97) 



Energy Manager Web  
3.7 Settings 

 SIMATIC Energy Manager PRO V7.2 - Operation 

318 Operating Manual, 12/2020, A5E38952754-AF 

3.7.5 User Management 

3.7.5.1 Overview 
In the setting "User Management" you create new users in Energy Manager Web and 
configure already existing users. An overview of the existing users in 
Energy Manager PRO Client can be found under the path "System > Configuration > User, 
group, rights management > User". The creation of new users can be found in the 
Energy Manager PRO Client under the path "Master data > Authorization > Insert user". Newly 
created users and user configurations in Energy Manager PRO Web are also adopted in the 
Energy Manager PRO Client and vice versa. 

The following figure shows the detail area "User management": 

 
① "New" and "Edit" buttons: Creating and editing new users. 
② Display table of existing users. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of users is recommended when a large 
number of users exist in the system. 

④ "Delete" button: Delete user from the system. 
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Newly created and already existing users in the system are displayed in tabular form in 
Energy Manager Web. The display table consists of the following five columns: 

 
Column Function 
Selection You can select individual users and any number of users with the help of the check boxes. Clicking on the 

check box in the column header selects all users. Clicking on the check box again in the column header 
deselects all users again. 

User name Displays the user name in Energy Manager. 
First name Shows the first name of the user. 
Last name Shows the last name of the user. 
Email Shows the e-mail address of the user. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 

See also 
Creating users (Page 320) 

Editing users (Page 322) 

Deleting users (Page 323) 
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3.7.5.2 Creating users 

Procedure 
To create a new user, follow these steps: 

1. Click on the "New" button in the detail area "User management". 

The configuration dialog "New - User" opens. 

 

2. Enter the personal information and location information in the "General" tab. 

The input of a user name is required. 

3. Click on the "Administration" tab. 

 

4. Enter the password of the new user in the "Password" text box. 

5. Confirm the password in the "Confirm Password" text box. 
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6. From the "Select group" drop-down list select the user groups to which the user is added. 

The following user groups are available: 

– Administrator: This user group includes comprehensive functional rights for Energy 
Manager. The user group has the right to delete, add or configure all objects. 

– Configurator: This user group has the right to configure Energy Manager objects but 
not to delete these objects. 

– Operator: This user group has the right to open and view Energy Manager objects but 
not to configure or delete these objects. 

– Guest: This user group does not have the right to delete, add or configure objects. The 
user group also does not have the right to create new reports and to calculate 
analyses. This grouping is intended to apply simple, temporary restrictions on 
significant operator actions in the system. 

7. The selected user groups are displayed in the "Currently selected" list. 

8. To remove the user from a user group again, click the Delete icon. 

9. Click on the "Save" button. 

Result 
The user has been created. 

See also 
Overview (Page 318) 

Editing users (Page 322) 

Deleting users (Page 323) 

Setting up users (Page 672) 

Creating user groups (Page 684) 
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3.7.5.3 Editing users 

Requirement 
• The user has been created. 

Procedure 
To edit a user, follow these steps: 

1. Click on the user to be edited in the detail area "User management". 

2. Click the "Edit" button. As an alternative, you can double-click the user to be edited. 

The configuration dialog "Edit - User" opens.  

3. Configure the personal information and location information. 

The input of a user name is required. 

4. You can assign a new password in the password settings. 

5. Under user group management you can assign the user to a new user group or remove the 
user from a user group again. 

6. Click on the "Save" button. 

 
  Note 

You can only edit individually selected users. 
 

See also 
Overview (Page 318) 

Creating users (Page 320) 

Deleting users (Page 323) 

Creating user groups (Page 684) 

Setting up users (Page 672) 
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3.7.5.4 Deleting users 

Requirement 
• The user has been created. 

Procedure 
To delete one or more users from the system, follow these steps: 

1. Click on the user to be deleted in the detail area "User management". As an alternative, you 
can also select one or more users to be deleted with the help of the check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete a user from the system in the "Edit - User" configuration dialog by clicking the "Delete" 
button twice. 

Result 
The user is deleted from the system. 

See also 
Overview (Page 318) 

Creating users (Page 320) 

Editing users (Page 322) 
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3.7.6 Units 

3.7.6.1 Overview 
In the setting "Units" you create new units in Energy Manager Web and configure already 
existing units. An overview of the existing units can be found in the 
Energy Manager PRO Client under the path "System > Configuration > Extended configuration 
> Unit". The creation of new units can be found in the Energy Manager PRO Client under the 
path "Master data > Configuration > Insert unit". New units and configurations of existing 
units in Energy Manager PRO Web are also adopted in the Energy Manager PRO Client and 
vice versa.  

The following figure shows the detail area "Unit - Management": 

 
① "New" and "Edit" buttons: Creating and editing new units. 
② Display table of existing units. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of units is recommended when a large 
number of units exist in the system. 

④ "Delete" button: Delete units from the system. 
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Newly created and already existing units in the system are displayed in tabular form in Energy 
Manager Web. The display table consists of the following four columns: 

 
Column Function 
Selection You can select individual units and any number of units with the help of the check boxes. Clicking on the 

check box in the column header selects all units. Clicking on the check box again in the column header 
deselects all units again. 

Name Shows the name of the unit. 
Description Shows the description of the unit. 
Unit type Shows the type of unit. 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 

See also 
Creating units (Page 326) 

Editing units (Page 327) 

Deleting units (Page 328) 
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3.7.6.2 Creating units 

Procedure 
To create a new unit, follow these steps: 

1. Click on the "New" button in the detail area "Unit - Management". 

The configuration dialog "New - Unit" opens. 

 
2. Enter a meaningful name in the "Name" text box. 

The input of a name is required. 

3. If required, enter a description of the unit in the "Description" text box. 

4. Select the type of unit from the "Unit group" drop-down list. 

The selection of a unit type is required. 

5. Click on the "Save" button. 

Result 
The unit is created. The created unit can be found in the Energy Manager PRO Client under 
the respective unit group.  

See also 
Overview (Page 324) 

Editing units (Page 327) 

Deleting units (Page 328) 

Configuring units (Page 700) 
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3.7.6.3 Editing units 

Requirement 
• The unit is created. 

Procedure 
To edit a unit, follow these steps: 

1. Click on the unit to be edited. 

2. Click the "Edit" button. As an alternative, you can double-click the unit to be edited. 

The configuration dialog "Edit - Unit" opens.  

3. Edit the name, the description, if required, and the unit type. 

The input of a name and selection of a unit type are required. 

4. Click on the "Save" button. 

 
  Note 

You can only edit individually selected units. 
 

See also 
Overview (Page 324) 

Creating units (Page 326) 

Deleting units (Page 328) 

Configuring units (Page 700) 
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3.7.6.4 Deleting units 

Requirement 
• The unit is created. 

Procedure 
To delete one or more units from the system, follow these steps: 

1. Click on the unit to be deleted. As an alternative, you can also select one or more units to be 
deleted with the help of the check boxes. 

2. Click the "Delete" button. 

3. Click the "Delete" button again to confirm the deletion process. As an alternative, you can 
delete a unit from the system in the "Edit - Unit" configuration dialog by clicking the "Delete" 
button twice. 

Result 
The unit is deleted from the system.  

See also 
Overview (Page 324) 

Creating units (Page 326) 

Editing units (Page 327) 
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3.7.7 Alarm lists 

3.7.7.1 Overview 
In the setting "Alarm lists" you configure existing alarm and message lists in Energy Manager 
Web. The creation of new alarm lists is only possible in the Energy Manager PRO Client. You 
also add one or more users to the corresponding alarm lists. The assigned users receive alarm 
messages of the corresponding alarm lists. An overview of the existing alarm lists in 
Energy Manager PRO Client can be found under the path "System > Configuration > KPI alert 
lists". Configurations of alarm lists in Energy Manager PRO Web are also adopted in the 
Energy Manager PRO Client and vice versa.  

The following figure shows the detail area "Alarm - Management": 

 
① "Edit" button Editing alarm lists. 
② Display table of existing alarm lists. 
③ Filter function: When you enter a text in the "Filter" entry field, all columns are searched and 

displayed accordingly in the display table. Delimitation of alarm lists is recommended when a 
large number of alarm lists exist in the system. 

Existing alarm lists in the system are displayed in tabular form in Energy Manager Web. The 
display table consists of the following two columns: 
 
Column Function 
Name Shows the name of the alarm list. 
Notification Shows the status of the alarm list. If no user is assigned to the corresponding alarm 

list, the status "Inactive" is shown. If the user is assigned to the alarm list and the 
option "Activate alert" is selected, alarm notification is activated. The status changes 
to "Active". 

When you click on the column header of one of the columns, the corresponding column is 
sorted in alphabetical order. When you click on the same column header again, the column is 
sorted in the reverse order. 
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See also 
Editing alarm lists (Page 331) 

Basic information on message lists (Page 722) 

Configuring custom message list (Page 724) 

Configuring message notification (Page 728) 
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3.7.7.2 Editing alarm lists 

Requirement 
• The alarm list is created. 

Procedure 
To edit an alarm list, follow these steps: 

1. Click on the message list to be edited. 

2. Click the "Edit" button. As an alternative, you can double-click the alarm list to be edited. 

The configuration dialog "Alert list" opens.  

 
3. Enter a numerical value in the "Value" text box. 
4. Select the associated time from the adjacent "Unit" drop-down list. 

The user will be informed about any existing messages in the time period entered. 
5. If you select the option "Activate alert", the assigned user is informed about alarms of the 

corresponding alarm list. 
The status changes to "Active". 

6. From the "Select user" drop-down list select the users who will receive the messages of the 
corresponding alarm list. Only users with an assigned e-mail address are displayed. 
The selected users are displayed in the "Currently selected users" list.  

7. You can remove the assigned users again by clicking the "Delete" icon. 
8. Click on the "Save" button. 

 
  Note 

You can only edit individually selected alarm lists. 
 

See also 
Overview (Page 329) 

Configuring message notification (Page 728) 

Basic information on message lists (Page 722) 
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3.7.8 Backup 

Overview 
In the setting "Backup" you configure the automatic creation of database backups in Energy 
Manager Web. You can find the corresponding settings in the Energy Manager PRO Client 
under the path "Administration > Backup". Configurations of backups in Energy Manager PRO 
Web are also adopted in the Energy Manager PRO Client and vice versa.  

With the help of the individual setting of the weekdays you can create a weekly backup plan. 
The "Last backup status" text field shows when the last full and incremental backup was 
created. In addition, a message is displayed as soon as no backup is found. The "Drive status" 
text field shows the host name and the storage space of the archive drive.  

 

 Note 
Restoring older versions 

Version V7.2 does not support restoring a backup that was created with Version 7.1. 
 

Configuring a backup 
To configure the setting "Backup", follow these steps: 

1. Enter the storage location of the backup on your PC in the "Backup directory" text box. 

2. If you want to manually create a backup, click on the "Change recovery model" button. To 
start the manual backup process, click on the "Backup" button. 

 
3. Select the daily start time of the backup from the "Daily start time" text field. 
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4. Select a backup type for each weekday from the "Backup mode" drop-down list. You can 
choose an incremental, full or no backup for each weekday. 

 
5. Click on a different entry in the navigation area to save the settings. 

See also 
Overview of settings (Page 306) 

Backup (Page 747) 

Restore (Page 749) 
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3.7.9 Regional settings 

Overview 
In the setting "Regional settings" you manage location-specific settings in Energy Manager 
Web. You can create new countries or delete already created countries from the system. 
Already created countries with the corresponding configurations can be found in the Energy 
Manager PRO Client under the path "System > Configuration > Countries". The creation of 
new locations can be found in the Energy Manager PRO Client under the path "Master data > 
Localization > Insert location". Changes to the regional settings in Energy Manager PRO Web 
are also adopted in the Energy Manager PRO Client and vice versa. 

The formats for date, decimal separation and currency are automatically taken from your PC 
Windows settings.  

Configuring regional settings 
To configure the setting "Regional settings", follow these steps: 

1. Select a location from the "Country" drop-down list. 

The corresponding entries of the selected location are displayed in the "Name" and 
"Location" text fields. 

2. If you want to create a new country, click the "Add new country" icon. 

 
3. Enter the name of the country in the "Name" text box and the associated location in the 

"Location" text box. You can also edit the name and location of already created locations. 
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4. To create the new country, click the "Confirm" icon. To cancel the action, click on the 
"Cancel" icon. 

 
5. Select the corresponding country code from the "Country code" drop-down list. 

6. Select the corresponding time zone from the "Time zone" drop-down list. 

7. Select the language for the report evaluation from the "Report language" drop-down list. 

8. To define the selected location as the default country, select the option "Default country". 

9. If you want to delete a country from the system, click the "Delete country" icon. Click on the 
icon again to confirm the process. 

10.Click on a different entry in the navigation area to save the settings. 

See also 
Overview of settings (Page 306) 

Inserting the location or country (Page 659) 
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3.7.10 Modbus device templates 

3.7.10.1 Overview 
In the setting "Modbus device templates" you create new Modbus templates in Energy 
Manager Web and configure already existing Modbus templates. You can create, edit, delete 
and export Modbus templates only in Energy Manager Web Client. New Modbus templates 
and configurations of existing Modbus templates in the Energy Manager Web Client are 
adopted in the Energy Manager PRO Client. 
When you create or configure a Modbus channel, you can use the Modbus templates. 
The Modbus templates are displayed in tabular form: 

 
① "New" and "Edit" buttons: Creating and editing new Modbus templates. 
② Display table of existing Modbus templates. 
③ Filter function: When you enter a text in the "Filter" entry field, the column Name" is searched 

and corresponding templates are displayed in the display table. Delimitation of Modbus tem-
plates is recommended when a large number of Modbus templates exist in the system. 

④ "Delete" button: Delete selected Modbus templates from the system. 
The display table consists of the following two columns: 
 

Column Function 
Selection You can select individual Modbus templates and any number of Modbus templates with 

the help of the check boxes. Clicking on the check box in the column header selects all 
Modbus templates. Clicking on the check box in the column header again deselects all 
Modbus templates again. 

Name Shows the name of the Modbus template. 
When you click on the column header of the "Name" column, it is sorted in alphabetical 
order. When you click on the same column header again, the column is sorted in the re-
verse order. 

See also 
Modbus TCP templates (https://support.industry.siemens.com/cs/de/en/view/109771884) 

https://support.industry.siemens.com/cs/de/en/view/109771884
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3.7.10.2 Exporting Modbus device templates 

Requirement 
• The Modbus device template has been created. 

Procedure 
Follow these steps to export a Modbus device template: 

1. Select the desired Modbus device template from the table of the detail area "Modbus 
templates - Administration". 

2. Click the "Edit" button. 

3. Click the "Download" button. 

Result 
The selected Modbus device template has been saved in the storage location for your 
browser downloads. The saved template has the name in Energy Manager Web as the file 
name and the data type ".ini". 
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3.7.10.3 Creating a Modbus device template 

Requirements 
• Do you have the functional right "Master Data > create, remove, configure"? 

• An exported Modbus device template is saved in its local system. 

Procedure 
To create a new Modbus device template, follow these steps: 

1. Edit the exported template according to your needs. 

At the beginning of the automatically created templates you can find a short description 
of all configurable contents for editing. 

 
  Note 

The description of the contents of a template is only available in English. 
 

2. Save the edited template in the "*.ini" file format in its local system. 

3. Click on the "New" button in the detail area "Modbus device templates - Administration". 

The configuration dialog "New - Modbus template" opens. 

4. Enter a meaningful name in the "Name" entry field. If you create a Modbus channel with a 
template, the name is displayed in the "Template" drop-down list. 

 
5. Click the "Upload" button. 

A dialog window in which you can search the local data system is displayed. 

6. Select the desired template from the local data system and click on the "Open" button. 

The folders saved in the template with all data points are displayed in the "Template" field. 

7. Click the "Save" button. 

Result 
The Modbus device template has been created. 
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3.7.10.4 Editing a Modbus device template 

Requirements 
• You have the functional right "Master Data > Configure". 

• The Modbus template has been created. 

Procedure 
To edit a Modbus template, follow these steps: 

1. Select the desired Modbus template from the table of the detail area "Modbus device 
templates - Administration". 

2. Click the "Edit" button. 

The dialog window "Edit - Modbus template" opens. 

3. Configure the Modbus template as for creating a Modbus template. 

4. Click the "Save" button. 

3.7.10.5 Deleting a Modbus device template 

Requirements 
• You have the functional right "Master Data > create, remove, configure" 

• The Modbus template has been created. 

Procedure 
To delete a Modbus template, follow these steps: 

1. Select one or more Modbus templates from the table of the detail area "Modbus device 
templates - Administration". 

2. Click the "Delete" button. 

Result 
The selected Modbus templates are deleted. 
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3.7.11 Data provider 
You can make the data in your Energy Manager system accessible to programs and systems 
via an OPC UA HDA Server. You configure the access in the "Data provider" setting. 

 OPC UA Server 
To configure "OPC UA Server" access, proceed as follows: 

1. Under "Start folder", use the structure browser to select the folders whose data is transferred 
with the OPC server. 

If you select a folder, the data of all nested folders will also be made accessible. 

2. Specify the address of the server on which the Energy Manager is installed. Enter the 
address in the following form: 

opc.tcp://[IP address]:[Port] 

3. Enable the security profiles used by the OPC UA HDA server. 

If you have activated a security profile, a certificate exchange is performed. To access the 
data via the OPC server, move the created certificate from the 
/Siemens/EnMPro/OpcUaServr/pkiserver/rejected/certs folder to the 
[...]/pkiserver/trusted/certs folder. 

4. If you enable "Anonymous user identity", you do not need login data to access the data via 
the OPC server. 

If you enable "Use name identity", you can specify a user name with password to access 
the data via the OPC server. The user name and the password must correspond to a user 
name and the corresponding password of a user of your Energy Manager system. 

If you specify the login data of an Energy Manager user, you can only access the data 
points that the user can also access in the Energy Manager. 

If you only enable "User name identity", you need to enter a user name with password to 
access the data via the OPC server.  

 

 Note 

If you configure the data provider while the server is running, the System service must be 
restarted via the Service Cockpit. Changes at the OPC server are only applied after the restart 
of the System service. 
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Additional information 
The following entries are available for each data point that is made accessible by the OPC UA 
server: 

• Unit 

• Acquisition category 

• Measured values 
If several compression levels are configured for the data point, the lowest compression 
level is made available. 

The entry on the measured values has the following label: [Data point 
name]_[Compression level] 

If a data point is configured as a counter, additional measured values are provided that are 
compiled as counters. This entry has the following label: [Data point 
name]_CNT_[Compression level] 
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3.8 Service Cockpit 
To open the Service Cockpit, click on the icon . 

To open the Service Cockpit in Energy Manager Web, you require the functional rights 
"Service Cockpit > view" and "Master Data > view". 

Setup 
The following figure shows the Service Cockpit: 

 
① Navigation area 
② Selection of detailed information 
③ Display of services 
④ Detailed information 
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3.8.1 Navigation area 
The navigation area displays all available acquisition components and the application server.  

The following figure shows the navigation area: 

 

To display the function dialog of the acquisition component in the detail area, click on the 
entry of the acquisition component in the navigation area. 

To display all acquisition channels of an acquisition component in the navigation area, click 
on the item of the acquisition component and then on the "Available channels" item. 

The status of the acquisition components and channels is displayed via the color of the 
corresponding icon: 
 
Color Acquisition component status Channel status 
Green At least one acquisition component is 

active. 
There is no gap in any channel of the 
acquisition component. 

Data acquisition of the channel is active. 
There is no gap. 

Red At least one acquisition component is 
active. 
There is no gap in at least one channel of 
the acquisition component. 

The channel is connected to the system.  
There is a gap. 

Gray All channels of the acquisition compo-
nents are not connected or are inactive. 

The channel is not connected to the sys-
tem or is inactive. 

The entry "Available channels" has the same status display as the corresponding acquisition 
component. 

If you hold the mouse pointer over the entry of a channel, the ID of the process is displayed 
via a tooltip. 
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3.8.2 Services 
Depending on the use of the selected system component, the corresponding services are 
displayed: 
 
System com-
ponent 

Energy Manager Service 

Application 
server 

• Database service (Database) 
• Report service (Reporting) 
• Portal service (Portal) 
• Calculation service (Calculation) 
• System service (System) 

Acquisition 
component 

• Portal service (Portal) 
• Acquisition service (Acquisition) 
• Kernel service (Kernel) 

If a server is used as the acquisition server and application server, all listed services are 
displayed. 

Status display 
The status of the services is indicated by the color of the icon: 
 
Color Status 

 

Service is running 

 

Service is stopped 

 

Service is stopped 

Start, restart and stop of services 
To control services, click on the icons in the following table: 
 
Symbol Function 

  Start service 

  Restart service 

  Stop service 
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3.8.3 System 
To call up this field, click on system component in the navigation area and the "System" tab in 
the selection of the detailed information. 

Information 
This field shows the following general information for the corresponding servers: 

 
 
Application server Acquisition component 

• The Energy Manager version used by the sys-
tem 

• The Energy Manager version used by the sys-
tem 

• The time of the last contact with the acquisi-
tion system 

• The system time 

The system field shows the following hardware information for all servers: 

• A list of the hard disks and their usage 

• The CPU load 

• The currently used work memory 

3.8.4 Installed software 
To call up this field, click on system component in the navigation area and the "Installed 
software" tab in the selection of the detailed information. 

Setup 
This field shows a table with the following information: 

• The programs installed on the server 

• The version of these installed programs 

Sort the list via the column headers. 
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3.8.5 Log files 
To call up this field, click on system component in the navigation area and the "Logs" tab in 
the detailed information selection. 

The following figure shows an overview of the "Logs" field: 

 
① Table with log files 
② Filter 

When you enter a text in the "Filter" text box, all columns are searched and displayed accordingly in the table. De-
limitation is recommended when a large number of log files exist in the system. Click on a column header to sort 
the corresponding column alphabetically.  

③ Update 
Updates the table with the log files. 

④ Open 
Opens the log file in the Energy Manager Web Client. 

⑤ Download 
Downloads the selected log file to your local system via your browser download. If several log files are selected, this 
button is disabled. 

⑥ Delete 
Deletes all selected log files. 

The table with the log files contains the following information: 
 
Name of the column Content of the column 
Service Name of the corresponding Energy Manager service 
Component Name of the associated subcomponent of the service 
File Name of the log file 
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Name of the column Content of the column 
Size Size of the log file in kilobytes 
Date changed Time of last change 

View of the log file  
The following figure shows a log file in the Energy Manager Web Client: 

 
① Table with the messages 
② Column filter 

To filter a column, click on the corresponding filter. Then select the entries by which the column is to be filtered. 
③ Filter 

When you enter a text in the "Filter" text box, all columns are searched and displayed accordingly in the table. De-
limitation is recommended when a large number of log files exist in the system. Click on a column header to sort 
the corresponding column alphabetically.  

④ Export as CSV 
Downloads the selected log file in CSV format to your local system via your browser download. 

⑤ Cancel 
Closes the view of the log file. 

⑥ Update 
Updates the log file 
Next log file 
If the latest log file with this name is not open, this button shows an arrow. 
To open the next log file, click on this button. 

⑦ Previous log file 
Opens the log file with the same name that was created before this log file. 
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The log file messages table contains the following information: 
 
Name of the column Content of the column 
Date Time stamp of the message 
Process ID ID of the channel to which the message provides information 
Components Component from which the message originates 
Log level Message type: 

• INFO = Information 
• WARNING = Warning 
• ERROR = error 

Log information Contents of the message 
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3.8.6 Gap recognition 
To open a list of acquisition gaps of a channel, click on the channel in the navigation area of 
the service cockpit. When you click on "Available channels" in the navigation area, the list for 
the top channel is displayed in the navigation area. You can check the functionality of data 
acquisition with the help of gap recognition. 

 

 
 
  
① Table with all gaps of the channel 
② Filter function: When you enter a text in the "Filter" entry field, all columns are 

searched and displayed accordingly in the display table. Delimitation is recommended 
when there is a large number of gaps. 

③ "Acknowledge":  
To acknowledge a gap, select the corresponding gap from the table and click twice 
on this button. 
The gap is deleted from the list. When all gaps are acknowledged, the status of the 
channel is set to green. 

④ "Refresh" 
Click on this button to update the table with the gaps. 

The display table contains three columns: 

 
 
Column Function 
Data point Data point of the gap 
Description Description of the data point 
Time stamp Time stamp of the gap 
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3.8.7 Troubleshooting with log files 

3.8.7.1 Kernel fault 
You can find more information on the log file in the reference under "Kernel (Page 903)". 

Requirements 
• You have the functional right "Administration > Logging Viewer > View" 

• You have the functional right "Administration > Service Cockpit > View" 

• The Service Cockpit in the web client is open. 

Raw values are missing in the chart with compression level acquisition values 
If the acquired measured values of the data source are not visible in the chart, proceed as 
follows to locate the problem: 

1. Check whether the following services are running: 

– Kernel service (Kernel) 

– Acquisition service (Acquisition) 

– Portal service (Portal) 

If the icon of the service is green, the service is running. 

2. Open the latest log file of the Kernel Service via the detail information "Log files". 

To facilitate the search, use the "Filter" function and sort the column "Last change" 

3. Search the log file for errors. 

Messages of category 3000 are error messages. 

Identify the interface at which the error is present using the process ID.  

4. With the help of the log file check whether values arrive in the kernel and are passed on. 

5. Check whether the acquired measured values are written to the raw files. 

The raw files can be found in the directory "Installation directory\GUI\mcl\RawFiles". 

You can find additional information on raw files in the following section. 

Raw files 
Values acquired from the data sources are stored in raw files by default. A folder is created at 
midnight local time for each day. As soon as the first value is acquired, a raw file is created in 
this folder for each data point. 

The name of the raw file consists of the ID of the data point. You can read the ID of the data 
point in the configuration dialog of the data point.  
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3.8.7.2 Acquisition service error 
You can find more information on the "Compression" log file in the reference under 
"Compression (Page 909)". 

Requirements 
• You have the functional right "Administration > Logging Viewer > View" 

• You have the functional right "Administration > Service Cockpit > View" 

• The Service Cockpit in the web client is open. 

The acquired measured values are visible, the 15-minute values are not. 
If the acquired measured values are visible and values of the "15 minutes" compression level 
are not visible, proceed as follows to locate the problem: 

1. Open the latest log file "Compression". 

2. Check whether values were compressed for the corresponding time stamp. Filter the log file 
by the identifier "CMPR". 

3. Filter in the log file by the identifier "RCAL" to display the compressed interval and the 
number of compressed values. 

4. To check whether the compressed values were uploaded to the SQL server, open the log file 
"Synchronisation" of the acquisition service. 

The local database of the acquisition component does not work. 
If the local database of the acquisition component does not work, error messages are 
displayed in the log files "Compression", "Kernel" and "Synchronisation". 

Open the log file "SQL Provider". This log file should be empty. If there are error messages in 
this log file, the local database is corrupt. 

Alarms for acquisition values are not generated 
If no alarms are generated in the event of limit violations in the values with the compression 
level "Acquisition values", proceed as follows: 

1. Open the latest log file "Compression". 

2. Filter the log file by the identifier "PLSI". 

3. Check whether limit violations have been detected. 

Gaps are not detected 
If no gaps are detected in the acquired values, carry out troubleshooting as follows: 

1. Open the latest log file "Compression". 

2. Filter the log file by the identifier "Gap". 

3. Check whether gaps have been detected. 
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3.8.7.3 Reporting service error 
For more information on the "Recalculation" log file, see the reference under "Recalculation 
(Page 914)". 

For more information on the "MEVA calculation" log file, see the reference under "MEVA 
calculation (Page 917)". 

Requirements 
• You have the functional right "Administration > Logging Viewer > View" 

• You have the functional right "Administration > Service Cockpit > View" 

• The Service Cockpit in the web client is open. 

Daily values in matrix but no monthly values calculated 
If you entered the daily values in a matrix, yet no monthly values were calculated, carry out 
troubleshooting as follows: 

1. Open the latest log file "Recalculation". 

2. Filter the log file by the identifier "ACOP". 

3. Check to see whether compression is still pending. 

4. Filter the log file by the identifier "RCAL". 

Derived data points are not calculated automatically 
If derived data points are not calculated automatically even though the data point is 
configured accordingly, carry out troubleshooting as follows: 

1. Open the latest log file "Recalculation". 

2. Filter the log file by the identifier "DCAL". 

3. Check to see whether recalculation is still pending. 

4. Filter the log file by the identifier "RCAL". 

MEVA/KPI is not calculated 
If a MEVA/KPI is not calculated, carry out troubleshooting as follows: 

1. Open the Logging Viewer in the Energy Manager Pro Client. 

For more information on the Logging Viewer, refer to the section "Logging Viewer" 

2. Search for error messages of the MEVA/KPI in Logging Viewer. 

3. Open the log file "MEVA calculation". 
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Substitute values are not calculated for manually acquired daily values 
If the substitute values are not calculated for gaps of manually acquired daily values, carry out 
troubleshooting as follows: 

1. Open the latest log file "Recalculation". 

2. Filter the log file by the identifier "REPV". 

3. Check whether gaps have been detected. 

4. Filter the log file by the identifier "RCAL". 

5. Check whether substitute values were generated. 

Interpolation of monthly values does not work 
If the interpolation of monthly values does not work, carry out troubleshooting as follows: 

1. Open the latest log file "Recalculation". 

2. Filter the log file by the identifier "EXPA". 

3. Check whether interpolation or extrapolation was performed. 

4. Filter the log file by the identifier "RCAL". 

5. Check whether an interpolated or extrapolated value was created. 
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3.8.7.4 Reporting service error 
You can find more information on the "Report Server" log file in the reference under "Report 
Server (Page 918)". 

Requirements 
• You have the functional right "Administration > Logging Viewer > View" 

• You have the functional right "Administration > Service Cockpit > View" 

• The Service Cockpit in the web client is open. 

Reports are not generated 
If only the first green check mark is displayed after starting a report, or an automatically 
calculated report is not displayed, carry out troubleshooting as follows: 

1. Open the log file "Report Server". 

2. Filter the log file by the ID of the report. 

3. Search for error messages. 

If macros and Visual Basic were not activated in the EXCEL settings, this error occurs. 

4. Check whether a default printer is defined in the operating system. 
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Administration 4
4.1 Administration of the Client 

4.1.1 Objects in the Client 

4.1.1.1 Object basics 

Object definition 
Objects let you configure all of the components you need for energy management in your 
organization in Energy Manager . 

The following objects are available, for example. 

• Folder

Object for structuring in the project tree of the Client

• Datapoint

Object for saving the measured values of a measuring point

• Prototype, loop

Objects for processing measured values during import

• Parameters, measuring variables

Objects for time-independent processing of measured values

• ERP domain, cost center relation, cost center, service type

Objects for Enterprise Resource Planning

• Report, Chart, Dashboard

Objects for the display of measured values

• User, user group, functional group, domain

Objects for configuring authorizations in Energy Manager

• Hardware, process, driver source, IO buffer

Objects for configuring data acquisition in Energy Manager
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Object properties 
A property is a characteristic that is assigned to a specific object. In Energy Manager, an 
object can have the following properties: 

• Automatically generated properties 

The system automatically generate these properties,, e.g. "Name" and "Description", when 
you create an object. 

• Manually assigned properties 

You can assign these properties to an object, such as "Created on" or "Created by". 

Manually assigned properties are then subdivided into the following categories: 

• Default properties 

You can assign a property that is already defined in Energy Manager to an object, "Created 
on" for example. 

• User-defined properties 

You can also create your own properties, which you can then assign to an object. 

You can use object properties for the following purpose: 

• To search for these properties 

• For titles in reports 

Access rights for objects 
You can prevent unauthorized read access to specific objects by defining these in Energy 
Manager: 

• Authority level 

You specify the authority level with a value between 0 and 1000:  

– "0" 

All users can view the object. 

– "1" to "1000" 

If you enter "50", for example, the object is visible to all users assigned authority level 
equal to or higher than 50. 

You can automatically assign the authority level of an object to all nested objects.  

• Domain 

The domain represents a location of a business, for example. Users can be assigned to one 
or several domains.  

Only the objects of the domain you activated are displayed. Newly objects are assigned 
exclusively to this domain. 
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Using and copying objects 
Once an object is created, you can use it elsewhere in the project tree, e.g. in a report or 
calculation. You can also create a clone of the object in order to create a similar object. 

This is done using the following Energy Manager commands: 

• Using "Copy and paste", you use the same object elsewhere. 

• "Disconnect", to cancel the use of the object. 

• "Delete", to remove the object from the project tree. 

"Delete" removes all instances of an object in the project. 

• Using "Clone", you receive a copy of the object's contents. 

See also 
Object properties  (Page 361) 

Object management (Page 365) 

Authorizations (Page 665) 
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4.1.1.2 Creating an object 

Overview 
If you are installing Energy Manager for the first time, the project tree contains only one 
default object: the "System" root.  

 

 Note 

You cannot edit or delete the "System" root. 
 

You may create and configure further objects in the project tree. Rule: Objects are always 
created as child object of the selected parent object. 

Procedure 
1. Select the folder in which you want to create the object. 

2. Click the object that you want to create in the menu bar, for example, "Data point". 

The object configuration dialog opens. 

3. Select the respective object and click "OK". 

Result 
The object is created in the project tree in the selected folder.  

 

You can view the object properties of the object, or create new properties for the object. 

See also 
Displaying object relations (Page 371) 

Object naming conventions (Page 373) 

Object properties  (Page 361) 
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4.1.1.3 Object properties 

Opening properties 

Requirement 
You have created the object. 

Procedure 
1. Select the object and click the "Properties" command in the shortcut menu. 

The object properties dialog opens.  
2. Edit the name and description of the object as required. 
3. Enter a value in "Authorization level" to specify the access rights for the object. 

The authority level is set to "0" by default.  
4. You can transfer the authority level to all child objects by activating the "Children inherit 

authority level". 

Result 
The object properties are open. 

 

You can assign new properties to the object. 

See also 
Assigning properties (Page 362) 
Creating an object (Page 360) 
Object basics (Page 357) 
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Assigning properties 

Requirement 
• You have created the object. 

• The object properties are open. 

Procedure 
1. Click "New" in the "Properties" area. 

The "Property" dialog opens.  

 
2. Select the property in the "Name" area. 

The data type of the selected property is automatically entered in "Value type". 

3. Enter a value. 

4. Click "OK". 
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Result 
The selected property is assigned to the object.  

 

You can assign a new property to the object. You can also define custom properties and 
assign these to the object. 

See also 
Creating an object (Page 360) 

Opening properties (Page 361) 

Object basics (Page 357) 

Defining custom properties (Page 364) 
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Defining custom properties 

Requirement 
• The object properties are open. 

• The "Property" dialog is open. 

Procedure 
1. Click "New". 

The "Property type" dialog opens. 

 
2. Type in a name for the property. 

3. Select the data type for the property in "Value type". 

4. Click "OK". 

Result 
You have defined a custom property. You can now assign this new property to the object. 

See also 
Assigning properties (Page 362) 
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4.1.1.4 Object management 

Object management basics 

Overview 
The following Energy Manager commands are available for managing objects in the project 
tree: 

• Move 

• Copy and disconnect 

• Clone and delete 

Moving objects 
Use the "Move" command to move an object to a different location. 

Example: 

1. You have created the "e_gas_consumption_1" data point in the "Report Data Collection" 
folder: 

 
2. However, you no longer need the "e_gas_consumption_1" datapoint for evaluation in a 

report; now you need it for visualization in a Chart. Move the datapoint to the "Chart Data 
Collection" folder: 

 

Reusing objects 
Use the "Copy" command to use an object in another location. Copied objects always have 
the same name. If you edit the object at one location, any changes will be applied to all other 
points of application. 

Example: 

1. You have created the "e_gas_consumption_1" data point for evaluation in a report in the 
"Report Data Collection" folder: 

 
2. You also need the "e_gas_consumption_1" datapoint for visualization in a trend. Copy this 

datapoint to the "Chart Data Collection" folder: 
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Revoke re-use of objects  
To revoke the re-use of an object in one location, use the "Disconnect" command. 

Example:  

1. You are using the "e_gas_consumption_1" datapoint in the "Report Data Collection" and 
"Chart Data Collection" folders: 

 
2. You no longer need the "e_gas_consumption_1" datapoint for visualization in a trend. 

Disconnect the datapoint in the "Chart Data Collection" folder. This datapoint is deleted in 
the Chart Data Collection folder. The data point is retained in the "Report Data Collection" 
folder: 

 

Copying objects 
You copy an object by using the "Clone" command. Use this command if you want to create 
several objects with similar properties. Example: 

1. You have created the "e_gas_consumption_1" data point for evaluation in a report in the 
"Report Data Collection" folder: 

 
2. For evaluation in a report, you require a further data point for the gas consumption of a 

different plant. Clone the "e_gas_consumption_1" data point, rename this data point 
"e_gas_consumption_2" and customize the properties accordingly: 

 

Deleting objects 
Use the "Delete" command to irrevocably delete an object from the project tree.  

Example: 

1. You are using the "e_gas_consumption_1" datapoint in both the "Report Data Collection" 
folder and the "Chart Data Collection" folder: 
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2. You no longer need the "e_gas_consumption_1" data point. Delete this data point. All 
instances of the data point in the project tree are deleted irrevocably. You can no longer 
restore the data point. 

 

See also 
Folder (Page 656) 
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Managing objects 

Requirement 
The objects have already been created. 

Moving or re-using objects 
1. Right-click the object and drag-and-drop it to the selected position. Observe the position of 

the guide line: 

– If you place the guide line directly underneath the object, the selected object is copied 
to the same structure level in the project tree for re-use. 

 

 

– If you place the guide line to the right of the object, the selected object is copied to the 
next nested level in the project tree structure, or re-used. 

 

 

The shortcut menu for moving and re-using is displayed. 

 
2. To move the object, click "Move here". 

The object is moved.  

3. To re-use the object, click "Copy here". 

The object is re-used. 
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Deleting/copying/canceling the re-use of an object 

 
1. Click "Delete" in the shortcut menu to delete a selected object. 

The object is deleted irrevocably from the project tree. 

2. You cancel the re-use of a selected object by clicking "Disconnect" in the shortcut menu. 

The object is no longer used at that location, but remains available for use in other 
locations. 

3. Proceed as follows to co copy the object: 

– Select the object and click "Clone" in the shortcut menu. 

The object configuration dialog opens. 

– Edit the object and then click "OK". 

The copied object is created in the project tree. 
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Locking objects 
You can lock the created objects in the project tree of the Client. This prevents the objects 
from being moved unintentionally within the project tree.  

1. Select the object and click "Lock" in the shortcut menu. 

 
You can no longer move the object and its nested objects in the project tree. 

2. Deactivate the "Lock" command if you want to move a child object in the project tree. 

You can now move the child object. The parent object remains in locked state. 

See also 
Creating an object (Page 360) 

Object management basics (Page 365) 
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4.1.1.5 Displaying object relations 

Overview 
An object created in Energy Manager forms a relation to other Energy Manager objects. The 
relation between objects in Energy Manager is termed "parent-child relation": 

 
① Parent object: This object can have more than one child object. 
② Child objects: While each child object can only have one parent object, it can also be the parent 

object for other child objects. 

Requirement 
You have created the object. 

Procedure 
1. To display all child objects that you have created directly under a parent object, select the 

parent object from the project tree and click the "Father to Child" button. 

The child objects are displayed in the display area of the Client. 
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2. To display the object under which you have created other objects, select the child object 
from the project tree and click the "Child to Father" button. 

The parent object is displayed in the display area of the Client. 

 

See also 
Creating an object (Page 360) 
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4.1.1.6 Object naming conventions 

Notes on the naming of objects  
Observe the following when naming objects: 

• Use an unambiguous name. 

• Use a maximum of 255 characters. 

• Use the following characters: 

– "A" to "Z" 

– "a" to "z" 

– "0" to "9" 

– "_" 

Name prefixes 
In order to enable the unambiguous identification of Energy Manager objects for acquisition 
and calculation of measured values, the following name prefixes were defined. 
 
Prefix Object 
a_ Derived data point 
d_ Data point 
e_ Generic data point 
k_ Constant 
p_ Prototype 
l_ Loop 
t_ Parameters 
m_ Measuring variable 

 

 

 Note 

When you create an object, the prefix is automatically entered in the name field. 
 

Recommendation for naming objects 
In order to ensure the uniqueness of the names, create a concept for naming the objects in 
Energy Manager before you start to configure your system. Use the following syntax. for 
example: 

Prefix_FIS_physical measuring variable_[plant unit]_plant 
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4.2 File 

4.2.1 Options 
"Energy Manager options" support configuration tasks in all system areas and user-specific 
customizations. The following table shows the available areas:  

 

Access 
To open "Energy Manager options", click the "Options" button in the menu bar under "File". 

 
 

 Note 

Changes in the extended parameters of the Energy Manager options can have undesired 
effects on the system behavior and should therefore only be carried out by trained users or 
administrators.  
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Energy Manager options in detail 
 
Tab Functions 
General 

 
The "General" tab primarily contains user-specific settings. In this dialog, you can customize the 
client language, the tooltips, and the Explorer appearance. 

Executable tasks 

 
See Task Management (Page 731)  

Measuring variables 

 
You can activate or deactivate "Measuring variables" in this tab. 

Jobs 

 
You can activate or deactivate "Energy Manager database" jobs in this tab. 

Query types 

 
You can activate or deactivate "query types" in this tab. 
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Tab Functions 
Module types 

 
You can activate or deactivate "module types" in this tab. 

Database 

 
Tab for editing global database settings. 

 
The tab provides corresponding number and text input fields. 
Description of the various options: 
Name Description 
ABGL_CHANGE If this value equals 1, derived datapoints will be 

recalculated during execution of the "Recalculate 
derived measurements" job. 

ABGL_CHANGE_IMPORT Import functions may set this value to indicate the 
number of values most recently imported. Recalcula-
tion is stopped if the value overshoots the limit of 
50,000 and resumed when the value has dropped 
below this limit again. Recalculation should be in 
wait state during the import of large data volumes. 
This parameter is only relevant if 
ABGL_CHANGE_WAIT = 1. 

ABGL_CHANGE_KLASSIFIZIERUNG Generally enables (value = 1) or disables (value = 0) 
differentiation between actual and forecast values 
for derived datapoints during execution of the "Re-
calculate derived measurements" job for derived 
datapoints. 

ABGL_CHANGE_WAIT Specifies whether to delay the recalculation of de-
rived datapoints during execution of the "Recalcu-
late derived measurements" job for derived 
datapoints. Enabled if value = 1, disabled if value = 
0. 
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Tab Functions 
Database (continued) ABGL_DEBUG If >= 2, all recalculations are logged to the error 

journal during execution of the "Recalculate derived 
measurements" job for derived datapoints. Logging 
is disabled if the value is < 2. 

AUSROLL_ANZAHL_MONATE Number of month for "Job DP roll-out", starting with 
job initiation. The default value is 36, i.e. three 
years. 

AUSROLL_INIT_FLAG "Job DP roll-out" issue: 
1: The entire time frame that has been defined for 
the rollout will be processed. Existing gaps will be 
padded in this way.  
0: Roll-out only up to the first value that exists.  
The default is 0. 

AUSROLL_ROOT_ORDNER For "Job DP roll-out", this specifies the node ID of the 
folder that contains the derived measurements or 
datapoints to roll out. The job is canceled and a 
corresponding error message is generated if this 
entry is missing. 

AUSROLL_STATISTIK Specifies the number of datapoints rolled out for the 
currently active "Job DP roll-out" job. 

EXPORT_FILENAME_MODUS Concerns the "Job for ASCII export to Energy Man-
ager PRO Standard": 
0: File name with date and time. 
1: File name without date and time 

EXPORT_PATH Concerns the "Job for ASCII export to Energy Man-
ager PRO Standard": 
Export directory. An error message is output and 
"C:\Data\Import" is returned as default directory if 
this entry is missing. 

BDATA_LASTPRF_QS Specifies whether or not to include corrupted values 
in the calculation for the "Load profile analysis" 
module.  
0: Corrupted values are ignored. 
1: Corrupted values are included. 

BILA_HEADER Concerns the "Balance" module: 
0: Hide header. 
1: Show header. 

COUNTRY_CODE Saves the regional setting the user has selected in 
database setup. Currently, the following coun-
tries/regions are supported: 2511 for Austria, 2512 
for Germany, 2513 for Spain (Catalonia). 

DB_DATE_FORMAT Date/time property format. Default: dd.mm.yyyy 
hh24:mm:ss 
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Tab Functions 
Database (continued) 
 

DB_FEJO_THRESHOLD Concerns the error journal: 
Suppression in [s] if many error messages with iden-
tical text content are being received. All new incom-
ing error messages having a time stamp within the 
threshold and identical text entries in the error jour-
nal will not be entered in the error journal. All error 
messages are output when the value is 0. 

DB_ZAEHLER_CHECK Specifies whether to enable or disable filtering for 
"MEVAs with count functionality". 
0: Filtering is disabled. 
1: Filtering is enabled. 

DB_ZAEHLER_DEBUG Specifies whether or not to enter additional diagnos-
tics messages in the error journal for "MEVAs with 
count functionality". 
0: disabled. 
>= 1: enabled. 

DB_ZAEHLER_FILTER Minimum value to be set for count filters in order to 
be taken into account for "MEVAs with count func-
tionality". 

DEFAULT_CAHE_BEHALTEN The "Delete analyses job" does not delete analyses 
(reports started manually or automatically) marked 
with selected "Keep" check box. This parameter 
defines the check box default for the creation of 
new analyses.  
0: Do not keep 
1: Keep 

DELETE_BY_COMPRESS_UNTIL For the "Compress measurement journal job", if the 
"Delete measured values" has been parameterized at 
the datapoint: Age in seconds as of which deletion is 
permitted. Default is "14 days" (=1209600 sec). 

DELETE_MSJO_COMMIT For the "Delete measurement journal job": Defines 
the number of data records to delete before a 
COMMIT is set. Default: 1000 

DELETE_MSJO_UNTIL For the "Delete measurement journal job": Age in 
days as of which deletion is permitted. The job is 
canceled and a corresponding error message is gen-
erated if this entry is missing. 

FEJO_EXPORT_FLAG For the "Delete error journal job": If the value 1 is 
set, the messages are exported to a file prior to 
deletion; the messages are only deleted if 0 is set. 

FEJO_EXPORT_MESS_FLAG For the "Archive MV errors" job: If the value 1 is set, 
the messages are exported to a file prior to deletion; 
the messages are only deleted if 0 is set. 

FEJO_EXPORT_MESS_PATH For the "Archive MV errors" job: Specifies the export 
directory for messages to be deleted. The file name 
"FEJO_EXPORT_MESS_PATH_" plus the date (DD-MM-
YYYY) is set permanently. 

FEJO_EXPORT_MESS_UNTIL For the "Archive MV errors", this parameter specifies 
the number of days the entries from the MV editor 
are retained in the database.  
The entries will be deleted on expiration of this time. 
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Tab Functions 
Database (continued) 
 

FEJO_EXPORT_PATH For the "Delete error journal job": Specifies the ex-
port directory for messages to be deleted. The file 
name "FEJO_EXPORT_PATH_" plus the date (DD-MM-
YYYY) is set permanently. 

FEJO_EXPORT_UNTIL For the "Delete error journal job", this parameter 
specifies the number of days the error messages are 
retained in the database. 
The error messages will be deleted on expiration of 
this time. 

FILE_MAX_SIZE_KB Specifies the maximum size in KB for files to be 
saved to the database. Default: 3000 KB 

IMPORT_DEBUG Enables/disables detailed logging at the DB interfac-
es; enable (1)/disable (0) 

ITSEC_EXPORT_FLAG For the "Delete old IT Security Data" job: If the value 
1 is set, the error messages are exported to a file 
prior to deletion; the messages are only deleted if 0 
is set. 

ITSEC_EXPORT_PATH For the "Delete old IT Security Data" job: Specifies 
the export directory for messages to be deleted. The 
file name "FEJO_ITSEC_EXPORT_" plus the date (DD-
MM-YYYY) is set permanently. 

ITSEC_EXPORT_UNTIL For the "Delete old IT Security Data" job: All security 
entries that are no older than ITSEC_EXPORT_UNTIL 
(specified in days) at the time of execution are de-
leted from the error journal. 

LANGUAGE_CODE Specifies the language for the Energy Manager da-
tabase. Set by the Database Setup program. Current-
ly supported languages are German and English. 
Possible values: DEU (German), ENG (English) 

Manual Insert Offset Defines the handling of the first time stamp during 
manual input: 
0: Values are entered with default Energy Manager 
end time stamp. The additional time stamp entered 
at the start is therefore listed as start time stamp.  
1 (default): Values are entered with default Energy 
Manager end time stamp. 

MATRIX_MAX_WORK_LOAD_FOR_FULL_CLI
ENT 

Limits the number of values in a matrix to the en-
tered number. 

MATRIX_MAX_WORK_LOAD_FOR_WEB Limits the number of values in a matrix in Energy 
Manager PRO Web to the entered number. 

MAX_ATTEMPS_TO_LOGIN Specifies the maximum number of unsuccessful 
login attempts to tolerate before the account is 
locked (an administrator may release the account 
again) 

MEVA_CHECK_LUECKEN 1: Check for gaps in the "df_mess_plusx", "df_avg", 
"df_max", and "df_min" time sequences (15 min).  
0: No check 
Can only be active if MEVA_STER_THRESHOLD is 
disabled (= 0). 
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Tab Functions 
Database (continued) 
 

MEVA_STER_THRESHOLD Specifies the threshold for the status returned for a 
specific Meva. 
0 = disabled  
> 0; threshold percentage; numbers with decimal 
places are also permitted, e.g.: 60.8. 
Valid for the following Mevas: minimum, maximum, 
average, total, total real 
Can only be active if MEVA_CHECK_LUECKEN is 
disabled (= 0). 

MODULE_EINHEIT Valid for the "Log with from/to" and "Continuous 
trend" modules. The units specified in the integrated 
Mevas are not output in the header unless 
MODULE_UNIT = 1. Also valid for the "Query with 2 
time stamps (from/to)" module. The units of the 
integrated datapoint are output accordingly in the 
header. 

NO_DST Global parameter; usually configured by means of 
Database Setup. Daylight saving time YES (value = 
0) / NO (value = 1). Example: 0=Europe with day-
light saving time, or 1=China without daylight sav-
ing time. 

NURSE_CYCLE Cycle in ms during which "autonurse.exe" is 
launched 

NURSE_SEARCH_PATHS Path(s) scanned by "autonurse.exe" for existing sink 
files. The paths are separated by the '|' character 
(without single quote) 

NURSE_STORAGE_DAYS Specifies the number of days to expire before the 
imported sink files are deleted from the import fold-
er.  

NURSE_TABLE Specifies the table to use for entries (MSJO, or 
MSJO4) 

NURSE_TRANSFERID 1 for MSJO, 0 for MSJO4 
OLD_PASSWORDS_NUMBER User: Specifies the number of recent passwords that 

the system remembers to prevent redundant as-
signments by users. Example: The last three pass-
words may not be used to assign a new PWD. 

PASSWORD_ADMIN_EXPIRED_DAYS User: Specifies the number of days (z. B.: 90 days) 
after which administrators must change their pass-
word. 

PASSWORD_EXPIRED_DAYS User: Specifies the number of days to expire until 
the password must be changed. 

PASSWORD_FORBIDDEN_CHARS Password: Invalid characters in the password. 
PASSWORD_LANG_SPECIFIC_CHARS Password: Definition of valid country-specific special 

characters 
PASSWORD_MIN_CHARS Password: minimum character length of the pass-

word. 
PASSWORD_MIN_DIGITS Password: Minimum number of digits the password 

must contain. 
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Tab Functions 
Database (continued) PASSWORD_MIN_LANG_SPECIFIC_CHARS Password: Minimum number of country-specific 

special characters the password must contain. 
PASSWORD_MIN_LENGTH Password: minimum length of the password (>= 

MIN_CHARS+MIN_DIGITS+MIN_PUNCT_MARKS+MIN
_LANG_SPECIFIC_CHARS) 

PASSWORD_MIN_PUNCT_MARKS Password: minimum number of special characters 
the password must contain. 

PASSWORD_PUNCT_MARKS Password: Definition of valid special characters 
PLAUS_GAP_KKS Specifies whether or not to display the KKS text for 

the "Plausibility check gaps".  
0: No 
1: Yes 

PREPROCESSOR_DEBUG Specifies whether or not additional debug infor-
mation is entered in the error journal while online 
compression is activated.  
0: No 
1: Yes 
2: Yes (extensive debug information) 

PREPROCESSOR_ENABLE Activates the online compression of measured val-
ues during the import to Energy Manager. Online 
compression is only executed if one of the several 
compression functions have been configured at the 
corresponding datapoint.  
You can always run the compression functions by 
means of the "General recalculation" or "Compres-
sion of the measurement journal" jobs.  
0: No 
1: Yes 

PRINT_VOLLZUGS_MELDUNG Compress, expand: Defines whether or not to dis-
play completion reports.  
0: No  
1: Yes 

Productplan_limit Specifies the number of recent days for which users 
may still modify production plans.  

REPA_LOES_ADHOC_DEF Specifies the period for deleting storage folders of 
the type "ad hoc" for the "Storage folder deletion 
period defaults" job. All specifications in days. 

REPA_LOES_JAHR_DEF Specifies the period for deleting storage folders of 
the type "year" for the "Storage folder deletion peri-
od defaults" job. All specifications in days. 

REPA_LOES_MONAT_DEF Specifies the period for deleting storage folders of 
the type "month" for the "Storage folder deletion 
period defaults" job. All specifications in days. 

REPA_LOES_MONATVAR_DEF Specifies the period for deleting storage folders of 
the type "current month" for the "Storage folder 
deletion period defaults" job. All specifications in 
days. 

REPA_LOES_TAG_DEF Specifies the period for deleting storage folders of 
the type "day" for the "Storage folder deletion period 
defaults" job. All specifications in days. 

STP_HOTFIX Hotfix number: Set by the Database Setup during 
the Energy Manager Packages updates.  
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Tab Functions 
Database (continued) STP_LAST_UPDATE Date of last update: Set by the Database Setup dur-

ing the Energy Manager Packages updates.  
STP_SERVICE_PACK Service pack number: Set by the Database Setup 

during the Energy Manager Packages updates. 
STP_VERSION Version: Set by the Database Setup during the Ener-

gy Manager Packages updates. 
VERBOSE If > 0, additional debug information is written to the 

error journal during calculation of modules and 
mevas. Possible values are 0, 1, and 2; no debug 
information is entered if the value = 0, the most 
debug info is entered when the value = 2. 
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Tab Functions 
Appl. "Application 
Server" 

 
Open this tab to edit registry values on the "Application Server". 

 

 
The tab provides corresponding number and text input fields.  
Description of the various options: 
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Tab Functions 
Appl. "Application 
Server" 
 

Context Name Description 
SOFTWARE\Siemens\EnMPRO Autoprint Cycle Cycle in seconds for automatic report-

ing. In this cycle, the function checks 
whether to calculate or print the re-
ports, or transfer these by email in 
automatic mode. 

SOFTWARE\Siemens\EnMPRO 
\Error Reporter 

FileName File name (including the path) for 
error reporting on the application 
server. 

SOFTWARE\Siemens\EnMPRO 
\Error Reporter 

Trace level Depth of detail for error reporting. 
Range of values from 0 to 5. 
0: maximum detail depth.  

SOFTWARE\Siemens\EnMPRO 
\Error Reporter 

Trace On Off Info Description of the Trace Level value 
0: error reporting is enabled. Maxi-
mum scope of error information. 
1: error reporting is enabled. 
5: error reporting is disabled 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

HostName Host name of the PC running ExcelRe-
portServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

PortNumber Communication port of the ExcelRe-
portServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

Timeout Timeout in milliseconds for communi-
cation with the ExcelReportServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

Excel Print Timeout Wait state interval between two print 
jobs, initiated upon print job prob-
lems. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

Kill Excel Activation of Excel killer:  
If = 0: disabled. 
If = 1: enabled. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

Max. lines for pretty 
tables 

Limits the number of lines for Ex-
celReportServer at which the color 
coding of values is disabled automati-
cally (due to their value status). 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

PortNumber Port used to communicate with the 
ExcelReportServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

Set Cell Colors Specifies whether to enable or disable 
color coding of the report values 
based on their value status. 
0: disabled. 
1: enabled. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportServer 

Show Model Specifies whether to enable or disable 
the display of a selected report model 
in the report header data.  
0: Inactive 
1: Active 

SOFTWARE\Siemens\EnMPRO 
\Kernel 

Startup Delay Waiting time in milliseconds at the 
kernel start before the start of pro-
gram execution of the kernel. 
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Tab Functions 
Appl. "Application 
Server" (continued) 

SOFTWARE\Siemens\EnMPRO 
\Mail 

Mail Text Mail text template for automatic 
emailing 

SOFTWARE\Siemens\EnMPRO 
\Mail 

my email address Sender address that Energy Manager 
enters for automatic transmission.  

SOFTWARE\Siemens\EnMPRO 
\Mail 

SMTP server SMTP Server for automatic transmis-
sion of emails. 

SOFTWARE\Siemens\EnMPRO 
\Matrix 

TimestampsAlignLeft Defines whether to display a valid 
range instead of time stamps for ma-
trix value input.  
If = 0: disabled; "time stamp", e.g.: 
"01.10.2010 03:00:00" 
If = 1: enabled; "valid range", e.g.: 
"01.10.2010 02:00:00 - 
01.10.2010 03:00:00" 
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Tab Functions 
Client 

 
Use this tab to edit registry values on the "Client PC". 

 

 
The tab provides corresponding number and text input fields. 
Description of the various options: 
Context Name Description 
SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

EnableOutputFlags Concerns logging: Output flags that 
will be set. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

Log-
Files_DeleteLogsOlderT
hanDays 

Concerns logging: Maximum time in 
days of log file availability. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

LogFiles_RootPath Concerns logging: root directory for 
log files. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

Log-
Files_UntouchableFree
DiscSpaceInMb 

Concerns logging: minimum available 
hard disk space that is not affected by 
logging actions in log files. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

SendTraceOut-
put2LogFiles 

Concerns logging: enable output to 
log files. 
If = 0: disabled. 
If = 1: enabled. 
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Tab Functions 
Client (continued) SOFTWARE\Siemens\EnMPRO 

\DocLiber\Logging 
SendTraceOut-
put2TraceToolViewer 

Concerns logging: enable output to 
TraceToolView. 
If = 0: disabled. 
If = 1: enabled. 
This option requires an installation of 
TraceToolViewer that is independent 
of Energy Manager. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\Logging 

SuppressOutputFlags Concerns logging: output flags that 
will be cleared. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\PortalConnection 

Host Host name of the Portal computer. 
Caution: Do not modify this value 
unless you know exactly what your 
are doing. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\PortalConnection 

Port Port for use by the Portal for client 
connections. 
default is 4444. 
Caution: Do not modify this value 
unless you know exactly what your 
are doing. 

SOFTWARE\Siemens\EnMPRO 
\DocLiber\PortalConnection 

PortalName Portal name. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

HostName Host name of the PC running ExcelRe-
portServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

PortNumber Communication port of the ExcelRe-
portServer. 

SOFTWARE\Siemens\EnMPRO 
\ExcelReportClient 

Timeout Timeout in milliseconds for communi-
cation with the ExcelReportServer. 

SOFTWARE\Siemens\EnMPRO 
\Matrix 

TimestampsAlignLeft Defines whether to display a valid 
range instead of time stamps for ma-
trix value input.  
0: disabled; "time stamp", e.g.: 
"01.10.2010 03:00:00" 
1: enabled; "valid range", e.g.: 
"01.10.2010 02:00:00 - 01.10.2010 
03:00:00" 

See also 
Mail settings (Page 309) 
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4.2.2 Configuration 
The "Energy Manager Configuration" dialog can be used to edit the connection settings of the 
Energy Manager Portal.  

On completion of the Energy Manager Setup, enter the connection settings once at the 
beginning of the startup process using the main menu: "File > Energy Manager 
Configuration".  

 

The "Energy Manager Configuration" dialog cautions you that modified connection settings 
may have a negative impact on the Energy Manager system functionality. Be careful when 
making changes! 
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You can edit the connection settings for the components that have been installed in the 
corresponding group settings.  

Table 4- 1 Energy Manager Configuration 

Option Description 
Portal Port number at which the Energy Manager Portal listens. 

The currently set port is displayed. Default is "4444". 
Select the "Restart" option to restart the Portal service with "OK".  
Both options are active once only and are disabled again at the next startup. 

Client Portal connection: 
"Computer": Name of the PC/server on which the Portal is running. 
"Port": Number of the port of the PC/server port on which the Portal is listening. 

 

 
"Use proxy": Activates use of a proxy server, through which communication with the portal is 
established.  
"Manual proxy configuration": Activates configuration of a proxy server. Enter its URL and the 
port. If you do not activate this option, the proxy server that is configured in the operating 
system will be used.  
"Use specific user login information": Activates entry of login data for the proxy server. 

You are always prompted to confirm your changes to connection settings. Your changes will 
be discarded of you click "No". 
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4.2.3 Account settings 

4.2.3.1 General 

Overview 
Enter the path in which the Account settings are stored in the "Archive basic directory" text 
box. 

 

See also 
Account settings (Page 311) 
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4.2.3.2 Password settings 

Overview 
Manage the password requirements in the password settings. For the "Password for Admin 
expires after (days)" and "Password expires after (days)" text boxes, you can enter a one to 
five-digit number. For all other numeric text boxes you can enter a one to two-digit number. 

 

See also 
Options (Page 374) 

Account settings (Page 311) 
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4.2.3.3 Data storage 

Overview 
In data storage you manage the duration in which you save the cyclically acquired data in the 
system. You also set the archiving behavior on expiry of the entered time. The archive 
directory displays the path under which the measured values of the cycle times are saved. 
You can only change the archive directory in the "General" tab.  

 

Managing the storage duration 
To manage the cyclically acquired data, follow these steps: 

1. In the 2nd column enter a numerical value for the storage period of the corresponding cycle 
time. 

The first column shows the available cycle times.  

2. Select the unit of the associated storage period in the 3rd column. 

3. Select the archiving behavior in the last column. If you select the menu command "Delete 
and export to file", the data is first archived and then deleted. If you select the menu 
command "Delete", the data is deleted from the system after expiry of the selected storage 
period. 

See also 
Account settings (Page 311) 
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4.2.3.4 Delete options 

Overview 
In the deletion options you set the duration after the expiry of which messages and alarms 
are deleted from the Logging Viewer. To enable the deletion process, select the respective 
check boxes. You can enter a one to six-digit number in the text boxes. The adjacent archive 
paths show you where the corresponding messages are stored. 

 

See also 
Account settings (Page 311) 
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4.2.4 Licensing 
The Energy Manager "Licensing" provides an overview of the currently used licenses as well 
as the available or missing licenses. 

Procedure 
1. Click the "Licensing" button in the menu bar under "File". 

 
The following information is displayed: 

• Datapoints: Number of used datapoints as well as the total number of available datapoints 
(including used ones). 

• Acquisitions: Number of used acquisitions and total available acquisitions. 

• Client: Number of currently used Energy Manager systems as well as total number of 
available Energy Manager systems. 

• Web clients: Number of currently used Energy Manager web clients as well as total 
number of available Energy Manager web clients. 

• Consumer: The presence of the additionally available license for the consumer 
functionality and the number of consumers licensed are indicated here. 

• Function packages: Additionally licensed function packages, such as Planning and 
Prognosis, are displayed here. 

Missing licenses, such as at a test license, are displayed in red. 
 

 Note 

Since you can use the licensed Energy Manager PROClient count as well as the licensed Web 
client count simultaneously on different computers (concurrent use), only the number of 
actively used licenses is displayed.  

If the user is not working actively in the Energy Manager PRO Client or in the Energy Manager 
PRO Web, the license is released again after a few seconds so that it is available again for 
other users. 
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4.3 Acquisition 

4.3.1 Architecture and interfaces 
The data you need for energy management often exist in different formats and systems: 

• Data from analog and digital measuring devices 

• Data from other production sites 

• Archived consumption data from the previous year 

In addition to the standard interfaces to Siemens products such as WinCC or PCS 7, Energy 
Suite and EE-Monitor, Energy Manager supports conventional standards so that you can 
acquire data from different sources: 

• Acquisition of energy and operational data from the field level via OPC or Modbus. 

• Acquisition of data from S7 controllers via SIMATIC NET. 

• Acquisition of data from measured value archives via OPC. 

• Acquisition of data from maintenance, production planning and ERP system databases. 

• Import of ASCII data from the company-wide file system, such as CSV or XML. 

• Manual entry of the measured and count value readings. 

Depending on the interface used, the data are either imported directly into the Energy 
Manager database or pre-processed in the acquisition component: 
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Acquisition components 
You can install the acquisition component on a separate computer. 

• The kernel acquires the values from the data sources and transfers them to the EnMPRO 
Acquisition Service. 

• The EnMPRO Acquisition Service stores these acquired values in files. Every data point has 
its own file. The files are stored in a folder for the current day. When the next day starts, 
new files and a new folder are created. 

• Files are created for totally 62 days. From the 63rd day, the oldest day is deleted. In this 
manner, the values of the data point are saved for 62 days. 

• With a minimum scan cycle time of 1 second, a file is 2 MB in size, and with higher cycles, 
correspondingly lower. 

• The acquired values are compressed in the EnMPRO Acquisition Service. The compressed 
values are temporarily stored in the local database of the acquisition component. 
Thereafter, the EnMPRO Acquisition Service synchronizes the local database with the MS 
SQL database. 
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Raw Files 

Acquisition cycle smaller than the first compression stage 

• The acquired measured values are written to the files, but not transferred to the SQL 
Server. 

• But the acquired measured values can be visualized in a chart of a data point so as to 
quickly and easily monitor the data acquisition in the Energy Manager. 

• Only the compressed values are present in the SQL Server. 

Acquisition cycle same as the first compression stage 

• The acquired measured values are stored on the SQL Server. 

• The acquired measured values and the compressed values are present on the SQL Server 
itself. 

• The acquired measured values are stored in the first compression stage and processed 
further there (for example, conversion to the consumption value). 
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4.3.2 Automatic acquisition 

4.3.2.1 Creating hardware 

Overview 
If you want to acquire data automatically with Energy Manager, you must map at least one 
acquisition component as object of the type "Hardware". An acquisition component is, for 
example, a PC or a mobile device (smartphone). You configure the data acquisition for this 
hardware in an additional step by means of a wizard. 

 

 Note 

The example project of the Energy Manager database already contains a "Hardware" object 
named "h_Siemens_PC" that is completely configured and enabled under "System > Customer 
> Data collection > Interfaces / Drivers". 

If you do not want to use the preconfigured object, disable the "Active" option. This will 
release the license that is bound to it.  

 

Procedure 
1. Select the folder in which the hardware is going to be created. 

2. Click "Add hardware" in the menu bar under "Acquisition > Automatic acquisition". 

The "Hardware" configuration dialog opens. 

3. Enter a name and, if necessary, a description. 

Recommendation: Also use the prefix "h_" as unique identification. 

4. Assign the PC or the mobile device to the "Hardware" object using the "..." button. 

 
  Note 

The name "localhost" is not permitted as computer name.  
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5. Select the "Active" option to use the hardware for data acquisition. 

6. Activate the type of acquisition component depending on the use: 

– Acquisition 

– Application server 

Only necessary if the application server is installed on the acquisition component.  

– Mobile device (is not required for the acquisition app) 

 

Result 
The "Hardware" object has been configured.  

 

 Note 

The acquisition ID is entered automatically under "Guid" when you have configured the 
acquisition component in the Energy Manager acquisition configuration. The acquisition ID 
uniquely identifies the connection between the Energy Manager Server and the acquisition 
component. 

 

See also 
Configuring a mobile device in Energy Manager (Page 927) 

Configuring acquisition components per wizard (Page 400) 

Creating data sources (Page 244) 

Connecting acquisition components to server (Page 400) 
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4.3.3 Connecting acquisition components to server 

4.3.3.1 Configuring acquisition components per wizard 

Overview 
In the Energy Manager acquisition configuration you establish the logical connection 
between the acquisition component (Acquisition) and the Energy Manager Server (Pairing). 
The Energy Manager acquisition component is installed together with the "Energy Manager 
Acquisition" software component. The acquisition component supports communication via a 
proxy server.  

You can configure the connection to the Energy Manager Server either by using the wizard or 
manually. 

• Configuring the connection manually 

You can configure the connection to the Energy Manager Server with or without access to 
the Energy Manager Server. The connection is created when saving the configuration 
data. If the Energy Manager Server cannot be reached, the configuration is saved locally. 
Upon restarting the Energy Manager acquisition configuration, an attempt is made to 
establish the connection using the saved configuration.  

• Setting up a connection using the wizard 

Configuration with the wizard requires a connection to the Energy Manager Server. The 
wizard performs a step by step check of the connection data that have been entered. 

Configuring the connection using the wizard 
You need the following data to log the acquisition component in to the Energy Manager 
Server: 

• Address and port of the Energy Manager Server 

• Energy Manager user name and password 

• Name of the "Hardware" object in Energy Manager 

Requirement 
• The "Energy Manager Acquisition" software component is installed on the PC. 

• Microsoft Internet Information Service (IIS) is installed on the PC. 

• The PC is connected to the Energy Manager Server. 

• The "Hardware" object is set up on the Energy Manager Server. 

• A user with the "Configure acquisition" authorization is set up on the Energy Manager 
Server. 

• For communication via proxy: 

– A proxy server must be available in the network. 

– The URL and login data must be known. 
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Procedure 
1. Start the web browser on the acquisition component and enter the following address: 

http://[COMPUTERNAME]/EnMPROAcquisition/Login.aspx 

 
2. Log on with the operating system user under which Energy Manager was also installed. 

The "Status" page of the Energy Manager acquisition configuration is displayed. If the 
acquisition component is not yet logged in to a Energy Manager Server, the "Configure the 
acquisition" dialog is displayed. 

 
3. Select the "Start connection wizard" option in the "Configure the acquisition" dialog. 

4. Enter the following connection data: 

– Address and port of the Energy Manager Server 
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5. As needed, select "Configure proxy settings", and enter the following connection data 
depending on the configuration of the proxy server: 

– Address and port of the proxy server 

– User name and password 

– Click on "Test connection". 

6. Enter your Energy Manager user name and password and click "Login". 

 
An acquisition ID is allocated and the name of the acquisition computer is displayed. 

 
7. Save your entries. 

Result 
The "Acquisition ID" is generated and entered for the connection between the acquisition 
component and the Energy Manager Server.  

The figure below shows a correctly configured connection to the Energy Manager Server: 

 

See also 
Areas in the Energy Manager acquisition configuration (Page 407) 
Creating hardware (Page 398) 
Setting up users (Page 672) 
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4.3.3.2 Configuring the acquisition component manually 

Overview 
The connection to the Energy Manager Server can be configured both with and without 
access to the Energy Manager Server . The connection to the Energy Manager Server is 
established when the configuration data are saved. If the Energy Manager Server cannot be 
reached, the configuration is saved locally. Upon restarting the Energy Manager acquisition 
configuration, the connection is restarted using the saved configuration.  

Requirement 
• The "Energy Manager Acquisition" software component is installed on the PC. 

• Microsoft Internet Information Service (IIS) is installed on the PC. 

• The PC is connected to the Energy Manager Server (optional). 

• The "Hardware" object is set up on the Energy Manager Server. 

• A user with the "Configure acquisition" authorization is set up on the Energy Manager 
Server. 

• For communication via proxy: 

– A proxy server must be available in the network. 

– The URL and login data must be known. 

Procedure 
1. Start the web browser on the acquisition component and enter the following address: 

http://[COMPUTERNAME]/EnMPROAcquisition/Login.aspx 

2. Log on with the operating system user under which Energy Manager was also installed. 

The "Status" page of the Energy Manager acquisition configuration is displayed.  

If the acquisition component is not yet logged in to a Energy Manager Server, select the 
"Manually configure connection" option in the "Configure the acquisition" dialog that is 
displayed. 

3. Enter the following connection data in the "Settings" area: 

– Address and port of the Energy Manager Server 

– Energy Manager user name and password 

– Name of the "Hardware" object in Energy Manager 
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4. As needed, select "Configure proxy settings", and enter the following connection data 
depending on the configuration of the proxy server: 

– Address and port of the proxy server 

– User name and password 

5. Save your entries. 

Connection setup to the Energy Manager Server is started.  

If connection to the Energy Manager Server is not possible, your configuration is saved 
locally. Upon the next restart of the acquisition component, a connection will be 
attempted using the saved configuration. You can start the acquisition component once 
more by using "Start / Restart". 

Result 
The acquisition ID is generated and entered as soon as the Energy Manager Server can be 
reached. Connection setup is started again upon each restart of the acquisition component 
with the specified data. Provision of the acquisition configuration depends on the configured 
start delay time of the acquisition service.  

The figure below shows a correctly configured connection to the Energy Manager Server: 
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4.3.3.3 Managing the acquisition component 

Overview 
You use the web page of the acquisition component for the following tasks: 

• Start or stop acquisition service 

• Modify or reset the connection data 

• Configuring a proxy server for the communication 

• Execute the software update for the acquisition component 

 
① Navigation area 
② Display and configuration area. The content depends on the selection in the navigation area. 

Requirement 
• The Energy Manager configuration is displayed in the Web browser. 

• The acquisition component is connected to the Energy Manager Server. 

Start or stop acquisition service 
1. Click "Status" in the navigation area. 

2. Click the appropriate button. 

If the acquisition service is stopped, data is not acquired. 
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Changing configuration settings 
1. Click "Status" in the navigation area. 

2. If you want to assign the acquisition component to another "Hardware" object, reset the 
acquisition service. 

3. If you want to change the user data, stop the acquisition service. 

4. Click on "Settings" or "Wizard" in the navigation area. 

5. Enter the connection data. 

Reset configuration settings 
1. Click "Status" in the navigation area. 

2. Click the appropriate button. 

The configuration settings of the acquisition component are deleted after confirmation. 
The acquisition component is not acquiring data any longer. 

3. Log the acquisition component in to a Energy Manager Server again afterward. 

Configuring a proxy server for the communication 
1. Click "Status" in the navigation area. 

2. Click "Configure proxy settings" 

3. Depending on the configuration of the proxy server, enter the following connection data: 

– Address and port of the proxy server 

– User name and password 

Updating acquisition software 
1. Click "About" in the navigation area. 

2. Enter the path and file name of the setup file under "Software update", for example, 
"C:\Installation\Setup.exe". 

3. Click "Update". 

The acquisition service is stopped and the acquisition software is updated. The acquisition 
service is started once again when the installation is complete.  

See also 
Configuring acquisition components per wizard (Page 400) 
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4.3.3.4 Areas in the Energy Manager acquisition configuration 

Layout of the Energy Manager acquisition configuration 
The figure below shows the layout of the Energy Manager acquisition configuration after 
login: 

 
① Navigation area 

• Status: Indicates the connection status of the acquisition component. 
• Settings: Displays the current configuration settings. 
• Wizard: Starts the wizard for input of the configuration settings. 
• Help: Opens the documentation on the Energy Manager acquisition component in PDF for-

mat. 
• About: Displays the installed software version. You can update the software version. 
• Logout: Displays the login window of the Energy Manager acquisition configuration again. 

② Display and configuration area. The content depends on the selection in the navigation area. 
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"Status" area 

 
The "Status" area of the Energy Manager acquisition configuration consists of the following 
areas: 

 
Area Entry Description 
Server connection - - 

Server Address Shows the name of the Energy Manager server. 
Status Displays the status of the connection to the Energy Manager Server. 

The following statuses are possible: 
• Green/online: The acquisition component is connected to the En-

ergy Manager Server. 
• Gray/offline: The acquisition component is not connected to the 

Energy Manager Server. 

Acquisition Service 
(Kernel) 
 

- - 
Status Indicates the acquisition state. 

The following statuses are possible: 
• Started: The acquisition has started and is running. 
• Stopped: The acquisition is stopped. 

Acquisition Name Displays the name of the hardware object. 
Acquisition ID Displays the acquisition ID which uniquely identifies the connection 

between the Energy Manager Server and the acquisition component. 
Current Date/Time OS Shows the current date and time of the PC on which the acquisition is 

running. 
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Area Entry Description 
Configuration Status - - 

Connection Configuration Shows whether the connection to the Energy Manager Server has 
already been configured. 

Current Acquisition Con-
figuration 

Displays the status of the current acquisition configuration. 
The following statuses are possible: 
• Received: The acquisition configuration has been successfully syn-

chronized with the Energy Manager Server. 
• Not Received: The acquisition configuration has not been success-

fully synchronized with the Energy Manager Server. 

"Settings" area 
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The "Settings" area of the Energy Manager acquisition configuration consists of the following 
areas: 

 
Area Entry Description 
Server - - 

Server Address Shows the name of the Energy Manager server. 
Port Shows the port of the Energy Manager server.  
 Displays the status of the connection to the Energy Manager Server. 

The following statuses are possible: 
• Green/online: The acquisition component is connected to the En-

ergy Manager Server. 
• Gray/offline: The acquisition component is not connected to the 

Energy Manager Server. 

Proxy server 
 

Configure proxy settings Indicates whether a proxy server will be used for the communication. 
The following statuses are possible:  
• Use system proxy settings: The proxy server that is configured in 

the operating system will be used. 
• Manual proxy configuration: Proxy server is manually configured: 

The server address and port are required. The type of authorization 
depends on the proxy server that is used.  

User settings - - 
 Energy Manager PRO user 

name 
Energy Manager user name 

 Password Password of the Energy Manager user (encrypted) 
Acquisition entry - - 
 Acquisition Name Name of the "Hardware" object 
 Acquisition ID Uniquely identifies the connection between the Energy Manager Serv-

er and the acquisition component. 

"Wizard" area 
The "Wizard" guides you through three steps for logging the acquisition component in to the 
Energy Manager Server. To run the wizard, the acquisition component must be connected to 
the Energy Manager Server. 
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The area of the wizard in "Step 1" contains the following entries: 
 
Entry Description 
Server Address Energy Manager Server name 
Port Port number of the Energy Manager server 
Proxy server Activates configuration of a proxy server. 
Status Displays the status of the connection to the Energy Manager Server.  
Test connection Checks the connection between the Energy Manager Server and the acquisition component. 

The next step is only displayed when the check is successfully completed.  
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The area of the wizard in "Step 2" contains the following entries: 
 
Entry Description 
User Energy Manager user name 
Password Password of the Energy Manager user (encrypted) 
Login Registers the user in Energy Manager. The next step is only displayed when the login is suc-

cessfully completed.  

 

The area of the wizard in "Step 3" contains the following entries: 
 
Entry Description 
Connecting new acquisition Shows only the "Hardware" type objects configured in Energy Manager under "Select acquisi-

tion" that have not yet been connected to an acquisition component.  
Replace existing acquisition Shows all the "Hardware" type objects configured in Energy Manager under "Select acquisi-

tion".  
Select acquisition Assigns the acquisition component to the "Hardware" type object configured in Energy Man-

ager.  
If you have enabled the "Replace existing acquisition" option, the existing assignment to this 
object is deleted.  

Save Generates the acquisition ID, which uniquely identifies the connection between the Energy 
Manager Server and the acquisition component.  

"About" area 
The "About" section of the Energy Manager acquisition configuration displays the software 
version installed on the acquisition component. 
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4.3.4 Configuring interfaces for data acquisition 

4.3.4.1 Acquisition wizard for interface configuration 

Overview 
Use the "Acquisition wizard" to configure the interface for data acquisition from a selected 
data source. Energy Manager supports the data acquisition via the following interfaces:  

• OLE DB 

• WinCC/PCS 7 

• S7 

• Modbus 

• FTP, sFTP 

• File Import 

• OPC DA, OPC HDA, OPC UA 

• Machines with SIMATIC EE monitor 

• Energy Suite Import 

• Simulation 

 

 Note 
SAT interface 

The SAT interface is only available upon request. Contact Siemens Customer Support.  
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Acquisition structure in the Client 
The acquisition wizard creates the following acquisition structure under the "Hardware" 
object:  

 
① Process:  

The process is created by the acquisition wizard and provides the configuration of the 
interface for the Windows service "Energy Manager PRO Kernel". The process contains the 
driver source, which in turn contains the driver itself. 

②, ③ Driver source and driver:  
Define the data transfer from the data source via the driver. 

④ IO buffer:  
The IO buffer contains the setting for the cycle time of sampling. An ASCII file is read in or 
measured values are requested from the data source according to this cycle time. In the 
case of the FTP, sFTP and File Import interfaces, the directory of the ASCII files is defined 
here. These settings are defined in the acquisition wizard. 

⑤ Datapoints that you created or selected during the configuration. 

Action overview 
The acquisition wizard guides you through the configuration of the interface. The following 
configuration steps are basically required for all interfaces after starting the acquisition 
wizard: 

1. Define the channel name 

2. Select the device configuration 

3. Configure the connection 

4. Define the datapoints 

5. Define the data transmission 

After this step, you can create another link or create the acquisition structure.  

6. Create the acquisition structure 
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Example 
The following example shows how to acquire data from a WinCC log via the "WinCC / PCS 7" 
interface using the acquisition wizard. 

1. Select the "Wizard..." command from the shortcut menu of the "Hardware" object. 

The "Acquisition Wizard" dialog opens.  

2. Select the interface. 

 
3. Enter the channel name and select the initial state for the acquisition: 

 



Administration  
4.3 Acquisition 

 SIMATIC Energy Manager PRO V7.2 - Operation 

416 Operating Manual, 12/2020, A5E38952754-AF 

4. Select the WinCC log from where the data is to be acquired: 

 
5. Select the logging tag with the values to be acquired. 

The corresponding datapoint is created automatically.  
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6. Define the transfer interval: 

 
Interim result: The connection is established to the WinCC log:  

 
7. Define an additional connection to another WinCC log with "New". 

- or -  

Create the acquisition structure with "Finish".  
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The following figure shows the acquisition structure created with the acquisition wizard:  

 

See also 
Creating hardware (Page 398) 

Location (Page 657) 

Assign time zone for acquisition or calculation (Page 662) 
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4.3.4.2 Display of cycle times of IO buffer and datapoint 
The cycle time in the datapoint is the update rate compared to the data source. 

• For interfaces with historical values (WinCC, OPC UA HA, OPC HDA, OLE DB, Energy Suite), 
the cycle time in the datapoint corresponds to the logging cycle in the data source. For 
example, with a 1 min WinCC log, the cycle time of the datapoint is also maximum 1 min. 

• For interfaces with online values (S7, Modbus TCP, OPC UA DA, OPC DA), the cycle time in 
the datapoint corresponds to the sampling of the process tag. 

• For the FTP, sFTP and File Import interfaces, the cycle time in the datapoint corresponds to 
the interval between the time stamps in the ASCII file. 

The cycle time of sampling in the IO buffer (transmission interval) defines the intervals at 
which the measured values are requested or ASCII files are retrieved. 

Relationship between the times 
• For interfaces with historical values: 

Cycle time in the IO buffer ≤ cycle time in the datapoint. A smaller cycle time in the IO 
buffer can be relevant for logs with large logging cycles if these logs do not receive new 
values punctually (e.g. 1 hour or 1 day). 

• For interfaces with online values and the ASCII interfaces: 

Cycle time in the IO buffer = cycle time in the datapoint. 

4.3.4.3 Time stamp of the measured values 
Time stamps for interfaces with historical values and for the FTP, sFTP and File Import 
interfaces are taken from the data source. 

Time stamps for interfaces with online values are formed via the local time of the acquisition 
component (Windows time of the PC on which the acquisition is installed). 

The following table shows all interfaces with the respective value used and how the time 
stamp is formed: 
 
Interface Historical and 

online data 
Only online data Time stamp 

OLE DB ✓  From the database 
WinCC ✓  From WinCC 
S7  ✓ Local time of acquisition 
Modbus TCP  ✓ Local time of acquisition 
FTP, sFTP and 
File Import 

✓  From the ASCI file 

OPC UA DA  ✓ Local time of acquisition 
OPC UA HA ✓  OPC UA server 
OPC DA  ✓ Local time of acquisition 
OPC HDA ✓  OPC HDA server 
EE monitor  ✓ Local time of acquisition 
Desigo CC ✓  From Desigo 
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4.3.4.4 Data acquisition via the "OLE-DB" interface 

Overview 
The "OLE DB" interface allows access to Excel tables as well as complex databases such as SQL 
Server or Oracle. You have to install the OLE-DB providers required for access separately, if it 
has not been installed with the Windows operating system. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via a unique identifier that is defined in the wizard. 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

• The OLE-DB data source can be accessed from the acquisition component. 

• You have knowledge of OLE-DB. 

• You have access rights in the SQL server. 

• There is a database table or database view that consists of at least three columns: 

– Column with the time stamps 

– Column with the values 

– Column with the identifier of a datapoint 

 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click on the "OLE-DB" entry. 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_OLE-DB". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 
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Select the device configuration 
1. Activate "Create user-defined configuration". 

Configure the connection 
1. Select the "OLE-DB Provider". 

2. Enter the "Connection String". 

Additional information on the Connection String is available on the Internet under 
"http://msdn.microsoft.com/de-de/library/ms254500(v=vs.110).aspx". 

3. Click on "Test connection". 

Server connection  
1. Enter a meaningful channel name for the IO buffer under "Interface name", for example, 

"IO_OLEDB". 

2. Select the table. 

3. Then select the columns which contain the data acquisition information: 

– Address of the datapoint that is to be acquired. 

– Acquired measured value 

– Time stamp of the measurement acquisition 

– Measurement acquisition state (optional) 

4. If necessary, enter those values under "Status mapping" which are to be recognized as valid 
in connection with the status selection. 

If you enter the value "0" under "Status mapping", for example, the values with status "0" 
are recognized as valid. Separate multiple entries with commas. 

Define the datapoints 
1. Click "New definition" under "New address". 

The "Datapoint" dialog opens.  

2. Enter a meaningful name for the datapoint. 

3. Enter the name of the datapoint from the table under "Datapoint ID". 

4. Activate the datapoint under "New address". 
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Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

2. To change the start of the acquisition period, activate "Overwrite TSP settings". 

Archive data from the defined start of the acquisition period until the interface was started 
are transmitted in their entirety. Current values since starting the interface will be 
cyclically transmitted depending on the selected interval. 

Result 
The acquisition structure for the "OLE-DB" interface is created below the "Hardware" object. 
Data acquisition starts once you have restarted the Energy Manager Kernel on the acquisition 
component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  
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4.3.4.5 Data acquisition via the "WinCC / PCS 7" interface 

Overview 
You use the "WinCC / PCS 7" interface to retrieve values from a process value log or 
compressed log. You need a separate channel for each log. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the logging tag in the WinCC log. 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server. 

• A WinCC client or WinCC single-user station is installed on the acquisition component. 

• A WinCC project is activated. 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click on the "WinCC / PCS 7" entry. 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_WinCC_ProcessValues". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

Browse WinCC 
1. Select the log whose data you want to retrieve. 

 

 Note 

You acquire count values by using a process value archive. 
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Define the datapoints 
1. Activate the logging tags whose values you want to retrieve. 

Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

2. To change the start of the acquisition period, activate "Overwrite TSP settings". 

Archive data from the defined start of the acquisition period until the interface was started 
are transmitted in their entirety. Current values since starting the interface will be 
cyclically transmitted depending on the selected interval. 

 

 Note 

To acquire data from a WinCC archive, the timestamps of the measured values must be 
rounded to the cycle. For 15-minute cycle values, for example, the timestamps must be 
rounded to 00:00:00, 00:15:00, 00:30:00 and 00:45:00 (hh:mm:ss). 

 

Result 
The acquisition structure for the "WinCC / PCS 7" interface is created below the "Hardware" 
object. Data acquisition starts once you have restarted the Energy Manager Kernel on the 
acquisition component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  

See also 
Creating a WinCC channel (Page 262) 
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4.3.4.6 Data acquisition via the "S7" interface 

Overview 
You use the "S7" interface to retrieve data from an S7 controller with the help of SIMATIC 
NET. You address the memory areas of the S7 controller absolutely. 

 

 Note 
Supported controllers 

The "S7" interface supports the following controllers: 
• S7-300 
• S7-400 
• S7-1200 

For an S7-1500, use the OPC UA DA server directly. You need an OPC UA license for the S7-
1500 for this purpose. 

 

The OPC DA server of SIMATIC NET is used for the "S7" interface. The settings for this 
OPC DA server are already contained in the acquisition component. This means that no 
further settings are necessary in the acquisition component. An S7 connection is configured 
in the acquisition wizard. The SIMATIC NET OPC DA server accesses the data blocks in the S7 
controller via the S7 connection. Additional configurations in STEP 7 are not required. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the address of the data blocks (e.g. DB18,REAL10) that is defined 
in the wizard. 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

• SIMATIC NET is installed on the acquisition component and licensed. 

• The access point "KERNEL" is configured in SIMATIC NET communication settings. 

• The"OPC settings" are configured in SIMATIC NET communication settings. 

• An understanding of addressing and communication with S7 controllers. 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "S7" entry. 
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Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_S7_ColorMixing_Consumption". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

Select the device configuration 
1. Activate "Create user-defined configuration". 

Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Connection name", for example, 

"IO_S7-CleaningStation". 

2. Enter the following data under "Acquisition": 

– Number of the CPU slot. 

– Connection Resource 

3. Enter the connection data to the S7 controller under "Partner": 

– Used interface 

– Address of the S7 controller depends on the selected interface 

– Numbers of the rack and the slot 

– Connection Resource 

Define the datapoints 
1. Click "New definition" under "New address". 

The "Datapoint" dialog opens.  

2. Enter a meaningful name for the datapoint. 

3. Under "Object" select the source from which you want to retrieve the values: 

– DB: Data block 

– I: Input 

– M: Bit memory 

4. Enter the "Data type", "Address" and "Bit no." depending on the "Object". 

The "number" is only relevant for the "DB" and identifies the data block.  

5. Activate the datapoint under "New address". 
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Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

Result 
The acquisition structure for the "S7" interface is created below the "Hardware" object. Data 
acquisition starts once you have restarted the Energy Manager Kernel on the acquisition 
component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  
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4.3.4.7 Data acquisition via the "Modbus" interface 

Overview 
You use the "Modbus" interface to retrieve data from measuring devices with Modbus support 
and Ethernet interface, for example, SENTRON PAC measuring devices. The "Modbus" 
interface supports the following modes: 

• Modbus TCP 

Additional information on Modbus TCP templates can be found on the Internet 
(https://support.industry.siemens.com/cs/de/en/view/109771884). 

• Modbus RTU over TCP 

Modbus RTU does not support Power Monitoring. 

Datapoints acquired by the following measuring devices are pre-configured in Energy 
Manager. 

• SENTRON PAC 2200 CLP 

• SENTRON PAC 3200 

• SENTRON PAC 4200 

• ET 200SP MF HF 

 

 Note 
Devices for separate listing of third-party consumption values 

The SENTRON PAC 2200 CLP device is required for separate listing of third-party consumption 
values. 

 

 Note 
Supported modules 

The ET 200SP MF HF device currently only supports AI Energy Meter modules.  
 

You define the addresses of the parameters for all other measuring devices using the 
associated operating instructions. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the Modbus register that is defined in the wizard. 

https://support.industry.siemens.com/cs/de/en/view/109771884
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Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

• TCP/IP connection data of the measuring device are available. 

• When Modbus RTU devices are connected, a Modbus TCP Gateway is connected in 
between. 

• The Modbus device can be reached via the network. 

• If a Modbus device template (Page 336) is present, the template is imported in Energy 
Manager. 

• Operating instructions of the measuring device are available1. 

• An understanding of the Modbus protocol1. 
1: Only required for manual configuration of a measuring device.  

Starting the wizard 
1. In the project tree of the Client , select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "Modbus" entry. 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_Modbus". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

Select the device configuration 
1. If you want to acquire data from a configured device, activate "Select device type from 

database". 

2. If you want to acquire data from any measuring device, activate "Create user-defined 
configuration". 
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Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Device name", for example, 

"IO_CleaningStation". 

2. Enter the TCP/IP connection data of the measuring device. 

3. Select the Modbus mode. 

The default port is entered. You can adapt the port number for specific devices.  

4. If the measuring device is connected with the acquisition component, check if it is available 
with "Test connection", if necessary. 

The Modbus protocol is used to establish the connection.  

5. Enter the address of the device in the "Slave address" field with a Modbus RTU over TCP. 

6. For an ET 200SP MF HF, enter the offset in the "Register Offset" field. 

 
  Note 

Register offset 

The pre-configured datapoints correspond to the EE@Industry E3 profile. The length of the 
profile for the AI Energy Meter is 53 Modbus registers.  

With an additional AI Energy Meter module, the register offset starts at 54.  

Via the register offset, you define the module from which data is acquired. 
 

Define the datapoints 
1. If you acquire data from a SENTRON PAC 3200 / 4200: 

– Activate the required parameters. 

The data point names are made up of the "Device name" and the "Parameter".  

2. If you are creating a user-defined configuration: 

– Click "New definition" under "New address". 

The "Datapoint" dialog opens.  

– Enter a meaningful name for the datapoint. 

– Enter the parameter addresses using the operating instructions of the measuring 
device. 

 
  Note 

The word sequence for 32-bit values and the byte sequence for 16-bit values are not 
clearly specified in the Modbus specification. Device manufacturers often use the "Big 
Endian" coding for 32-bit values. This coding is therefore the default in data point 
configuration.  

 

– Activate the datapoint under "New address". 
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Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

Result 
The acquisition structure for the "Modbus" interface is created below the "Hardware" object. 
Data acquisition starts once you have restarted the Energy Manager Kernel on the acquisition 
component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  

See also 
Creating a Modbus TCP channel (Page 264) 
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4.3.4.8 Data acquisition via the "FTP, sFTP" interface 

Overview 
You use the "FTP, sFTP" interface to read data from ASCII files of an FTP server. Correct 
configuration of the process, IO buffer and datapoint is important. After successful 
configuration, transfer of the ASCII files from the FTP directory to the Energy Manager 
acquisition component is carried out automatically after the cycle time of the IO buffer.  

After successful importing of the files from the FTP directory, these are initially stored in the 
%Install-DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer% directory.  

After successful insertion of the data into the database the files are stored in the %Install-
DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer%\imported directory. 

If insertion of the data into the database is not successful, the files are stored in the %Install-
DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer%\failed directory. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via a unique identifier that is defined in the wizard. 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server. 

• An FTP server is set up and accessible. 

• Connection data for the FTP server are available. 

• The time stamps in the ASCII file are ascending. 

However, it is possible that the subsequent ASCII files have older ascending time stamps. 

• The FTP server is started. 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "FTP, sFTP" entry. 
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Define the channel name 
1. Enter a meaningful name for the communication channel, for example "Acq_FTP". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

4. If the FTP server supports "sFTP", activate "Secure connection". 

Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Group name", for example, 

"FTP_S7-CleaningStation". 

2. Enter the connection data for the FTP server, for example "ftp:\\[Hostname[:Port]]\[FTP 
directory]". 

The port number does not have to be specified. If you do not specify a port number, "21" 
is used by default.  

The "FTP directory" is the directory in which the ASCII data are stored. 
 

  Note 

Ensure that there are no blank spaces in the FTP directory. Data acquisition is only possible 
with an FTP directory without blank spaces.  

 

3. For secure connections, you must enter the user name and password. 

4. Select the format in which the data exist in the ASCII files. 

 

 Note 

During the installation of Energy Manager an example file is stored in %Install-
DIR%\EnMPRO\GUI\ftp for each supported ASCII format. Information about the example files is 
available in the Reference in the chapter ASCII FTP formats (Page 845). 
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Define the datapoints 
1. Click "New definition" under "Access via address" 

The "Datapoint" dialog opens.  

2. Enter a meaningful name for the datapoint. 

3. The "Create datapoints" dialog opens. You can import data for several datapoints with one 
ASCII file. Create all the required datapoints and identify these under "Datapoint address" 
unambiguously with the designation of the datapoint in the ASCII file. The datapoint address 
is applied automatically in the datapoint. 

4. Select all the datapoints by means of a check box or click "Select all". 

5. Click "OK". 

Define the data transmission 
1. Select the data transmission interval for the IO buffer in which the acquisition component 

acquires the values. 

Result 
The acquisition structure for the "FTP, sFTP" interface is created below the "Hardware" object. 
The data acquisition starts automatically after the cycle time of the IO buffer. 

You can change the acquisition structure at any time with the wizard or add additional 
connections.  
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Configuration of process, IO buffer and datapoint 
In order to ensure correct FTP or sFTP import the following configurations are set 
automatically and may not be changed: 

• IO buffer: "Kernel" check box must be selected. 

 
 

• Datapoint: "Kernel" check box must be selected. 

 
 

 

 Note 

If the data of the ASCII file are not available in time-synchronous form, select the "Direct 
Insertion" check box at the Process. Otherwise no data are transferred. 
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The setting of the "Safe connection" check box at the Process is taken from the definition of 
the channel name and can be changed here, if required. 
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4.3.4.9 Configuring data acquisition via the "File Import" interface 

Overview 
With the "File Import" interface you read out data from ASCII files locally from your computer. 
Correct configuration of the process, IO buffer and datapoint is important. After successful 
configuration, transfer of the ASCII files from the local directory to the Energy Manager 
acquisition component is carried out automatically after the cycle time of the IO buffer.  

After successful importing of the files from the local directory, these are initially stored in the 
%Install-DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer% directory.  

After successful insertion of the data into the database the files are stored in the %Install-
DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer%\imported directory. 

If insertion of the data into the database is not successful, the files are stored in the %Install-
DIR%\EnMPRO\GUI\mcl\ftp\upload\%Name_of_IO-Buffer%\failed directory. 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via a unique identifier that is defined in the wizard. 

Requirement 
• The time stamps in the ASCII file are ascending. 

However, it is possible that the subsequent ASCII files have older ascending time stamps. 

• The FTP server is started. 

Starting the wizard  
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "File Import" entry. 

Define the channel name 
1. Enter a meaningful name for the communication channel, for example "Acq_FTP". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 
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Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Group name", for example, 

"FTP_S7-CleaningStation". 

2. Enter the directory in which the ASCII data are stored, for example"C:\EnMPRO\File_Import". 

 
  Note 

Ensure that there are no blank spaces in the directory. Data acquisition is only possible 
with a directory without blank spaces.  

 

3. Select the format in which the data exist in the ASCII files. 

 

 Note 

During the installation of Energy Manager, an example file is stored in %Install-
DIR%\EnMPRO\GUI\ftp for each supported ASCII format. Information about the example files is 
available in the Reference in the chapter ASCII FTP formats (Page 845). 

 

Define the datapoints 
1. Click "New definition" under "Access via address" 

The "Datapoint" dialog opens.  

2. Enter a meaningful name for the datapoint. 

3. The "Create datapoints" dialog opens. You can import data for several datapoints with one 
ASCII file. Create all the required datapoints and identify these under "Datapoint address" 
unambiguously with the designation of the datapoint in the ASCII file. The datapoint address 
is applied automatically in the datapoint. 

4. Select all the datapoints by means of a check box or click "Select all". 

5. Click "OK". 

 

Define the data transmission 
1. Select the data transmission interval for the IO buffer in which the acquisition component 

acquires the values. 

Result 
The acquisition structure for the "File Import" interface is created below the "Hardware" 
object. The data acquisition starts automatically after the cycle time of the IO buffer. 

You can change the acquisition structure at any time with the wizard or add additional 
connections.  
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Introduction 
In order to ensure correct File Import the following configurations are set automatically and 
may not be changed: 

• IO buffer: "Kernel" check box must be selected. 

 
 

• Datapoint: "Kernel" check box must be selected. 

 
 

 

 Note 

If the data of the ASCII file are not available in time-synchronous form, select the "Direct 
Insertion" check box at the Process. Otherwise no data are transferred. 
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4.3.4.10 Data acquisition via the "OPC-DA / OPC-HDA" interface 

Overview 
You use the "OPC" interface to retrieve the data provided by an OPC server. The "OPC" 
interface supports the OPC specifications "OPC-DA" and "OPC-HDA" as well as the following 
data types: 

• Integer 

• Float 

• Boolean 

The "OPC" interface converts the Boolean values "True" and "False" to "1" and "0".  
 

 Note 

You can select the values for the datapoints directly under the following prerequisites: 
• OPC server is installed on the acquisition component. 
• OPC server supports reading of OPC items. 

 

 Note 
OPC server is not installed on the acquisition component 

If possible, use "OPC TCP Tunnelling" software to establish the connection to the OPC server. 
Accessing an external OPC server via DCOM is not supported for security reasons.  

 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the datapoint name in the OPC server. 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

• OPC server and / or OPC client are installed on the acquisition component. 

• An understanding of addressing and communication with OPC. 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "OPC-DA" or "OPC-HDA" entry. 



Administration  
4.3 Acquisition 

 SIMATIC Energy Manager PRO V7.2 - Operation 

442 Operating Manual, 12/2020, A5E38952754-AF 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_OPC-DA". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Group name", for example, 

"IO_OPC-DA". 

2. Select the OPC server under "OPC-DA datapoints" or "OPC-HDA datapoints". 

3. If you have selected "OPC-HDA", select the "OPC-HDA aggregate type", if necessary. 

The acquired values are compressed accordingly, for example, the mean of the reading 
interval is formed.  

Define the datapoints 
Activate the required datapoints.  

The datapoint names are made up of the "Group name" and the "Datapoint".  

Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

2. Only for OPC-HDA: To change the start of the acquisition period, activate "Overwrite TSP 
settings". 

Archive data from the defined start of the acquisition period until the interface was started 
are transmitted in their entirety. Current values since starting the interface will be 
cyclically transmitted depending on the selected interval. 

Result 
The acquisition structure for the "OPC" interface is created below the "Hardware" object. Data 
acquisition starts once you have restarted the Energy Manager kernel on the acquisition 
component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  

See also 
Create OPC DA, OPC HDA, OPC UA channel (Page 255) 
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4.3.4.11 Data acquisition via the "OPC UA" interface 

Overview 
"OPC Unified Architecture" is a specification for the transmission of process values and archive 
data. Using the OPC UA interface, you read data from a server that supports the "OPC UA" 
interface.  

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the datapoint name in the OPC server. 

Security policy 
The OPC UA server uses the TCP/IP protocol for data exchange. For authorization, certificates 
are exchanged between server and client. In addition, you can encrypt the data traffic. 

 

 Note 

When configuring the OPC UA server, activate at least one "Security policy" and its associated 
"Security mode". Otherwise the OPC UA server and the clients will communicate insecurely. 

During the first access to an encrypted OPC UA server instance a certificate for encrypting the 
data is created. This certificate has to be accepted individually in the respective server 
product.  
• Siemens Simatic NET V15: By means of the "Siemens Communication Settings" software in 

the "OPC UA certificates" menu command. 
• Siemens WinCC TIA V15: Moving of the new certificates from the path "C:\Program Files 

(x86)\SIEMENS\Automation\SCADA-RT_V11\WinCC\opc\UAServer\PKI\CA\rejected\certs'" to 
"'C:\Program Files (x86)\SIEMENS\Automation\SCADA-
RT_V11\WinCC\opc\UAServer\PKI\CA\certs" 

 

To use the OPC UA server from the S7-1500 controller, activate the function "Permit access 
with PUT/GET communication from remote partner (PLC, HMI, OPC, …)" in the TIA Portal 
under "Properties > Protection > Connection mechanisms". 

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

• An OPC UA server is installed on the acquisition component. 

• The Discovery server for OPC UA is enabled as a windows service, and the URL is known. 

• Good knowledge of addressing and communication with OPC UA, and of authorization 
using security certificates. 

• The certificate exchange is provided for at the time that the interface is configured. 
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Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click on the "OPC UA" entry. 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_OPC-UA". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

Configure the connection 
1. Enter a meaningful group name for the IO buffer, for example, "IO_OPC-UA". 

2. Under the "Search address", enter the URL of the OPC UA Discovery Server. 

3. Click "Discover". 

All available OPC UA servers will be listed under "Import datapoints".  

4. Select the desired OPC UA server and click on "Connect". 

If the OPC UA server demands authorization, the "Server configuration" dialog will be 
opened.  

– Depending on the OPC UA server, either enter "User name / Password" or the "Token". 

5. If you have selected "OPC UA HDA access", select the aggregation type if necessary. 

The acquired values are compressed accordingly, for example, the arithmetic mean of the 
reading interval is formed. 

Define the datapoints 
The "Browse access points" dialog indicates the datapoints that are available on the OPC UA 
server. 

• Activate the required datapoints. 

The datapoint names are made up of the "Group name" and the "Datapoint". 
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Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

2. If you have enabled "OPC UA HDA", you can change the start of the acquisition period. For 
this, select "Overwrite TSP settings". 

Archive data from the defined start of the acquisition period until the interface was started 
are transmitted in their entirety. Current values since starting the interface will be 
cyclically transmitted depending on the selected interval. 

Result 
The acquisition structure for the "OPC UA" interface is created below the "Hardware" object. 
Data acquisition starts once you have restarted the Energy Manager kernel on the acquisition 
component.  

You can change the acquisition structure at any time with the wizard or add additional 
connections.  

 

 Note 

If you change the server address for an existing OPC UA server connection and you want to 
continue to acquire the measurement data, you have to restart the kernel. 

 

See also 
Create OPC DA, OPC HDA, OPC UA channel (Page 255) 
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4.3.4.12 Data acquisition via the "Machines" interface 

Requirement 
• The Consumer functionality is licensed separately. 

Overview 
With the "Machines" interface, the option exists to establish communication with consumers 
(e.g. CNC machines) via TCP/IP. During configuration of the interface, a communication port 
must be entered (specified by the respective consumers) on which the driver listens and the 
interface receives data. 

A previously created consumer template is used to automatically create a structure consisting 
of consumers, associated datapoints (defined as inputs in the consumer template), Mevas 
(defined as outputs in the consumer template) and optional Widget Dashboards and reports.  

The consumers actively send data in a report that is specified by the Energy Manager. The 
consumers register in Energy Manager using a frame consisting of the name and type of the 
consumer. During import in the acquisition wizard, the consumers are displayed grouped by 
consumer type. If no type is sent, the consumer is assigned to the "undefined" group. 

If the TCP/IP connection is disconnected or if no data is received for more than two minutes, a 
consumer must register again using a specified protocol so that data will be received in 
Energy Manager again.  

If necessary, consumers can also be created manually without the Wizard. Additional 
information on this is available in the section "Consumers and structured view (Page 591)" 

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via a unique identifier. The identifier is created in the 
communication block of EE monitor. 

Procedure 
The interface is created in two steps: 

Creation of the interface: 

1. First, in the project tree of the Client, select the "Hardware" object and select the "Wizard..." 
command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "Machines" entry. 

3. Enter a meaningful channel name, for example, "Machine_Interface". 

4. Select the country whose time zone is used for the time stamp of the acquired values. 
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5. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 

6. Enter the Listener IP port on which the data will be received. The IP Port is specified by the 
consumers. Click "Finish". The structure of the interface with process, driver source and 
driver is created below the hardware. 

Import and creation of consumers: 

1. In the project tree, click on the newly created "Process" object and select the "Wizard..." 
command from the shortcut menu. 

2. The "Acquisition Wizard" dialog opens again. Click on the channel name and then click 
"New". 

 
3. All registered consumers are listed by type. Click the type whose consumers you want to 

import or assign a template to. 
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4. Click "Template". 

Now, assign the following data to the consumers: 

– Template. Information on creation of consumer templates is available in the section 
"Load templates (Page 708)". 

– Location. Information on creation of a location is available in the section "Inserting the 
location or country (Page 659)". 

– Organization unit. Information on creation of an organization unit is available in the 
section "Inserting an organizational unit (Page 665)". 

Consumers cannot be created with assignment to a consumer template. 

If no location or no organization unit is assigned, these consumers cannot be created 
below the respective location or organization unit during automatic creation of the 
structure.  

 
The template is assigned to all consumers of the selected type. 

 
5. In the next step, select the "Data transmission interval". The interval specifies the cycle in 

which data is sent by the machine and received in Energy Manager. This also automatically 
sets the cycle time for the datapoint. Interval values below 15 minutes are automatically 
compressed to 15 minute values unless the "Compression" setting of the datapoint specifies 
that acquisition values are also to be archived as acquisition values. Additional information 
on automatic compression is available in the user manual. 
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6. A separate IO buffer is created for each consumer and can be customized here if necessary. 
Using "Edit" you can change the name of the IO buffer and the status (active, not active) and 
cycle time. Note, however, that the data transmission interval and the cycle time of the IO 
buffer should be consistent. The "Kernel" option in the IO buffer must be selected during 
creation of the consumer structure or consumer datapoints. 

Click "Finish". 

 

Result 
The acquisition structure, together with the datapoints defined as inputs in the consumer 
template, is created automatically below the IO buffer. 

The name of datapoints consists of the datapoint prefix "d_", and the name of the consumer 
and name of the input (datapoint). 
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In addition, the consumers are created below the defined location, including the inputs 
(datapoints) and outputs (Mevas) specified by the consumer template. If Widget Dashboards 
or reports were configured in the consumer template, these are also created in the 
corresponding folders. 

 

 

If an organization unit was selected during assignment of the consumer template, the 
corresponding structure is also created below this organization unit. 
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4.3.4.13 Data acquisition via the "Energy Suite Import" interface 

Overview 
Data acquisition via the interface "Energy Suite Import" corresponds to the interface "OPC-
UA". Therefore, import the values in accordance with Data acquisition via the "OPC UA" 
interface (Page 443). The "Energy Suite Import" interface offers the advantage that additional 
information from the WinCC archive of the Energy Suite is transferred to Energy Manager , so 
that this information no longer has to be configured manually in the datapoints. The 
following information is automatically applied from the field "Runtime Comment": 

• Type of the datapoint: 

– Counter Value 

– Energy value 

– Power value 

• Unit: 

– GW, m3, m3/h, hl/h, l/h, Nm3/h, kg, T, kg/h, t/h, Pcs, pcs/h, Wh, kWh, MWh, GWh, kW, 
MW. 

• Cycle time in seconds 

• End of counter range (overflow value) 

If there are no entries in the "Runtime Comment" field, the datapoints are filled with the 
Energy Manager PRO Standard entries (Others, kWh, 15 min).  

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the datapoint name in the OPC server. 

Procedure 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "Energy Suite Import" entry. 

3. Enter a meaningful "Group name" for the IO buffer, for example, "IO_Energy_Suite". 

4. Enter the URL of the WinCC Professional OPC UA server under "Discover URL". 

5. Click "Browse". 

All available OPC UA end points are listed under "Import Datapoints".  

6. Select the desired OPC UA end point and click on "Connect". 

If the server demands authorization, the "Server configuration" dialog is opened.  

– Depending on the server, either enter "User name / Password" or the "Token". 
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7. The "Browse Address Space" dialog indicates the datapoints that are available on the WinCC 
server. 

– Activate the required datapoints. 

The additional information is included in the string of the "Datapoint identifier" in the 
details for the datapoint and subsequently taken from it during the creation of the 
datapoint.  

The string from the WinCC Runtime Comment field consists of a header "EnS:" as well 
as a sequence of four digits. The sequence of the four digits is separated by a semi-
colon. This also applies to values that do not exist, for example: "EnS: 1;1179;900;;" 

The first digit specifies the type of the datapoint: 0 = Counter Value, 1 = Energy value, 
2 = Power value. 

The second digit specifies the corresponding unit of the datapoint, for example "1179", 
which corresponds to kWh. 

The third digit specifies the cycle time in seconds, for example "900", which 
corresponds to 15 minutes. 

The fourth digit specifies the end of counter range for the counter value, for example 
"999999.9". 

8. Select the interval in which the acquisition component acquires the values. The smallest 
cycle time occurring in the Energy Suite project is applied automatically as the cycle time. 
This can be changed if necessary. 

The acquisition structure for the "Energy Suite Import" interface is created below the 
hardware. 

Updating values 

If values in the Energy Suite have changed, you can update the datapoints in Energy 
Manager. 

1. Open the wizard by right-clicking the IO buffer. 

2. There is a button in the top right-hand corner of the dialog with which information can be 
loaded again. Information about new datapoints or ones no longer existing as well as all the 
additional information (datapoint type, unit, cycle time, end of counter range) are loaded. 

– Datapoints that already exist in the Energy Suite and in Energy Manager are displayed 
with a gray background and the check box is activated. The datapoint cannot be 
deactivated at this point. 

– Datapoints that no longer exist in the Energy Suite have a gray background and the 
check box is not selected. These data points are set automatically to not active in 
Energy Manager but not deleted during updating. 

– Datapoints that are added in the Energy Suite do not have a gray background, can be 
selected and be imported to the Energy Manager as already described above. 

See also 
Creating an Energy Suite channel (Page 259) 
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4.3.4.14 Data acquisition via the "Simulation" interface 

Overview 
You use the "Simulation" interface to simulate data acquisition.  

Requirement 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server and activated. 

Starting the wizard 
1. In the project tree of the Client, select the "Hardware" object and select the "Wizard..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "Simulation" entry. 

Define the channel name 
1. Enter a meaningful channel name, for example, "Acq_Simulation". 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data are acquired. 

– NOT ACTIVE: Data are not acquired. 

Select the device configuration 
1. Activate "Create user-defined configuration". 

Configure the connection 
1. Enter a meaningful channel name for the IO buffer under "Group name", for example, 

"IO_Simulation". 

Define the data transmission 
1. Select the interval in which the acquisition component acquires the values. 

Result 
The acquisition structure for the "Simulation" interface is created below the "Hardware" 
object.  

You can edit the acquisition structure at any time with the wizard.  
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4.3.4.15 Data acquisition via the "Desigo CC" interface 
Use the interface "Desigo CC" to read out the data saved on a Desigo CC system via the Desigo 
CC web service. Energy Manager supports Desigo CC V3.0.  

The link between the measured values of a process tag and the associated datapoint in the 
Energy Manager is made via the datapoint name in Desigo CC. 

Requirements 
• The "Hardware" object has been created. 

• The acquisition component is logged in to the Energy Manager Server. 

• The Desigo web server is online and can be accessed from the acquisition component. 

Start wizard 
1. In the project tree of the client, select the "Hardware" object and select the "Wizard ..." 

command from the shortcut menu. 

The "Acquisition Wizard" dialog opens. 

2. Click the "Desigo CC" entry. 

Define the channel name 

 

1. Enter a meaningful channel name 

2. Select the country whose time zone is used for the time stamp of the acquired values. 

3. Specify the status of the data acquisition on the acquisition component: 

– ACTIVE: Data is being acquired. 

– NOT ACTIVE: Data is not being acquired. 
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Defining the Desigo CC name 

 

1. Enter an unassigned group name in the text box "Group name". 

2. Enter the URL of the Desigo web server in the text box "Desigo Server". 

You can check the connection with the "Ping Service" button. 

3. Enter your access data in the text boxes "User name" and "Password". 

4. Click the "System IDs" button. Select the system ID with the required data points from the 
"System Id" drop-down list. 

5. Click the "Browse Series" button. 

Desigo CC Trend Series Browser 
1. Select at least one data point with the mouse pointer. You can use the <CTRL> or <SHIFT> 

keys to select several data points. Click the "OK" button. 

Creating data points 
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All selected data points are listed in the left-hand area. 

1. Select all data points for data acquisition. 

The selected data points are displayed in the right-hand area together with an "Edit" 
button for each one. 

2. To edit a selected data point, click the "Edit" button of the corresponding data point. 

The "Data point" dialog box opens. 

 
3. To edit the data point name, enter the desired name in the "Data point name" text box. 

4. To edit the data point identifier, enter the desired identifier in the "Data point address" text 
box. 

5. Click the "OK" button. 

Select transmission interval 

 

1. Click the "Continue" button. 

The dialog box "Select transfer interval" is opened. 

2. Select the interval in which the acquisition component acquires the values from the "Define 
data transmission interval" drop-down list. 

3. To import the data from a particular time, activate the check box "Overwrite TSP settings". 
Enter the required time in the "Retrieve data since" text box. 

Overview of channels 
1. To create a new group for the channel, click on the "New" button. 

For this group, repeat all steps from the section Define Desigo CC name. 

2. To edit a group, select the corresponding group and click on the "Edit" button. 

3. To delete a group, select the corresponding group and click on the "Delete" button. 

Result 
The Desigo CC channel is created with all configured groups and data points. 

See also 
Creating a Desigo CC channel (Page 268) 
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4.3.5 Starting the kernel service 

Overview 
The kernel service acquires measured values cyclically and transmits them to the application 
server. The kernel service is automatically installed with the acquisition component of Energy 
Manager. 

 

 Note 

If you do not configure the kernel service properly, it prevents the automatic transfer of 
measured values to the application server. 

You must only restart the kernel service if you modify the configuration of the interface. If 
you add more data points or archives (WinCC), restarting the kernel service is not necessary. 

 

Requirement 
• The "Hardware" object has been created. 
• Interfaces are configured. 

Procedure 
1. Double-click the "Hardware" object in the project tree of the Client. 

The "Hardware" dialog opens. 
2. Click "Kernel". 

The "Energy Manager Kernel Service Cockpit" is opened. The status of the kernel service is 
displayed:  

 
 

 Active 

 Stopped 

 Undefined status 

3. Click "Start/Restart". 

Result 
Data acquisition is started or continued via the interfaces configured on the acquisition 
component.  

Alternative procedure 
You can also restart the kernel service for an acquisition component from the Service Cockpit. 
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4.3.6 Datapoints 

4.3.6.1 Creating data points 

Overview 
This section provides instructions related to the following actions: 

Creation and configuration of data points 

Data points are operating data points which receive their values directly from an interface 
(database interface, drivers, etc.). 

Requirement 
All necessary objects have been configured: hardware, driver source, process, drivers, IO area, 
etc. 
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Procedure 
1. Select the folder in which the data point is going to be created. 

2. Click the "Insert Measurement" button in the menu bar under "Acquisition > Datapoint". 

The "Datapoint" dialog opens. 
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• Fill out or parameterize the fields as follows: 

– Enter the "Name" of the measurement (data point type). Observe the naming 
conventions. 

– You can describe the measurement in more detail in the "Description" field. 

– You can enter a KKS or FIS number, or a user-specific text in the "Inventory No." field. 
This text will be output, for example, if the "KKS Text" mode is selected for a report. 

– Under "Ident. Token" you may enter an additional identifier. However, this ID is used 
only by a special import/export interface. 

– Select the "Process" from which the data is acquired. 

– Select the desired "Unit". 

– Select the "Input Unit" check box to use a unit for the manual input of matrix data. 

You may define the "kW" unit and the "MW" input unit. The value 500,000 W is then 
stored in the database with the notation "500 kW". The value is displayed or entered in 
the format 0.5 MW for manual matrix input. 

– Select "Measurement" at the function. 

– The type of the measured values is to be defined at "Type" in order to ensure correct 
calculation of the statistical values Minimum, Maximum, Average or Work and Power. 

– "Active" must be if the measurement is to be used (acquired) in the system. 

– The "Log to DB" check box is only set if the acquired values are transferred directly to 
the database without having been calculated. 

– "Kernel" must be activated if the acquisition component of this measurement can or is 
to be used. 

– "Priority High": The value of a datapoint cannot be modified through a matrix. 

– "Cloud relevant": If you want to export the measured values of the data point to 
MindSphere, select the "Cloud relevant" check box. You configure further settings for 
MindSphere in Energy Manager PRO Web. 

– The date fields "Creation Date"and "Valid at" are filled with the current date when the 
datapoint is created. The "Valid until" field is set to the default date 01/01/2500. 
Further functionalities are currently not associated with these fields. 

– The user who most recently modified the measurement configuration is entered 
automatically in the "Last changed by" field. 

– Under "Versioning" you can select whether the data of this measurement are entered 
versioned or not versioned. 

– In the "Cycle Time" field, enter the period during which the values will be available 
cyclically. For data points, this period is copied automatically from the cycle time entry 
specified the detail settings. 

– Under "Country", select the country whose time zone you want to use for the 
acquisition. 

– The replacement value is set to "NO" by default. The entries in the field "Replacement" 
and "Corrected until" are required for replacement value strategies. 
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– "Calculation Window and Unit": If "Historical value" is selected as the replacement 
value, you can define here how far back the calculation is to be effected. 

– The "Corrected until" date field is set automatically by a job after the measurement has 
been revised. The default is set to 01/01/2007. 

• Data point types: 

– "Generic" 

– "Datapoint" 

– "Constant" 

– "Derived" 

After having selected the "Datapoint" type, click "Details" to open the dialog for detailed 
configuration of the datapoint: 

 
"Name" and "Description" (corresponds to the short and long texts) are copied from the 
main dialog and displayed but cannot be edited in this dialog. 

Depending on the respective driver, the exact designation with which the values and the 
associated datapoint are linked must be entered as the "Address". 

Select the driver that acquires the data from the "Driver Source" field. 

In the "Cycle time" field, specify the interval for polling the values of this data point. 

You may enter a user-specific text in the "Comment" field. 

In the "IO Buffer" field, you can select all of the IO buffers that have been configured for 
the driver source selected (e.g. a separate IO buffer for each scan cycle). 

In the "Data type" field, you can select one of the types dty_float, dty_integer, 
dty_boolean, or dty_string (available only for OPC). 

The "Browse OPC Server..." button is activated if an OPC driver has been selected in "Driver 
Source". You can browse all OPC servers and their tags that are locally available on the 
acquisition computer running the acquisition kernel and enter these in the "Address" field 
with double-click. 
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  Note 

If you select a cycle time that does not match a compression level, only the values which 
were acquired while this cycle time was configured are displayed.  

If a cycle time is then selected which matches a compression level, a gap in the values 
arises. The gap corresponds to the data which was acquired with the cycle time that did 
not correspond to a compression level. 

For this reason, configure a compression level before you select the corresponding cycle 
time. 

You configure compression levels under "Compression".  
 

  Note 

An IO buffer should always contain data points with the same cycle time. Otherwise, data 
points with a higher cycle time will always be included in the scan cycle. 

 

1. Confirm your entries with "OK". The configuration dialog is closed. The object is now 
generated at the corresponding tree position. 

 

See also 
Creating data points (Page 277) 

Location (Page 657) 
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4.3.6.2 Creating generic data point 

Overview 
A generic data point does not receive its value directly from a particular interface, but from a 
different source. Such different sources could be ODBC connectors, matrices, or loops.  

Requirement 
• All software components are installed. 

• All necessary objects have been configured, e.g. the hardware, driver source, process, 
drivers, or the IO area. 

Procedure 
1. Select the folder in which the data point is to be created. 

2. Click the "Insert Measurement" button in the menu bar under "Acquisition > Data Point". 

The "Data Point" dialog opens. 
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3. Parameterize the fields. 

– Enter the "Name" for the measurement, taking naming conventions into account. 

– You may also enter a "description". 

– Enter the "Inventory N#". 

The inventory number is a KKS or FIS number. The inventory number is output if you 
select the "KKS Text" mode for a report.  

– Enter, if necessary, "Ident. Token" as additional identifier. 

The "Ident. Token" is used only by a special import/export interface.  

– You can select a "Process" that is not actively used for data acquisition, e.g. 
"a_erf_null", or "a_rech_PDS". 

– Select the physical unit. 

The unit may depend on the processing routine (loop), or on the lower-level data type.  

– Select the "Input Unit" check box and select the unit. 

The "Input Unit" is used for the manual input of matrix data.  

Example: You selected the "kW" unit and defined the "MW" input unit. The value 
500,000 W is stored in the database with the notation "500 kW". You can enter the 
value "0.5 MW" manually in the matrix.  

– Select "Measurement" from the "Function" field. 

– The type of the measured values is to be defined at "Type" in order to ensure correct 
calculation of the statistical values Minimum, Maximum, Average or Work and Power. 

– Enable or disable versioning of the data of this measurement using the "Versioning" 
drop-down list box. 

– Enter the "Cycle Time" for cyclic availability of the values. 

– Under "Country", select the country whose time zone you want to use for the 
acquisition. 

– Select the "Active" check box if the measurement is used in the system (e.g. loops). 

– Select the "Log to DB" check box to write the values returned from a loop to a 
database. 

– Select the "Kernel" check box to enable the use of the acquisition component of this 
measurement. 

– Select the "Priority High" check box to enable write protection for manual matrix input. 

– The substitute value" is set to "NO" by default. The entries in the field "Replacement" 
and "Corrected until" are required for replacement value strategies. 

– "Calculation Window and Unit": If "Historical value" is selected as the substitute value, 
you can define here how far back the calculation is to be effected. 

– Set the "Generic" radio button in the "Type" area. 

4. Confirm your entries with "OK". 



 Administration 
 4.3 Acquisition 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 465 

Result 
The configuration dialog is closed. The server object is now generated at the corresponding 
tree position. 

 
The current date is set in "Creation Date", "Valid from", and "Valid until" date fields when you 
create a new measurement. Further functionalities are currently not associated with these 
fields. 

Once the measurement has been corrected, the date and time are set automatically in the 
"Corrected until" field.  

The user name of a user who changes the configuration of the measurement is entered in the 
"Last changed by" field.  

You successfully configured the generic point and it is now ready for use. 

See also 
Location (Page 657) 



Administration  
4.3 Acquisition 

 SIMATIC Energy Manager PRO V7.2 - Operation 

466 Operating Manual, 12/2020, A5E38952754-AF 

4.3.6.3 Creating constants 

Overview 
A constant represents a special type of data point that is used as default for data acquisition 
or for generation of a substitute value. For example, if the averaging period of loops is set by 
means of a constant, a change to this constant will instantaneously change the averaging 
period of all loops concerned. Otherwise, you would have to parameterize each loop 
individually. A replacement value can be generated for each data point and may be used to 
substitute missing values, provided the "Substitute value" strategy has been selected. 

Requirement 
All software components are installed. 

Procedure 
1. Select the folder in which the constant is going to be created. 

2. Click the "Insert Measurement" button in the menu bar under "Acquisition > Data Point". 

The "Data Point" dialog opens. 
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3. Fill out or parameterize the fields as follows: 

– Enter the "Name" for the measurement (data type constant). Observe the naming 
conventions. 

– You can enter additional information on the measurement in the Description field. 
– In the "Inventory no." field, you can enter a KKS or FIS number or a user-specific text 

that is not intended for further use in constants. 
– In the "Process" field, select the process that is parameterized on the PC that has to 

work with this constant. 
– Select the physical unit. 
– The user who most recently modified the measurement configuration is entered 

automatically in the "Last changed by" field. 
– The "Corrected until" date field is irrelevant for constants. 
– The "Type" field does not have any effect at the constants. 
– The "Versioning" field is irrelevant for constants. Therefore, select "NO". 
– The cycle time, too, is irrelevant and can be set to one second. 
– Under "Country", select the country whose time zone you want to use for the 

acquisition. 
– Select the "Active" check box to enable the constant for use in the system. 
– Do not select the "Log to DB" check box, as the value is only read from the database but 

not written. 
– Select the "Kernel" check box to enable the use of this constant by the acquisition 

component. 
– The current date is set in "Creation Date", "Valid from", and "Valid until" date fields 

when you recreate the measurement. Further functionalities are currently not 
associated with these fields. 

– Under "Ident. Token" you may enter an additional identifier. 
– Select "Measurement" from the "Function" drop-down list box. 
– Keep the "NO" entry in the "Substitute value" field, as this function cannot be used for 

constants. Similarly the function "Calculation Window" and "Unit". 
– Select the "Constant" radio button in the "Type:" area. 
– After having selected the "Constant" type, click "Details…" to open the dialog for 

detailed configuration of the constant: 

 
– Enter the constant value. 

When using the constant as substitute value for the substitute value strategy, briefly 
change to the "Constant" type, enter the substitute value and then restore the previous 
type setting. 

4. Confirm your entries with "OK". The configuration dialog is closed. The server object is now 
generated at the corresponding tree position. 
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Result 
You successfully configured the constant and it is now ready for use. 

See also 
Location (Page 657) 
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4.3.6.4 Creating derived data points 

Overview 
Derived data points represent operating data points that are used to write MEVA results to 
the database. This means instead of being provided by a sublevel control system, the values 
are calculated directly in Energy Manager. Once calculated, the values are written back to the 
database again as separate data stream. 

Procedure 
1. Select the folder in which the data point is to be created. 

2. Click the "Insert Measurement" button in the menu bar under "Acquisition > Data Point". 

The "Data Point" dialog opens. 

 
3. Enter the general information on the data point. 

Do not activate the "Kernel" option. 
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4. Activate the "Derived" datapoint type and click "Details". 

The "Derived Measurement" dialog opens. 

 
5. Configure the derived data point as follows: 

– Under "From" and "To", enter a calculation time range. 

The "To" time can be in the future. 

– The "Calculated until" field shows the time up to which the derived data point is 
already calculated. 

– If you select the option "Future values" under "Categorization", the current 
compression interval of the data point is recalculated for every value. 

– If you select "real value" under "Categorization", the current compression interval of the 
data point is calculated after all values are acquired. 

– Activate "Automatic recalculation" to recalculate the derived data point if new or 
update values are available. 

– Select a compression level. 

The selected compression level is transferred to the configured measuring variable. 
This measuring variable calculates based on the values of the selected compression 
level. 

– In the "Offset" entry field, enter the value of the duration with which the start of the 
daily interval deviates from midnight. 

The daily values are calculated taking this deviation into consideration. If an Offset of 6 
hours is configured, for example, the daily values from 6 am to 6 am are calculated. 

– Click "OK". 

6. Click "OK" again. 

The derived data point is now generated at the corresponding project tree position. 
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7. Copy the required measuring variable, which includes the calculation rule for the derived 
data point, under the derived data point. 

 
 

  Note 

Automatic recalculation is discarded in the following situation: 

If a derived data point is recalculated manually using the "Recalculate" function, only the 
actual data point and its directly nested data points are calculated. Any data points at 
lower levels or data points above the actual data point are not recalculated. This rule is not 
valid for data points transferred via interfaces. 

 

8. Specify how to calculate the derived measurement. 

The following options are available: 

– Calculation in a report using a module 

– Automatic calculation 

To automatically calculate the derived measurement, activate the "Recalculate 
automatically" option in the details of the data point. 

 
  Note 

To reduce the system utilization, deactivate the "Recalculate automatically." option for 
derived data points whose automatic calculation is not required anymore. 

 

Result 
The derived data point is configured. 

See also 
Location (Page 657) 

4.3.6.5 Configuring versioning 
This section provides instructions related to the following actions: 

• Configuration of data point versioning 

All values are saved along with their date of creation if you are using versioning. By using this 
function, you limit the view to data on a specific date of creation. 

Requirement 
The data point has been properly created and configured. 
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Procedure 
1. Select the datapoint to be versioned in the Client. 

2. Select the "Edit" command from the shortcut menu of the data point. 

The "Data Point" dialog opens.  
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3. Select the required versioning type under "Versioning". 

– No 

No versioning. The time set entered last is saved in the system.  

 

– Yes 

All time sets are saved to the system, including the corresponding generation dates. 
The date and time of the system entry is displayed as version. 
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Result 
You successfully configured versioning for the data point and the function is now ready for 
use. 

When starting a report you can use the actual version or a maximum creation date. It is also 
possible to display all versions in the measured value editor. 
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The following example shows up to four dates/times at which data sets have been entered in 
the system (01/01/2003, 04/01/2003, 07/01/2003, and 10/01/2003) 

 
Values used for version date 02/01/2003: 
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Values used for version date 06/01/2003: 

 
Values used for the "actual version": 
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4.3.6.6 Configuring replacement value strategies 

Overview 
The following substitute value strategies are available for closing gaps in measured values or 
compressed values of a data point: 

• You can use the measured values of a different data point to eliminate gaps in the 
measured value series of a data point (AKS = Anlagen-Kennzeichnungs-System - Plant 
Identification System). 

• You can use fixed values to eliminate gaps in the measured value series of a data point 
(replacement value). 

• You can use past measured values of the same data point to eliminate gaps in the 
measured value series of a data point (historical value). 

• You cannot eliminate gaps in the measured value series of a data point (NO). 

• You can use the most recent valid measured value to eliminate a gap in the measured 
value series of a data point (LRU - last recently used). 

Requirements 
• The data point is configured. 

• The measuring journal contains at least one entry for the data point. 

Procedure 
1. Click "Edit" in the shortcut menu of the selected data point. 

The data point configuration dialog opens.  

2. Proceed as follows to eliminate gaps in the measured value series of a data point using the 
measured values of a different data point: 

– Select "AKS" under "Replacement". 

– Insert the other data point underneath the data point that contains the gap. 

3. Proceed as follows to eliminate a gap in the measured value series of a data point using a 
fixed value: 

– Select "Replacement value" under "Replacement". 

– Select "Constant" under "Type". 

– Enter the selected substitute value under "Details" and confirm the configuration with 
"OK". 

– Change back to the original type of the data point. 
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4. Proceed as follows to eliminate a gap in the measured value series of a data point using a 
past measurement value of the same data point: 

– Select "Historical value" under "Replacement". 

– Enter a count value under "Calculation window". 

– Select the time interval associated with the "calculation window" under "Unit". 

5. Proceed as follows to eliminate a gap in the measured value series of a data point using the 
last valid value: 

– Select "LRU" under "Replacement". 

6. Select "NO" under "Replacement" if you do not want to eliminate the gap in the 
measurement series of the data point. 

7. Activate "Replace invalid" to replace invalid measured values of the data point with the 
selected replacement value strategy. 

8. Select the time as of which you want to replace the gap under "Corrected until". 

9. Confirm the configuration with "OK". 

Result 
You have successfully configured the substitute value strategy for the data point.  

See also 
Job queue (Page 731) 

User jobs of the job queue (Page 839) 

Configuring replacement value strategies (Page 285) 
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4.3.6.7 Configuring counters 

Overview 
Counters represent operating data points that save count values instead of consumption 
values as measurement values to the database. Configuration information for the counter is 
required to ensure that differentiations in these counter states are correctly evaluated. 

Requirement 
The data point has been properly created and configured. 

Procedure 
1. Select the data point for which a counter is to be created and then select the "Edit" 

command from the shortcut menu to open the data point configuration. 

2. The "Measurement" configuration dialog opens. Select "Counter" to open the counter 
configuration. 

3. Select the counter type (e.g. active energy) and a location (e.g. consumer 117a). 

 
 

  Note 

The "Operating value" counter type may only be used for measured values which are 
acquired by the scanner functionality of the SIMATIC Energy Manager V1.0 app. The 
counter type is used for data points that record measured values instead of real count 
values to provide the device number that is necessary for identification. 
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4. Click New to create a new counting device for which the following information is required: 

 
5. In the "Counter number" text box, enter a unique number for this meter. If the counters are 

read with the Energy Manager V1.0 app and the barcode scanner, enter the barcode of the 
counter as the counter number. 

6. Enter a unique description for this counter in the "Description" text box. The suggested 
description is the description of the data point and the counter number. 

7. If you select "Only count up" from the "Counter type" drop-down list, all valid counter values 
are in ascending order. If a negative counter difference is calculated, the situation is treated 
as a counter overflow. 

8. If you select "Count up and down", valid counter values may be greater or less than the 
previous value. This option is suitable for level measurements, for example. 

9. In the "Installation Date" box, use the calendar to enter the time at which the counter was 
installed. This date is used as a reference for when counter values are valid. 

10.In the "Start Value" text box, enter the value of the counter at the time installation. 

11.Enter the counter constant in the "Constant" text box. 

The default setting of the counter constant is "1". The counter difference is multiplied by 
this constant. 
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12.Enter the start of the counting range in the "Range start" text box. 

13.Enter the end of the counting range in the "Range end" text box. 

14.If you enable "Cyclic reset", the counter is reset to zero if a value is less than the previous 
value. In this case, the difference is calculated as follows: 0 + current counter state 

15.In the "Value at replacement" text box, enter the value of the counter at the time of 
replication. 

16.If you enable "Filtering", enter the value in the "Lower limit" text box. All count values from 
this value onwards are filtered. All count values less than or equal to this value are treated as 
invalid. 

The limiting value is applied to the first compression stage.  

17.If you enable "Counter difference", enter the value in the "Lower limit" text box. If the most 
recently calculated difference is less than this value, the current counter value is treated as 
invalid. 

The limiting value is applied to the first compression stage.  

18.If you activate "Counter difference", enter a value in the "Upper limit" text box. If the most 
recently calculated difference is greater than this value, the current counter value is treated 
as invalid. 

The limiting value is applied to the first compression stage.  

19.The following fields have no function in Energy Manager and are for information purposes: 

– Range warning 

– Replacement 

– Comment 

– Manufacturer 

20.To create the counter, click "OK". 

Result 
The counter configuration of the data point has been successfully configured. 

See also 
Configuring counters (Page 282) 

Counter value filtering (Page 923) 
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4.3.6.8 Configuring the plausibility 

Overview 
Configure the datapoint limits that you want to use to monitor the limits of a measured 
value. 

You can configure different datapoint limits in the "Plausibility" dialog: 

 
① Upper limit, upper limit warning, lower limit warning and lower limit of a measured value 
② Time window after which it is checked whether the measured value series of a datapoint has 

gaps. 1 
③ Selection of criteria for datapoint comparison 
④ Entry in a message list if configured limits are exceeded 
1 Example for datapoint with "15 min" cycle time: The values are tested by the system at the 
full minute, for example, at 02:30:00 p.m. and not at 02:30:05 p.m. The system checks 
whether at least one value exists in the measured value series of the datapoint for the last 
cycle time + the defined period in the "Gap" field (15 min + 15 min = 30 min), for example, 
from 02:00:00 p.m. to 02:30:00 p.m. If no value exists, a message is generated. In addition, 
the affected datapoint is listed under "GAP Detection" in the Service Cockpit. 

If the cycle time of a datapoint is less than 1 minute, the number of values is also checked for 
completeness. 
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Example for datapoint with "10 s" cycle time: The values are tested by the system at the full 
minute, for example, at 02:30:00 p.m. and not at 02:30:05 p.m. The system checks whether 
at least one value exists in the measured value series of the datapoint for the last cycle time + 
the defined period in the "Gap" field (10 s + 1 min = 1:10 min), for example, from 02:28:50 
p.m. to 02:30:00 p.m. In addition, the number of values is tested for completeness for the 
last minute, for example, from 02:27:50 p.m. to 02:28:50 p.m. / 6 values per minute at "10 s" 
cycle time. 

Applications 
The limits of the measured values are evaluated for the following applications: 

• The measured values are marked in red following limit violations in the Energy Manager 
PRO Mobile app and in the matrix in the Energy Manager PRO Client and in the Energy 
Manager PRO Web. 

• Message lists 

• Module type for "Plaus. check deviation reference datapoint" report 

• Module type for "Plausibility check of gaps" reports 

• Module type for "Plausibility check of MIN/MAX" reports 

• At activated messages the high and low limits as well as the warning levels can be 
displayed in the Chart. 

Requirement 
The datapoint is configured. 

Procedure 
 

 Note 
Subsequent modification of limits 

Changes to the limit definitions only affect newly acquired data. Existing data is not updated.  
 

1. Click "Edit" in the shortcut menu of the datapoint. 

The datapoint configuration dialog opens. 

2. Click "Plausibility". 

The "Plausibility" dialog opens. 

3. Enter the required limits (upper limit, upper limit warning, lower limit warning, lower limit) 
for the measured value. 

4. In order to identify gaps in the measured value series of a datapoint, select the time delay 
after which a check is to made to determine whether a measured value has been acquired 
for the datapoint. 
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5. To compare the datapoint with a different period, (same datapoint but different period), 

– select the "Another Time Period" option in the "Compare With" area and 

– define the period with which the current period is to be compared. For example, enter 
"1" and "1 month" to compare the current month with the prior month. 

6. To compare the datapoint with a different datapoint, 

– select the "Reference Object" option in the "Compare With" area and 

– select a datapoint. 

7. Enter the lower limit and upper limit. Select the type of limits as "Absolute" or "%". 

– The entered upper limit defines the amount by which the value may be exceeded 
(value + upper limit) before a message is generated. 

– The entered lower limit defines the amount by which the value may be fallen below 
(value - upper limit) before a message is generated. 

8. Select the "Alerts" check box to generate a message in a message list at a violation of the 
configured limits. 

9. Click "OK". 

Plausibility check and compression functionality 
The following plausibility checks are available for entry values directly on the acquisition 
component:  

• Upper limit 

• Upper limit warning 

• Lower limit warning 

• Lower limit 

• Gap 

If a plausibility check is to take place and messages are to be generated, these must be 
activated in the datapoint with the "Plausibility" button. 

The acquisition component then checks the entry values for plausibility and sends a message 
via email or generates an entry in the message list, provided that the message list is 
configured correctly.  

The following plausibility checks in the "Compare With" area 

• Another Time Period 

• Reference Object 

• Upper Limit 

• Lower Limit 

can only be checked if the entry values are available on the server. For this purpose, the 
"Entry values" option must be additionally selected for the datapoint in "Compression".  

A detailed description of the additional functionality of the acquisition component is available 
in the SIMATIC Energy Manager - Acquisition system manual. 
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See also 
Module overview (Page 773) 

Configuring the plausibility settings (Page 283) 

Message lists (Page 722) 

Manual acquisition with Energy Manager PRO Mobile (Page 927) 
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4.3.6.9 Configuring compression 

Overview 
The acquisition component automatically compresses the acquisition values with an 
acquisition cycle that is smaller than or equal to one day. Acquisition values with a larger 
acquisition cycle are stored without compression directly at the Energy Manager Server into 
the database.  
The compression levels 1 minute, 15 minutes, 1 hour and 1 day are selected automatically 
when a data point is created (cycle time below 1 day), but can be deselected again, if 
necessary, using the "Compression" button. Acquisition values are compressed to the selected 
compression levels and saved in the database. This means that incoming 1-minute values, for 
example, are compressed to 15-minute values, 1-hour values and 1-day values, and the 
compressed values are saved in the database. Other compression levels can be selected 
additionally.  
A detailed description of the additional functionality of the acquisition component is available 
in the SIMATIC Energy Manager - Acquisition system manual. 

Procedure 
1. If you want to create additional compression levels or delete existing compression levels, 

click "Edit" in the shortcut menu of the desired datapoint. 

2. The data point configuration dialog opens. 

 
  Note 

Ensure that the correct "Type" is selected when creating the datapoint. This is necessary 
for correct calculation of the statistical values.  
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– Select "Power / Flow" if power values (e.g. kW) or flow rate values (e.g. m3/h) will be 
acquired in the data point. 

– Select "Energy / Amount" if energy values (e.g. kWh) or quantity values (e.g. m3/h) will 
be acquired in the data point. 

– Select "Count Value" if increasing count values will be acquired in the datapoint. 

– Select "Process Value" if process values (e.g. temperature, pressure) will be acquired in 
the data point. 

– Select "Others" for all other values. 

3. Click "Compression". You will see all automatically created compression levels. In the 
example below, all entry values (= 15-minute value) for a datapoint with a cycle time of 15 
minutes are automatically compressed to 1-hour and 1-day values. 

 
4. If you want to delete a compression level, select it and click "Delete". 

5. If you want to create an additional compression level, click "New". 

If you want to edit an existing compression level, click "Edit". 

 
– Specify the cycle to which compression is to occur (= Archive Cycle). 
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– Specify the values you want to compress (=Base Cycle). In the above example, the daily 
values are to be additionally compressed. 

– Specify the time in the past up to which the values are also to be compressed. 

If you edit an existing compression level, the time up to which the compression level is 
calculated is displayed in the "Compr. until" field. If you select an earlier time, the 
compression level is recalculated from this time. 

– Select "Active" for the compression. As an alternative to deleting existing compression 
levels, you can also deactivate them here. 

Confirm the configuration with "OK". 

Result 
You successfully configured compression of the measured values of the data point.  

See also 
Options (Page 374) 

Job queue (Page 731) 

User jobs of the job queue (Page 839) 

Acquisition categories in Energy Manager (Page 499) 
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4.3.6.10 Configuring the export function 

Overview 
The export functionality is used to provide measured value sets in a specified format to other 
system. The result may be a file that contains the measured value sets, table entries, or 
viewing by means of View VW_EXPORT_VIEW. 

 

 Note 

To use View VW_EXPORT_VIEW, you must be using your own Oracle version.  
 

Along with the data point configuration, you also need a corresponding database job.  

Requirement 
The data point has been properly created and configured. 

Procedure 
1. Select the data point for which the export function is to be created and then select the "Edit" 

command from the shortcut menu to open the data point configuration. 

2. The "Measurement" configuration dialog opens. Select "Export" to open the export 
configuration dialog. 

 
3. Click "New" to create a new export function for which the following information is required: 
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4. The name and description are transferred from the data point and cannot be edited 

Export function: Energy Manager PRO Standard, EDM Forecast, SAP PM VT historical 6h, 
SAP PM VVT historical 6h, VIEW 

Identification token: Used for identification in the partner system 

File name: Name of the output file  

Comment: Any descriptive text 

5. Click "OK" to generate the export function. 

 
6. Add the "Job for ASCII export Energy Manager PRO Standard" to the job queue to enable 

execution of the configured export function. 

It is not necessary to provide an active job for the VIEW export function, because as soon 
as a data point has been assigned to this export function, its data can be called by means 
of View vw_export_view. 

Result 
You successfully configured the export function(s) of the data point and these are now ready 
for use. 



 Administration 
 4.3 Acquisition 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 491 

4.3.6.11 Measurements editor 

Opening the measured value editor 

Overview 
You view existing measurement values in the measurement value editor. You can also 
change existing measurement values or enter new measurement values. You can export data 
from the measurement value editor or import data from ASCII files. 

Procedure 
1. Select the data point for which you want to request the measured data. 

2. Select the "Edit measured values" command from the shortcut menu of the data point. 

The dialog for defining the query period opens. 

 
3. Enter a start time in the "FROM" field. 

4. Do not change the default "AdHoc" setting in the "Polling type" field if you want to enter an 
individual end time. Enter the end time in the "TO" field. Otherwise, the end time is set 
automatically in the "TO" field, depending on the selected "query type". The time range is 
rounded at the same time, depending on the query type. 

5. If recorded data has been versioned, you can enter corresponding settings in the "Version" 
field. 

– If you keep the "Current" setting, the values of the current version will be displayed. 

– If you select "All", the values of all versions of the datapoint are displayed. 

– If you do not make a selection, you can access the previous versions with the "date 
time picker" selection dialog. 

6. For "Compression", select a compression level in order to display compressed values. 

7. Save your entries with "OK". 
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Result 
The measured value editor opens. The upper part shows the name of the datapoint and the 
time zone of the country of the datapoint and the selected query type. 

 

The measurement value editor shows the values of the compression level that you selected 
when defining the interval in the "Compression" field. For example, you can select the 
compression level "Daily values" for a datapoint with a cycle time of 15 minutes for the 
interval query and then see the compressed daily values in the "Sum" field in the 
measurement value editor. The order of the columns of the measurement value editor 
depends on the datapoint type. This type was previously set in the configuration of the 
datapoint. A distinction is made between the following data point types: 

• Power / Flow 

• Energy / Amount 

• Count Value 

• Process Value 

• Others 

A detailed description of the compression functionality of the acquisition component is 
available in the SIMATIC Energy Manager - Acquisition system manual. 

 

 

All values calculated automatically using the compression functionality of the acquisition are 
displayed: 

• Actual value in the Sum field (= entry value, daily value, monthly value, depending on 
selection in "Compression" field). 

• Average 

• Power or flow value 
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• Minimum value in compressed time period and associated time stamp (in this example, 
15-minute values were compressed to daily values) 

• Maximum value and associated time stamp 

 

The following fields are also displayed: 

• Version shows one of the following values: 

– No date No date is displayed in the current version of the measurement value. 

– A date Until this date, the measurement value is valid for older versions. 

• Last Value shows the last value of the counter if counts are acquired in the data point. 

• Acquisition Status 

• Correction Status 

• Entry Time shows the time of the entry in the database. 

Click "Up" or "Down" to page the monitoring interval up or down by one step.  

Select "Refresh" to reload the selected time range from the database.  

Select the "Insert", "Edit", "Remove", or "Manual Input" buttons to insert, edit, or delete values.  

Click "Close" to exit the measured value editor. 

Manipulating values 

Overview 
This section provides instructions related to the following actions: 

• Inserting, editing, and deleting values 

• Manual input 

• Data structure for measured values 

• Acquisition status 

• Correction status 
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Procedure 
1. To delete one or several measured values, select these accordingly and then click "Delete". 

2. To edit a measured value, select it accordingly and then click "Edit". 

 
3. The current entry is visible in the Details Area. Edit the selected values and click "OK". 

The "Corr.Status" entry is toggled automatically to "valid with manual manipulation". 

This result is displayed in orange color in all evaluations using this corrected value for 
calculations. This functionality allows you to clearly determine whether the result was 
modified by means of system input or manual manipulation.  

You cannot change the value of the sum of the values of data points configured as 
counters. 

4. Click "Manual input" if you want to supplement specific values. 

The "Manual data input" dialog box opens. 
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5. Supplement the data of the new value as follows: 

– Enter the selected period in the "FROM / TO" fields. 

– Enter the "Value". 

– Select the "Interval". 

– Enter the "Time Zone" and compression ("Compr."). 

6. Click "OK". 

Result 
All values entered, edited, or deleted in this way will be logged in the Logging Editor. 

Each value in Energy Manager is saved with the following data. 

• Time stamp 

• Time zone (daylight saving time) 

• Value 

• Interval (in seconds). 

• Duration (in seconds). 

• MinMaxTime (entered only by few functions) 

• Text (a data point configured for text input is entered in this field) 

• Acquisition status (entered by the data acquisition function) 

• Correction status (manual manipulation, adjustment jobs,..) 

• Compression level (acquisition values; other compression levels are not generated until a 
compression is carried out.) 

• Version date 

You can find the possible acquisition status with a brief description in the section "Acquisition 
status of a value (Page 761)". 

You can find the possible correction status with a brief description in the section "Correction 
status of a value (Page 763)". 
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Filtering in the measurement value editor 

Filter options 
Use the filter function for fast access to information. Click "Filter" in the measurement value 
editor to open the "Filter" dialog.  

 

Select the column from the first list. Select the operator from the second list. Additional 
entries are available in the third column, depending on the entry you selected in the first 
column. You may also logically link the filters by setting an "AND" or "OR" operation in the 
fourth column.  

Click "OK" to activate the filters. The result is displayed in the measurement value editor. 
Uncheck the "Filter" check box to cancel filtering.  

Exporting and importing process data 

Overview 
This section provides instructions related to the following actions: 

1. Exporting data 

2. Editing data 

3. Importing data 

Requirement 
• The measurement value editor is open. 
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Exporting data 
1. Select the desired data in the measured value editor. 

2. Click "Export". 

The Save As... dialog opens.  

3. Select a target folder and specify a file name. Click "Save". 

The selected data is saved to a text file in Energy Manager standard format.  
 

 Note 

When exporting data from Energy Manager, the export is marked with the version of Energy 
Manager. Export with the version is not taken into account in previous Energy Manager 
versions. An export or import of data is therefore only possible for identical Energy Manager 
versions. 

 

Data export is logged in Energy Manager. A corresponding export object is generated in the 
"Import/Export" folder. The data point whose values were exported is inserted under the 
export object.  

 
 

 Note 

The data of the entire display period is exported instead of only the selected data.  
 

Editing data 
1. Double-click on the export object to edit it. 

The export object will be opened in the corresponding application, e.g. Notepad or 
Microsoft Excel.  

2. Change the desired data. 

3. Save the file again in *.TXT or *.CSV format. 

Microsoft Excel replaces the separator ";" with a tab character.  

Importing data 
1. Click "Import" in the measurement value editor. 

The "Open" dialog opens.  

2. Select the file in Energy Manager standard format. 
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3. Click "Open". 

The data is now imported.  

If the data point is configured for saving values with versioning: All values entered are 
assigned a new version. If you import the data of a different data point, the following 
message is output: 

"Caution: MeasID inconsistent. Do you want to continue?"  

Confirm this prompt with "Yes", or cancel the import with "No". This message prevents you 
from accidentally overwriting the data of an incorrect data point.  

A plausibility check of the data is discarded if you run the import using the "Edit > Import 
measured values" command from the Energy Manager menu bar. 

The "Update type" dialog is opened if the data point is configured so that the data is saved 
without versioning. 

4. Select the option: 

– "INSERT": Inserts only values that are not yet available in the database. 

– "INSERT only new values": Inserts only values that are not yet available in the database. 
Use this option whenever possible when importing large data volumes. 

– "INSERT and UPDATE": inserts new values and overwrites existing ones. 

Result 
A message is displayed on successful completion of the import, for example, that 24 of 24 
data records were imported. The exported and imported data are recorded in the Logging 
Viewer depending on the configured "Verbose" level. 

Data import is logged in Energy Manager . A corresponding import object is generated in the 
"Import/Export" folder. The corresponding datapoint is inserted under the import object. 
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4.3.7 Acquisition categories in Energy Manager 

Overview 

 
In Energy Manager select a corresponding acquisition category for the acquired measured 
values of a measuring point. 

The following table provides an overview of the available acquisition categories: 
 

Acquisition cat-
egory 

Description 

Power / Flow • Use this category for acquired power values. 
• Energy Manager automatically calculates the consumption value from the power value. The con-

sumption values are then compressed using the summation function. 

Energy / Amount • Use this category for acquired consumption values. 
• The consumption value may be the energy consumption directly, media consumption or the pro-

duction quantity. 
• Energy Manager automatically calculates the power value from the consumption value. The con-

sumption values are then compressed using the summation function. 

Counter value • Use this category for acquired count values. 
• Energy Manager automatically calculates the consumption value from the count value. The power 

value follows from the consumption value. The consumption values are then compressed using the 
summation function. 

Process value • Use this category for acquired process values, e.g. temperature. 
• The acquired measured values remain unchanged and are compressed with the average value func-

tion. 

The acquired measurement values and the consumption values calculated from them are 
saved in the same data point. You therefore only need one data point. 
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Example: category Count value 
 
Time stamp Acquired count value With category Count value With category Energy 
06-16-2020 14:00 1000 kWh   
06-16-2020 14:15 1020 kWh 1020 kWh – 1000 kWh = 

20 kWh 
1020 kWh 

06-16-2020 14:30 1050 kWh 1050 kWh – 1020 kWh = 
30 kWh 

1050 kWh 

06-16-2020 14:45 1060 kWh 1060 kWh – 1050 kWh = 
10 kWh 

1060 kWh 

Total  60 kWh 3130 kWh 

The category Count value is the correct category. An incorrect category results in wrong 
compressed values.  

Example category Power value 
 

Time stamp Acquired power value With category Power value With category Process val-
ue 

06-16-2020 14:00 988 kW 988 kWh / 4 = 247 kWh 988 kW 
06-16-2020 14:15 920 kW 920 kWh / 4 = 230 kWh 920 kW 
06-16-2020 14:30 940 kW 940 kWh / 4 = 235 kWh 940 kW 
06-16-2020 14:45 980 kW 980 kWh / 4 = 245 kWh 980 kW 
Total  935 kWh 3828 kW / 4 = 957 kW 

Both the categories are possible with the acquired power value. If the Energy Manager has to 
convert the power value into a consumption value, the category Power value should be used. 
If the Energy Manager has to calculate the average power, the category Process value should 
be used. 
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4.3.8 Compression of the acquired measured values 

Compression of energy, power and count values 
In Energy Manager acquired measured values of the categories energy, power and count 
value are compressed on the basis of the consumption value. The sum function is used for 
compression of the acquired measured values. By default, the 15-minute value, the daily and 
monthly value are calculated using the sum function. 

In addition to the sum function, the maximum, minimum and average consumption of a 
compression level are also automatically calculated. 

 
 

Compression of process values 
In Energy Manager, acquired process values are compressed to the average of the process 
value. By default, the 15-minute value, the daily and monthly value are calculated using the 
average value function. In addition to the average, the maximum and minimum are 
automatically calculated for each compression level. If you want to calculate average power 
or the maximum and minimum power for each compression level, you can also use this 
category for power values. 
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4.3.9 Calculation of the compression levels 

4.3.9.1 Compression basis 
In Energy Manager there are two levels for the compression of acquired measured values. 
The first level comprises the selection of the correct compression function (sum or average 
value function). The second level comprises the database of the compression. With the 
second level, the following two database methods for compression are available: 

• Previous compression level as database 

• Acquired measured values of the data source as database 

4.3.9.2 Previous compression level as database 

Overview 
The values of the compression level are calculated using the values of the previous 
compression level. The values of the compression level "daily values" are calculated, for 
example, by the summation of the 15-minute consumption values within a day. Monthly 
values are calculated accordingly on the basis of the daily values. As fewer values are used for 
calculating the next compression, this method offers an efficient performance of your PC. 
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4.3.9.3 Acquired measured values as database 

Overview 
The values of each compression level are calculated on the basis of the acquired measured 
values of the data source. If the acquisition value is of the category power or count value, the 
associated consumption value is used for the compression level. Use this method if you want 
to determine the maximum power from the acquired measurement values, for example. 

 

4.3.9.4 Selecting a database 
You define the selection of the compression method in the configuration dialog of the data 
point of the measuring point. 

Requirement 
• The data point has been created. 

Procedure 
 To specify the compression method, follow these steps: 

1. Right-click on the data point of the measuring point in the navigation area. 

The shortcut menu opens. 

2. Click on the menu command "Edit". 

The data point configuration dialog opens. 

3. Click the "Compression" button at the bottom of the Configuration dialog. 

The "Compression" configuration dialog opens. 

4. To create a new compression level, click on the "New" button. 
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5. Select the required compression level from the "Archive cycle" drop-down list. 

6. Select the required compression level as database from the "Base cycle" drop-down list. You 
can choose between the compression levels "15-minute values", "acquisition values", "daily 
values" and "monthly values". 

7. To save the compression level, click the "OK" button. 

Result 
The desired compression level including the underlying database is selected and created. 
Select the database for each compression level from the "Basic cycle" drop-down list.  

If you select the previous compression level as the basis, use the method of the previous 
compression level as the database.  

 

If you select the entry "Acquisition values" as the basis for each compression level, you use 
the method of the acquired measured values of the data source as database. 
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4.3.10 Manual acquisition with the matrix 

Overview 
You use the "Matrix" object to manually enter data in the Energy Manager PRO Client and 
Energy Manager PRO Web. 
This section provides instructions related to the following actions: 
1. Configuring matrix objects 
2. Assignment of datapoints 
3. Possible datapoint configurations 
4. Data input 

 

 Note 

Only use manual acquisition for a peak load detection because it requires more computing 
power. 

With this configuration, the maximum value in each compression is the peak value of the 
acquired measured values. 

 

Requirement 
Datapoints have been created.  

Configuring matrix objects 
1. Select the folder in which the matrix object is going to be created. 

2. Click the "Insert Matrix" button in the menu bar under "Acquisition > Manual acquisition". 

The configuration dialog of the matrix object opens. 
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3. Enter a "Name", an optional "Description", and the "Query type". 

The query type determines the time horizon that is displayed in the matrix. Example: You 
have entered daily values in the course of a week. In this case, the query type used is 
"Week", and the "Cycle time" is 1 d for the days. The system automatically calculates the 
"FROM / TO" time period.  

4. Select the datapoint entry to display in the matrix header from the "Text Type:" list box. 

5. Select the "Cycle Time" as required. Ensure that this cycle time matches the cycle time of the 
datapoint. 

6. Adjust the "Corr. Status:" entry if applicable. 

7. Select the "Web Insert" check box to enable user input of values via the Web. 

8. Select the "Plausibility" check box if you want to enable the plausibility check function. 

9. Select the "Transposed" check box if you want to change the time axis from vertical to 
horizontal mode. The same procedure applies to the datapoint name. 

10.Select the "Acyclic" check box to enable the input of batch-related data in the matrix. Select 
the datapoint that contains the batch information from the "Charge Values" list box. 

11.Click "OK" to create the matrix object in Energy Manager. 

12.OK input saves the settings to the database and creates an object in the Energy Manager. 

 
13.Assign the datapoints to the matrix in the conclusive step. Ensure that this cycle time 

matches the cycle time of the datapoint. 

 
Provided the "Plausibility" function has been enabled, the "high limit" and "low limit" are used 
to check the plausibility of the datapoint configuration in the matrix. 

The following function types of the datapoint will affect the matrix: 

• "Event Measurement T1 spontaneous", "Event Measurement T1 cyclic", and the definition 
of the datapoint that contains the batch information 

You can find more detailed information on this in the section"Configuring "Batch analysis" 
reports (Page 552)". 

• "Text": The values entered are saved to a text field. 

• "Priority high": Although you may enter values in this datapoint, it is not possible to edit 
these values using the matrix. 

See also 
Options (Page 374) 

Matrix (Page 39) 
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4.3.11 Manual acquisition with the SIMATIC Energy Manager app 
Information about mobile data acquisition using SIMATIC Energy Manager App can be found 
in the section "Setting up mobile data acquisition with the SIMATIC Energy Manager app for 
iOS and Android (Page 151)" and in the section "Manual acquisition with Energy Manager 
PRO Mobile (Page 927)". 

4.3.12 Importing data 
For more information on data import, refer to the following sections: 

• via OLE DB: "Data acquisition via the "OLE-DB" interface (Page 420)" 

• via Measurements editor: "Measurements editor (Page 491)" 

• via matrix: "Manual acquisition with the matrix (Page 505)" 

• via ODBC Connector: "ODBC connector (Page 930)" 

4.4 Processing 

4.4.1 Preprocessing 

4.4.1.1 Basics for preprocessing 

Overview 
You can preprocess the measured values you import to Energy Manager before you save 
these to the database. For example, you can compress the acquisition values to daily values 
or calculate a conditional average value of different measurement series.  

Energy Manager provides two options for real-time pre-processing of measured values: 

• Compression of measured values  (Page 501)during import 

• Processing measured values with loops 

The processing of values before entering them into the database is known as "Preprocessing".  
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The following diagram illustrates the preprocessing of measured values imported to Energy 
Manager. You can use the loop concept to individually process or link the measured values of 
different data points: This allows you to calculate average, minimum and maximum values, 
for example. 

 

 
Data point 

 
Calculation module (Loop) 

 
Database entry 
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Compression of measured values during import 
You can compress the acquisition values in the import phase. This "Online compression" is 
activated by default. You then configure the selected compression functions in the data 
point. It is also possible to configure a substitute value strategy.  
As an alternative, you can compress acquisition values with jobs at any time, or recalculate 
compressed values.  
Application example: You import counter values in Energy Manager. The consumption values 
and daily consumption values will be calculated by differentiation during the import. 
See also: Compression of the acquired measured values (Page 501) 

Processing measured values with loops 
Loops are calculation functions that you apply to one or several data points. You can use 
loops, for example, to calculate or link measured value series of different recording periods. 
Energy Manager allows you to use preconfigured loops or to program your own calculation 
functions using the Measurement Compile Language (MCL) programming language. Energy 
Manager provides various calculation functions, for example, conditional recordings, 
extensive filter functions, trigonometric functions, logic operators, compare operations, or 
conversion operations. You can also map non-linear processes with unknown function rules 
or equations in the form of tables. Users with corresponding configuration authorization may 
always change data point assignments, calculation modules, and logic conditions by means 
of the user system. 
Application example: Conditional calculation of minimum, maximum and average values. The 
interval duration for the grouping function (e.g. ½ h), the measured values with 
corresponding interval duration, and the trigger input are set at the loop input for conditional 
calculation. The calculation is only initiated if the trigger input is set to active high state (=1). 
Results of the calculation are output for the corresponding period on the right side based on 
the conditional minimum, maximum and average values. 

 
This functionality is defined from the Client using MCL (Measurement Compile Language). 

Additional information 
The next chapters cover the "Preprocessing": 
• Creating and configuring data points 
• Creating and configuring loops 
• Creating prototypes 
• Functions for prototypes 
• Description of the MCL language 
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4.4.1.2 Configuring loops 

Overview 
This section provides instructions related to the following actions: 

• Creating loops 

• Configuring loops 

Requirement 
The necessary data points and prototypes have been successfully created in the system. 

Procedure 
1. Select the folder in which the loop is going to be created. 

2. Click the "Insert Loop" button in the menu bar under "Processing > Preprocessing". 

The "Loop" dialog opens. 

 
3. Enter the loop name in the "Name:" input field. The "l_" prefix must be added for loop 

identification. You may enter additional information in the "Description:" field. If available, 
you may also enter a KKS or FIS number as inventory ID. The current time is set by default 
for the date of initial creation of the loop. The logged on user is automatically entered in the 
"User:" field. Select the process that is to run the loop in the "Process:" field. This selection 
assigns the loop to a specific hardware. A separate process is usually created for loop 
calculations. Set the ACTIVE state in the "State:" field and select the "Active" check box. 
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4. Confirm your entries with "OK". 

The configuration dialog is closed. The server object is now generated at the 
corresponding tree position. 

 
5. Copy the necessary prototype and the data points/constants to be processed to the new loop 

structure. 

 
6. Select the new loop. Select "Edit..." from the shortcut menu. 

The loop configuration dialog opens. 

7. Select the prototype in the next step. 

 
The dialog displays the parameters and their type, depending on the respective prototype. 
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8. The real data points and constants are assigned to the parameters in the next step. Select 
the parameter to be assigned a measurement and click "Assign". 

 
9. The next window displays all measurements that are available. Select a measurement and 

confirm this with OK. 

 
The loop configuration is completed once you have assigned all data points or constants 
to the respective parameters. Exit the dialog with "OK". 
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10.You can click "MCL…" to check the appearance of the loop in the MCL language and how it is 
compiled by the Energy Manager kernel. 

 
11.The "Recompile" function can be used at runtime to modify an existing or active loop. 

Example: A different scaling factor needs to be assigned because it has been changed in the 
PLC. 

Result 
You have now configured a loop that is compiled during restart by the responsible kernel, 
saved to an mcl file, and assigned values that are calculated online. 
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4.4.1.3 Configuring prototypes 

Overview 
Prototypes represent the basis for loops. The algorithms are predefined and available for 
further calculations. 

Requirement 
Energy Manager was properly installed and the "p_test01" prototype is available. 

Procedure 
1. Select the folder in which the prototype is going to be created. 

2. Click the "Insert Prototype" button in the menu bar under "Processing > Preprocessing". 

The "Prototype Editor" dialog opens. 

 
3. Enter the prototype name in the "Name:" input field. The "p_" prefix must be added for 

prototype identification. You may enter additional information on the prototype in the 
"Description:" field. Specify the prototype's response by means of MCL declaration. Enter all 
necessary I/Os in the parameters. Click "New" and enter the "Name" and "Description". Select 
the output (out) or input (in) type and the order of transfer. Confirm your entries with "OK". 
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4. Once you have added all necessary I/O parameters, save the new prototype with "OK". 

 
5. Select "Edit" to edit existing parameter names and declarations. You may select "Delete" to 

delete parameters, or change their order with "Up" or "Down" (use with caution for existing 
loops). 

Result 
A new prototype is available and can be used to configure new loops. 

See also 
Operations for generating calculation blocks (prototypes) (Page 798) 

Description of MCL (Page 808) 
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4.4.2 Calculation 

4.4.2.1 Basics on calculation 
A measurement variable, also known as MEVA in the system, forms the basis for calculating 
the various parameters in the analyses and reports. 

MEVA concept 
• MEVAs are used to calculate KPIs / EnPIs 

• The object name MEVA stands for measurement variable 

• A MEVA consists of a function type that calculates a result based on the input values 

• Data points, parameters und MEVAs can be combined with one another with this object 

Therefore, the input values of a MEVA can originate from these three objects 

• The input data for the MEVA must be stored in the SQL Server (see "Architecture and 
interfaces (Page 395)") 

• The result of the MEVA can be stored in a derived data point or used in a report 

In addition, the result can also be used in a chart and a dashboard 

 

The outstanding advantage of this concept is that the MEVAs are only calculated for the data 
sets that are needed for analysis within a specific evaluation period. This approach leads to a 
drastic reduction of database memory and archiving requirements. 

The results of the MEVAs can be written to derived data points or be visualized directly in MS 
Excel. The quality of the values is color coded. 
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4.4.2.2 Measuring variable 

Overview 
This section provides instructions related to the following actions: 

• Creating a MEVA 

• Configuring a MEVA 

Requirement 
The necessary data points and parameters have been successfully created in the system. 

Procedure 
1. Select the folder in which the MEVA is going to be created. 

2. Click the "Insert Measuring Variable" button in the menu bar under "Processing > 
Calculation". 

The "Measurement Variable" dialog opens. 

 
3. Enter the MEVA name in the "Name:" input field. The "m_" prefix must be added for MEVA 

identification. You may enter additional information on the MEVA in the "Description:" field. 
If available, you may also enter a KKS or FIS number as inventory ID. Select a processing 
routine as function type (click Details to view a short description of the function). Select the 
unit that is derived from the processing routine and sublevel data points or MEVAs. 

4. Confirm your entries with "OK". 

The configuration dialog is closed. The server object is now generated at the 
corresponding tree position. 

 
5. Copy the data points, parameters, or MEVAs to the new measurement variable. 
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Result 
You have now configured a MEVA that you can use for further processing in reports or 
derived data points. 

See also 
Functions for measuring variables (Page 812) 

Creating MEVAs / KPIs (Page 301) 
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4.4.2.3 Parameters 

Overview 
This section provides instructions related to the following actions: 

• Creating parameters 

• Configuring parameters 

• Reading parameters by means of Meva 

Procedure 
1. Select the folder in which the parameter is going to be created. 

2. Click the "Insert Parameter" button in the menu bar under "Processing > Calculation". 

The "Parameters" dialog opens. 

 
3. Enter a meaningful name (t_xxx) and a description (optional). If you enter the substitute 

value 3.225, i.e., as long as no valid values have been defined, the value 3.225 is always 
returned for this parameter. 

4. Click "New" to open the dialog for editing the parameter values. 

5. Define the "Value" and the duration of validity. Save and confirm your entries with "OK". 
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6. The value entered is now displayed, can be edited using the "Edit" function, and be deleted 
again with "Delete". Moreover, you can add new values for additional time ranges. 

 
 

 Note 

For the following MEVA functions, you must also link the parameter with a parameter-MEVA: 
• Minus (ID: 1735) 
• Percentage (ID: 1739) 
• If Then (ID: 2746) 
• Difference from DP (ID: 2812) 
• Inventory change (ID: 2904) 

 

See also 
Measuring variable (Page 517) 

Parameters (Page 146) 

Parameter (Page 47) 

Creating parameters (Page 295) 
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4.4.3 Profiles 

4.4.3.1 Basic information on profile 
Based on the comparison day principle, you can generate media consumption forecasts at 
any time using a combination of master profiles, profiles, typical days, and special effects. 

The next chapters cover the following components: 

• Status 

• Typical days 

• Profiles 

• Master profiles 

4.4.3.2 Configuring states 

Overview 
States are used to set the default values for a typical day, or, for example, to distinguish 
between the days in the high tariff period (HT, value=1) and in the low tariff period (LT, 
value=0). These values are evaluated using special measuring variable functions. 

 

 Note 

The HT (high tariff) and LT (low tariff) states have already been generated as domain data 
and cannot be deleted. 

 

Procedure 
1. Select the folder in which the status is going to be created. 

 
2. Click the "Insert Status" button in the menu bar under "Processing > Profile". 
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The "Status" dialog opens. 

 
3. Enter a meaningful "Name" and optionally a "Description". 

4. Enter the required "Value" and its "Unit". 

5. Select a color, if necessary, and confirm with "OK". 

Result 
You have successfully configured the status and it is now ready for use. 

See also 
Configuring a shift (Page 522) 

4.4.3.3 Configuring a shift 

Introduction 
Use the "Shift" object to subdivide a day into several shifts. In addition you can use Status, for 
example, to assign different tariff information to each shift. If you use a "Shift" object beneath 
a query type, you can query time range by shift.  

Requirement 
Statuses have been created.  

Procedure 
1. Select the folder in which the shift will be created 

2. Click the "Insert shift" button in the menu bar under "Processing > Profile". 

The "Shift" dialog opens. 

3. Enter a meaningful "Name" and optionally a "Description". 

4. Select the time that will be interpreted as the "Day transition". 
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5. To define a shift, click "New". 

The "Shift status" dialog opens.  

6.  Enter the "Duration", and select the desired "Status". 

 

Result 
The "Shift" object has been created.  

See also 
Configuring states (Page 521) 

Configuring typical day (Page 523) 

Configuring query types (Page 703) 

4.4.3.4 Configuring typical day 
Typical days describe the progression of consumption for a defined consumption unit in the 
course of a day. Typical days can be used to forecast a "typical" future consumption.  

Alternatively, you can enter the different time periods of a day manually. Use this option to 
calculate a current or past actual energy consumption of a typical day.  

Requirement 
• The typical load distribution is known. 

• The necessary status or shift data has been created in the system. 
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Procedure 
1. Select the folder under which the typical day is going to be created. 

 
2. Click the "Insert Day" button in the menu bar under "Processing > Profile". 

 
The "Typical Day" dialog opens. 

 
3. Enter a descriptive "Name" and an optional "Description" and confirm your entries with "OK". 

4. Complete the same procedure for the remaining days of the week, including the necessary 
special days (holidays, special shifts, bridging days, production downtimes). 
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5. You can now enter the values manually for each typical day. Select "Insert…" to enter the 
status and the respective valid FROM-TO time range. 

Status corresponds with a default value that may be or has to be changed. 

This option is frequently used to handle slight periodic fluctuation of status values. 
Examples: "value 1" from 00:00 to 12:00 h and "value 2" from 12:00 to 24:00 h. 

 
6. The "fill" option is used to handle a smaller pattern of values, e.g. 1 h pattern. You may also 

specify a cycle time. 

However, in order to form a basis for a realistic forecast, the 1 h values are determined 
automatically by means of analysis report and written to the database. 

 

Result 
You have successfully created the typical day and it is now ready for use. 

See also 
Configuring a shift (Page 522) 



Administration  
4.4 Processing 

 SIMATIC Energy Manager PRO V7.2 - Operation 

526 Operating Manual, 12/2020, A5E38952754-AF 

4.4.3.5 Configuring profiles 

Overview 
A profile is used to configure the consumption of a typical week with the help of type days.  

You can employ two modes to configure a profile: 

• "Weekly": Configuration of a fixed sequence of seven days. In the "Weekly" mode, assign 
type days to the weekdays. The type day "Default" is assigned to a weekday by default. 

• "Day sequence": Configuration of a flexible day sequence. Select the type days for the "Day 
sequence" mode and specify their sorting order for the profile. 

 
  Note 

You must activate the calendar to enable the use of the "Day sequence" mode. 
 

Requirement 
The type day is configured. 

Procedure 
1. Select the folder below which you want to configure a profile in the structure tree of the 

Client. 

2. Click the "Insert Profile" button in the menu bar under "Processing > Profile". 

The "Profile" dialog opens. 

3. Enter a unique name and an optional description for the profile. 
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4. Proceed as follows to configure a profile on a weekly basis: 

– Select the "Weekly-based" mode. 

– Assign the weekday a configured type day of selecting the type day from the weekday 
selection list. 

– Click "Edit" click the type day. 

 
– Confirm the configuration with "OK". 
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5. Proceed as follows to configure a profile on a daily basis: 

– Select the "Daily sequence" mode and then click on "New". 

– Select one or several type days. 

 

– Confirm the configuration with "OK". 

– Select "Use" to activate the calendar. 

Result 
The profile is configured. Configure the holidays that you want to take into account for the 
profile. Open the calendar to edit the profile, or to display a graphic diagram of the profile.  

See also 
Configuring typical day (Page 523) 

Selecting holidays for profile (Page 529) 

Using a calendar for a profile (Page 530) 



 Administration 
 4.4 Processing 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 529 

4.4.3.6 Holidays and calendar 

Selecting holidays for profile 

Overview 
Select the holidays that you want to take into account for the profile.  

Requirement 
• The profile is configured. 

• You have configured the country and its regional holidays. 

Procedure 
1. Double-click the desired profile in the Client. 

The "Profile" dialog opens. 

2. If the holidays are to be treated as a type day, select the relevant type day under "Treat 
holidays as". 

3. Click on "Holidays". 

The "Holidays" dialog opens. 

4. To select a holiday of a specific country for the profile, click "New" and then select the 
corresponding country and its holiday. 

You can edit the selected holiday in the "Holiday profile" dialog. 

 
5. To select all holidays of a specific country for the profile, click "import" and then select the 

country. 

You can edit the selected holidays in the "Holidays import" dialog. 

 
6. Confirm the configuration with "OK". 
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Result 
You have selected the holidays for the profile. You can edit or delete the configured holidays. 

 

See also 
Configuring profiles (Page 526) 

Using a calendar for a profile 
To graphically represent or change a configured sequence, use the calendar in which shifts 
are rolled out. The average consumption for the same shifts is calculated in accordance with 
the calendar.  

Application example: You define a sequence with rollout for one quarter in the calendar. You 
can always respond to changes such as special shifts in the calendar. This functionality always 
keeps your consumption data and forecasts up to date. 

The calendar consists of the following components: 

• Detail view: Provides a graphic view of daily and shift information. The type days and 
shifts configured in the profile can be modified in the detail view. 

• Monthly view: Allows you to select one of several days for visualization in the detail view. 
You can use the <CTRL> or <SHIFT> keys to select several days. 

• Type day: Shows all shifts of typical days you have configured. 

Requirement 
The profile is configured. 
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Procedure 
1. Double-click the desired profile in the Client . 

The "Profile" dialog opens. 

2. Activate "Use" and then click "Calendar". 

3. To transfer the configured day sequence to the calendar, click "Rollout" and select the time 
range. 

The start date is set to Monday by default. 

 
4. Confirm the configuration with "OK". 

The day sequence is entered in the calendar. 

5. To select all shifts of a typical day, click "Select day elements" in the shortcut menu of the 
typical day. 

6. To delete a type day, click on "Delete day(s)" in the shortcut menu of the type day. 

7. To add a type day, select a type day under "type day", or drag-and-drop it to the calendar. 



Administration  
4.4 Processing 

 SIMATIC Energy Manager PRO V7.2 - Operation 

532 Operating Manual, 12/2020, A5E38952754-AF 

Result 
You can use the calendar for the profile. Deactivate the "Use" option in the "Profile" dialog if 
you no longer need the calendar. The rolled-out day sequence is retained in the calendar. 
Existing type days will be overwritten if you enter a new rollout for the same time range in 
the calendar. 

 

See also 
Configuring profiles (Page 526) 
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4.4.3.7 Configuring root profiles 

Overview 
A master profile specifies how to forecast media consumption based on different profiles in 
the course of the year. 

Requirement 
The necessary profiles have been successfully created in the system. 

Procedure 
1. Select the folder in which the master profile is going to be created. 

 
2. Click the "Insert Master Profile" button in the menu bar under "Processing > Profile". 

 
The "Master Profile" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description". Confirm your entries and generate 

the master profile with "OK". 
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4. Double-click reopens the editing dialog. Click "New" to select a profile for the period starting 
on January 1 and a time as of which a different profile is to be applied. Confirm with "OK". 

 
5. The selected profiles and FROM-TO ranges are now generated. You can edit and remove 

selected settings or add a new range. 

 
6. If a different period has been configured, the profile is valid as of the new FROM time. The 

TO time is set automatically at the previous profile. 

 
7. Confirm and complete the master profile configuration with "OK". 

Result 
You have successfully created the master profile and it is now ready for use. 
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4.4.3.8 Special effects 

Overview 
In preparation for the adjustment of the basic load profile, define corresponding parameters 
as a correction factor that takes long-term load changes (= special effects) into account. 

The correction factor adjusts the consumption value over time accordingly by a fixed value, 
e.g. an absolute power value in MW or kW that is added to the basic load profile. However, it 
is also possible to multiply the profile value by a specific factor. 

One of these parameters can be adjusted for calculation of a percentage increase , e.g. 
multiplication of the profile value by a specific factor. 

Requirement 
Successful installation of all software components. 

Procedure 
1. Create a parameter and specify its value, including the range of validity. 

 
2. When changing values or their valid ranges, you must recalculate the reports accessing 

these valid ranges of values. 
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3. Create the MEVAs that fetch the parameter values and distribute these to the respective 
modules for calculations or output. 

 
4. Select the "Parameter" function type and append the "_para" (for "Parameter") suffix to the 

MEVA name. 

 
5. Complete the MEVA configuration by connecting the parameter to the corresponding MEVA 

node. 

Result 
You have successfully created the measuring variable and the parameter for use as 
adjustment factors. 



 Administration 
 4.4 Processing 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 537 

4.4.4 Plants and product definition 

4.4.4.1 Basic information on plants and product definitions 

Overview 
Energy consumption is often decisively determined by individual large consumers or 
production lines at which various products or batches are produced. Moreover, individual 
production areas are frequently inappropriately synchronized from an energy aspect, or not 
at all. As a result, performance peaks and off peak times that may develop are often 
disadvantageous with regard to cost-efficient energy supply. 

As a consequence and in order to provide a realistic forecast of energy demands, it is 
indispensable to create and maintain a production plan for the entire plant or specific 
production areas and to integrate this plan into the load forecast. 

Energy Manager supports the creation and maintenance of a production and availability plan 
for entire plants (factory, production lines), or plant units (machinery, etc.). 

The production plan logs all production phases that may have a significant impact on energy 
demands. With regard to large consumers, it is usually sufficient to determine whether or not 
the plant is going to be in operation. The logging of downtimes and restricted availabilities is 
usually of particular significance. 

Moreover, it must be possible to plan production line throughput rates (items / time, quantity 
/ time) that have an impact on energy demands. 

In order to be able to determine the corresponding energy demand equivalent from the 
planned production sequence, it is necessary to create a model of the consumption 
parameters for the various production phases or types. 

 

Energy Manager supports you in the maintenance or modification of the model parameters 
(consumption parameters) in every production phase (e.g. downtime, special shift, 
production x). You can take the values of the model parameters, e.g. of the batch analysis. 
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These media-specific (electrical power, gas, heat, etc.) parameters form the basis for 
calculating load requirements in the respective production phase in accordance with the 
equation y = k*x+d: 

 
x Quantity 
y  Consumption, for example, electrical power (MW) 
d Section to y 
k Incline 

Authorized end users may adjust the individual model parameters of the production phases 
with the aim of improving the quality of load forecasting. 

The next chapters present the following contents related to production planning: 

1. Consumer type 

2. Material 

3. Plant 

Requirement 
• The license for energy prognosis and planning exist. 

• Successful installation of all software components. 

See also 
Forecasting based on production plan (Page 569) 
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4.4.4.2 Creating consumption types 
You need consumption types to create models of planned production sequences. These 
models are used to calculate the respective energy demands. The values for d and k are saved 
in the consumption type. If you do not know the values for d and k, you can determine the 
values via the report "Batch analysis" or the widget "Multi-variable regression analysis". 

Requirements 
• Production planning is properly installed. 

• The values for d and k are known. 

Procedure 
1. Select the folder in which the consumption type is going to be created. 

 
2. Click the "Insert Consumption Type" button in the menu bar under "Processing > Plant and 

Material". 

 
The "Consumption Type" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description". Confirm your entries and generate 

the consumption type with "OK". 
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4. Double-click reopens the editing dialog. Select "Insert..." to create the 1 (k) and 2 (d) 
parameters. 

 
5. You only need to define parameters 1 and 2. 

 
 

  Note 

Consumption types for electrical power, gas, steam_HD, steam_MD, and steam_ND have 
already been created as domain data. 

 

Result 
The consumption type has been successfully created and can now be used as consumption 
parameter in the product types. 

See also 
Forecasting based on production plan (Page 569) 

MultiRegression (Page 187) 

Batch and material-related analysis (Page 549) 
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4.4.4.3 Creating a material class 

Overview 
When you create a new material in the course of the production planning you can assign it to 
a specific material class.  

Procedure 
1. Click "Insert material class" in the menu bar under "Processing > Plant and Material 

definition". 

2. The "Material class" dialog opens. 

 
3. Enter a name and optionally a description. 

4. Save with OK. 

Result 
The new material class has been created. 
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4.4.4.4 Configuring material 

Overview 
Material (product types) in combination with consumption parameters (=consumption types) 
are required to calculate respective energy demands.  

Requirement 
The necessary consumption types have been successfully created in the system. 

Procedure 
1. Select the folder in which the material is going to be created. 
2. Click the "Insert Material" button in the menu bar under "Processing > Plant and Material". 

The "Material" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description". Confirm your entries and generate 

the material with "OK". 
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4. Double-click reopens the editing dialog. 

 
5. Click "New" to open the dialog for editing the consumption parameters. 
6. Select a consumption parameter, enter a value, and confirm your entries with "OK". 

 
 

  Note 

Consumption types for electrical power, gas, steam_HD, steam_MD, and steam_ND have 
already been created as domain data and cannot be deleted. You may create additional 
parameters as required. 

 
7. The value entered is now displayed, can be edited using the "Edit..." function, and be 

deleted again with "Delete". 
8. After values have been changed, the reports accessing these values must be recalculated. 

Result 
You have successfully created the material that is now ready for use in plants (production 
plans). 
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4.4.4.5 Configuring the plant 

Overview 
In order to calculate production-dependent forecasts, Energy Manager employs integral 
production plans (plants) that specify the production or the status of a factory, building, 
machine, etc. (= material). 

The forecast value of these materials is specified at the respective "Material" definition (in 
operation, standstill, revision, grade XXX, etc.). 

Requirement 
• Cyclic (monthly) and timely allocation of the plants (production plans), as far as 

production has an impact on load requirements. 

• The materials used (product types) have been successfully created in the system. 

• The production plan is only available if the license for energy prognosis and planning is 
available. 

Procedure 
1. Select the folder in which the plant (production plan) is going to be created. 

2. Click the "Insert Equipment" button in the menu bar under "Processing > Plant and Material". 

The "Production Plan" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description". Click "OK" to confirm your entries 

and to generate the production plan. 
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4. Double-click reopens the editing dialog. 

 
5. Select "New..." in the "Production Plan" tab to open the editing dialog. 
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6. Specify the following entries for the production plan: 

– Select the required lot type, e.g., Production of XXX, Plant is in revision, etc. 

– Select the product under "Material" and enter a description of the product, if necessary. 

– Specify the time span in which the product will be produced. 

– Specify in which quantity the product will be produced. 

– Enter the correction factor and the Z factor. 

– You may enter a comment if required. 

– Click "OK" to confirm your entries. 

 
7. The value entered is now displayed, can be edited using the "Edit..." function, and be 

deleted again with "Delete". 
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Importing production plans 
1. To import production plans from an Excel file to Energy Manager, click "Import..." and select 

the required Excel file. 

During an import from the Excel file, the existing data in Energy Manager are deleted in 
the respective production plan and new data are entered in the respective columns. 

If you define the production plan using an Excel file, the Excel spreadsheet must have the 
following structure: 

 
① The number of worksheets that are copied to the production plan are found in cell A2. 
② To activate correction factors, enter the value 1 in the cell A3. 
③ The name of the plant is found in cell A4. 
④ The column headers are found in line 5. 
⑤ The format of the time stamp is DD.MM.YYYY hh:mm. 
⑥ The name of the worksheet is the name of the plant. 
 

  Note 

Note that only the following entries are imported from the Excel file: 
• Entries in which the "TO" time stamp is in the future. 
• Entries in which the "FROM" time stamp is not older than five days. 

You can change the number of days under "Energy Manager Options > Database > 
Productplan_limit".  

Before the data import, the table contents in question are deleted and reentered.  
 

2. To automate the import process, use the predefined task "Production_Plan_Import" under 
"Configuration > TaskManagement". 

You can use this task, for example, to import the production plans from an Excel file each 
day at a specific time to Energy Manager. 
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Result 
You have successfully created the plant and its production plan and these are now ready for 
use. 

See also 
Options (Page 374) 

Functions for Task Management (Page 842) 

Forecast (Page 566) 

Task Management (Page 731) 
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4.4.5 Batch and material-related analysis 

4.4.5.1 Configuring data points for batch and material ID 
To carry out a batch analysis, you need a data point each for batch ID and material ID. 
The start and end time of a batch is calculated via the change of the batch ID. A batch ID must 
be saved in the data point for each time. 
For this reason there is a separate batch ID for the time periods between batches. The ID for 
this case is 0. 
The material ID specifies which material is produced in the batch and in which plant the batch 
is produced. 

Requirement 
• The data point has been created. 

Procedure 
To configure a data point for acquiring the batch ID or material ID, follow these steps: 
1. Open the shortcut menu using the right mouse button. 
2. Select the "Edit..." menu command. 

The "Data point" dialog box opens. 
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3. Configure the data point with the following settings: 

– Function: "Result measurement T1 spontaneous" or "Result measurement T1 cyclic" 

For further information on the functioning of the data point, read the section 
"Background: Batch-related data" in the section "Configuring "Batch analysis" reports 
(Page 552)". 

– Type: "Other" 

4. If you have created the data point manually, you also configure the following settings: 

– Process: Select the channel to which you want to assign the values of the data point. 

– Unit: Select the unit "1". 

– Data point type: Data point 

– Address: Enter the address that the driver uses to identify the data point. 

Result 
The data point is configured. 

See also 
Creating data points (Page 458) 
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4.4.5.2 Creating a plant variable 

Overview 
In the course of the plant definition or during the batch analysis you can also create a new 
plant variable.  

Procedure 
1. Click "Insert plant variable" in the menu bar under "Processing > Plant and Material 

definition". 

The "Plant variable" dialog opens. 

 
2. Enter a name and optionally a description. 

3. Save with OK. 

Result 
The new plant variable has been created. 
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4.4.5.3 Configuring "Batch analysis" reports 
The batch analysis helps you to evaluate the energy and media consumption for a specific 
batch or product per plant. The batch analysis also takes batches into account that are 
handled sequentially on several plants. 

The "Batch analysis" report provides you with a reporting module in Energy Manager, which 
you can use to evaluate the energy consumption per batch or material. 

The following figure shows the parameters that you need for this analysis. 

 
① Consumption data 

This example relates to the gas and electricity consumption. The CO2 that develops during pro-
duction, for example, is calculated based on the CO2 equivalent of the consumers. 

② Production data 
The quantity or number of products manufactured within the batch runtime. 

③ Batch data 
The "Batch ID" is used as unique identifier of the batch and defines the start and end of batch 
runtime. 
The "Material ID", for example, denotes the product type manufactured in this batch. 

The diagram in the following figure highlights the data acquisition process of a batch that is 
busy from 10:00 h to 12:00 h: 

 
1 Consumption and production data is acquired during batch runtime at an acquisition cycle of 

five seconds. At a runtime of two hours, 1440 values are saved as raw data for each data point. 
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2 At the end of the batch, the batch data is generated and calculated in the mevas, e.g. the total, 
on the basis of the acquired raw data. Use the "Generate batch data" database job to generate 
the batch data. 
You may delete the raw data on completion of your calculation, e.g. after one week. 
The pre-calculation of batch data offers you two advantages: 
• You acquire the consumption data of a batch in the seconds range and profit from very 

precise data. 
• The time it takes to generate the batch analysis report is reduced, as the values of the pre-

calculated MEVAs are used. 

Requirement 
The following data points have been created and configured: 

• At least one data point for the consumption values of the batch 

• A data point for the production figures of the batch 

• A data point for the Material ID of the batch 

• A data point for the batch ID of the batch 

The section "Configure data points for batches and material ID (Page 549)" describes how to 
configure the data points for acquiring the batch ID and material ID. 

In the following example a batch analysis is configured with these data points: 
 
Name Description Cycle time 
d_PM1_Electricity Acquires the power consumption of a plant. 5 s 
d_PM1_Gas Acquires the gas consumption of a plant. 5 s 
d_PM1_CO2 Acquires the CO2 production of a plant. 5 s 
d_PM1_Production Acquires the quantity or number of products manufactured 

on a plant. 
5 s 

d_BatchID_PM1 Acquires the batch start and end times. 5 s 
d_MaterialID_PM1 Acquires the material IDs of the product types produced per 

batch. 
5 s 

Copying data points 
1. Copy the data points that you need for the batch analysis to the selected subfolder. 
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Creating MEVAs 
1. Under the desired folder, create measuring variables with the "Sum real" database function 

for each data point used. 

Example of the creation of the "m_PM1_Electricity_sumR" measuring variables for the 
"d_PM1_Electricity" data point: 

 
2. Copy the corresponding data points to the subfolder of the MEVA folder. 

 

Creating plant variables 
1. Create the necessary plant variables in the selected subfolder. 

The section "Creating a plant variable (Page 551)" describes how to create plant variables. 

 
The "Batch DP" and "Material DP" plant variables are predefined in Energy Manager. Copy 
these plant variables to the selected folder. 
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Creating a plant 
1. Create the necessary plant variables in the selected subfolder. 

The section "Configuring the plant (Page 544)" describes how to create a plant. 

 
2. In the plant configuration dialog, drag-and-drop the plant variables, including the 

corresponding measuring variables / data points from the project tree to this folder. 

 

Intermediate result 
You have successfully created all objects that you need for the "Batch analysis" report. 
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Batch-related data 
Take into consideration the following points with regard to the acquisition values of the 
batch and consumption information for batch data analysis: 

• Acquisition values of the required numerical data points do not have to exist in the global 
database. Batch calculation recognizes when the acquisition values are not saved on the 
global database and automatically transfers the required data from the acquisition 
component. 

Example: 

The input data point "d_BatchID_PM1" for recording the batch start and end time is 
recorded in a 5-second cycle. Due to the compression configuration of the data point, only 
the compression levels 15 minutes, 1 day and 1 month are saved in the global database. 
The 5-second values remain as acquisition values on the acquisition component. 

 
  Note 

The acquisition data are saved on the acquisition component for 62 days. If saved 
acquisition values are used on the acquisition components, batch analysis is therefore 
only possible for the last 62 days. 

 

• Acquisition values of the required STRING data points must exist in the global database. 

• To enable the display of batch information in a data point, select one of the following 
entries in the "Function" list box: 

– "Event measurement T1 spontaneous" 

– "Event measurement T1 acyclic" 

 

• You do not have to specifically mark data points for saving consumption information. 

 

 Note 

If a large volume of acquisition data is used, e.g. 5-second values for several weeks, the data 
transmission may delay batch generation. 
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Background: Batch-related data 
The data is stored in a data point with the configuration "Event measurement T1 
spontaneous" as follows: 
 
Time stamp Value 
01.02.2008 14:32 0 
01.02.2008 15:12 1 
01.02.2008 18:20 0 
01.02.2008 21:10 1 

Each changing value defines the end or start of a batch. In the above case it is possible to 
define values for the following time ranges in the matrix. 

• 01.02.2008 14:32 - 01.02.2008 15:12 

• 01.02.2008 15:12 - 01.02.2008 18:20 

• 01.02.2008 18:20 - 01.02.2008 21:10 

The data is stored in a data point with the configuration "Event measurement T1 cyclic" as 
follows: 
 
Time stamp Value 
01.02.2008 14:32 0 
1 February, 2008 14:33 0 
1 February, 2008 14:34 1 
1 February, 2008 14:35 1 
1 February, 2008 14:36 0 

In this case, it is possible to define values for the following time ranges in the matrix. 

• 01.02.2008 14:32 - 01.02.2008 14:34 

• 01.02.2008 14:34 - 01.02.2008 14:36 

The values entered are written to the database with "TO" time stamp and are therefore 
available for further evaluations. 

Calculating batch data 
1. Copy the "Calculate_Batchdata" task to the selected subfolder to calculate the batch data. 

The "Calculate_Batchdata" task is predefined in Energy Manager. It is not necessary to 
recreate this task. 

 
2. You can start the task manually by double-clicking the task and clicking "Start". 
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Intermediate result 
The batch data is being generated. The total of the consumption values of the period 
contained in the meva that is assigned to the plant is calculated automatically. 

You can display the batch data in the "Batch list" tab of the "Plant" or "Material" dialog with 
the corresponding filter entries.  
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Creating a report 
1. Create a report with the query type "Day" and "Batch-related analyses" module in the 

selected subfolder. 

The section "Creating a report (Page 603)" describes how to create a report. 

 
2. Create a report template. 

3.  Copy the plant variables, the plant, as well as the associated measuring variables and data 
points to the subfolder of the report module. 

 
4. Start the report with the query type "Day" and query period for the batch analysis. 
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Result 
The calculated batches are visualized in the report. 

 

Using the batch analysis result for regression analysis 
Use the diagram functionality of Microsoft Excel for the regression analysis. The analysis is 
based on the recorded production and consumption data depending on the produced 
product. 

1. Create an autofilter. In the "Materials" column, filter by the required product type. 

2. Because consumption and produced quantity are relevant for the regression analysis, hide 
the columns that are not required. 

In this example, use the data of columns I and K.  

 
3. Insert the diagram type "Point (X Y)", for example, on a new worksheet. 

4. Select the required range as data range in the batch analysis. 
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5. To identify outliers more clearly, generate a trend line if necessary. 

Based on the formula, read the factors "k" and "d" which you can use as basis for a 
production-planning oriented forecast:  

 

See also 
Task Manager (Page 738) 

Configuring reports (Page 605) 
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4.4.5.4 Using the batch list 

Overview 
The batch list shows you the batches that were produced on a plant. 

The following filter options are available for displaying specific batches: 

• Time frame 

The batch list shows only the batches that were produced in the selected time frame. 

• Plant 

The batch list shows only the batches that were produced on the selected plant. 

• Material 

The batch list shows only the batches that were produced on the selected production lot 
type. 

You may also edit batches in the batch list and add new batches to the list. For example, you 
may view and edit the figures that were used for batch calculations. You can access the batch 
list either via a plant or via a material. 

 

 Note 

The "Batch list" tab is not available until the plant completion and renewed opening of a 
Material or a Plant. 
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Procedure 
1. Double-click a plant or material and select the "Batch list" tab. 

The "Batch list" tab is displayed in the "Plant" or "Material" dialog. 

 
2. Specify the following data to display the selected batches in the batch list: 

– Specify the required time frame in "From ... to". 

– Select the production lot type from the "Material" dialog. 

– Select the plant from the "Equipment" dialog. 

3. Click "Update". 

The batches are displayed in the batch list. 
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4. You may create a batch manually as follows: 

– Click "New". 

The "Batch Details" dialog opens. 

 

– Enter a Batch ID in the "Batch ID" field. 

– Select the plant from the "Equipment" dialog. 

– Select the production lot type from the "Material" dialog. 

– Specify the required time frame in "From ... to". 

– Click "OK". 

The batch will be created. You can display the batch in the batch list by entering the 
corresponding filter criteria. 

5. The batch figures can be viewed and edited by clicking on "Edit". 

The "Equipment Variable" area lists the plant variables that were assigned to the respective 
plant. 

The "Value" and "Unit" fields list the corresponding figures that were calculated based on 
the respective mevas.  

– You can edit figures by clicking the respective entry in the "Value" field. 

6. A batch is removed from the batch list by clicking "Delete". 
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7. Click "Overview" to display the overview for a batch. 

 
8. Click "Update" to recalculate the batches. 
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4.4.6 Forecast 

Definition 
Energy Manager is used to plan and forecast the energy requirements of your company for a 
time period which can be freely selected.  

Usage 
Planning and forecasting are preconditions for sustainable energy management. This is 
facilitated by generating forecasts of the energy requirements and load profiles for one or 
several locations, individual consumers, production areas, or buildings.  

Energy requirements planning for a specific time period returns procurement benefits due to 
the tiered tariff systems of the energy providers. Maximum financial benefits are achieved at 
the following conditions: 

• The difference between the expected and actual consumption is kept to a minimum. 

• Load peaks are shifted to tariff times during which energy generation is at a lower cost. 

Demands on an energy management system 
Load peaks in industrial plants are primarily determined by production processes, as well as 
shift or product cycles. The forecasting methods may differ even among different plant units: 

• Forecasting in pulp mills, for example, is usually based on production quantities. The 
shredder and waste paper units are only in operation as required, which is why 
forecasting is based on production plans. 

• By contrast, forecasting in the automobile industry is based on shift schedules. 

Implementation in Energy Manager 
Energy Manager supports the following methods for planning and forecasting: 

• Multi-Variable Regression Analysis based on daily consumption values 

As the forecast may depend on up to five variables with the help of the multi-variable 
regression analysis, this method is recommended. The other methods for planning and 
forecasting do not offer the possibility of making the result dependent on further 
variables. 

• Forecast based on the comparison day principle 

• Forecasting based on production plan 

The forecasts can be compared with the ACTUAL data in future analyses.  

See also 
Configuring the plant (Page 544) 

Task Management (Page 731) 



 Administration 
 4.4 Processing 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 567 

4.4.6.1 Multi-Variable Regression Analysis 
Forecasting based on daily values is based on previously acquired actual values. In this case, 
the energy consumption is allocated to each daily production. In the forecast, you then 
calculate the expected energy requirements as a function of the expected production 
quantity.  

You can analyze the daily production quantities and corresponding consumption data with 
the help of a regression analysis. With the result of the analysis, Energy Manager calculates 
future consumption data depending on up to five variables. You define these variables when 
configuring the regression analysis. 

Forecasting based on the regression analysis is implemented in Energy Manager with the 
"MultiRegression" widget in the Energy Manager Web Client.  

Procedure 
To create a forecast with the help of multi-variable regression analysis, follow the 
configuration description of the MultiRegression widget (Page 187). 

4.4.6.2 Forecast based on the comparison day principle 
The comparison day principle is based on shifts or day types which are observed over a 
reference period, such as a quarter. The energy demand is calculated depending on the 
scheduled days and associated plant operating times.  

• Examples of type days: Workday (8 hours), workday (6 hours), workday (10 hours), 
holiday 

• Examples of shifts: Morning shift, evening shift, night shift, special shift 

Usually, you plan type days on a weekly basis, while flexible planning without committing to 
an entire week is also possible. Holidays and other non-working days are taken into account 
automatically. 

Use the calendar to react to changes: You can change type days or shift these to other 
weekdays. Therefore, your forecasts are always up-to-date.  

Evaluation of the forecast quality, i.e. the comparison with actual data, concludes the 
forecast. The result may affect the next forecast.  

Procedure 
Proceed as follows to create a forecast based on the comparison day principle: 

1. Configure a profile or master profile with shifts as described in thesection "Profile" 
(Page 521). 

2. Configure the report "Load profile analysis module type", as described in the section "Report" 
(Page 601). 

3. Select the "Start..." menu command from the shortcut menu of the report. 

4.  Select the time period from the past on the basis of which you create the forecast from the 
drop-down list "From" and "To". 

Make sure that the configured day sequence of the profile is rolled out for this period. 
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5. Under "Extended parameter", enter the term "save" in the "Batches" entry field. 

 
6. Click the "Start" button. 

The respective average consumption for the corresponding shifts is determined and 
saved. 

7. To obtain a forecast, use the report module "Protocol" for a future time period. 

Make sure that the configured day sequence of the profile is rolled out for this period. 
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4.4.6.3 Forecasting based on production plan 
With forecasting based on production planning, energy consumption is calculated based on 
the production quantities or batches to be produced. A stable relation between power 
consumption and batches/quantities is a prerequisite for this. The following linear equation 
y = k • x + d is used for this. 
The variables have the following meaning in the linear equation:  
 
Tag Meaning 
y Predicted consumption 
k Consumption per produced quantity 
x Quantity/number of pieces produced 
d Consumption that is independent of the produced quantity  

To be able to carry out a production plan-related forecast, you need the values for k, d and x. 
If you do not know these values, determine the values using one of the following methods. 
• "Batch analysis" report 

The section "Batch and material-related analysis (Page 549)" describes how to configure 
the "Batch analysis" report. 

• "Multi-Variable Regression Analysis (Page 187)" widget. 
Provide the Energy Manager with the value for x via a production plan. 
Provide Energy Manager with the values for k and d via a consumption type. 
You can define the production plan directly in Energy Manager or by means of a predefined 
Microsoft Excel file. 

Requirements 
• The corresponding plant with production plan is created and configured. 

• The corresponding consumption type is created and configured. 

Procedure 
To create a production plan-related forecast, proceed as follows: 

1. Create an MEVA of the type "Load forecast generally relatively". 

2. Connect the consumption type and the plant with the MEVA. 

3. Create a report with a protocol module. 

Define the time period for the forecast in the report. 

4. Connect the MEVA to the report. 

The MEVA thus receives the time period for the forecast. 

5. Start the report. 
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4.4.6.4 Examples of forecasting 

Configuring long-term forecast reports 

Overview 
An overall forecast is calculated for the following year at the end of each annual period (e.g. 
end of December). The basic load profiles that have been calculated and adjusted by the 
customer, including the future holidays calendar in Energy Manager, form the basis for an 
overall forecast. This long-term demand forecast is calculated once in Energy Manager 
(initiated manually). and forms the basis for calculating demands of the following year or of 
the next years (2-year forecast). The results of this forecast are retained without changes in 
the Energy Manager system for the entire year. The long-term forecast has a resolution of 
one hour. 

Requirement 
• A profile that contains the typical and special days has been created in the system. 

• A measuring variable for forecast calculation and the derived data point has been created 
in the system. 

Creating derived data points 
1. Create a derived data point that you can use to create the long-term forecast. 

2. Set the cycle time to 1 hour. 

The data point is then ready for use. 

 

Creating measuring variables 
1. To create the long-term forecast, create a measuring variable that adds up the profile values 

and special effects. 

Profile values: Function type "Profile value 

Special effects: Function type "Parameter" 
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2. Create the "m_Forecast_AVZ_total_add" measuring variable (function type "Addition of n 
MEVAs") in the same way. Copy the measuring variables in the order displayed to the 
"m_Forecast_AVZ_total_add" measuring variable node. 

This measuring variables adds up the profile value and the adjustment values. 

 
3. Configure this measuring variable as input of the derived data point (author's remark: that 

was created above). 

 
4. Create the "m_Long-term forecast_AVZ_average" measuring variable with function type 

"Average". Copy the derived data point "a_longtermforecast_AVZ" to this measuring variable 
node. 

 

Configuring "long-term forecast" reports 
1. Create the report "Long-term forecast_electrical power_analysis_AVZ" with the module types 

"Module derived measurement" and "Log with from/to" as well as the "Ad-Hoc" and "Year" 
query types. 

Import a configured template so that the necessary macros are available. 

The Client then contains the following structure: 

 
2. Assign the objects to be evaluated to the modules. 

 
3. Copy the derived data point for the total consumption forecast (profile + adjustments) to the 

"Derived measurement" module structure. 

4. Copy the measuring variable for profile calculation, the three measuring variables for the 
adjustment factors, as well as the measuring variable for the calculated total consumption to 
the "Report module" structure. 

5. You must specify the cycle for calculation of the values. Preset this value to avoid incorrect 
entries. 



Administration  
4.4 Processing 

 SIMATIC Energy Manager PRO V7.2 - Operation 

572 Operating Manual, 12/2020, A5E38952754-AF 

6. Select the "Edit" command from the shortcut menu of the report. 

7. Select the "AdHoc" and "Year" query types. Select interval "1" and unit "h" accordingly. 
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Starting report calculation 
1. Start the report, e.g. for a year. 

2. Select the "1 h" interval in the "Module Start/Stop Info" dialog if the interval is not set by 
default. 

3. Click "OK to close the dialog and to start report calculation. The report is created in the "Year" 
query type structure. 

 
The report result is available in the following form: 

 

Column F displays the forecast values, while columns G, H, and I display the adjustments. 
Column J displays the sum of the profile value + adjustments. Columns D and E display the 
time range of the values. 

Enter the <CTRL+D> keystroke to start generation of the diagrams for all 12 months of the 
calculated year. 
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The profile value and sum trends are identical if no adjustments were made. The data in the 
following screenshot was manipulated to visualize an adjustment. 

 

Result 
You have successfully configured the long-term forecast and it is now ready for use. 
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Configuring schedule reports 

Overview 
Every month a schedule is calculated for the next month and the result is reported to the 
energy supplier. The schedule is created in Energy Manager in the last working week of the 
month. The Excel file is communicated manually to the energy supplier by a team member of 
the customer. A resolution of 1 h is specified for the load data of the schedule registration. 

Layout of the report template 
This report template consists of two worksheets:  
• "INFO" worksheet: General information on the reporting instance. 
• "Internal" worksheet: Actual values. 

 
With the exception of dates, the contents of INFO are constants and defined in the template. 
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The "Internal" sheet in schedule format consists of the following columns and rows: 

• Columns A, B, and C contain the schedule structure and may not be modified. 

• Date row 1 and header rows 2 to 17 can be applied without changes. Exception: Name of 
the balancing group member; to be supplemented accordingly. 

• Columns D and E contain hourly performance values, with column D containing the 
figures of ENERGIE_LF consumption and column E containing the figures of possible 
energy returns to the ENERGY supplier. Only one of the figures, i.e. supply or return, may 
be unequal to zero in any hour. Performance figures are always entered as positive 
numbers. 

Requirement 
• A profile that contains the typical and special days has been created in the system. 

• A measuring variable for forecast calculation and the derived data point has been created 
in the system. 

• The "m_Forecast_AVZ_total_add" measuring variable for calculating the forecast value has 
been created in the system. 

 

Configuring "Schedule" reports 
1. Create a derived data point "a_Monthly schedule_AVZ" for monthly forecasting (= schedule). 

Copy the "m_Forecast_AVZ_total_add" measuring variable to this data point structure. 

 
2. Create the "m_Monthly forecast_AVZ_total_average" measuring variable for reading the 

monthly forecast data. Copy the "a_Monthly schedule_AVZ" to this measuring variable 
structure. 

 
3. Create the "Monthly schedule_electricity_AVZ" report. Instead of the "Report with FROM/TO" 

module, select the "Schedule B/L KISS-A month" module. Assign the corresponding data 
points and measuring variables to the modules. 
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Report result 
1. Start the report. 

As a result, the schedule is displayed in Excel. After having checked the values, forward 
the schedule by e-mail. 

 

Once calculation has been completed in Energy Manager, the responsible instances of the 
controlling department must validate the tabular analyses that were generated and specify 
the corresponding version number in line 8 "Version". 

The principal is under the obligation to maintain the version number for the various analyses 
that were generated to identify late registrations of the schedules. 

Result 
You have successfully created the schedule report for further use. 
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Configuring daily load course reports 

Overview 
Every day, a report that contains the actual consumption figures is calculated for the previous 
day. The result is written to a derived data point with hourly resolution for comparison 
purposes (controlling report). 

The values for this report are calculated on a "rolling" basis using the figures of the last 14 
days to avoid non-contiguous data. Such data gaps may develop, for example, in the course 
of necessary maintenance on the acquisition PC.  

Layout of the report template 
This report template consists of two worksheets: 

• "Sheet1" contains the calculated progression of the load profile. 
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• "Load profile" represents the corresponding diagram that is filled automatically. 

 
 

  Note 

When using templates with a user-specific graphic worksheet, the templates always have 
to be saved and closed in the data worksheet (entry point of the modules). Closing the 
template in graphic worksheet prevents you from loading reports using this template. 

 

Requirement 
All data points and mevas needed to calculate the daily load profile have been created in the 
system. 
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Configuring "Daily load profile" reports 
1. Create the ""m_Sum_supply_AVZ_add"" meva (function type "Addition of n MEVAs") for 

calculating the actual value of consumption. Copy the "m_Supply_1_AVZ" and 
"m_Supply_2_AVZ" mevas to the structure of this measuring variable. 

 
 

  Note 

Calculations depend on the respective plant concerned. The number of feed cables, 
necessary scaling, count value differences, etc. 

 

2. Create a derived data point "a_Total load_ACTUAL_AVZ" for calculating daily consumption. 

You may use the ODBC connector, for example, for the initial import of the chronological 
load profile. 

3. Copy the "m_Sum__supply_AVZ_add" meva to the structure of this data point. 

 
 

  Note 

If load profile history data has already been written to this data point, the ODBC data 
source is also connected below this data point. However, this has no influence on the 
calculation of values. 

 

4. Create the "Daily load profile_electricity_AVZ" report, similar to the "Long-term forecast" 
report. Instead of the "Report with FROM/TO" module, select the "Query with 1 time stamp" 
module. Activate the "start automatically" option for the "Day" query type and set the 
deletion period to one week. 

 
  Note 

Strictly observe the order of the modules: The module first needs to calculate (fill) the 
derived data point to prepare it for reading by the query module. 

 

5. Assign the data point to the modules. 

 
6. Create a parameter with value "14". Implement the parameter in the structure of the "Day" 

query type. 

This factor extends the daily queries accordingly to the last 14 days instead of the last day. 
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Report result 
The report is started automatically in accordance with the configuration. 

The result shows the supply figures of the last 14 days in Excel, including minimum, 
maximum, average, and total consumption figures. 

 

Result 
You have successfully created the daily load profile report that can now be put into use or be 
calculated automatically on a daily basis. 
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Configuring controlling reports 

Overview 
On expiration of the period (year), a retrospective report is generated; it contains the 
comparison of the measured load profile with forecast data (long-term forecast values) and 
the schedule with schedule adjustments. The offset derived from the TARGET/ACTUAL 
comparison is visualized in absolute (MW) and relative (%) figures. The result is provided as 
annual analysis (starting at the beginning of the year) in a defined format. A resolution of 
one hour (1h) is specified for the load data derived from the TARGET/ACTUAL comparison. 

Layout of the report template 
This report template consists of an "empty" worksheet, as the module has not yet calculated 
and generated all values and headings. 

 

Requirement 
The following data points must be created and continuously calculated: 

Total energy input (total performance/unit charge figures) of the factory, the derived DP for 
long-term forecasting, derived DP for the schedules. 
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Configuring "Controlling" reports 
The analysis consists of general header data of the report and of the tabular view of 
performance figures. These performance figures are derived from the long-term forecast, the 
registered schedule, and total energy consumption of the respective plant. 

In addition to performance figures, the list shows the deviations between the schedule and 
actual values measured. Deviations are calculated and listed both as absolute [MW] and 
relative [%] values. 

These deviations are to be visualized in a separate diagram for every month of the year. You 
have already set up the "m_Long-term forecast_AVZ_average", "m_Monthly 
forecast_AVZ_total_average", and "m_Total load_AVZ_average" mevas in the system: 

 
1. Set up the "m_Deviation_year_month_AVZ" meva (function type "MEVA minus MEVA") for 

calculating the difference between the monthly and long-term forecasts. 

2. Copy the "m_Monthly forecast_AVZ_total_average" and "m_Long-term 
forecast_AVZ_average" mevas to the structure of this meva in the correct order. 
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3. Create the "Controlling_target_actual_electricity_AVZ", similar to the "Long-term forecast" 
report. This report only needs a module of the type "ACTUAL/TARGET schedule". 

4. Assign the measuring variables to the module, observing the correct order. 

 

Report result 
1. Start the report, e.g. for a year. 

In addition to the FROM and TO times, the configured report outputs the values for long-term 
forecasting, possible adjustments, the schedule value, as well as the actual value. 

These values are used to calculate absolute and relative deviation figures. 
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Enter the <CTRL+D> keystroke to start generation of the diagrams for all 12 months of the 
calculated year. 

 

Result 
You have successfully created the controlling report that can now be used to determine 
forecasting quality. 
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Configuring analysis reports 

Overview 
Analysis reports are used to examine the load progression with regard to a profile. Load 
distribution is determined for all existing typical days and special days across the evaluation 
period. The result returns the load profile, for example, of a typical Monday or Tuesday. 

If an analysis is performed, for example, for each typical "Monday" in the year, all Mondays 
will be used for the calculation, except for any holidays or special days that coincide with a 
Monday. In a year with 48 Mondays, for example, the mean value is calculated for the time 
window from 00:00 to 01:00 for all Mondays and output as result. The same rule is applied to 
all other intervals. 

 

 Note 

Special days that are not created and output as such will corrupt the result, as these would be 
treated as standard days. 

 

Corrupted values are ignored in the analysis. However, you can force the inclusion of 
corrupted values with an entry in Energy Manager options (BDATA_LASTPRF_QS = 0). 

After the results have been reviewed and a plausibility check has been completed, the 
calculated values are written directly to the typical days and special days by starting the 
report and activating the "save" parameter. 

Requirement 
• The module with the type "Load profile analysis module type" and a profile with the typical 

days and special days to be analyzed have been created. 

• The measuring variable for calculating the total load average has been created. 

Creating and configuring analysis reports 
1. Create the "Analysis_AVZ" report with the "Load profile analysis module type" as well as the 

"AdHoc" and "Year" query types. 

The Client then contains the following structure: 

 

 
2. Assign the objects to be analyzed to the module: In this case, this is a measuring variable 

that calculates a total load average and a profile that is to be filled with the typical days and 
special days. 

You must specify the cycle for calculation of the values. Preset the value in order to 
simplify the procedure and to avoid incorrect entries. 
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3. Select the "Edit" command from the shortcut menu of the report. 

4. Select the "AdHoc" and "Year" query types. Enter interval "1" and unit "h" accordingly. 

 

Starting analysis reports 
1. Start the report, e.g. for a year. 

2. Select the "1 h" interval in the "Module Start/Stop Info" dialog if the interval is not set by 
default. 

3. Click "OK to close the dialog and to start report calculation. The report is created in the "Year" 
query type structure. 
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Filling typical days 
1. The report result is available in the following form: 
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The typical day is output in line 19. The "Number of values" above that specifies the 
number of days used to calculate the typical day. The result is marked in blue color if this 
value is less than three. 

Line 16 displays the measuring variable and the profiles used as the basis for calculation of 
the typical days. 

2. If the current load profile has caused implausible calculation results, find and eliminate these 
"outliers" until your calculation seems plausible. 

 
  Note 

As an alternative, you can fill in the typical days and manually correct the outliers in the 
typical days. 

 

Initiate the filling of typical days by entering the "save" command in the text batches field 
when starting the report. 
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The calculated values were written to the typical days or special days. This status can be 
checked by editing the typical days. 

 

Result 
You have completed the configuration of the profile, including its assigned typical and special 
days, so that the profile can now be used in forecasting. 

 

 Note 

Adjust the typical day setting annually, i.e. recalculate the values on the basis of the load 
profile of the previous year. 

 



 Administration 
 4.4 Processing 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 591 

4.4.7 Consumers 

4.4.7.1 Consumers and structured view 

Requirement 
• The Consumer functionality is licensed separately. 

Overview 
In Energy Manger you can map consumers such as CNC machines or establish 
communication using TCP/IP and map its data in Energy Manager. 

A previously created consumer template is used to automatically create a structure consisting 
of consumers, associated datapoints (defined as inputs in the consumer template), Mevas 
(defined as outputs in the consumer template) and optional Widget Dashboards and reports.  

Information about the consumer template is available in the section "Load templates 
(Page 708)". 

The consumers actively send data in a report that is specified by the Energy Manager. The 
consumers register in Energy Manager using a frame consisting of the name and type of the 
consumer. During import in the acquisition wizard, the consumers are displayed grouped by 
consumer type. If no type is sent, the consumer is assigned to the "undefined" group. 

If the TCP/IP connection is disconnected or if no data is received for more than two minutes, a 
consumer must register again using a specified protocol so that data will be received in 
Energy Manager again.  

If necessary, consumers can also be created automatically using the wizard of the "Machines" 
interface. More detailed information about this is available in the section "Data acquisition via 
the "Machines" interface (Page 446)". 
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Procedure 
1. In the project tree, click on the location or organizational unit below which you want to 

create the new consumer. 

2. On the "Master Data > Configuration" tab, click "Consumer". 

3. Enter a name and optionally a description, as well as a producer of the consumer. 

 
Select the previously defined consumer template that is used for automatic creation of 
datapoints, Mevas, Widget Dashboards, and reports. 

The "Location" and "Organizational Unit" fields are filled automatically. If you create the 
consumer below a location, the "Location" field is automatically filled with this location. If 
the consumer is also to be assigned to an organizational unit, you must copy the 
consumer below the desired organizational unit. The field for the organizational unit is 
then automatically filled in the consumer. 



 Administration 
 4.4 Processing 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 593 

4. The "Mapping" tab shows the inputs, outputs, Widget Dashboards, and reports defined 
according to the consumer template as they will then be created automatically. 

 
5. Click "OK". 

Result 
The structure made up of consumer, associated datapoints (inputs), Mevas (outputs) as well 
as Widget Dashboards and reports is created. You can copy the entire structure below an 
organization structure.  
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Structured view 

Structured view in Energy Manager PRO Client 

You can display the consumers now by location or organizational unit by clicking on the 
"Structured" tab in the project tree. 

The tree is structured by location and organizational unit, thus geographically and 
organizationally. Only consumer objects are structured, i.e. all other objects are not 
displayed. 

The view structured by location is shown at the top. 

 

The view structured by organizational unit is shown at the bottom. 

 

Structured view in Energy Manager PRO Web 

The structured view is also available in Energy Manager PRO Web. For this, it is necessary to 
correctly define the entry points for the user group. There is a dedicated entry point for the 
location and another for the organizational unit. Define these entry points for the user group 
in the "Location" and "Organization" fields by moving the respective location and 
organizational unit into the fields using drag-and-drop.  

 
The definition of these entry points "Location" and "Organization" is optional. For use of 
Energy Manager PRO Web, the "Basis" entry point must always be defined. Details on the 
definition are available in the section "Defining an entry point (Page 685)". 
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All locations and organizational units below the object defined as the entry point are shown 
including their associated consumers. The view corresponds to a view of the Energy Manager 
PRO Client, i.e. only consumers are displayed. A click on "Geographical" displays all consumers 
structured by location. 

 

A click on "Organization" displays all consumers structured by organizational unit. 
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A click on a consumer displays the standard Widget Dashboard defined in the consumer 
template in the right area, which can then be edited. 

 

 Note 

Only consumers are displayed in the structured view under "Geographical" or "Organization", 
the same as in the Energy Manager PRO Client. The structured view serves as an overview of 
consumers according to location or organizational unit. For this reason, all other objects such 
as datapoints and Mevas that are configured during creation of a consumer are hidden. Only 
the standard Widget Dashboard is displayed. If you would also like to see the entire consumer 
structure in the Energy Manager PRO Web as it is created in the Energy Manager PRO Client, 
proceed as for all other objects that you want to make available on the web. Copy the 
consumer to the folder defined for Energy Manager PRO Web (e.g. Intranet_Viewer). You can 
then, for example, create other Widget Dashboards for a consumer from there. You also have 
the option of creating a Widget Dashboard in addition to a location or organizational unit. 
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4.4.7.2 Creating a filter object 

Overview 
In Energy Manager you can configure consumer templates with aggregated KPIs. These KPIs 
are already used in some widgets in Energy Manager PRO Web, in which charts display the 
calculated KPI values. The "filter object" is available if you want to also use the aggregated 
KPIs in reports. You use the filter object to narrow specific KPIs of consumers, which you then 
calculate and display in a report with the module type "Protocol - KPI aggregation". 

Procedure 
To create a filter object for a created consumer, follow these steps: 

1. From the navigation area select a consumer under which you want to create the filter 
object. 

2. Click the "Insert filter object" object in the menu bar under "Processing > Consumer". 

The "Filter object" configuration dialog opens. 

 
3. Enter a meaningful name for the filter object in the "Name" text box. 

The input of a name is required. 

4. Move a cost center or a plant to the "Substructure" text field with drag and drop. 

The KPIs contained in the inserted object are displayed in the "Available" list. 
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5. To filter a list, enter the corresponding text in the "Free text" text box. 

The listing in the "Available" list is filtered accordingly. 

6. Select the KPIs you want to use in the report and click on the upper arrow. 

The selected KPIs are moved to the "Selected" list. You can remove no longer required KPIs 
from the list using the lower arrow. 

7. To save the configurations, click the "Save" button. 

Result 
The filter object has been created. To calculate the KPIs in the report, you must insert the 
filter object below the module type "Protocol - KPI aggregation" of a report.  
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4.4.7.3 Consumer report 

Overview 
To ensure an overview of the use and number of consumers the "Machine Protocol" report 
module is available. Unlike other modules, objects do not have to be attached as input below 
the module for the machine protocol. All configured consumers are automatically included in 
the report. 

For each time instance of the queried interval at which the number of utilized machines 
changes, the report contains the following: 

• Date 

• Number of consumers 

• Consumer name 

• Vendor 

• Creation Date 

Procedure 
1. Create a new report including desired query type and select the "Machine Protocol" type for 

the module. 

2. Define the Interval and the Unit for the module. 

3. Click "Generate Entry Points" to generate the master data of the report. 

4. Place the Entry point of the module below the master data, e.g. in line 15, using "Cut" and 
"Paste". 

5.  Design the layout for the report and save it. After closing, you can start the report. 

6. Start the report by right-clicking it The report result opens. 

Details on creating reports are available in the section "Report (Page 601)". 

Result 
The master data of the report is output at the top of the report: 
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The actual report content is output below the entry point for the "Machine Protocol": 
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4.5 Analysis 

4.5.1 Reporting 

4.5.1.1 Report 

Basics on reports 

Overview 
You can visualize or process the measured values that have been acquired in Energy 
Manager. Energy Manager generates the reports in files in the Microsoft Excel or Microsoft 
Word format. The visualization of the values as a table of diagram is always based on the 
functionality of Microsoft Excel. Reports in Microsoft Word use embedded Excel object to 
visualize the values.  

In both applications, all formatting and elements can be used to design the reports.  

Reports can be generated manually or automatically, dispatched by email, printed, saved to a 
file server, and viewed in Energy Manager PRO Web. 

Report results are stored in the structure tree of the Client. The name of report results 
consists of the name, calculation period and the creation date. 

You can use the predefined reports provided in Energy Manager as the basis for your project. 
The default reports are available in "Customer > Reports". 

 

You can use data points, MEVAs and parameters in the report. In the case of the data points, 
the acquired values in the files cannot be used, only those stored on the SQL Server. 

See also: "Architecture and interfaces (Page 395)" 
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Components for creating reports 
You need a query type and a module to create a report. 

Use a query type specify the time range of report and to configure automatic reporting.  

Use a module to specify how the acquired measured values will be calculated and visualized. 
The following module types are available: 

• Query module: Returns values without calculation, e.g. the measured values of a month 
on a daily basis. 

• Balancing module: Returns a value for a time period, e.g. the monthly energy costs. 

• Protocol module: Returns values for all intervals of a time period, e.g. the monthly energy 
costs on a daily basis. 

Certain modules need additional parameters when you start a report. A protocol module, for 
example, needs interval as start parameter. 

 

 Note 
Maximum number of modules 

The maximum number of modules is 100. 
 

Procedure for creating reports 
Proceed as follows to create a report: 

1. Create a report. 

2. Configure a query type and a module for the report. 

3. Configure a template for the report. 

4. Enter the reported values. 

5. Generate the report. 

See also 
Creating a report (Page 603) 

Configuring query types (Page 605) 

Configuring modules (Page 609) 

Configuring the layout for an Excel report (Page 614) 

Entering values in reports (Page 626) 

Opening report results (Page 55) 

Display modes (Page 787) 



 Administration 
 4.5 Analysis 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 603 

Creating a report 

Procedure 
1. Select the folder in which the report is going to be created. 

2. In the menu bar under "Analysis > Reporting", click the "Insert Excel report" button or the 
"Insert Word report" button. 

The "Report" dialog opens. 

3. Enter a unique name and an optional description for the report. 

 
  Note 

Do not use Excel-specific expressions such as A1 or =FG14 during the report creation. 

The report name cannot contain any special characters. The following characters are 
permitted: 
• A to Z 
• a to z 
• 0 to 9 
• _ 
• Space 

 

4. Select a display type. 

The display type specifies the heading for the datapoint'S value column. 

5. Under "Country", select the country whose time zone you want to use for the calculation. 

6. Configure one or more query types (Page 605). 

7. Configure one or more modules (Page 609). 

8. Confirm the configuration with "OK". 
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Result 
The report has been created. 

 

See also 
Configuring the layout for an Excel report (Page 614) 

Entering values in reports (Page 626) 

Query types (Page 765) 

Module overview (Page 773) 

Display modes (Page 787) 

Assign time zone for acquisition or calculation (Page 662) 

Creating reports (Page 217) 
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Configuring reports 

Configuring query types 

Overview 
Use a query type to configure the time frame that is queried in a report. You may configure 
several query types in the report. An object is created in the project tree of the Client for each 
query type of a report. 

Procedure 
1. Double-click the desired report in the project tree of the Client or create the query type in 

the course of a new report. 

2. Click "New" in the "Query types" field. 

The "Query type" dialog opens. 

3. Select a query type and enter a description if necessary. 

4. Select a compression level. 

Usually, you select "Entry values". 

5. Under "Holding time", define the interval after which the results of a report are to be 
automatically deleted from the project tree of the Client. 

If you want to automatically delete the report results, you also need to start the "Job for 
deleting analyses". 

6. Enable the respective options. 

7. Click "OK". 
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Result 
The query type is configured for the report.  

You can edit or delete the query type, or add a new one for the report. 

 

See also 
Creating a report (Page 603) 

Configuring modules (Page 609) 

Query types (Page 765) 

Time unit abbreviations (Page 771) 

Creating a printer (Page 691) 

Creating a folder (Page 694) 

User jobs of the job queue (Page 839) 

Setting up users (Page 672) 

Automating a report (Page 607) 

Task Management (Page 731) 
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Automating a report 

Requirement 
• The report is configured. 

• For the "Print" and "Save in directory" options: 

– The printer has been created. 

– The directory has been created. 

• For the "Send by Mail" option: 

– The connection to an SMTP server is configured in the Energy Manager options. 

– User has been created with an email address. 

• For the "Send Link to Recipient by Mail" option: 

The URL for Energy Manager PRO Web has been entered under "Energy Manager Options" 
in the "Appl." tab in the "WEBSERVER" field, for example, "http://localhost/EnMPROWeb". 

Procedure 
In order to automate a report open the query type and activate the respective options. 
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1. To automatically print a report, follow these steps: 

– Activate the option "Print". 

– After finishing the configuration, create a "Printer" folder below the hardware object. 

– After finishing the configuration, copy the "Printer" object under the "Printer" folder. 

2. Proceed as follows to automatically email the report: 

– Activate the "Send by Mail" option. 

– Activate the report format for mailing, e.g. "PDF". 

– Activate the "Send Link to Recipient by Mail" check box if you only want to email the 
link to the stored report. 

The recipient will receive an email with the link instead of the file. 

The recipient accesses this report by clicking this link, logging in to Energy Manager 
PRO Web , and opening the report. 

– After finishing the configuration, create an "E-mail" folder under the hardware object. 

– After finishing the configuration, copy the "User" object under the "E-mail" folder. 

– After finishing the configuration, copy the "User" object under the query type. 

 

3. Proceed as follows to automatically save the report to a directory: 

– Activate the "Save in directory" option. 

– Activate the report format for saving. 

– After finishing the configuration, create a "Directory" folder under the hardware object. 

– After finishing the configuration, copy the "Directory" object under the "Directory" 
folder. 

– After finishing the configuration, copy the "Directory" object under the query type. 

 

4. Click "OK". 

Result 
The selected options are executed after the start of a report, irrespective of whether a report 
is started automatically or manually. 

See also 
Configuring query types (Page 605) 

User jobs of the job queue (Page 839) 

Job queue (Page 731) 
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Configuring modules 

Overview 
Use a module to configure the visualization of a report in Microsoft Excel or Microsoft Word. 
You can configure several modules for a report.  

Requirement 
The report is configured. 

Procedure 
1. Double-click the desired report in the structure tree of the Client. 

The "Report" dialog opens. 

2. Click "New" in the "Module" area. 

The module configuration dialog opens. 

3. Enter a unique name and an optional description for the module. 

 
  Note 

Do not use Excel-specific expressions such as A1 or =FG14 during the creation and 
configuration of modules. 

The module name cannot contain any special characters. The following characters are 
permitted: 
• A to Z 
• a to z 
• 0 to 9 
• _ 

 

4. Select a module type. 

– You need a datapoint to configure a query module. 

– You need a data point, a parameter or a measuring variable to configure a balancing 
module or a protocol module. 

5. Activate "Query interval at start" to enter the interval at the start of the report. 

6. Activate "Insert rows before the values" in order to insert rows for the new values. 
Corresponding rows will be inserted prior to the wiring of values. Activate this option, for 
example, when using graphic objects in the template. 

Existing rows will be overwritten by default. Activate this option, for example, when using 
row operations in Microsoft Excel . 

7. Click "time window correction" and select a time under "With query type" for starting report 
evaluation . 
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8. In order to shift the time range for the evaluation of a report, click "Time period correction" 
and select a value and a time unit under "Align by". 

 
9. Confirm the configuration with "OK". 
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Result 
The module is configured for the report. You can edit, delete, or clone the module, or insert a 
new one for the report. 

 
If the module needs start parameters for the report, enter the start parameters in the 
"Module" area of the "Report" dialog, for example, 1 h for the "Protocol" module. Missing start 
parameters for a module are marked in red color.  

 

See also 
Basics for designing the report layout (Page 612) 

Creating a report (Page 603) 

Time unit abbreviations (Page 771) 

Module overview (Page 773) 
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Design of the report layout 

Basics for designing the report layout 

Overview 
Energy Manager uses Microsoft Excel or Microsoft Word to visualize reports. Specify the 
layout and representation individually in the relevant program. In this way, for example, you 
can visualize consumption values in a diagram. 

Principle of name generation 
 

 Note 
Report templates based on Microsoft Word 

In Microsoft Word, you use embedded Excel objects, into which Energy Manager imports 
values as in the figure shown below.  

 

 

When you click "Generate name" in the report configuration, a new report template is created 
or an existing one is updated. The module names ① are entered in column "A" ②. A name 
with the relevant module name is created for each cell ③. In addition, the master data of the 
report is entered in column "B". A name with the relevant master data is created for each cell 
④. 
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For report templates in Microsoft Word , the data are imported into the embedded Excel 
objects that contain the module names. 

 

 Note 

If you define the module name as a valid cell address or a sheet name on which the module is 
placed, you will not be able to load the report.  

If you define the module name with "A51", for example, an error will occur. The module 
name "A51" is a valid jump label for MS Excel. 

If you define the module name with "AVZ", for example, and the sheet name is also "AVZ", an 
error will occur. The module name "AVZ" is a valid sheet name for MS Excel. 

 

Entering values 
Values are entered as follows when you generate a report: 

• Modules: The values are entered as of the cell below the corresponding name. For this 
reason, you need to shift each cell with a module name from column "A" to a position 
where contents will not be overwritten (cut & paste). 

Example: The daily listing of consumption values of a month usually needs between 29 
and 32 rows: One row for the header and, depending on the months, between 28 and 31 
rows for the days.  

You can use the naming manager in Microsoft Excel to view and edit the names and their 
cell ranges.  

You may also distribute the cells to several sheets.  
 

  Note 

If you distribute cells that contain module names to several sheets, activate the sheet that 
contains the original definition of names before closing.  

 

• Master data: The values are entered as of the cell with the corresponding name. 

Modifying or adding module names 
If you change a module name in Energy Manager, or if you add an additional module to a 
report in Energy Manager, carry out the "Generate name" function again. Move the name 
fields of the newly inserted module to the desired position. 

Alternatively, you can also use the name manager. 

See also 
Configuring the layout for an Excel report (Page 614) 

Configuring modules (Page 609) 
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Configuring the layout for an Excel report 

Overview 
You can configure a template for an Excel report. In this template, you specify how the 
measured values are displayed. 

Requirement 
• The report is configured. 

• The query type is configured for the report. 

• The module is configured for the report. 

Procedure 
1. Double-click the desired Excel report in the structure tree of the Client. 

The "Report" dialog opens. 

2. To create a report template in Microsoft Excel, click "Generate name". 

Microsoft Excel opens and the module name is entered in column "A".  

3. Move the cell containing the module name to a position at which the module has sufficient 
space for its measured values. 

4. Structure the template. You can find additional information in the Microsoft Excel online 
help. 

 
  Note 

Special characters and spaces are not allowed in the table name. 
 

5. If you want to run a macro in Microsoft Excel after you have generated the report, follow 
these steps: 

– Open the macro editor in Microsoft Excel. 

– Insert the Sub OnBDataLoadDone procedure in the spreadsheet that contains the 
original name definitions. Note that this entry is case-sensitive. 

– Write the program code and close the macro editor. 

– Set the security level to "low" in the Microsoft Excel security settings. Activate the 
"Trust access to Visual Basic projects" option under "Trusted Publishers". 

 
  Note 

You cannot run a macro without having made the aforementioned security settings.  
 

6. Save the template to an Microsoft Excel file. 
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Result 
The template is configured for the report. 

 

Alternative procedure 
Alternatively, you can import an existing template for the report. To do this, click "Import" in 
the "Report" dialog and select the required file. If required, you can adapt the module names 
in the report template using the name manager.  

See also 
Basics for designing the report layout (Page 612) 

Creating a report (Page 603) 

Configuring query types (Page 605) 

Configuring modules (Page 609) 
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Configuring the layout for an Word report 

Overview 
You can configure a template for a Word report. In this template, you specify how the 
measured values are displayed. 

Use the following objects to visualize the measured values:  

• Tabular representation: Embedded Excel table 

• Graphical representation: Trend chart 

Requirement 
• The report is configured. 

• The query type is configured for the report. 

• The module is configured for the report. 

Procedure 
1. Double-click the desired Word report in the structure tree of the Client. 

The "Report" dialog opens. 

2. In order to prepare a template for the report in Microsoft Word, click "Open". 

Microsoft Word opens.  

3. Insert the desired objects, for example an embedded Excel table. 

 



 Administration 
 4.5 Analysis 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 617 

4. Save and close the template. 

5. Click "Generate name". 

Microsoft Word opens. A "Energy Manager PRO" worksheet is inserted into each chart or 
each embedded table. The module name is entered in column "A" on this worksheet. 

 
6. Move the cell containing the module name to a different worksheet, to a position where the 

module has sufficient space for its measured values. 

 
  Note 

During generation of the report, only those module names will be populated, which are 
contained on a different "Energy Manager PRO sheet" worksheet. 

 

7. To design the template, use Microsoft Word. 

8. Save the template to a Microsoft Word file. 

Result 
The template is configured for the report. 
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Working with report templates 

Report templates 

Overview 
In Energy Manager you can use an existing report to create a template that is the basis for 
new reports. If you create a new report and assign a template to it, the following 
configurations from the template are applied: 

• Display modes 

• Query types 

• Modules 

• Report layout 

Using templates for reports makes sense for similarly structured plants or sites, for example 
when separate reports are required for nearly identical production lines. Changes to the 
template affect all reports that are generated in the future, which are based on this template.  

Requirement 
• In order to create, configure and delete a report template, you need corresponding rights, 

which are defined in the functional group under "Template Manager". 

Creating a report template 
You can create a new template using the "Report as Template" option in the shortcut menu of 
the report (right-click). 

Overview of existing report templates 
Click the "Templates" button in the menu bar under "Master Data > Configuration". The 
existing report templates are displayed on the "Reports" tab. 

More details on creating and using report templates are available in sections "Creating a 
template (Page 619)" and "Using a template (Page 621)". 

See also 
Edit template (Page 623) 

Disconnecting a report from a template (Page 625) 
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Create a template 

Requirement 
A report has been created. 

Procedure 
1. Select the "Report as template" command from the shortcut menu of the report. 

The "Report" dialog opens. 
 

  Note 

A report can only serve as a template if a template has not yet been assigned to the report 
itself. 

 

2. Enter a new name for the template. 

3. As needed, change query types, modules or the report layout. 

 
4. Save the template. 
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Result 
The template is created and is shown in the menu under "Master Data > Configuration > 
Templates". All templates are also visible in the Templates folder in the shortcut menu. 

See also 
Edit template (Page 623) 
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Using a template 

Requirement 
A template has been created. 

Procedure 
1. Select the folder in which the report is going to be created. 

2. In the menu bar under "Analysis > Reporting", click the "Insert Excel report" button or the 
"Insert Word report" button. 

The "Report" dialog opens. 

 

3. Enter a meaningful name and an optional description for the report. 

4. Select a template from the list under "From template", and click "Apply". 

The "Report" dialog is filled out with the template's specifications. 

5. Save the report. 
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Result 
A new report based on a template has been created.  

See also 
Entering values in reports (Page 626) 
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Edit template 

Introduction 
Templates for reports are centrally managed under "Master data > Configuration > 
Templates". You can create, edit or delete templates: 
• "Edit": The changes affect all reports that are generated in the future, which are based on 

the edited template. 
• "Delete": The template is disconnected from all templates that are based on the template 

that is to be deleted. Then the template including the configured query types and modules 
is deleted. 

 
  Note 

If a template has been disconnected from a report, you can never again assign a template 
to this report.  

 

Requirement 
A template has been created. 

Procedure 
1. Click the "Templates" button in the menu bar under "Master Data > Configuration". 

The "Templates dialog" opens, and displays the list of templates. 
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2. In order to edit a template:  

– Select a template, and click "Edit". 

The "Template" dialog opens. 

– Perform the changes. 

– Save the template. 

3. In order to delete a template:  

– Select a template, and click "Delete". 

Result 
The changes are applied automatically to all the reports that are based on this template. 

See also 
Create a template (Page 619) 

Disconnecting a report from a template (Page 625) 
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Disconnecting a report from a template 

Requirement 
A report was created using a template. 

Procedure 
1. Click "Edit..." in the shortcut menu of the report. 

The "Report" dialog opens. 

2. Click "Disconnect". 

 
  Note 

If you disconnect a template from a report, you can never again assign a template to this 
report. However, you can create a template for other reports from this report. 

 

3. As needed, change the configured query types, modules or the report layout. 

4. Save the report. 

Result 
The template is disconnected from the report.  

See also 
Edit template (Page 623) 
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Entering values in reports 

Requirement 
• The report is configured. 
• The data point, parameter and measuring variable have been created. 
• You have created the printer, the directory, and the user. 
• The module and request type are configured for the report. 

Procedure 
1. Assign the module the corresponding data points, parameters or measuring variables to 

visualize the selected values in the report. 

 
  Note 

Object descriptions of Data points, Measuring variables and Parameters must not contain 
Excel-specific expressions such as A1 or =FG14. 

If you output the properties of objects in reports, do not use Excel-specific expressions in 
the output properties. 

 
– Assign the module a data point if you have configured a query module. 
– If you have configured a balancing module or a protocol module, assign a data point, a 

parameter or a measuring variable to the module. 
 

  Note 

If you have assigned a parameter to a protocol module, configure the replacement 
value and, if required, the associated validity period in the input dialog.  

 

2. To print, save, or e-mail the report automatically, assign the corresponding printer, e-mail 
address and/or directory to the query type. 

Result 
The values are entered in the report. 

 

See also 
Configuring query types (Page 605) 
Configuring modules (Page 609) 
Fundamentals of creating printer and directory (Page 691) 
Setting up users (Page 672) 
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4.5.1.2 Charts 

Creating a Chart 

Overview 
With the Chart object it is possible to make a predefined Chart available to several users. This 
means that the configuration via the Chart object is not user-specific in contrast to the 
configuration of a Chart directly at the datapoint, at the matrix or at a measuring variable. 
Configurations such as colors or the number of the displayed datapoints thus apply for all the 
users and not only for the current user. 

Procedure 
1. Click the object or the folder under which you want to create the Chart object. 
2. Click the Chart icon in the area "Analyze > Reporting". 

The "Chart" dialog opens. 

 
3. Enter a name and optionally a description. 
4. Save with OK. 
5. The Chart object is created under the desired object. 
6. Assign the datapoints to be displayed to the Chart object. 

Result 
The Chart object has been created and the desired datapoints assigned. 

 
You can configure the Chart object with a double-click. 

See also 
Displaying the Standard Chart (Page 61) 
Show details (Page 62) 
Comparing values of different time ranges (Page 63) 
Exporting the Chart (Page 65) 
Creating charts (Page 226) 
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4.5.1.3 Dashboards 

Dashboard basics 

Definition of "Dashboard" 
 

 Note 

In addition to the freely configurable dashboard in the Energy Manager PRO Client, there is 
also the Widget Dashboard. Configure the Widget Dashboard in Energy Manager PRO Web. In 
the Widget Dashboard you can insert multiple widgets which provide a clear overview of the 
various measurement and plant data. 

 

You can use the Dashboard and default objects to obtain a clear overview of historical data 
from the Energy Manager database.  
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Using the Dashboard 
The Dashboard provides you with an overview of your production and consumption data. You 
may distribute the data to be visualized to several dashboards for a clearer overview. Add a 
navigation button to each Dashboard to facilitate navigation between the dashboards. 

Use the Energy Manager "Dashboard" object in the following situations, for example: 

• To visualize consumption or cost parameters 

• To visualize consumption or cost states 

• To obtain a detailed overview of a production site, or of the combination of several 
production sites 

You may also use Energy Manager PRO Web to call the stored Dashboards. 

 
①, ②, ③ Large selection of display object templates, for example, pointer instruments, diagrams, or status displays.  
④ Process visualization using dynamic Sankey objects 
⑤ Buttons for navigation between multiple dashboards 
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Dashboard notes 
Observe the following information: 

• Value input 

A Dashboard visualizes only values of the following data points: 

– "Generic" data point type 

– "Derived" data point type 

– "Datapoint" data point type 

You can visualize values that are calculated based on measurement functions by assigning 
each measurement function a derived data point.  

• Time range 

Make sure that you set the time range to be visualized to a sufficient length. Moreover, 
the data points must contain measurement data for the specified time range.  

Rules for creating dashboards 
Observe the following rules before you start to create a Dashboard: 

• Plan the data quantity to be visualized and the corresponding distribution of this data. 

• You can distribute large data quantities to several dashboards to improve the overview 
and performance. 

Use a navigation button to switch between the dashboards; create this button in each 
Dashboard by means of dashboard object "Panel Switch". 

• Recommendation: When configuring the refresh cycle for Dashboard, enter the time in 
seconds e.g. 900 seconds for a refresh cycle of 15 minutes. 

Configuring dashboards 
Create a graphic overview as follow: 

1. Create one or several dashboards in the project tree of the Client. 

2. Copy the data points to be visualized as nested entry to the Dashboard you created. 

3. Create the Dashboard layout by compiling the selected dashboard objects in the 
"Dashboard" editor. 

4. Assign the selected data points to the dashboard objects used and customize the layout of 
the dashboard objects. 

5. If you have created several dashboards for a graphic overview, add one or several buttons to 
the Dashboard using dashboard object "Panel Switch" and assign the respective Dashboard 
to each button. 

Use these buttons to switch between the dashboards. 

6. Open the selected Dashboard in full-screen mode. 

The Dashboard displays the values of the data points used for a defined period. 
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See also 
Create dashboard (Page 632) 

Configuring the time range (Page 860) 

Dashboard objects (Page 859) 

Example of configuring a dashboard (Page 644) 
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Create dashboard 

Overview 
To create a Dashboard in Energy Manager , create a Dashboard in the project tree of the 
Client. 

Procedure 
1. In the project tree of the client, select the folder below which you want to create a 

Dashboard. 

 
2. Click the "Dashboard " button in the menu bar under "Analysis > Reporting". 

The dialog for creating the Dashboard opens. 

 
3. Enter a name such as "CU Group Overview" and an optional description for the Dashboard. 

4. Click "OK". 

Result 
The Dashboard is created in the project tree of the Client.  

 

You can edit the name and description of the Dashboard by clicking "Edit" in the shortcut 
menu of the Dashboard. 

Create the layout for the new Dashboard. 

See also 
Dashboard basics (Page 628) 

Creating the dashboard layout (Page 636) 

Setting up dashboards (Page 163) 

Example of configuring a dashboard (Page 644) 
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Structure of the Dashboard editor 

Function 
Use the "Dashboard" editor to create the layout for your Dashboard. 

Structure of the editor 
The "Dashboard" editor has the following structure: 

 
① Menu bar and toolbar 

The menu bar and toolbar provide default commands and icons, for example, for saving files or aligning objects. 
② Workspace 

You visualize, compile and configure the dashboard objects for your Dashboard on the workspace. 
③ Symbol palette 

The symbol palette provides all dashboard objects that you can use. You can change between the Dashboard and 
Sankey palettes. 
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Menu bar of the editor 
The menu bar of the "Dashboard" editor has the following structure: 

• File 

The "File" menu is used to save, close or export/import the current Dashboard. 

Use the "Export"/"Import" function to make the Dashboard available to other Energy 
Manager users. 

 
  Note 

Exporting a Dashboard 

The exported Dashboard can only be opened in an Energy Manager System. 
 

• Edit 

The "Edit" menu commands are used to perform standard document editor actions such as 
copying or deleting objects. 

• View 

The "View" menu lets you hide or unhide the pallets. 

Editor toolbar 
The toolbar of the "Dashboard" editor has the following structure: 

• Position 

 
These icons are used to position dashboard objects on the workspace. These can be used, 
for example, to place a dashboard object into the background of a different dashboard. 

• Align 

 
These icons are used to align dashboard objects on the workspace. You can use them, for 
example, to align objects to the center. 

• Size 

 
These icons are used to resize dashboard objects on the workspace. You can use them, for 
example, to resize the width of a dashboard object to fit the width of a different 
dashboard object. 

 

 Note 
Using the toolbar 

The toolbar icons are only available if you select several dashboard objects on the workspace.  

Press the <CTRL> key for multiple selection of dashboard objects. 
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Instead of the toolbar icons, you may use the shortcut menu commands of the dashboard 
objects: 

 

See also 
Exporting/importing dashboards (Page 643) 

Creating the dashboard layout (Page 636) 
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Creating the dashboard layout 

Overview 
Create a layout for the Dashboard you created. This layout defines the appearance of the 
Dashboard.  

You are provided two pallets, each containing different dashboard objects for creating the 
layout: 

• Dashboard palette: Contains objects such as "Gauge" or "Pie Chart" for creating graphic 
overviews. 

 
• Sankey palette: Contains objects such as "Process" for creating Sankey charts. 
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Requirement 
The Dashboard is created. 

Procedure 
1. Click "Layout" in the shortcut menu of the Dashboard. 

 
The "Dashboard" editor opens. 

2. Click "Configuration" in the shortcut menu of the workspace to configure the Dashboard. 

3. In the editor, select the symbol palette that contains the dashboard objects to be used in the 
layout: Dashboard Palette or Sankey Palette. 
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4. Drag-and-drop the selected dashboard objects from the symbol pallet to the workspace. 

 

The objects are placed into the workspace. 

The "Dashboard" editor lets you set up different alignments for multiple dashboard 
objects. You need a reference object to which you can align other objects. Start by 
selecting an object in the "Dashboard" editor and define it as reference object. 

– On the workspace, select the reference object to which you are going to align other 
dashboard objects. 

– Select the dashboard objects by means of multiple selection. 

– Select the command from the toolbar, or from the shortcut menu of the dashboard 
objects. 

The selected objects are aligned. 

5. Save the layout. 

Result 
You have created the Dashboard layout.  

Configure the dashboard objects used in order to customize them, or to link them with the 
selected data points. 



 Administration 
 4.5 Analysis 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 639 

See also 
Create dashboard (Page 632) 

Structure of the Dashboard editor (Page 633) 

Configuring dashboard objects (Page 640) 

Configuring the dashboard (Page 859) 

Dashboard objects (Page 859) 

Example of configuring a dashboard (Page 644) 
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Configuring dashboard objects 

Overview 
After having created the Dashboard layout, configure the dashboard objects to be used as 
follows: 
• Link the dashboard objects with the data points containing the values to be visualized on 

the Dashboard. 
• Customize the appearance of the dashboard objects, for example, the background color or 

text layout. 
 

 Note 
Configuration of the dashboard objects 

The following figures show the configuration of the "Pie Chart" dashboard object.  

For information about the configuration of other dashboard objects, refer to chapter 
"Dashboard objects". 

 

Requirement 
• You have created the Dashboard layout and opened it in the "Dashboard" editor. 
• The desired datapoints are created in the project tree of the Client. 

Procedure 
1. Copy the data points that contain the measured values to be visualized to the nested folder 

of the Dashboard. 

 
2. You configure a selected dashboard object by double-clicking it on the workspace. 

Alternatively, you can select the "Configuration" command from the shortcut menu of the 
dashboard object. 

 
The dashboard configuration dialog opens. 
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3. Configure the dashboard object to suit your requirements. 

You can customize the "Pie Chart" dashboard object as follows, for example: 

– Select "New" to set the number of bars to display in the pie chart. 

– Select "Data point" to assign each bar the data point containing the values to be 
displayed in the pie chart. 

– Select "Caption" to specify the text that describes the respective bar in the pie chart. 

– Select "Layout" to define the bar colors for the pie chart and activate the selected 
option for displaying the measured values in the pie chart. 

 
– Select "Time range" to define the period from which the measured values are to be 

displayed in the pie chart. 

– Select "Parameters" to define additional settings for the pie chart, for example, the 
background color or title. 

4. Click "OK". 
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Result 
You have configured the selected dashboard object. 

 

You may also configure the background on which the dashboard objects are positioned. 
Right-click in an empty area of the workspace and select the "Configuration" command from 
the shortcut menu. 

Configure all other objects that are used in your Dashboard, save the layout, and open the 
Dashboard in full-screen mode. 

See also 
Creating the dashboard layout (Page 636) 

Dashboards (Page 73) 

Configuring the time range (Page 860) 

Dashboard objects (Page 859) 

Example of configuring a dashboard (Page 644) 
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Exporting/importing dashboards 

Overview 
You can make a Dashboard available to external Energy Managerusers by exporting the 
Dashboard to a file. Distribute this file, for example, by E-Mail.  

The Energy Manager users can now import and use the exported Dashboard file on their 
Energy Manager System. 

Requirement 
You have created the Dashboard and opened it in the "Dashboard" editor. 

 Exporting dashboards 
1. Select "File" > "Export" from the menu bar. 

The dialog for saving the file opens. 

2. Select the directory and enter the file name. 

3. Save the file in EDD format, for example, "CU_Group_Overview.edd". 

4. You can send the stored file by E-Mail. 

Importing dashboards 
1. Select "File" > "Import" from the menu bar. 

The dialog for opening the file opens. 

2. Select the file in EDD format and click "Open". 

The Dashboard is displayed in the "Dashboard" editor on the workspace. 

See also 
Structure of the Dashboard editor (Page 633) 
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Example of configuring a dashboard 

Creating datapoints for the Dashboard 

Overview 
This example shows how you can visualize daily consumption in a week as bar chart in a 
dashboard. High limit overshoot is also to be visualized graphically.  

Preparations 
You need the following objects for this example: 

• 2 data points 

• 1 derived data point 

• 1 matrix 

• 1 measuring variable 

 
Name Type Cycle Valid from Query type 
d_Water1_Compressor Data point 1 d 05.11.2012 - 
d_Water2_Compressor Data point 1 d 05.11.2012 - 
a_Sum_CompressedWater1) Derived 1 d 05.11.2012 - 
Matrix_WaterConsumption_DailyValues - 1 d - Month (starting on 

01.11.2012) 
m_Sum_CompressedWater Addition with check-

sum 
- - - 

 1) When configuring the data point, select "Plausibility" to set the "High limit" to "200".  
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Creating objects 
1. Create a "Dashboard Example" folder and set up the aforementioned objects as follows: 

 
2. Enter the following values in a matrix: 

 

Time stamp e_Water1_Compressor e_Water2_Compressor 
05.11.2012 50 60 
06.11.2012 40 100 
07.11.2012 20 60 
08.11.2012 30 70 
09.11.2012 60 100 

3. Conclude your setup by calculating the derived data point for the time period "November 
2012". 

See also 
Creating a Dashboard (Page 646) 
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Creating a Dashboard 

Setting up the dashboard 
1. Set up a new "Dashboard" object and enter the object name "Water Consumption Chart". 

2. Copy the data points to the structure below the dashboard: 

 
3. Select the "Layout" command from the shortcut menu of the dashboard to configure the 

dashboard. 

The dashboard configuration dialog opens. The left pane displays the "Dashboard palette" 
by default. Drag-and-drop the dashboard objects from this palette to the workspace. 

Creating bar charts with three bars 
Use a bar chart to provide a clear overview of data point values. 

1. Insert the "Bar chart" dashboard object to visualize consumption values: 
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2. Select the data point to use for the input of bar values and set the caption text: 

 

The default bar chart consists of one bar. You need three bars to visualize the three data 
points. Set different bar colors to highlight the difference.  
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3. Add two bars and assign these to the other two data points: 

 

Interim result 
You have set up three bars with the following data point assignments:  

• Series 1: e_Water1_Compressor 

• Series 2: e_Water2_Compressor 

• Series 3: a_Sum_CompressedWater 
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Set time range 
Use the time range to define the data point values to be displayed. In this example you 
display the consumption volumes of the week in November from 05.11.2012 to 09.11.2012.  

1. Enter the time range to visualize in this bar chart: 
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Insert warning when values are exceeded  
For example, any limits that you defined for a data point in the "Plausibility" settings can be 
visualized with color coding in the dashboard. Rule of thumb: Always evaluate only one limit 
violation in a dashboard object. Use multiple dashboard objects if you have defined multiple 
limits.  

1. Insert the "Status" dashboard object and select the data point: 
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2. Define the limit to be evaluated. 

 
3. Exit the configuration dialog and save the dashboard. 

Result 
The dashboard is configured.  

See also 
Displaying a Dashboard (Page 652) 
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Displaying a Dashboard 

Procedure 
1. Double-click the dashboard in the Client. 

The dashboard opens. The consumption values of the specified period are visualized 
graphically: 

 

2. Change one of the values of time stamp "08.11.2012" in the matrix to "200". 

3. Recalculate the derived data point. 
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Result 
The high limit of the consumption total is exceeded. The status indicator changes to "red": 
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4.5.2 Energy efficiency 

4.5.2.1 Generating a filtered overview object 

Overview 
A filtered overview object provides you with an overview of all energy efficiency measures 
that are important to you.  

If you want to generate a report that contains all data of an energy efficiency measure in 
Microsoft Excel , insert the filtered overview object under the module of the report. 

Requirement 
You created the energy efficiency measure. 

Procedure 
1. Select the folder under which you wish to create the filtered overview object. 

2. Click "EE Overview" under "Master Data" in the Client . 
The "Energy Efficiency Measures View" dialog opens. 

3. Click "Create Node". 

4. Enter a unique name and an optional description for the filtered overview object. 

5. Click "Filter" to filter the relevant energy efficiency measures. 

The "Energy Efficiency Measurements View Filter" dialog opens. 

6. Enter the filter data. 
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7. Confirm your entries with "OK". 

The relevant energy efficiency measure is displayed in the "Measures" area. 

 
8. Confirm the configuration with "OK". 

Result 
You have created the filtered overview object.  

 

Double-click the filtered overview object to view the filtered energy efficiency measure.  

To generate a report for the filtered energy efficiency measure, insert the filtered overview 
object under the report. Use the "Energy Efficiency Measure" module for this report. You can 
find more information on this topic in the "Module Overview" chapter, keyword "Energy 
Efficiency Measure". 

See also 
Module overview (Page 773) 

Configuring reports (Page 605) 
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4.6 Master data 

4.6.1 Folder 

Overview 
Folders in Energy Manager serve to structure the project tree. You have the possibility of 
building up the pressure in accordance with the requirements of a user. Through the copying 
functionality you can make desired objects such as datapoints available in several folders for 
different users. In the process, for example, a structure based on the layout of the technical 
plants and equipment and additionally a structure based on the accounting can be created. 
The following figure shows an example of this: 

 

Procedure 
1. Click the Master data tab. 

2. Click Folder and enter a name for it 

 

See also 
Object management basics (Page 365) 
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4.6.2 Localization 

4.6.2.1 Location 

Basics on location and country 
With the "Country" object, you can map a country, a region a federal state or a location, for 
example. You can structure objects of the type "Country" hierarchically and in this way also 
map the geographical structure of the company for example: 

 
This option is required if, for example, the individual federal states of a country have different 
public holidays or different time zones. Accordingly, you can store the following country-
specific information in the "Country" object: 

• Holiday settings 

• Country code 

• Time zone 

• Report language 

"Holidays" application 
The information about holidays is required when working with objects of the "Profile" type. 
Here you can define the use of a typical holiday. 

You can enter the holidays manually in the "Country" object or import them from a "*.HOL" 
type file, e.g. from Microsoft Outlook. More details about this file type and the storage 
location of the file are available in the corresponding Microsoft documentation. 

"Time zone" application 
The information about time zones is required if, for example, a company has its locations in 
various countries with different time zones.  

The data is acquired in the local time of the time zone. The information of the acquisition 
time zone is not used until evaluation for correct calculation of the data. 
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Recommendation for the structure in the Client 
You can also use the "Country" object to create a meaningful structure in the project tree of 
the Client. If, for example, you have created a report for a specific country, attach the report 
below the country. This provides you with an overview of the existing reports and the 
corresponding countries.  

 

See also 
Inserting the location or country (Page 659) 

Assign time zone for acquisition or calculation (Page 662) 
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Inserting the location or country 
The following countries are already predefined in Energy Manager: 

• Germany 

Creating a country or location 
1. Click the "Insert location" button in the menu bar under "Master Data > Localize". 

The "Countries" dialog opens. 

 
2. Enter a name and an optional description for the country or the location. 

3. Select the corresponding country code. The country code determines the date format, the 
separator as well as the currency identifier, that are taken automatically from the Windows 
settings underControl Panel > Region. 

4. Select the corresponding time zone. 

5. Select the desired report language. This defines the language of the automatically inserted 
master data of the report (date, from to, user, etc.). 

English and German are supported. 

6. To edit holidays for the country created, click the "Holiday settings" button. 

The dialog for editing holidays opens. 
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Editing holidays 
1. Click "New" to create a new holiday. 

The "Holiday" dialog opens. 

2. Enter a name and an optional description for the holiday. 

3. Select the corresponding date. 

Click "Every year" if the holiday is at the same date every year. 

4. Confirm your entries. 

The holiday is created. 
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5. To import holidays from a HOL file, click "Import" and select the desired file, e.g. 
"Outlook.hol". 

 
  Note 

More details about the "Outlook.hol" file and the storage location of the file are available 
in the corresponding Microsoft documentation. Alternatively, you can use the search 
function in your Explorer to find the file. The storage location depends on the operating 
system and language, e.g. "C:\Program Files (x86)\Microsoft Office\Office12\1031". Open 
the file with a text editor, delete all entries from the file that are not relevant for the 
country to be created, and save this in a different location. Then import this file from this 
storage location using the Energy Manager import functionality for holidays.  

 

 

See also 
Assign time zone for acquisition or calculation (Page 662) 

Regional settings (Page 334) 
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Assign time zone for acquisition or calculation 

Overview 
You can specify the time zone of a country for the following objects: 

• Report 

• Hardware 

• Data point 

Requirement 
A country is configured with its time zone. 

Assigning time zones for reports 
1. To assign the configured time zone of a country for a report, select the required country in 

the "Report" dialog. 

The local time of the country is used in the calculation of a report. 
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2. Alternatively, you can change the set time zone in the "Start Report" dialog. 

 

Assigning time zones for hardware configuration 
1. To assign the configured time zone for an acquisition, activate the "Select location for this 

specific channel" option in the wizard in the "Define Channel Name" dialog, and select the 
required country. 

 
The time stamp is corrected to the specified time zone. 
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Assigning time zones for data points 
1. To assign the configured time zone for data points, select the required country in the "Data 

Point" dialog. 

 

See also 
Creating a report (Page 603) 

Generating reports (Page 50) 

Creating generic data point (Page 463) 

Creating data points (Page 458) 

Creating constants (Page 466) 

Creating derived data points (Page 469) 

Acquisition wizard for interface configuration (Page 413) 
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4.6.2.2 Inserting an organizational unit 

Requirement 
• The Consumer functionality is licensed separately. 

Overview 
It is possible to set up a structure made up of organizational units in which each 
organizational unit can be assigned to exactly one higher-level organizational unit. Each 
organization unit can have multiple lower-level organizational units. Multiple consumers can 
be assigned to each organizational unit. 

Creating an organizational unit 
1. Click the "Insert organizational unit" button in the menu bar under "Master Data > 

Localization". 

The "Organizational Units" dialog opens. Enter a name and optionally a description for the 
new organizational unit. 

 
2. Create the necessary structure of organizational units. 

 

4.6.3 Authorizations 

4.6.3.1 Basic information on authorizations 

Overview 
The Energy Manager authorization concept is basically split into two parts.  

First you can restrict the viewing of objects based on the authority level and domain 
membership settings.  

Second you can restrict functions such as the calculation of reports. 

Each user is assigned to one or several user groups, which are assigned to one or several user 
groups.  
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Functional rights 
Through the functional group determine the user receives their authority level and also their 
functional rights, e.g. for starting reports or editing measured values.  

 

The most important functional groups are stored in the system. The following example 
demonstrates this setup for the functional group of administrators. 
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Visibility of objects 

Authority level 

The user also receives an authority level by means of the functional group. All the objects in 
Energy Manager, for example also folders, have an authority level. 

The authority level, for example of a report, can be entered directly when creating the object, 
or by right-clicking on the object in the project tree under "Properties". 

 
In order for an object to be visible for a user the authority level of the user must be at least 
equal to or higher than the authority level of the object. 

 

Example: An object has the authority level 750. Through his functional rights the user has the 
authority level 500. Since the user's authority level is lower than that of the object, the object 
and its nested objects are hidden to this user.  

Domains 

Each user group may be assigned to one or several domains. A domain in this context 
represents an organization unit. Likewise, all objects are assigned to one or several domains. 
If the assigned domains of the user group corresponds to the assigned object domain, the 
object is visible to the user. 

The configuration is again possible by right-clicking the object or after opening the user 
group under "Domains". 

Exchange folders are provided that can be used to exchange objects such as reports or 
datapoints between the domains. 

You configure the authorization concept in the project tree. The corresponding objects are 
available in the project tree structure under "Configuration > Rights administration": 
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See also 
Setting up users (Page 672) 

Creating user groups (Page 684) 

Navigation (Page 99) 
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4.6.3.2 Domains 

Assigning domains to a user group 
1. To assign domains to the user group, double-click the corresponding user group in the plant 

tree. 

2. Click "Domains" in the user group configuration dialog. 

The available domains are displayed under "Available" in the domain selection dialog.  

 
3. Using the arrow key, assign the selected domain to the user group. 

 
  Note 

The view may be restricted for the administrator as well. Another administrator who, for 
example, is assigned only two of four domains may pass only these two domains to user 
groups. 

 

4. Save the configuration with "OK". 
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Specifying the view of different domains 
1. To specify the view of different domains, click the icon in the menu bar 

 

2. Select the required domain and click "OK". 

Use the filter function to speed up the search for the required domain. 

 
The entry "<all>" makes all objects in the domains that are assigned to the user visible. If 
the user selects only one domain from this list, only the objects that are assigned to this 
domain will be visible. 
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Configuring the domain membership of objects  
1. Select the object and then select the "Domains" command from the shortcut menu. 

The available domains are displayed under "Available" in the domain selection dialog. 

 
2. Using the arrow key, assign the selected domain to the object. 

3. If the authority level that has been assigned prevents the object from being visible to all 
users, activate the "Insert into a domain exchange folder" function. 

In this case, a link to the object concerned is created in the exchange folder. 

4. Select the "Assign domains to children" check box if you want to assign the nested objects of 
an object to the new domain. 

5. Select the "Remove domains from children" check box if you want to remove the nested 
objects of an object from the domain. 

6. Save the configuration with "OK". 
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4.6.3.3 Users 

Setting up users 

Introduction 
A user is required in Energy Manager for a user to be able to login to Energy Manager, Energy 
Manager Web or Energy Manager PRO Mobile. Even if a user only receives emails from Energy 
Manager, he/she requires user access.  

Energy Manager supports automatic logout of users after a lengthy period of inactivity. The 
duration of inactivity is configurable via the functional group. 

If a user has entered the wrong password several times during login to Energy Manager, this 
user is locked out by the system. Only an administrator can remove this lock. 

Requirement 
• Authorization to create users exists. 

• Access to an email server is set up in Energy Manager. 

Setting up users 
1. Select the folder in which you want you create the user. 

2. Click the "Insert User" button in the Client in the menu bar under "Master data > 
Authorization". 

The "Users" dialog opens. The "General" tab is displayed. 

3. Enter the selected Energy Manager user name for the user, for example, the last name of 
the user and the first letter of the first name. Alternatively you can specify an account ID as 
the user name. 

4. Enter the email address of the user. 

Notifications about password changes and temporary passwords will be sent to this email 
address. This email address can also be used to log in to Energy Manager.  
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5. You can also enter a user description. 

6. As needed, enter additional contact information for the user. 

 

Locking and unlocking a user 
A locked user can no longer log into Energy Manager : 

• Energy Manager PRO Client 

• Energy Manager Acquisition configuration 

• Energy Manager Web 

• Energy Manager PRO Mobile 

A locked user continues to receive email notifications that are configured for him/her, for 
example, emails with Energy Manager reports.  

1. To deactivate the user, activate the "User disabled" option. 

2. You can unlock user access again by clicking "Unlock". 

User access has now been deactivated or reactivated. 
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Set password 
1. Select the "Administration" tab in the "User" dialog. 

2. Click "Set password". 

The "Change Password" dialog opens. 

3. Enter the selected password and confirm the password. 

4. The authority level of the user is displayed for information purposes. The authority level of 
the user is taken from the functional group. 

Enabling Single Sign On 
When a user starts the Energy Manager PRO Client, the system checks whether his/her 
Windows user name is entered in Energy Manager . If Energy Manager can identify the name, 
the user does not have to reenter his/her access data.  

1. Double-click the user's entry in the project tree in the Client. 

The "Users" dialog opens. 

2. Select the "Administration" tab. 

 
3. Activate the "Enable single sign on" option. 
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4. Click "Select System User". 

The "Select User" dialog opens. 

 
Alternatively, you can enter the Windows user name directly in the "Select System User" 
field. 

5. Select the user's Windows user name and click "OK". 

6. The Windows user name of the user is applied in the "Select System User" field. 

Creating Quicklinks for Web and Client 
You can create Quicklinks for the user, for Energy Manager PRO Web and Energy Manager 
PRO Client . To do so, select the corresponding tab and create the required Quicklinks. You 
can find additional information on this topic in the "Quicklinks" section. 

Result 
The Energy Manager user is created in the project tree of the Client. 

 

See also 
Basic information on authorizations (Page 665) 

Configuring query types (Page 605) 

Fundamentals of creating printer and directory (Page 691) 

Object naming conventions (Page 373) 

Creating user groups (Page 684) 

Options (Page 374) 

Creating users (Page 320) 

Editing users (Page 322) 
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Quicklinks 

Quicklinks for client 

Overview 
Quicklinks are references to objects in Energy Manager that are used frequently, for example, 
reports. Quicklinks are available to the user for which you have created the Quicklinks.  

You can create Quicklinks for the Energy Manager PRO Client as well as the Energy Manager 
PRO Web. 

Requirement 
You have the "Create Quicklinks" authorization.  

Procedure 
1. Open the configuration dialog for the required user. 

2. Select either the "Quicklinks for Web" or the "Quicklinks for Client" tab. 
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3. Use drag-and-drop to move the object from the project tree of the Client to the "Add 
Quicklink by using Drag & Drop" field. 

 
4. Then click "Add". 

The Quicklink is displayed in the "Quicklinks" area. 

5. If you have created several Quicklinks, specify the sequence with the "Up" and "Down" 
buttons. 
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Result 
The Quicklink is displayed in the "Quicklinks" area: 

• The object name to which the Quicklink points becomes the title. 

• The default icon and background color for this object type is used. 

Depending on the used tab, the Quicklink is displayed in Energy Manager PRO Web or in the 
Client.  

 
 

 Note 

You can change the order of the Quicklinks in the "Quicklinks" area with drag&drop.  
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Editing Quicklinks 
You can change the following properties of a Quicklink with the "Edit Quicklinks" function: 

• Name 

• Symbol 

• Color 

Requirement 
• You have the "Edit Quicklinks" authorization. 

• The Quicklink is created. 

Procedure  
1. Right-click the Quicklink in the "Quicklinks" area in the Client. 

The "Edit Quicklink" dialog box opens. 

 
2. Edit the Quicklink as required. 
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Alternative procedure 
You can also edit the Quicklinks in the configuration dialog of the respective user. 

See also 
Client as navigation tool (Page 23) 

Quicklinks for Web (Page 681) 

Create Quicklinks (Page 33) 

Editing Quicklinks (Page 35) 



 Administration 
 4.6 Master data 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 681 

Quicklinks for Web 

Overview 
You have the option of creating and editing the required Quicklinks in Energy Manager PRO 
Client. You can create up to 50 Quicklinks for each user. 

Procedure 
1. In the Client, double-click the desired user, for example "SIEMENS". 

 
2. Select the "Quicklinks for Web" tab. 
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3. To create a new Quicklink for the user, drag the required object ("Dashboard" in the 
example) from the project tree and drop it onto the "Add Quicklink by using Drag & Drop" 
field. Then click "Add". 

 
  Note 

The only objects you can create as Quicklinks are those listed under the entry point for 
Energy Manager PRO Web, for example under "System > Intranet Viewer". 

 

The Quicklink is displayed in the overview. 

 
4. Click "Edit" to edit the Quicklink. 

The following editing options are available: 

– Change the name of the Quicklink 

– Specify Quicklink as homepage 

– Set the icon for the Quicklink 

– Set the background color for the Quicklink 

5. To delete the Quicklink, click "Delete". 

6. To change the order of the Quicklinks in the overview, click "Up" or "Down". 
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Result 
When you log on with your user access information in Energy Manager PRO Web , the created 
Quicklink is displayed as the homepage. 

 

See also 
Quicklinks for client (Page 676) 

Editing Quicklinks in the Web (Page 106) 

Creating Quicklinks in the Web (Page 103) 

Authorizations (Page 665) 
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4.6.3.4 User group 

Creating user groups 

Creating user groups 
1. To create a user group, click the "Insert User Group" button in the Energy Manager PRO 

Client in the menu bar under "Master Data > Authorization". 

The "User Group" dialog opens. 

2. Enter the "Name" for the user and an optional "Description". 

Assigning user authorizations 
1. To actually assign authorizations to the user: 

2. Assign the user to a user group in the plant tree. 

 
3. Assign the user group to one of several functional groups in the plant tree. 

 

See also 
Basic information on authorizations (Page 665) 

Setting up users (Page 672) 
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Defining an entry point 
You configure Energy Manager PRO Web using the Energy Manager PRO Client. This is where 
you define an entry point for Energy Manager PRO Web.. 

Procedure 
1. Create a folder in the client, for example, "Intranet Viewer". 

2. Copy the objects that are to be seen and edited in Energy Manager PRO Web below this 
folder. 

 
3. Assign the user group the defined entry point by moving the target folder from the plant 

structure to the "Basic" field using drag-and-drop. 

 
The "Location" and "Organization" fields serve the display of the structured view in Energy 
Manager PRO Web. If a location or organization is moved to the respective field using 
drag-and-drop, all consumers are displayed in Energy Manger PRO Web structured by 
location or organizational unit. More details about the structure view are available in the 
section "Consumers and structured view (Page 591)". 
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Authorizations in Energy Manager PRO Web 
Provided the authority level of the functional group and the domain membership of the user 
group of the respective Energy Manager PRO Web user were configured correctly, the object 
and all lower-level objects are visible in Energy Manager PRO Web . Same as on the fully-
fledged client, Energy Manager PRO Web checks if the necessary authorizations, 
corresponding to the functional group to which the user belongs, exist for the actions to be 
executed. 

 

 Note 

Before you can assign the domain, you first have to create the user group. 
 

See also 
Creating user groups (Page 684) 



 Administration 
 4.6 Master data 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 687 

4.6.3.5 Functional group 

Creating functional groups 

Creating functional groups 
1. To create a functional group, select the "Functional Groups" folder in the project tree and 

click the "Insert functional group" button in the menu bar under "Master data > 
Authorization". 

The "Functional Group" dialog opens. 

 
2. Enter the "Name" for the user and an optional "Description". 

3. Select the "Authority level". 

If the user group is assigned several functional groups, the respective highest value is 
transferred to the user. 
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4. If required, activate "Auto Log Off" and enter the number of minutes until the automatic 
logout. 

30 seconds before the automatic log-off, a dialog is opened, in which the seconds until 
the automatic log-off are counted down. 

5. Save the configuration with "OK". 

Enabling Single Sign On  
With the Single Sign On in the functional group you allow a group from the Windows Active 
Directory to log into the Energy Manager PRO Client as well as Energy Manager PRO Web 
without having to enter the login data again. As soon as a user of this group has logged into 
the Windows operating system, he also has access to Energy Manager. 

1. Click "Select" in order to open the Windows dialog for selecting the group. 

The "Select Group" dialog opens. 
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2. Create a new group in the Windows Active Directory or select an existing user group directly 
from the Active Directory. With "Advanced..." you have the possibility of displaying all the 
existing user groups and of selecting one. 

 
The Windows users from this group can now log in by double-clicking the Energy Manager 
icon on the desktop without having to enter a user name or a password. In the Energy 
Manager PRO Web, the user clicks the "Windows Login" button and the Windows user name 
as well as the associated password are applied. 

If a user of the Active Directory group opens the Energy Manager and if an Energy Manager 
user does not yet exist with this login name, a new user with the same name automatically is 
created. Since this Energy Manager user was activated using the Single Sign On option, no 
password is assigned in this case. If this user is no longer a member of the group of the Active 
Directory, this user can no longer log into Energy Manager. 

If a user with the same name already exists in Energy Manager, this user retains their Energy 
Manager password and can then still log into the Energy Manager, even if they are no longer 
a member of the Active Directory. 

If the name of a user changes in the Active Directory, the user name is also updated in the 
Energy Manager. 

 

 Note 

If a group of a domain is enabled for the Single Sign On, the "Energy Manager Portal" service 
must also run as a domain user. 
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Specifying authority levels 
Each object in Energy Manager has an authority level. In the functional group define 
authority levels for all the users who belong to this functional group. The authority level of 
the user is taken from the functional group. An object is only visible for the users of a 
functional group if the authority level of the functional group or of the user respectively is 
higher or at least equal to the authority level of the object. 

Specifying the authority level of the functional group: 

1. Enter the authority level for the functional group. 

Specifying the authority level for an object: 

1. To specify the authority level of an object, select the "Properties" command from the 
shortcut menu of the object in the properties dialog. 

2. Specify the "Authority level". 

 
  Note 

Always assign authority level values that are greater than or equal to your authority level. 

Select the "Inherit Authority Level to children" check box to enable the transfer of the 
authority level to all child objects. 

Usually, an inheritance is not required: If the parent object is not visible, the nested 
objects are also not visible. However, this inheritance is necessary if you make the child 
objects available to other domains by means of the exchange folder. 

 

 



 Administration 
 4.6 Master data 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 691 

4.6.4 Output 

4.6.4.1 Fundamentals of creating printer and directory 

Basics 
The setting up of a printer and a directory is the prerequisite for the automatic printing and 
storing of reports in Energy Manager. 

Create a printer or a directory in the respective hardware. 

If you wish to use the automatic sending of reports via email, create a user including email 
address. 

See also 
Creating a printer (Page 691) 

Creating a folder (Page 694) 

Configuring query types (Page 605) 

Setting up users (Page 672) 

4.6.4.2 Creating a printer 

Overview 
The creation of a printer in Energy Manager is the requirement for the automatic printing of 
reports. 

Requirement 
• The printer is connected to the application server. 

• The hardware is configured in Energy Manager . 
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Procedure 
1. In the Configuration mark the Printer folder. 

 
2. Click the "Insert Printer" button in the menu bar under "Master Data > Output". 

The "Printer" dialog opens. 

3. Enter a unique name and an optional description for the printer. 

4. Enter the printer name in the "Printer name" field, including the port. 

5. To determine the printer port, open the Excel file "Printers V2.0.xls" under 
"Options\Features\Tools" on the Energy Manager product DVD. 

Separate the printer name with the "#" separator to enable automatic printing of reports. 
The separator is inserted automatically.  
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6. Enter the date and time as of which the printer will be valid. 

 
7. Confirm the configuration with "OK". 

Result 
You have successfully created the printer. To automatically print a report on this printer, 
create a "Printer" folder below the hardware object. Copy and paste the printer under the 
query type of the report, and below the "Printer" folder. Then automate the report. 

See also 
Creating hardware (Page 398) 

Fundamentals of creating printer and directory (Page 691) 

Configuring query types (Page 605) 

Object naming conventions (Page 373) 
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4.6.4.3 Creating a folder 

Overview 
The creation of a directory in Energy Manager is the requirement for the automatic saving 
and creating of reports. 

Requirement 
• The folder is available on the PC. 

• The "Hardware" object has been created in Energy Manager . 

Procedure 
1. In the Configuration mark the Directory folder. 

2. Click the "Insert Directory" button in the menu bar under "Master Data > Output". 

The "Directory" dialog opens. 

3. Enter a unique name and an optional description for the directory. 

4. Enter the selected directory in the "Path" field. 

Use the UNL notation to specify the directory to prevent the network drives from being 
mapped on the application server. 

5. Enter the date and time as of which the directory will be valid. 

 
6. Confirm the configuration with "OK". 
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Result 
You have successfully created the directory. To save the results of the report in this directory, 
create a "Directory" folder below the hardware object. Copy and paste the directory to the 
query type of the report and below the "Directory" folder. 

See also 
Fundamentals of creating printer and directory (Page 691) 

Creating hardware (Page 398) 

Configuring query types (Page 605) 

Object naming conventions (Page 373) 
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4.6.5 Enterprise Resource Planning (ERP) 

4.6.5.1 Basics on objects for Enterprise Resource Planning 
Additional information is needed when booking services in ERP. In Energy Manager , this 
information is mapped in the form of the following objects: 

1. ERP domain 

2. Service type 

3. Cost center 

4. Cost center relation 

4.6.5.2 Creating ERP domains 

Overview 
ERP domains are necessary for accounting by means of cost center relations and serve as 
criterion for selection of the respective cost centers. 

Requirement 
The ERP objects have been properly installed. 

Procedure 
1. Select the folder in which the ERP domain is going to be created. 

2. Click the "Insert ERP Business Unit" button in the menu bar under "Master Data > ERP". 

The "ERP Domain" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description" as well as the "external label". Click 

"OK" to confirm your entries and to generate the ERP domain. 

 

Result 
You have successfully created the ERP domain and it is now ready for use by the cost centers. 
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4.6.5.3 Creating service types 

Overview 
Service types are required for settlement details in the cost center relations. 

Requirement 
The ERP objects have been properly installed. 

Procedure 
1. Select the folder in which the service type is going to be created. 

2. Click the "Insert ERP Cost Element" button in the menu bar under "Master Data > ERP". 

The "ERP Service Type" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description" as well as the "external label". Click 

"OK" to confirm your entries and to generate the service type. 

 

Result 
You have successfully created the service type and it is now ready for use in the settlement 
details for cost center relations. 
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4.6.5.4 Creating cost centers 

Overview 
Cost centers are necessary for accounting by means of cost center relations and are assigned 
to exactly one domain. 

Requirement 
The ERP objects have been properly installed. 

Procedure 
1. Select the folder in which the cost center is to be created. 

2. Click the "Insert ERP Cost Center" button in the menu bar under "Master Data > ERP". 

The "ERP Cost Center" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description" as well as the "external label". After 

having assigned the cost center to a domain, click "OK" to confirm your entries and to 
generate the cost center. 

 

Result 
You have successfully created the cost center and it is now ready for use with the cost center 
relations. 
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4.6.5.5 Creating cost center relations 

Overview 
Cost center relations are necessary for the settlement of values computed in Energy Manager 
in an external ERP system. 

Requirement 
The ERP objects have been properly installed. 

Procedure 
1. Select the folder in which the cost center relation is going to be created. 

2. Click the "Insert ERP Cost Center Relation" button in the menu bar under "Master Data > ERP". 

The "ERP Cost Center Relation" dialog opens. 

 
3. Enter a meaningful "Name" and an optional "Description" as well as the "external label". 

Select the domain and set the source and destination cost centers in the "Settlement 
From/To" area. Set up the service type in the settlement details. The specified personnel 
number is used to launch the transaction on the ERP system on the specified accounting 
day, provided the "Active" state has been set. 

 

Result 
You have successfully configured the cost center relation and it is now ready for use in 
accounting. 
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4.6.6 Configuration 

4.6.6.1 Configuring units 

Overview 
A unit may be assigned to any physical variable such as power or work, as well as to non-
physical variables such as costs. You may define and generate new units if the ones that are 
available are inappropriate. 

All available units are located in the "Constant and definitions > Unit" section of the 
configuration folder.  

Inserting the unit 
1. Select the folder in which the unit is going to be created. 

2. Click the "Insert Unit" button in the menu bar under "Master Data > Configuration". 

The "Unit" dialog opens. 

 
3. Enter the unit name in the "Name" field. 

4. You may also enter a "description". 

5. Then select the suitable "Unit type" for the unit. 

The unit type is used to group similar units.  

6. Click "OK" to save the configuration. 

See also 
Creating units (Page 326) 

Editing units (Page 327) 
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4.6.6.2 Unit conversions 

Opening the unit conversion 
1. Click the "Open Unit Conversion" button in the menu bar under "Master Data > 

Configuration" to open the unit conversion. 

 
2. Edit the factors for conversion between the source and target units or generate new 

conversion factors. 

These conversion factors are used only in a few MEVA functions for unit conversion for 
output, as well as in the matrix for input to storage unit conversion. 
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4.6.6.3 Configuring cycle times 

Overview 
You define data acquisition intervals in Energy Manager by setting the cycle time, for 
example, 1 day. Data is acquired at daily intervals in this case. The value is generated at 
00:00:00 h. 

Energy Manager provides predefined cycle times, e.g. "1 hour", or "1 second". You may set up 
a custom cycle time if the list of predefined cycle times does not contain a suitable entry. 

 

Procedure 
1. Select the folder in which you want to set up the cycle time. 

2. Click the "Insert Cycle Time" button in the menu bar under "Master Data > Configuration". 

The "Cycle time" dialog opens. 

3. Type in a name for the cycle time. 

4. You may also enter a description for the cycle time. 

5. Enter a value in "Value" and select the unit, e.g. "5" and "[d] days". 

 
6. Click "OK". 

Result 
The cycle time is configured and created in the project tree of the Client. 

 

You can edit, clone, or delete the configured cycle time. 
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4.6.6.4 Configuring query types 

Overview 
You use a query type in Energy Manager to specify a time range, which is queried for 
example in a report. 

Energy Manager provides predefined query types, e.g. "week", or "year". If the list of 
predefined query types does not contain a suitable entry, first check under "File > Options" on 
the "Query types" tab to determine whether the desired query types exists and is also active. 
If the desired query type does not exist yet, create an own one. 

Procedure 
1. Select the folder in which you want to create the query type. 

2. Click the "Insert Query Type" button in the menu bar under "Master Data > Configuration". 

The "Query type" dialog opens. 

3. Type in a name for the query type. 

4. You may also enter a description for the query type. 

5. If you would like to define a query type based on a time range: 

– First enter a value in "Duration" and select the desired unit. 

With the duration you define the time range that you then use in reports for queries, 
for example 1 month. 

The time range defined by you under "Duration" always begins depending in the 
settings in the "Interval back". 

– Enter a value under "Interval back" and select the desired unit. 

With "Interval back" you have the possibility to define the beginning of the time range 
defined under "Duration". The beginning of a query type can therefore also lie in the 
past.  

Staying with our example from above with a "Duration" of 1 month, a setting of, for 
example 0 months at the "Interval back" means that the query begins on the first day 
of the current month.  

A setting of 1 month at the "Interval back" would mean that the time range begins on 
the 1st day of the previous month.  

A setting of 0 days at the "Interval back" would mean that the time range begins at the 
beginning of the current day.  
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– Enter a value in "Offset" and select the desired unit. 

With the offset you define a time offset that begins with the start time of the query 
type. You can, for example, shift the beginning of the query by 1 hour. If, for example, 
you have defined a "Duration" of 1 month, and an "Interval back" of 0 months, this 
means that the query begins on the first day of the current month at 00:00:00. With an 
"Offset" of, for example, 3 hours you can shift the beginning of the query to 03:00:00. 

It is also possible to enter a negative offset.  

– If needed, active a "One-time offset". 

You require the one-time offset, for example, if you have defined a "Duration" of 8 
hours (one shift) and an offset of 04:00:00 hours. The query thus begins at 04:00:00. 
In order to ensure that an offset of 04:00:00 hours is not added at each new query you 
can activate the "One-time offset". This ensures that you realize a periodic continuation 
of the query from 04:00:00 to 12:00:00 and from 12:00:00 to 20:00:00. Otherwise the 
next period would start at 12:00:00 plus offset, meaning at 16:00:00.  

 

6. Under "Default Report delete after", you define the interval after which the results of a report 
are to be automatically deleted from the project tree of the Client . 

These specifications are applied in the query type in the report in the "Delete report after" 
field. You can overwrite the applied specifications. 
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7. Under "Default start report after" specify the interval after which a report is to be started 
with this query type. These specifications are applied in the query type in the report in the 
"Start report after" field. You can overwrite this activated data. The automatic mode itself 
has to be defined at the query type of the report. 

8. If you would like to define a query type based on a shift: 

– Select "Shift selection". 

The settings under "Duration" and "Offset" will be ignored. 

 

– You require a "Shift" or a "Typical day" from which the definition of the time range to 
be queried can be taken. Copy the "shift" or "typical day" object in the project tree 
under the query type. 

 

The sequence of the "shift" or "typical day" objects under query type has no effect. In 
the query, the shifts or typical days will be sorted according to the times that are 
actually configured.  

 

 Note 

The new query type is made up of all the configurations made in "Interval back", "Duration" 
and "Offset". You have the possibility to cover all the query types. To ensure that the new 
query type is correct, you should check all the settings. Even if you do not require an "Interval 
back", you must nevertheless check the existing setting there. The lower section of the 
configuration window shows a calculation example that corresponds to the respective 
current settings. 
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Result 
The query type is configured and created in the project tree of the Client. The query type is 
available in each object, in which time periods are queried, for example in dashboards or 
reports.  

See also 
Configuring a shift (Page 522) 
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4.6.6.5 Templates 

Report templates 

Overview 
In Energy Manager you can use an existing report to create a template that is the basis for 
new reports. If you create a new report and assign a template to it, the following 
configurations from the template are applied: 

• Display modes 

• Query types 

• Modules 

• Report layout 

Using templates for reports makes sense for similarly structured plants or sites, for example 
when separate reports are required for nearly identical production lines. Changes to the 
template affect all reports that are generated in the future, which are based on this template.  

Requirement 
• In order to create, configure and delete a report template, you need corresponding rights, 

which are defined in the functional group under "Template Manager". 

Creating a report template 
You can create a new template using the "Report as Template" option in the shortcut menu of 
the report (right-click). 

Overview of existing report templates 
Click the "Templates" button in the menu bar under "Master Data > Configuration". The 
existing report templates are displayed on the "Reports" tab. 

More details on creating and using report templates are available in sections "Creating a 
template" and "Using a template". 

See also 
Create a template (Page 619) 

Using a template (Page 621) 

Edit template (Page 623) 

Disconnecting a report from a template (Page 625) 

Working with report templates (Page 618) 
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Load templates 

Requirement 
• The Consumer functionality is licensed separately. 
• In order to create, configure and delete a consumer template, you need corresponding 

rights, which are defined in the functional group under "Template Manager". 

Overview 
Consumer templates allow you to define several categories of consumers (such as machines). 
In this way, a large number of consumers can be managed and configurations can be reused 
for new consumers without having to create them again. 
In the template, you define which Input and which Output the associated consumers have.  
If you use a predefined consumer template when creating a specific consumer, the consumer 
and its associated structure is created as a result. In so doing, each input is created as a 
datapoint and output as a Meva below the consumer. Datapoints are also created below the 
IO buffer. For the input of a consumer template you define the input datapoint, and for the 
output you define the calculation procedure based on a Meva. 
In addition you can have a predefined Dashboard and a report template created 
automatically, which are also created below a consumer as a result. 
In the Widget Dashboard in Energy Manager PRO Web you then have the option of having the 
outputs (Mevas) and inputs (datapoints) of all machines of a template displayed by location 
or organizational unit. 

Procedure 
1. On the "Master Data > Configuration" tab, click "Templates" and then the "Consumer" tab. 

Create a new consumer with "New". 

 
As result under each machine 
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Input tab 

1. First, define the inputs of the consumer template. Assign a Name and define the Category as 
either Power / Flow, Energy / Amount, Count Value, Process Value Others or Text. At least 
one input must be defined. Define the Unit and save. The created inputs correspond to the 
input datapoints of a consumer. 
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Output tab 

Define the output of the consumer template on the Output tab. You can assemble the 
formula for the output from the predefined inputs and mathematical operands. At least one 
input must be defined. 

1. Enter a name and optionally a description for the output. 

2. Select the calculation type if required. Two calculation types are available: 

– Calculation before aggregation 

– Calculation after aggregation 

The calculation types define when results of an individual consumer are aggregated. 

With this functionality, it is possible to correctly calculate all inputs and all outputs of 
consumers of a location or all inputs and all outputs of consumers of an organizational 
unit and to display them in the Widget Dashboard (in Energy Manager PRO Web). 
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An example should illustrate the two functions: You define a consumer template with 
Inputs and outputs.  

In the "Function" (Output tab) of the consumer template, you define the calculation 
procedure (formula) for the Meva, which will be created as the result under each of the 
eight machines. Then, you create eight consumers (e.g. machines) that use this template. 
This means that the datapoints (inputs) and Mevas (outputs) defined according to the 
template are created for each of the eight consumers. Four of the eight consumers are 
assigned to Location A and the other four to Location B. Three of the eight consumers are 
assigned to Organizational Unit A. The other five consumers are assigned to 
Organizational Unit C.  

As the result you want the Widget Dashboard to display all inputs (e.g. corresponding to 
the energy consumption of the machines) and all outputs (e.g. corresponding to the 
produced quantity of the machines) of Location A and Organizational Unit C. 

– "Calculation before aggregation": 

The "Calculation before aggregation" function specifies that each consumer must be 
calculated individually using the formula before all results are aggregated into an 
overall result. 

– "Calculation after aggregation": 

The "Calculation after aggregation" function specifies that all consumers must first be 
aggregated and then the overall result is calculated using the formula.  

For example, it the formula includes a division by a variable, the overall result would be 
false if all individual results of the consumers were summed, since according to 
mathematical calculation rule, the adding of individual fractions with different 
denominators is not permitted. On the other hand, if the denominator contains a 
constant, it is permissible to add all individual results. 

The "Calculation after aggregation" function is thus only relevant when you are using a 
division for a formula in which the denominator contains a variable (e.g. an input). If, on 
the other hand, the denominator contains a constant number (as in the figure above), you 
can also select "Calculation before aggregation". The same overall result would be 
returned in both cases. 

3. In the "Function" field, you assemble the formula that specifies the calculation rule for the 
result of the output. The formula is calculated by the Meva that is created below the 
consumer. Assemble the formula by double-clicking inputs and mathematical operands to 
select them, or type the formula directly in the field. 

4. Define the unit of the output in the "Field" unit. 

5. You can filter existing inputs in the "Filter" field. Enter the designation of the searched-for 
input. 

6. The output can be assigned to a profile that is then multiplied by the profile value. In this 
way, for example, different energy tariffs can be correctly accounted. Details on creating a 
profile are available in section "Configuring profiles (Page 526)". 
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Dashboard tab 

You can define a "Widget Dashboard " on the "Dashboard" tab.  

1. Enter a "Name" and optionally a "Description" for the Widget Dashboard . 

2. Specify whether you want to use the Widget Dashboard by default ("Set as default"). This 
results in this Widget Dashboard being displayed first as soon as you click on the associated 
machine in Energy Manager PRO Web. As a result, only one Widget Dashboard can be set as 
default per machine. 

 
In the Energy Manager PRO Client, the Widget Dashboard is created under a consumer that 
uses this template. 

In Energy Manager PRO Web , the Widget Dashboard can also be displayed and edited for the 
respective consumer.  

Report tab 

You can create a report in the "Report" tab. 

1. You can create a new report with "New". The details for creating a report are available in the 
section "Creating a report (Page 603)". 

2. You can edit the report with "Edit". 

3. You can delete the report with "Delete". 
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4. With "Edit Modules", you can assign the datapoints and Mevas defined as inputs and outputs 
to this report. The "Configure Modules" dialog opens. 

Click on the module and then on "Add Tag/MEVA". Choose the inputs and outputs you 
want to output in the report and save the inputs. 

 
After saving, a report template is created for this report under "Templates > Report 
templates". This report template will be used when a consumer is created to create a specific 
report that is created below the consumer. If the report template is deleted, it is no longer 
possible to create a report when a consumer is created. For this reason, do not delete the 
report templates as long as you have created consumer templates including reports. 

Result 
The consumer template is created and is shown in the menu under "Master Data > 
Configuration > Templates". 

 

Details on the creation of a template or on the automatically created structure can be found 
in section "Consumers and structured view (Page 591)". 

If you modify a template that is in use for a specific consumer, you will be notified that all 
changes will affect the relevant consumers and you will be prompted to indicate whether you 
want to save the changes. 

Templates that are being used by consumers cannot be deleted.  

All templates are also visible in the Templates folder in the shortcut menu. If a dashboard is 
defined in the consumer template, this is also shown in the Templates folder in the shortcut 
menu. 
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4.7 "Administration" menu tab 

4.7.1 Management and monitoring 

4.7.1.1 Logging Viewer 

Overview 
The Logging Editor displays the most important system messages and error messages.  
This section provides instructions related to the following actions: 
1. Opening the Logging Editor 
2. Fields in the Logging Editor 
3. Filter options 
4. Archiving messages 

Requirement 
Successful installation of all software components. 

Opening the Logging Editor 
1. Click the "Open Logging Viewer " button in the menu bar under "Administration > 

Management and Monitoring". 

The Logging Viewer is opened. 
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The LoggingViewer always displays the messages of the current day; the most recent 
message is displayed on top. In the case of a message surge, the time filter automatically sets 
the "hour" mode to reduce the waiting time. 

You may select the monitoring period. Select "Refresh" to view the messages of the selected 
monitoring period, e.g. of the selected day: 

 
Use the "<" and ">" buttons to page the scroll the selected time interval towards the past or 
future.  

All columns can be sorted in ascending or descending order. Click in the header of the 
respective column to sort it.  

 

Fields of the LoggingViewer 
The following columns functions are available in the LoggingViewer: 

• Source 

The error source is the first sorting criterion. Three error sources are currently 
implemented in the system: Kernel, database, and measurements editor. 

• Error class 

The error class can be used to refine message filtering, e.g. evaluation error, job 
management error, deleted, or modified. 

• Event time 

The event time is used to record the time of error or event occurrence. 

• Object 

Certain messages include details on the object in this area. For example, the 
measurements editor logs the data point with name and the MESS_ID that has been 
processed. 
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• Time stamp 

The specific time stamp affected by changes, deletion of creation of new measured values 
is logged in this area. 

• Stext 
The short text, for example, logs the way in which a value has been changed: Value 12.88 
-> 13.54 

• Ltext 
The measurements editor logs the daylight saving and winter time as well as the 
compression level in this column. The remaining sources log the error message in plain 
text in this column. 

The LoggingViewer stores all the information pertaining to security settings. 

The following example shows some actions that are logged in the system: 
• Each successful login or log-off, e.g. "User Admin logged in to DocLiber from 

atw11565@ATPC0BAD". 
• Each failed login attempt, e.g. "Unknown user TEST attempted to login to DocLiber from 

atw11565@ATPC0BAD" or "User Admin failed to log in to DocLiber from 
atw11565@ATPC0BAD". 

• An unauthorized user carrying out an action. 
• Authorization changes, e.g. "User FLORIAN was added to group Administrators". 

Filter functions of the LoggingViewer 
Use the filter function for fast access to the correct information. Click "Filter" in the Logging 
Viewer to open the "Filter" dialog.  

 
Select the column from the first list. Select the operator from the second list. Additional 
entries are available in the third column, depending on the entry you selected in the first 
column. You may also logically link the filters by setting an "AND" or "OR" operation in the 
fourth column.  

Click "OK" to activate the filters. The result is displayed in the Logging Viewer. Uncheck the 
"Filter" check box to cancel filtering.  

The system provides several database jobs for archiving messages. The jobs and the settings 
are listed in the Job queue (Page 731). 
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4.7.2 Service Cockpit 

Overview 
The Service Cockpit provides you with an overview of the status of the acquisition 
components that are configured in the system. 

You use the Service Cockpit to manage the available acquisition components and the drivers 
installed on them.  

Use 
You can also use the Service Cockpit for the following purposes: 

• To obtain an overview of all configured acquisition components. 

• To view the log files that log all actions of an acquisition component. 

• To determine the status of an acquisition component. To show whether the acquisition 
component is acquiring data, or whether an error has occurred. 

• To control an acquisition component: You can restart the acquisition component if its fails 
to run. 

Requirement 
For the software update of the acquisition component: 

• The acquisition component is installed on the PC. 

• The PC is connected to the Energy Manager Server. 

• You have the functional right "Service Cockpit > view". 

• You have the functional right "Master Data > view". 
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Layout 
The Service Cockpit has the following layout: 

 
① The left window pane lists the acquisition components that are configured in the system. 
② The right window pane displays information about the acquisition component or interface se-

lected in ①: 
• Name and version of the acquisition component 
• Time of last communication between the acquisition component and the Energy Manager 

PRO Client 
• Configuration files 
• Log files 
• Gap detection during data acquisition 
You can also perform a software update of the acquisition component here. 
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1. Click the "Open Service Cockpit" button in the menu bar under "Administration > 
Management and Monitoring" to open the Service Cockpit . 

The "Service Cockpit" dialog opens. 

2. Select the acquisition component. 

All information about the acquisition component is displayed. If the time information of 
"Acq/Local Time" deviates by more than five seconds from each other, the time is shown in 
red.  

 
3. Click the "Update" button to manually update the information about the acquisition 

component. 

The information in the Service Cockpit is refreshed automatically at intervals of ten 
seconds.  

4. To restart the acquisition component, click the "Restart" button. 

5. To deactivate the acquisition component, activate the "Disabled" option. 

Status color code 
The following status color code is valid in the Service Cockpit: 

• Green: The acquisition component is acquiring data. 

• Red: The acquisition component is interconnected with the system, but is not acquiring 
data. 

• Gray: The acquisition component is not interconnected with the system. 



Administration  
4.7 "Administration" menu tab 

 SIMATIC Energy Manager PRO V7.2 - Operation 

720 Operating Manual, 12/2020, A5E38952754-AF 

Managing log files 
1. Select the "Log Files" tab to view the log files. 

All log files of the selected acquisition component are displayed. 

 
2. You can open a log file with double-click. 

Alternatively, you can click the "Open" button to open a log file. 

The log file is opened in an editor. 

 
3. You can select a log file and then delete it by clicking the "Delete" button. 

Display installed software 
1. Click the "Software" tab to display the software installed on the acquisition component. 
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Managing interfaces 
1. Select the required interface in the right-hand window area. 

The information about the interface is displayed, for example, gaps in the data acquisition 
or configuration files of the acquisition component. 

 
2. If there are gaps in the data acquisition, you can acknowledge these if required. 

3. To open a configuration file of the acquisition component, select the required file and click 
the "Open" button. 

The file is displayed in an editor. 
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4.7.3 Message lists 

4.7.3.1 Basic information on message lists 

Overview 
A message list informs you of defined deviations of the measured values of a data point. You 
can view this information as follows: 

• by means of a message list view 

• by means of e-mail 

Configure the deviation criteria for the measured values of a datapoint for a datapoint, see 
section "Configuring the plausibility (Page 482)". 

Message lists contain three categories: 

• "Predefined": contains predefined message lists. The following predefined message lists 
are available: 

– All: contains all messages and warnings. 

– All Warnings: Contains all warnings generated when a measured value approaches a 
configured limit. 

– All Violations: contains all messages generated when a measured value violates a limit. 

– GAP detection not acknowledged: Contains unacknowledged messages which relate to 
gaps in the data acquisition. 

– All not Acknowledged: Contains all unacknowledged messages. 

The predefined message lists cannot be edited or deleted. 

• "Public": contains published message lists that can be used by all users. 

• "My": contains message lists that you have configured. 

Notes on message lists 
 

 NOTICE 

Messages in Energy Manager do not replace the message configuration in the process 
control system 

The message is not linked to the process control system. If you want to react to the 
message, you have to configure limit monitoring in the process control system. 

 

To view the messages in a message list, you need to configure the limits for the required data 
point and activate their message. 

Messages are disabled in the project by default. Contact your administrator if you want to 
enable the message for the project. 
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Procedure for configuring a message list 
To configure a message list, follow these steps: 

1. Configure a message list. 

2. Define the message list contents by means of a filter. 

3. You can also configure a message notification, if necessary. 

See also 
Overview (Page 329) 

Editing alarm lists (Page 331) 
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4.7.3.2 Configuring custom message list 

Overview 
You may configure a custom alarm list. In this alarm list you use filters to define which 
messages are displayed. 

Requirement 
• The data point is configured. 

• The data point limit is configured. 

• The message is activated for the limit. 

Procedure 
1. Click the "Open KPI Message Lists" button in the menu bar under "Administration > 

Management and Monitoring". 

2. Then click "New". 

The alarm list configuration dialog opens. 

3. Enter a unique name and an optional description for the alarm list. 

The "Owner" field displays the name of the user who configures the alarm list. 

4. Activate "Publish" to make the alarm list available to all users. 

5. Confirm the configuration with "Save". 
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Result 
The custom alarm list is configured.  

 

Configure one or more filters to specify the contents of the alarm list. You can use the "Clone" 
function to copy the custom alarm list for configuring a different alarm list. You may delete 
the custom alarm list. 

You can open a alarm list that you have made available to all users by selecting 
"Configuration > KPI Alert Lists" in the project tree of the Client. 

 

See also 
Configuring filter for a message list (Page 726) 

Configuring message notification (Page 728) 

Configuring the view for a message list (Page 730) 

Overview (Page 329) 
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4.7.3.3 Configuring filter for a message list 

Overview 
A alarm list filter allows you to exclude messages that you do not need. 

The following rules are valid for filters: 

• For a alarm list configuration containing multiple filters, you need to logically link the 
filters by means of "AND" or "OR" operator. 

• In a configuration with multiple filters, the filters in the list are evaluated from the top 
down. 

Requirement 
The alarm list is configured. 

Procedure 
1. Select the desired alarm list under "Administration > Alarm lists" in the Client . 

2. Click "Add" in the "Configuration" tab. 

3. You may enter filter expressions in a parenthesis. 

4. Select a filter criterion and a condition, e.g. "Value" and ">". 

5. Enter a value, e.g. 1000. 

6. Select an operator / additional operators to interconnect multiple filters. 

7. Click "Up" or "Down" to specify the sorting order by which multiple filters are to be 
evaluated. 

8. Confirm the configuration with "Save". 
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Result 
The filter for the alarm list is configured. With this filter, messages are included in the alarm 
list if their data point value is greater than 1000. You can check the result of the filter 
configuration in the "View" tab. You can delete the filter, or add a new one. 

 

See also 
Configuring custom message list (Page 724) 

Filter criteria for a message list (Page 771) 
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4.7.3.4 Configuring message notification 

Overview 
A message notification informs you by e-mail of unacknowledged messages from a alarm list.  

Requirement 
• The alarm list is configured. 

• The user with the e-mail address is created. 

Procedure 
1. Select the desired alarm list under "Administration > Alarm lists" in the Client . 

2. Click "Notification(s)" in the "Configuration" tab. 

The "Message notifications" dialog opens. 

3. Select a time interval and a time unit for the notification cycle. 

The "Last run" and "Next scheduled run" fields show the time stamp for the last and next 
verification.  

4. To ignore old messages, activate "Set". Select a time for the activation of the notifications. 

5. To activate the notifications, select the "Active" option. 

6. Use the arrow keys to assign the e-mail address. 

 
7. Click "OK". 

 

 Note 

A maximum of 10 alarm messages are sent in one e-mail. If more than 10 alarm messages 
are present, Energy Manager send 10 alarm messages in one e-mail. The number of pending 
alarms is specified in this e-mail. Energy Manager does not send any further e-mail for the 
other alarm messages. 
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Result 
Message notification is configured. Open the view of the corresponding alarm list to 
acknowledge a message. 

See also 
Configuring custom message list (Page 724) 

Time unit abbreviations (Page 771) 

Setting up users (Page 672) 

Editing alarm lists (Page 331) 

Overview (Page 329) 
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4.7.3.5 Configuring the view for a message list 

Overview 
Using the view for a alarm list you specify the period of evaluation.  

Requirement 
The alarm list is configured. 

Procedure 
1. Double-click the desired alarm list under "Configuration > KPI Alert Lists" in the project tree 

of the Client. 
The "Alarm List View" dialog opens. 

2. Select a query type. 
3. Select a start and end time. 
4. To refresh the alarm list view in manual mode, disable "Automatic update" and then click 

"Refresh". 
"Automatic update" is activated by default for a alarm list view. 

5. Confirm the configuration with "OK". 

Result 
The alarm list view is configured. Click "Acknowledge" to prevent a message from being sent 
by e-mail. 

 

See also 
Configuring custom message list (Page 724) 
Configuring message notification (Page 728) 
Query types (Page 765) 
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4.7.4 Task Management 

4.7.4.1 Job queue 

Overview 
Energy Manager Job Queue can be used to run database jobs once or at cyclic intervals.  

In general, three types of jobs are available in Energy Manager. 

1. User jobs of the job queue: 

These jobs are created in the job queue solely by the user. The repetition interval is 
specified by the user. 

2. System jobs of the job queue: 

System jobs are created in the course of the configuration of objects in Energy Manager. 
These jobs run automatically once a day. If necessary, system jobs can be started manually 
in the job queue if a cycle time of less than one day is required. 

3. Background jobs (outside the job queue): 

Background jobs are on the one hand internal jobs that are required for optimal 
functionality of the system (for example synchronization jobs). On the other hand, 
background jobs (like system jobs) are defined by the user in the course of configuration. 
However, background jobs are not executed automatically once a day. Rather they are 
only started at the cycle times specified by the user or manually as required. Background 
jobs are not visible in the job queue. 

 

 Note 

All the jobs currently running become visible in the detailed view of the Logging Viewer. The 
detailed view of the Logging Viewer can be set in the Energy Manager options on the 
"Database" tab using the entry "3" in the "VERBOSE" line. 

 

User jobs of the job queue 
• Job "Generate batch data" 

• Job "Export prognosis EDM" 

• Job "Export SAP R/3 PM historical PD 6h" 

• Job "Export SAP R/3 PM historical PPD 6h" 

• Job "Export PD as ASCII" 

• Job "Export all configured formats" 
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Detailed information about the respective user jobs of the job queue is available in the 
Reference in Chapter User jobs of the job queue (Page 839). 

 

Procedure 
1. Click the "Open job queue" button in the menu bar under "Administration > Task 

Management". 

The Energy Manager Job Queue is opened.  

TheJob Queue contains jobs to be executed at cyclic intervals or in the future. You can 
always "refresh" the view.  

2. Create a new job as follows: 

– Click "New". 

– Select the "Type" (of job). 

– Select the "Start time". 

– Select the "Cycle time". Select "None" if the job is executed only once. 

– Save the configuration with "OK". 

3. Delete a new job as follows: 

– Select the job in the Job Queue. 

– Click "Delete job". 

 

 Note 

All exported files correspond to the format of the current Energy Manager version. If you 
require the files to be exported in the format of the preceding version V6.X, this can be 
realized in the Energy Manager options in the "Database" tab by using the entry "1" in the row 
"EXPORT_OLDV&STYLE". 
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System jobs 
The following job is configured during configuration of a new query type. System jobs are 
already preconfigured and run automatically once per day. Only the duration of the job still 
has to be defined in the query type. 

• Job "Delete old analyses": 

If a new query type is configured using "Master Data > Configuration", "Insert Query Type" 
button, this can then be used in any report. This means that the settings for the above job 
are valid in all reports in which this query type is used.  

Specify the time after which a report with this query type is to be deleted in Energy 
Manager. 
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However, this configuration can be overwritten if necessary during creation of a new 
report without having to create a new query type in the master data. The figure below 
shows the use of the "Month" query type during creation of a report. In this case, it is 
possible to overwrite the setting for deleting the report. The change is then only valid for 
this report. The configuration of the query type created in the master data remains 
unchanged. 
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The following job is configured in "File > Account Settings > Data Storage".  

• Job "Delete old measured values": Specify: 

– After which period data are to be deleted from the database. 

– After which period data are to be deleted from the database and archived. 

– Whether no action is to be set. 

In the Energy Manager options ("File" tab), you can use an entry in 
"DELETE_MSJO_COMMIT" to change the value after how many records a COMMIT is to be 
set. 

 

Configuration or activation of the following system job is effected in "File > Account settings 
> Delete options".  

• Job "Delete old log entries": 

Activate the check box and specify the period after which general messages are to be 
deleted from the Logging Viewer. In the Energy Manager options in the "Database" tab 
you can use the entry "1" in "FEJO_EXPORT_FLAG" to specify that the entries to be deleted 
are to be exported to a file (*.csv) beforehand. 

• Job "Delete old log entries of the IT security": 

Activate the check box and specify the period after which specific messages of the IT 
security are to be deleted from the Logging Viewer. In the Energy Manager options in the 
"Database" tab you can use the entry "1" in "ITSEC_EXPORT_FLAG" to specify that the 
entries to be deleted are to be exported to a file (*.csv) beforehand. 
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• Job "Delete old log entries of measured values": 

Activate the check box and specify the period after which messages about measured 
values are to be deleted from the Logging Viewer. In the Energy Manager options in the 
"Database" tab you can use the entry "1" in "FEJO_EXPORT_MESS_FLAG" to specify that the 
entries to be deleted are to be exported to a file (*.csv) beforehand. 

• Job "Delete old alarms": 

Activate the check box and specify the period after which alarms are to be deleted from 
the alarm lists. Messages of the alarm list are automatically exported to a file (csv.) before 
being deleted.  

 
 

  Note 

If archiving is activated for files to be deleted, these are archived to corresponding 
subdirectories of the archive basic directory before being deleted. The Archive basic 
directory can be viewed in the "Account settings > General" and be modified if required. 
The default retention time for archived data amounts to 10 years. 

 

The following job is executed automatically by the system. 

• Job "Optimize database": 

The job served to optimize tables of the database. Since the optimization of large tables 
can take a longtime, so that the system efficiency may be impaired as a result, the user 
has the option to exclude large tables from the optimization. The entry 
"OPTIMIZE_BIG_TABLES" in the Energy Manager options under "Database" is available to 
this purpose. The entry "0" means that the optimization of large tables is excluded.  
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Background jobs 
The following job is configured during configuration of a new query type or in the course of 
report automation. During initial configuration, confirm the required change of the database 
settings. 

• Job "Automatic analysis": 

Specify after which period a report with this query type is to be started in Energy Manager. 
If necessary, the configuration can be overwritten during the creation of a report of the 
query time. 

Configuration of the following jobs is carried out during the configuration of the database 
backup. 
• Job "Database backup": 

Specify at which times a database backup is to be carried out. 

 
Other background jobs that the user cannot change are: 
• Job "Remove abandoned measured values": Deletes values that cannot be deleted 

immediately. 
• Job "Review analysis automation": Checks the execution of the report automation. 
• Job "Review database backup automation": Checks the execution of the database backups. 

See also 
Logging Viewer (Page 714) 
Configuring query types (Page 703) 
Automating a report (Page 607) 
Account settings (Page 311) 
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4.7.4.2 Task Manager 

Overview 
Energy Manager Task Management Is used to perform different actions, e.g. starting reports, 
importing / exporting data, or initiating calculations. 

You configure the Task Management in the Client. The task also has to be set up on the 
application server, as tasks are executed by means of the Microsoft Scheduler. You may start 
a configured task manually from any client.  

The system provides a number of predefined tasks. The following section describes the 
general structure of Task Management.  

 
① Task Manager serves as grouping object and to define the hardware that is to run a task. 
② The task object contains information on the function to be executed and the schedule. 
③ The interval definition becomes necessary as soon as a time frame that is relative to the current 

time has to be defined. 
④ Objects required for the task. 

 
 

 Note 

The task is used to execute a *.cmd file that is stored in the "CMD" section of the Energy 
Manager installation folder on the application server. For this reason, the task schedule needs 
to be created on the application server. The user running the task must have corresponding 
Administrator privileges. 

 

This section provides instructions related to the following actions: 

• Creating the Task Manager. 

• Creating tasks 

• Creating interval definitions 

• Existing tasks 
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Creating the Task Manager 
1. Select the folder under which the Task Manager is going to be created. Save all tasks to this 

folder to avoid the creation of different tasks with the same content. 

 
2. Click the "Insert Task Manager" button in the menu bar under "Administration > Task 

Management". 

The "Task Manager" dialog opens. 

 
3. Enter a user "name" and an optional "description". 

4. Select the PC on which Task Manager is to be set up from the "Hardware" list box. 

5. Save the configuration with "OK". 

Create a task in the next step. 

See also 
Functions for Task Management (Page 842) 

Task (Page 740) 

Interval definition (Page 741) 
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4.7.4.3 Task 

Creating the task  
1. Click "Insert Task" in the menu bar under "Administration > Task Management". 

The "Task" dialog opens. 

 
2. Enter the task "name" and an optional "description". The name may not contain special 

characters. 

3. Select the function that the task has to execute from the "Command Line:" list box. 

 
  Note 

After having changed or updated the command line contents (*.CMD file), you must enter 
your login information once again.  

 

4. If you want to store a schedule that determines the start of the task, proceed as follows: 

– Click "Schedule". 

– Enter your "User name" and "Password" in the "Task Logon" dialog. Click "OK". 

The Microsoft Scheduler opens.  

– Configure the task and then close the input dialog with "OK". For more information on 
Microsoft Scheduler, refer to the Microsoft Windows online help. 

5. Save the configuration with "OK". 

If necessary, specify an interval definition. 

See also 
Task Manager (Page 738) 

Interval definition (Page 741) 
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4.7.4.4 Interval definition 

Creating the interval definition 
1. Click the "Insert Interval Definition" button in the menu bar under "Administration > Task 

Management". 

The "Export Task" dialog opens. 

 
2. Enter a "Name" and an optional "Description" for the interval definition. 

3. Define the time window in the "Interval back:", "Duration:", and "Offset:" fields. The time 
window contents are always relative to the current time. 

4. To export all data points to a single file, select the "One file only" check box and enter the 
"Target Filename". However, be aware of the fact that the size of the import file is limited to 
5000 lines. 

A separate file is generated for each data point if this option is not activated. 

5. Select the "Remove after export" check box to delete the files from the database on 
completion of the export. 
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6. Click "Start" to export only selected data points. 

– Select the data points to export and then click "Start selected". 

 

7. Save the configuration with "OK". 

Example 
Example: Configuration of the example above 

Let us assume that the task is going to be launched on January 17, 2008 at 13:57 

Truncate with "Month" 01/01/2008 00:00 

Interval back (6) 07/01/2007 00:00 

Offset (no offset) 07/01/2007 00:00 

Duration (1 day) 07/01/2007 00:00 - 07/02/2007 00:00 

The interval from 07/01/07 00:00 to 07/02/07 00:00 is now defined in the example. 

See also 
Task (Page 740) 

Task Manager (Page 738) 
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4.7.5 Import and export 

4.7.5.1 Basic principles of export and import 

Overview 
You can export your configuration data in XML format in Energy Manager and import them 
again. Use the "Import / Export" option, for example, to back up your configuration data.  

When exporting data from Energy Manager, the export is marked with the version of Energy 
Manager. Export with the version is not taken into account in previous Energy Manager 
versions. An export or import of data is therefore only possible for identical Energy Manager 
versions. 

Conflict test during import 
The objects to be imported are compared with the objects in Energy Manager based on name 
and type during import. If an object already exists, the same object is created additionally 
with a sequential number . 

 

 Note 
You cannot undo the data import! 

Therefore prepare the import process carefully. Check if there are conflicts with existing data 
prior to the import. Note the following recommendations: 
• If you want to import exported data again, divide the preceding export of the data into 

several steps. 
• If possible, export only data you have created yourself. 
• It is not advisable to carry out an import of the entire Energy Manager structure. 

 

4.7.5.2 Export configuration 

Export options 
You can export the following structures from Energy Manager: 

• Complete folder structure 

The selected object is exported with all child objects.  

• Single object 

Only the selected object is exported. Child objects are not exported. 
 

 Note 

Objects with an ID of less than 5000 are master data of Energy Manager. If these data is 
included in the export, the existing master data are updated during the import.  
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Procedure 
1. Click the "Export" button in the menu bar under "Administration > Import and Export". 

The "Export Wizard" dialog opens. 

2. Select the object you want to export. 

 
3. Select the required export option. 

4. Select the directory in which the export files are to be stored. 

The data are exported from Energy Manager. Two files are created during the export:  

– "Nodes.xml" with the exported data 

– logdoc.txt" with detailed information on the export 

5. Click "Finish". 

Result 
The data export is complete.  



 Administration 
 4.7 "Administration" menu tab 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 745 

4.7.5.3 Importing data 

Import options 
You can import the following structures from Energy Manager: 

• Complete folder structure that is saved in the XML file. 

• Complete folder structure of the selected object 

• Single object 

Requirement 
The export data is stored in the file system.  

Procedure 
1. Click the "Import" button in the menu bar under "Administration > Import and Export". 

The "Import Wizard" dialog opens. 

2. Enter the folder in which the XML file you wish to import is located. 

3. Select the required import option. 
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4. Select the folder in which the import data is to be stored. 

 

The import process is started. The objects to be imported are compared with the existing 
objects in Energy Manager. If objects with identical names and types already exist in 
Energy Manager, you are prompted to make a selection for each object: 

– Select for each object if the existing object is to be overwritten or kept. 

The import is executed once this conflict check is complete.  

5. To close the wizard, click "Exit". 

 

 Note 

Reimporting of data is only possible in the same version from which the data were also 
exported. 

 

Result 
The import data is stored in the specified folder in the Client. 
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4.7.6 Backup and Restore 

4.7.6.1 Backup 

Overview 
The backup functionality offers you the possibility to restore the system in the case of a 
hardware failure. A backup can be started manually or be automated. For each day of the 
week it is possible to select an incremental backup, a full backup or no backup. The storage 
location of the backup can be defined. 

Procedure 
1. Click the "Adminstration" tab and then the "Backup" icon. 

 
2. Click the "Status" tab. Three functions are available here: 

Status of the active backup: 

– It is possible to carry out a backup immediately manually. If the database is not in 
archive mode yet, first switch to this mode by clicking the button. 

– Otherwise a full backup is started by clicking the "Backup" button and is stored under 
the preset path. The status of a running backup is indicated by the bar. 

Status of the last backup: 

– The date and time when the last backup was carried out are displayed. You can check 
here when the last correct backup was carried out. 

– If a backup was aborted due to an error, this is indicated by an error message. More 
detailed information on this topic is available on the "Administration > Management 
and Monitoring" tab in the Log Viewer. 

Status of drive: 

– Here you see how much storage space is still available for carrying out the backup. You 
see the designation of the database host as well as the associated backup path. The 
storage capacity can only be displayed if the application and database are installed on 
the same computer. 
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3. Click the "Configuration" tab. Here you can select the storage site of the backup as well as 
configure the execution of the backup. 

Browse backup directory: 

– With the "Browse" button you can search for the directory in which the backup is to be 
stored. The browse functionality is only available if you are at the database server. A 
directory on the database server or a directory linked to the database server via UNC 
Notation has to be selected as the backup directory. A directory mapped with the 
database server is not recognized in the system. Additional information on the required 
user permissions can be found in the database documentation. 

Configure automatic backup:  

– Specify for each weekday when an incremental or a full backup is to be carried out. In 
as far as you carry out backups you must carry out at least one full backup per week. It 
is not possible to carry out solely incremental backups. The very first backup to be 
performed must be a full backup. 

– With a full backup, the entire database is backed up, which is why it requires more 
memory space and more time than an incremental backup. With an incremental 
backup, the portions that are not yet backed up since the last back up are backed up. 

– If you have selected "None" for the backup for each weekday, the archiving mode is 
deactivated. In case of a defect it is then not possible to restore the database. 

 

 Note 

Never save backups on the same physical hard disk that also contains the database. In the 
case of a defective disk, the database as well as the backup would be lost. 

 

Result 
Correctly executed backups are stored in the selected or preset directory: 

 

To learn how to restore the database, refer to the section "Restore (Page 749)". 

See also 
Backup (Page 332) 
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4.7.6.2 Restore 

Overview 
The Restore function is a separate application which helps you to restore the complete 
database should the necessity arise. 

 

 Note 
Restoring older versions 

Version V7.2 does not support restoring a backup that was created with Version 7.1. 
 

Procedure 
1. Contact Support in the event of a restore. 

2. Restoration can only be carried out on a database that already exists. Re-install the failed 
components, but at least the database. Carry out the installation from the DVD and using 
the installation manual included on it. To connect the newly installed components to the 
system again, use the same passwords. 

3. The "DbRestore.exe" application is located in the installation directory of the Energy 
Manager in the folder "DB" > "EnMPRO" > "Admin" > "restore". The file can only be executed 
at the database server. Run the file. 

 
The operating system user who carries out the restoration must have corresponding local 
rights, for example, belong to a database administrator user group.  

4. Select a language and click "Next". 

5. Browse the directory in which the backups are located and click "Next". 

 
6. In this context the name of the database, the selected backup directory and the date of the 

backup file are displayed once more. 

7. Select the time at which the database is to be restored. You can select either the last 
available backup or a backup from a specific moment. In as far as no backup file is available 
on this date, a corresponding information is displayed. 

8. Click "Start" to start the restoration. Restoration is carried out automatically with the full 
backup and the incremental backup belonging the selected moment of restoration. 
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9. After restoration has been completed successfully, you can terminate the wizard with 
"Finish". 

10.Restart the computer. 

 

 Note 

You can only use the Restore and Backup function if you used the same Admin passwords 
when installing the systems in question.  

 

Result 
The progress of the restoration process is indicated by a bar. 

 

 

By clicking the "View Log" button you obtain detailed information about the restoration 
process. 

If you want to save the log, click "Save to File". The log is then stored as a text file in the 
Restore directory. 

 

See also 
Backup (Page 332) 



 Administration 
 4.8 Historizing calculation logic 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 751 

4.8 Historizing calculation logic 

4.8.1 History management basics 

Definition 
The history management in Energy Manager saves every change to the configuration of a 
calculation. This enables the tracing and reconstruction of the configuration of a calculation 
at any given instant. 

Example 
One year ago, you configured a report for the calculation of the power costs of two loads. 

 

In the course of the year, you have added the calculation of a third load.  

 

Now you are required to reconstruct the report for the calculation of the power costs of two 
loads at a specific time. To do this you use the history management of the report: 

1. In the history management with monitoring time stamp, look for the configuration that you 
want to reconstruct. 

2. When generating the report under "Model", enter the required monitoring time stamp. 

The report is generated using the configuration data saved under the specified monitoring 
time stamp. 

 
  Note 

Versioning measured values 

In order to correctly reconstruct the report, when generating the report, enter the version 
of the measured values valid at the time of the specified monitoring time stamp.  
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Objects for history management 
You can display configuration changes for the following Energy Manager objects: 

• Data point of type "Derived" 

• Measuring variable 

• Report 

The following configuration data are displayed during the history management of objects: 
 
Configuration Meaning 
Calculation tree Shows objects of the calculation and their order in the calculation tree.  
Type Shows the type of the object, e.g. "Module". 

"Type" is only used in the history management of the reports. 
Name Displays the name of the object. 
Function Displays the function of a data point or of a measuring variable, e.g. "Measure-

ment" or "Addition of MEVAs". 
Operation Displays the type of change to the object, e.g. "Delete". 
Unit Displays the unit of a data point or measuring variable, e.g. "kWh". 
Changed on Displays the date when the change was made to the object. 
Changed by Displays the user who made the change to the object. 
Description Displays the description of the changed object. 

The following restrictions apply to the history management of reports: 

• No history is kept of report templates. 

• No history is kept of start values. 

• Automatically generated reports are only calculated with the current configuration data. 

• Reports that are generated in Energy Manager PRO Web are only calculated with the 
current configuration data. 

• Specific modules, e.g. plausibility modules, are only calculated with the current 
configuration data. 
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Display types for history management 
During object history management you can select the following display type: 

• Only state 

With this display type, the current calculation tree and the configuration data are 
displayed for the required monitoring time stamp. 
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4.8.2 Historization of data points 

Procedure 
1. Select the data point for which you want to view the historization. 

2. Select the "History management" command from the shortcut menu. 

3. You first have to select a date to call the corresponding configuration. 

4. Clicking "Calculate" displays the tree that is currently available for the selected time. The 
configuration status that is valid at the selected time is displayed in the list. The log for data 
points includes changes to units and functions. The log for derived data points also includes 
changes to the assigned measuring variable. 
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5. Click the "Recalculate derived Measurement ..." button to enter a time period. If the 
calculation rule of the derived data point has changed, enter the time period for which the 
derived data point is recalculated. 

 
However, this requires that the check box "Actual model" was not selected in the 
definition of the derived data point. If the check box is selected, the defined models are 
not activated and the calculation is always based on the current model. 

6. Clicking "Excel" opens an Excel spreadsheet and the displayed data is inserted for further 
use. 

7. To get to the definition of the models for derived data points, click on the "Define validity 
period" button. 

8. Click "Add", "Edit", or "Delete" buttons to specify or edit the various validities of the models. 

 
 

  Note 

A model may not end within an interval of the derived data point. If a derived data point 
has been assigned the "Month" interval, the model may only change on the first day of 
each month (01.xx. 00:00). 
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A recalculation of the derived data point is not automatically initiated when models are 
changed. To recalculate the derived data point according to a changed calculation rule, click 
"Calculate".  

 
In the dialog, enter the time period for which the derived data point is recalculated. The last 
model is always assigned the stop date of 01.01.2040. 

However, this requires that the check box "Actual model" was not selected in the definition of 
the derived data point. If the check box is selected, the defined models are not activated and 
the calculation is always based on the current model. 
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4.8.3 Historization of measurement variables 

Procedure 
1. Select the measuring variable for which you want to view the historization. 

2. Select the "History management" command from the shortcut menu. 

3. You first have to select a date to call the corresponding configuration. 

4. Click "Calculate" to display the tree that is currently available for the selected time. 

The entry always contains the currently valid function. The description field contains 
entries for both the old and new functions. The old unit or the new unit is listed in the 
description field "Unit". 

 

5. Click "Excel" to open an Excel spreadsheet in order to insert the data that is displayed for 
further use. Click "Close" to exit the dialog. 

The history of objects is retained for their entire life time in the system. 
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4.8.4 Historization of reports. 

Overview 
The following report attributes are included in the log: 
• Objects in the calculation tree and their order. Example: Which data points or parameters 

were connected at a specific time to a module or Meva node and their order. 
• MEVA: function and unit 
• Measurement: Unit 
• Parameter: Substitute value 
• Module: Module type 

Procedure 
1. Select the report for which you want to view the historization. 
2. Select the "History management" command from the shortcut menu. 
3. You first have to select a date to call the corresponding configuration. 
4. Click "Calculate" to display the tree that is currently available for the selected time. 

All changes with regard to "Insert", "Update" and "Delete" operations of modules, 
connected data points and Mevas are included in the log. 
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5. At the start of reporting, you can select the model (date) that is to be used to calculate the
report. The measured values that are valid at this point in time (version) should be used
accordingly for calculations.

6. To disable the display of the model date in the header data of the report, assign the value 0
to the name "Show Model" in "Administration > Energy Manager Options > Appl.".

The model date is displayed in the header data of the report by default: Show Model  = 1.

See also 
Options (Page 374) 
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Reference 5
5.1 Acquisition status of a value 

The acquisition status of a value shows whether this value was acquired properly. Values are 
displayed independently of the acquisition status in the chart and reused in MEVAs. 

The following list contains all relevant acquisition statuses with a short explanation: 

• STER_OK

A value with this acquisition status was acquired properly.

Effect: In the report, this value is displayed in black.

• STER_GAP

A value with this acquisition status is requested more often than defined in the data point.

Example: A data point has a cycle duration of 15 minutes. This means that the value of the
data point is requested every 15 minutes at the interface. If - because of a
misconfiguration - the value in Energy Manager is requested every 5 minutes, 3 values are
passed to the acquisition component after each 15 minute cycle. Since only one value is
saved in the 15 minute interval, the first two values are discarded and the third value with
the STER_GAP acquisition status is saved.

Effect: In the report, this value is displayed in light green.

• STER_INVALID

This acquisition status is only relevant for values of an OPC or OLE DB interface. In addition
to the measured value, a status can be acquired as well with these interfaces. If the
acquired status of a value is "Invalid", this value receives the acquisition status
STER_INVALID in the Energy Manager.

Effect: In the report, this value is displayed in red.

• STER_FIRST

The first captured measured value after the restart of the kernel of the acquisition
component receives the STER_FIRST status.

Effect: In the report, this value is displayed in black.

• STER_FIRST_INVALID

This status is a combination of the acquisition statuses STER_INVALID and STER_FIRST.

If the first captured measured value after the restart of the kernel of the acquisition
component is invalid, the value receives this status.

Effect: In the report, this value is displayed in red.
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• STER_LAST 

If the kernel of the acquisition component is stopped or restarted, the last captured 
measured value before the stop of the acquisition component receives the STER_LAST 
status. 

Effect: In the report, this value is displayed in black. 

• STER_LAST_INVALID 

This status is a combination of the acquisition statuses STER_INVALID and STER_LAST. 

If the last captured measured value after the restart of the kernel of the acquisition 
component is invalid, the value receives this status. 

Effect: In the report, this value is displayed in red. 
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5.2 Correction status of a value 
Each acquired value in Energy Manager has a correction status. The correction status 
indicates whether and how a measured value was corrected. You can see and change the 
correction status of a value in the matrix or the measured value editor. 

Values with a different correction status than "Valid" are displayed in orange in the report. 
Values are displayed independently of the capture status in the chart and reused in MEVAs. 

The following value correction states are possible: 

• Valid 

If a value was not corrected, the value has this correction status. 

• Valid with manual manipulation 

If a value in the matrix or the measured value editor is overwritten, the value receives this 
correction status. 

• Corrected 

If a value is automatically corrected by the system, the value receives this correction 
status. 

Example: If the counter value difference (consumption) does not correspond to the filter 
criteria, this value is automatically corrected. 

• Corrected with LRU 

If a missing value is inserted via the substitute value strategy "LRU", the value receives this 
correction status. 

• Corrected with substitute measurement 

If a missing value is inserted via the substitute value strategy "AKS", the value receives this 
correction status. 

• Corrected with substitute value  

If a missing value is inserted via the substitute value strategy "Substitute value", the value 
receives this correction status. 

• Invalid  

You can give values this correction status. Values with this correction status are not 
processed further in the MEVAs.  

• Valid corr. with LRU and manual manipulation 

This correction status is not assigned automatically. 

If a value with the "Corrected with LRU" status is overwritten in the matrix or measured 
value editor, the value keeps this status. To mark such values accordingly, you can give 
these values the correction status "Valid corr. with LRU and manual manipulation". 
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• Valid corr. with substitute value measurement and manual manipulation 

This correction status is not assigned automatically. 

If a value with the "Corrected with substitute measurement" status is overwritten in the 
matrix or measured value editor, the value keeps this status. To mark such values 
accordingly, you can give these values the correction status "Valid corr. with substitute 
value measurement and manual manipulation". 

• Valid corr. with substitute value and manual manipulation 

This correction status is not assigned automatically. 

If a value with the "Corrected with substitute value" status is overwritten in the matrix or 
measured value editor, the value keeps this status. To mark such values accordingly, you 
can give these values the correction status "Valid corr. with LRU and manual 
manipulation". 
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5.3 Query types 
The following query periods are available: 
 
Query type Description 
Derived-E2 
Discontinued, no longer availa-
ble in the new version.  

Derived measurement E2 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
09.01.2008 00:00 - 26.05.2035 00:00 
Interval for automatic start of reporting: 
09.01.2008 00:00 - 26.05.2035 00:00 

Ad-Hoc This query type represents a user-specific query period. You must 
enter both the start and end time. 
Interval for automatic start of reporting: 
Query type cannot be used in automatic reporting. 

Current quarter Current quarter 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 01.04.2008 00:00 
Interval for automatic start of reporting: 
01.01.2008 00:00 - 01.04.2008 00:00 

Analysis shift 1 
or 
shift 1 

Shift 1 queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 05:30 - 08.01.2008 13:30 
Interval for automatic start of reporting: 
07.01.2008 05:30 - 08.01.2008 13:30 

Analysis shift 2 
or 
shift 2 

Shift 2 queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 13:30 - 08.01.2008 21:30 
Interval for automatic start of reporting: 
07.01.2008 13:30 - 08.01.2008 21:30 

Analysis shift 3 
or 
shift 3 

Shift 3 queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 21:30 - 09.01.2008 05:30 
Interval for automatic start of reporting: 
07.01.2008 21:30 - 09.01.2008 05:30 

Energy supplier - Year Energy supplier queries - Years 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
31.08.2006 22:00 - 31.08.2007 22:00 
Interval for automatic start of reporting: 
31.08.2006 22:00 - 31.08.2007 22:00 
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Query type Description 
Energy supplier - Month Energy supplier queries - Months 

Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
30.11.2007 22:00 - 31.12.2007 22:00 
Interval for automatic start of reporting: 
30.11.2007 22:00 - 31.12.2007 22:00 

Energy supplier - Day Energy supplier queries - Days 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
06.01.2008 22:00 - 07.01.2008 22:00 
Interval for automatic start of reporting: 
06.01.2008 22:00 - 07.01.2008 22:00 

Energy supplier - Week Energy supplier queries - Weeks 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
Sun. 30.12.2007 22:00 - Sun. 06.01.2008 22:00 
Interval for automatic start of reporting: 
Sun. 30.12.2007 22:00 - Sun. 06.01.2008 22:00 

Next year Forecast next year  
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2009 00:00 - 01.01.2010 00:00 
Interval for automatic start of reporting: 
01.01.2009 00:00 - 01.01.2010 00:00 

Next month Forecast next month 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
09.01.2008 00:00 - 09.02.2008 00:00 
Interval for automatic start of reporting: 
09.01.2008 00:00 - 09.02.2008 00:00 

Next day Forecast next day 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
09.01.2008 00:00 - 10.01.2008 00:00 
Interval for automatic start of reporting: 
09.01.2008 00:00 - 10.01.2008 00:00 

Next week Forecast next week 
Interval for manual start of reporting: 
09.01.2008 00:00 - 09.02.2008 00:00 
Interval for automatic start of reporting: 
09.01.2008 00:00 - 09.02.2008 00:00 

Financial year + 6h Financial year + 6h queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.10.2007 06:00 - 01.10.2008 06:00 
Interval for automatic start of reporting: 
01.10.2006 06:00 - 01.10.2007 06:00 



 Reference 
 5.3 Query types 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 767 

Query type Description 
GAS - Month GAS month queries 

Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.12.2007 06:00 - 01.01.2008 06:00 
Interval for automatic start of reporting: 
01.12.2007 06:00 - 01.01.2008 06:00 

GAS day Query GAS days 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
06.01.2008 06:00 - 07.01.2008 06:00 
Interval for automatic start of reporting: 
06.01.2008 06:00 - 07.01.2008 06:00 

Financial year Financial year queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.10.2007 00:00 - 01.10.2008 00:00 
Interval for automatic start of reporting: 
01.10.2006 00:00 - 01.10.2007 00:00 

Year Query year 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 01.01.2009 00:00 
Interval for automatic start of reporting: 
01.01.2007 00:00 - 01.01.2008 00:00 

KR-14-year Query KR-14 year 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.12.2007 00:00 - 01.12.2008 00:00 
Interval for automatic start of reporting: 
01.12.2006 00:00 - 01.12.2007 00:00 

Month Query month 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 01.02.2008 00:00 
Interval for automatic start of reporting: 
01.12.2007 00:00 - 01.01.2008 00:00 

Month + 6h Monthly queries + 6h 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 06:00 - 01.02.2008 06:00 
Interval for automatic start of reporting: 
01.12.2007 06:00 - 01.01.2008 06:00 
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Query type Description 
Cur. month Current month 

Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 01.02.2008 00:00 
Interval for automatic start of reporting: 
01.01.2008 00:00 - 01.02.2008 00:00 

Current month + 6h Queries current month + 6h 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 06:00 - 01.02.2008 06:00 
Interval for automatic start of reporting: 
01.01.2008 06:00 - 01.02.2008 06:00 

Month (current + M) Month super (2 months) queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 01.03.2008 00:00 
Interval for automatic start of reporting: 
01.01.2008 00:00 - 01.03.2008 00:00 

Production day 
Discontinued, no longer availa-
ble in the new version. 

Query production days 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 05:30 - 09.01.2008 05:30 
Interval for automatic start of reporting: 
07.01.2008 05:30 - 08.01.2008 05:30 

Production day T7 
Discontinued, no longer availa-
ble in the new version. 

Query production day Converter 7 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 05:30 - 09.01.2008 05:30 
Interval for automatic start of reporting: 
07.01.2008 05:30 - 08.01.2008 05:30 

Production day T8 
Discontinued, no longer availa-
ble in the new version. 

Query production day Converter 8 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 05:30 - 09.01.2008 05:30 
Interval for automatic start of reporting: 
07.01.2008 05:30 - 08.01.2008 05:30 

Production day T9 
Discontinued, no longer availa-
ble in the new version. 

Query production day Converter 9 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 05:30 - 09.01.2008 05:30 
Interval for automatic start of reporting: 
07.01.2008 05:30 - 08.01.2008 05:30 
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Query type Description 
Shift 
Discontinued, no longer availa-
ble in the new version. 
Query type corresponds to day 
+6h 

Shift queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
07.01.2008 06:00 - 08.01.2008 06:00 
Interval for automatic start of reporting: 
07.01.2008 06:00 - 08.01.2008 06:00 

Shift 06:00-14:00 Shift 06:00-14:00 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 06:00 - 08.01.2008 14:00 
Interval for automatic start of reporting: 
07.01.2008 06:00 - 07.01.2008 14:00 

Shift 06:00 - 14:30 Shift 06:00-14:30 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 06:00 - 08.01.2008 14:30 
Interval for automatic start of reporting: 
07.01.2008 06:00 - 07.01.2008 14:30 

Shift 14:00-23:00 Shift 14:00-23:00 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 14:00 - 08.01.2008 23:00 
Interval for automatic start of reporting: 
07.01.2008 14:00 - 07.01.2008 23:00 

Shift 14:30-23:00 Shift 14:30-23:00 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 14:30 - 08.01.2008 23:00 
Interval for automatic start of reporting: 
07.01.2008 14:30 - 07.01.2008 23:00 

Shift 23:00-06:00 Shift 23:00-06:00 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 23:00 - 08.01.2008 06:00 
Interval for automatic start of reporting: 
07.01.2008 23:00 - 07.01.2008 06:00 

Since new year Queries since beginning of the year 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 08.01.2008 00:00 
Interval for automatic start of reporting: 
Query type cannot be used in automatic reporting. 
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Query type Description 
Since the beginning of the pre-
vious year 

Queries since the beginning of the previous year 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2007 00:00 - 08.01.2008 00:00 
Interval for automatic start of reporting: 
Query type cannot be used in automatic reporting. 

Since beginning of month Queries since the beginning of the month 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
01.01.2008 00:00 - 08.01.2008 00:00 
Interval for automatic start of reporting: 
Query type cannot be used in automatic reporting. 

Hour 
Discontinued, no longer availa-
ble in the new version. 

Hourly queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 09:00 - 08.01.2008 10:00 
Interval for automatic start of reporting: 
08.01.2008 08:00 - 08.01.2008 09:00 

Hour with half-hour offset 
Discontinued, no longer availa-
ble in the new version. 

Queries of hours with half-hour offset 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 09:30 - 08.01.2008 10:30 
Interval for automatic start of reporting: 
08.01.2008 08:30 - 08.01.2008 09:30 

Day Daily queries 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 00:00 - 09.01.2008 00:00 
Interval for automatic start of reporting: 
07.01.2008 00:00 - 08.01.2008 00:00 

Day + 6h Daily queries + 6h 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 06:00 - 09.01.2008 06:00 
Interval for automatic start of reporting: 
07.01.2008 06:00 - 08.01.2008 06:00 

Day curr. Current day 
Time of observation: 08.01.2008 09:15:12 
Interval for manual start of reporting: 
08.01.2008 00:00 - 09.01.2008 00:00 
Interval for automatic start of reporting: 
08.01.2008 00:00 - 09.01.2008 00:00 

Day/shift Daily query - 1h 45min 
Interval for manual start of reporting: 
06.01.2008 22:15 - 07.01.2008 22:15 
Interval for automatic start of reporting: 
06.01.2008 22:15 - 07.01.2008 22:15 
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Query type Description 
Comparison (internal) Internal function for comparison queries 
Week Weekly queries 

Interval for manual start of reporting: 
07.01.2008 00:00 - 14.01.2008 00:00 
Interval for automatic start of reporting: 
31.12.2007 00:00 - 07.01.2008 00:00 

Week/shift Weekly queries - 1h 45min 
Interval for manual start of reporting: 
30.12.2007 22:15 - 06.01.2008 22:15 
Interval for automatic start of reporting: 
30.12.2007 22:15 - 06.01.2008 22:15 

5.4 Filter criteria for a message list 
 
Column Description 
Value Value of the message 
Batch Batch ID of the message 
Message Number of the message 
Class Type of the message: Warning or violation 
Status key Status key of the message 
Status description Status description of the message 
Ackn. User name (Energy Manager) Name of the user on Energy Manager level who acknowledged the message. 
Ackn. user name (field) Name of the user on field level who acknowledged the message. 
Writing user (field) Name of the user on field level who configured the message. 
Tag name Tag name of the message 
Tag ID Tag ID of the message 
Time stamp Time as of which activated messages are displayed. 

5.5 Time unit abbreviations 
 
Abbreviation Time unit 
d Day 
h Hour 
Y Year 
M Month 
min Minute 
s Second 
W Week 
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5.6 Unit conversion Energy/Power 
 

 
Energy Power 
J J/h 
kJ kJ/h 
MJ MJ/h 
GJ GJ/h 
Ws Ws/h 
Wh W 
kWh kW 
 GWs/h 
GWh GW 
TWh TW 
VArh VAr 
kVArh KVAr 
MVArh MVAr 
GArh GVAr 
VAh VA 
kVAh kVA 
MVAh MVA 
GVAh GVA 
Nm3 Nm3/h 
m3 m3/h 
l l/h 
hl hl/h 
kg kg/h 
t t/h 
tCO2 tCO2/h 
pce pce/h 
pce pce/h 
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5.7 Module overview 
Specific modules must be assigned different objects. The following table lists all available 
modules, highlights all objects to be connected, or provides examples of the layout of result 
presentations. 

 
Query Inputs: 

1..n data points (d_, e_, a_) 
Start parameters: 
None 
Result: 
The connected operating data points transfer all measured values of the query period from the 
database to Excel. 

Batch query Inputs: 
1 ... n equipment variables or data points 
Equipment variables link equipment with a data point that contains the measured values. 
Start parameters: 
If required, batch selection  

Query with 1 timestamp Inputs:  
1..n data points (d_, e_, a_) 
Start parameters:  
None 
Result:  
The connected operating data points transfer all measured values of the query period from the 
database to Excel. The time stamp is displayed only once. A gap will develop if a value is missing 
for a time stamp. 

 

Query with 1 timestamp 
transposed 

Inputs:  
1..n data points (d_, e_, a_) 
Start parameters:  
None 
Result:  
The connected operating data points transfer all measured values of the query period from the 
database to Excel. The time stamp is displayed only once. A gap will develop if a value is missing 
for a time stamp. 
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Query with 2 timestamps 
(from/till) 

Inputs:  
1..n data points (d_, e_, a_) 
Start parameters:  
None 
Result:  
The connected operating data points transfer all measured values of the query period from the 
database to Excel. The time stamp is displayed only once. A gap will develop if a value is missing 
for a time stamp. 

 
In the Energy Manager options you can use the MODULE_EINHEIT parameter to define whether 
you want to also output the unit (0 = unit output disabled, 1 = unit output enabled). 

Conditional calculation of 
derived measurements 

Inputs: 
1 measuring variable of function type "Gap check" (m_) 
1 ...n derived data points (a_) 
Start parameters: 
None 
Result: 
The module evaluates the result of the measuring variable of function type "gap check". If the 
result = 1, the module deletes the measured value series for the specified query period. If the 
result = 0, the module calculates the derived data point for the specified query period. 

Derived measurement 
only level 1 

Inputs: 
1 ...n derived data points (a_) 
Start parameters: 
None 
Result: 
The derived data points are only calculated in one level in the evaluation period. No data is re-
turned to MS Excel. In contrast to the module "derived measurement", only the directly con-
nected derived measurements are calculated, without taking into account any possible 
cascading of derived measurements. This module is therefore faster. 
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Batch related analyses Inputs: 
Plant variable batch ID 
Plant variable material ID 
These two plant variables are created during the installation of Energy Manager.  
1 ... n plant variables 
Plant variables link an item of equipment with a MEVA that contains the measured values. 
Start parameters: 
If required, batch selection  
Result: 
In addition to the information about the selected batches, the function outputs the correspond-
ing measured values of the connected data points, or of the MEVAs that are linked by means of 
an equipment variable. The batches can be selected explicitly in a dialog at the start of evalua-
tion. If this specification is missing, the batches are selected based on the evaluation query peri-
od. 
More information on the batch- and material-related analysis can be found in the section Batch- 
and material-related analysis (Page 552). 

Batch related analyses + Inputs: 
Plant variable batch ID 
Plant variable material ID 
These two plant variables are created during the installation of Energy Manager.  
1 ... n plant variables 
Plant variables link an item of equipment with a MEVA that contains the measured values. 
Start parameters: 
If required, batch selection  
Result: 
In addition to the information about the selected batches, the function outputs the correspond-
ing measured values of the connected data points, or of the MEVAs that are linked by means of 
an equipment variable. The batches can be selected explicitly in a dialog at the start of evalua-
tion. If this specification is missing, the batches are selected based on the evaluation query peri-
od.  
The calculation of the data is not based on the previously calculated measurement values but 
the data is calculated separately by the module. 
More information on the batch- and material-related analysis can be found in the section Batch- 
and material-related analysis (Page 552). 

Balance Inputs:  
1 ... n measuring variables (m_)  
1..n data points (d_, e_, a_) 
Start parameters:  
None 
Result:  
The measuring variable or the data point is calculated across the entire observation period of the 
report.  

 
In the Energy Manager options you can use the BILA_HEADER parameter to define whether you 
want to insert a header (1 = header is displayed, 0 = header is not displayed). 
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Balance with time stamp Inputs: 
1 ... n measuring variables (m_) 
Note: Only the minimum or maximum function type 
Start parameters: 
None 
Result: 
The measuring variable is calculated across the entire observation period of the report. The 
minimum or maximum values are returned with time stamp. 
In the Energy Manager options you can use the BILA_TS_HEADER parameter to define whether 
you want to also insert a header (1 = header is displayed, 0 = header is not displayed). 

Balance since new year Inputs: 
1 ... n measuring variables (m_) 
Start parameters: 
None 
Result: 
The measuring variable is calculated starting at the "Since new year" and ends with the end of 
the query period. 
For example for the monthly report April 2008; calculates the period from Jan. 01, 2008 to May 
01, 2008. 

Balance comparing Inputs:  
1 ... n measuring variables (m_)  
1..n data points (d_, e_, a_) 
Start parameters:  
None 
Result:  
The measuring variable or the data point is calculated across the entire observation period of the 
report. Moreover, the last period or the same period of the previous year is calculated and re-
ported.  
For example for the monthly report April 2008; March 2008 and April 2007 are shown. 

 
Only the query types month, month+6h, day and day+6h are supported. 

Balance comparing SNY Inputs: 
1 ... n measuring variables (m_) 
Start parameters: 
None 
Result: 
The measuring variable is calculated starting at "Since new year" and ends with the end of the 
query period as well as the same time period of the previous year.  
For example for the monthly report April 2008; calculates the period from Jan. 01, 2008 to May 
01, 2008 as well as the time period from January 1, 2007 to May 1, 2007. 

Recalculate batch data Inputs: 
1 plant 
Start parameters: 
None 
Result: 
The batch data of the plant is recalculated when the report is started. 
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Duration curve Inputs:  
1 ... n measuring variables (m_)  
Start parameters:  
Interval, e.g. 3  
Unit, e.g. h 
Result:  
With a query period of one day and three hour interval, the duration curve module returns eight 
values (in a 3 hour pattern) (sorted protocol). The MEVA is calculated during the interval and 
sorted accordingly. 

 
In the Energy Manager options you can use the MODULE_EINHEIT parameter to define whether 
you want to also output the unit (0 = unit output disabled, 1 = unit output enabled). 

Duration curve sorted Inputs: 
2 ... n measuring variables (m_) 
Start parameters: 
Interval, e.g. 3 
Unit, e.g. h 
Result: 
With a query period of one day and three hour interval, the duration curve module returns eight 
values (in a 3 hour pattern). The values of the first MEVA are output sorted in descending order 
and the remaining MEVAs are sorted following the first MEVA. 

Documentation of all 
operating data points 

Inputs: 
1 ... n hardware objects  
1 ... n measurements (including derived measurements)  
1 ... n measuring variables 
If you do not connect anything, you only receive an empty report with headers. 
Start parameters: 
None  
Result: 
All operating data points and MEVAs created in the system are listed, including their attributes.   



Reference  
5.7 Module overview 

 SIMATIC Energy Manager PRO V7.2 - Operation 

778 Operating Manual, 12/2020, A5E38952754-AF 

Properties Inputs:  
1 ... n property types 
1 ... n objects to be evaluated 

 
Start parameters:  
None 
Result:  
A matrix consisting of the property types and objects is set up. The objects are listed vertically 
from top to bottom, the property types from left to right. 

 

Energy apportionment 
V2 

Inputs: 
Data point that represents the loss factor. 
MEVA, which represents the total infeed of the hall. 
Parameters with sublevel data point that represent the cost centers. 

 
Start parameters: 
None 
Result: 
The consumption calculated based on the MEVA is multiplied by the data point value (loss fac-
tor). The product of this calculation is allocated in accordance with cost center factors (parame-
ters). The result is written directly to the data point that is connected to the parameter node.  
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Energy Efficiency 
Measures 

Inputs:  
1 ... n filtered overview objects 

 
Start parameters:  
None 
Result:  
The module outputs all data of the energy efficiency measures that is filtered in an overview 
object. 

Schedule B/L KISS-A 
Month 

Inputs: 
1 measuring variable (m_) 
Start parameters: 
Interval, e.g. 15 
Unit, e.g. min 
Result: 
Works like a protocol module. You can, however, only connect one measuring variable. The 
output is assigned a special format - Day, from, to - as shown in the Excel table. 

Schedule Target/Actual Inputs: 
1 measuring variable (m_) 
Start parameters: 
Interval, e.g. 15 
Unit, e.g. min 
Result: 
The measuring variable is calculated in a 15-minute pattern. As hourly values are output in MS-
Excel, the 15-minute values are added up to form hourly values. If the value is positive, the 
result is entered in the 3rd column. If the value is negative, the result is entered in the 4th col-
umn. 

Daily temperature figure Inputs: 
1 data point (d_, e_, a_) that represents the outdoor temperature. 
Start parameters: 
None 
Result: 
The connected data point is used to calculate the daily average. The daily temperature figure is 
calculated as follows. 
Daily average of the outdoor temperature TA: 
DTf = (20° - TA) if TA < 15° DTf = 0 if TA ≥ 15° 
Monthly value: Total of all daily values 
Query period: 1 month 
Interval: 1 day 
Query period: 1 year 
Interval: 1 month 
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Load forecast analysis Inputs: 
1 measuring variable (m_)  
1 profile or master profile 
Start parameters: 
Interval, e.g. 15 
Unit, e.g. min 
Result: 
The forecast load profile is considerably dependent on the typical days. This module is provided 
to enable calculation of the time set of a past period. You can use the load profile analysis mod-
ule to analyze any time frame. As a result, the power value per period (15-minute or hour) is 
output for all typical days in the evaluation period. If the analysis covers a yearly range (for ex-
ample, for the typical day Monday), all Mondays will be used for calculations, provided these are 
not holidays or special days. In a year with 48 Mondays, for example, the mean value is calculat-
ed for the time window from 00:00 h to 01:00 h for all Mondays and output as result. The same 
rule is applied to all other intervals. 
A corresponding measuring variable must be connected directly below the module node. The 
measuring variable prepares the data point that you want to analyze.  
You must also connect the profile that defines the typical days. You can also use a master pro-
file. 
Corrupted values are ignored in the analysis. If you also want to make use of corrupted values, 
you have to define the parameter BDATA_LASTPRF_QS = 0 in the Energy Manager PRO options. 
BDATA_LASTPRF_QS = 1 means corrupted values are not taken into account. 
The module provides the corresponding result in the following form: 
Calculation Profile From To  
 ProfWinter 01.04.2006 01.10.2006  
 ProfSummer 01.10.2006 01.04.2007  
Reference object MasterProfile m_OverallProfile   
Profiles  ProfSummer ProfWinter ProfSummer, 

ProfWinter 
No. of values  169 173 23 
Time  TDSummer TDWinter TDHoliday 
00:00 01:00 8.36 8.80875 9.36 
01:00 02:00 8.425 8.7625 9.425 
02:00 03:00 8.25875 8.72 9.25875 
03:00 04:00 8.225 8.94125 9.225 
04:00 05:00 8.1975 9.041875 9.1975 
05:00 06:00 8.21625 9.34625 8.21625 
06:00 07:00 8.31625 11.44188 8.31625 
07:00 08:00 8.38375 13.48125 8.38375 
08:00 09:00 8.4525 14.445 8.4525 
09:00 10:00 8.45375 14.6775 8.45375 
10:00 11:00 8.45 14.78813 8.45 
11:00 12:00 8.49 14.87188 8.49 
12:00 13:00 8.4975 14.84125 8.4975 
13:00 14:00 8.5525 14.78938 8.5525 
14:00 15:00 8.53625 14.59313 8.53625 
15:00 16:00 8.57875 14.09438 8.57875 
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Load forecast analysis 16:00 17:00 8.58125 13.23375 8.58125 
17:00 18:00 8.51875 12.5325 8.51875 
18:00 19:00 8.50125 11.57625 8.50125 
19:00 20:00 8.445 10.60125 8.445 
20:00 21:00 8.40125 9.760625 8.40125 
21:00 22:00 8.34875 9.286875 8.34875 
22:00 23:00 8.32375 8.953125 8.32375 
23:00 00:00 8.31375 8.77125 8.31375 
The time period in which the profile was calculated is displayed for master profiles (lines 1 to 3). 
The names of the connected master profile or profile and of the measuring variable are dis-
played in line 4 next to the reference object. 
The typical day is output in line 7. The number of days used to calculate the typical day is shown 
next to the "Number of values" entry. The result is marked in blue if this value is less than three. 
Line 4 displays the profiles used as the basis for calculation of the typical days. This line should 
never contain more than one profile. If it contains several profiles, the text is output in red font. 
The typical days can be written back to the database. For this purpose, the user must enter the 
text "save" in the text field below (header Text:) in the second dialog "Module Start/Stop" when 
starting the report. 

LTEXT for current version Inputs:  
1..n data points (d_, e_, a_)  
Start parameters:  
None 
Result:  
All text objects of the current version are read for the connected data points and displayed with 
time stamp. 

 

LTEXT for all versions Inputs:  
1..n data points (d_, e_, a_)  
Start parameters:  
None 
Result:  
All text objects of all versions are read for the connected data points and are displayed with time 
stamp. The latest version is always listed on top. The version date represents the value creation 
date. 
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Machine Protocol Inputs: 
None 
Start parameters: 
None 
Result: 
All configured consumers are automatically output in the report, including the date (on which 
the number of consumers changed), number of consumers, consumer name, vendor and crea-
tion date. The machines and machine protocols can only be selected if the license for the con-
sumer functionality exists. 

 

Derived measurement Inputs: 
1 ...n derived data points (a_) 
Start parameters: 
None 
Result: 
The derived data points that are used in this report are calculated in the evaluation period. No 
data is returned to Excel. 

n Maxima Inputs: 
1 parameter (t_). This parameter is optional. Use this parameter to specify the number of maxi-
mum values of a data point that are calculated. If you do not specify this parameter, the five 
maximum values of a data point are calculated. 
1..n data points (d_, e_, a_) 
Start parameters: 
None 
Result: 
The module calculates the required number of maximum values of a data point for the specified 
query period. The module also outputs the following measured values: 
• 12 measured values that are available before a maximum measured value 
• 11 measured values that are available after a maximum measured value 
If the additional measured values lie within the query period, the module outputs the additional 
values. The module will not output any additional measured values if the last value in the query 
period is a maximum measured value. 
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Validation deviation 
reference DP 

Inputs:  
1..n data points (d_, e_, a_)  
Start parameters:  
None 
Result:  

 

Validation gap Inputs:  
0 ... n data points (d_, e_, a_)  
When you connect data points, the data points must be active.  
If you do not connect any data points, all data points in the system are checked. 
Start parameters:  
None 
Result: 

 

Validation Min Max Inputs:  
0 ... n data points (d_, e_, a_)  
When you connect data points, the data points must be active.  
If you do not connect any data points, all data points in the system are checked. 
Start parameters:  
None 
Result: 

 

Validation status not ok Inputs:  
0 ... n data points (d_, e_, a_)  
When you connect data points, the data points must be active.  
If you do not connect any data points, all data points in the system are checked. 
Start parameters:  
None 
Result: 
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Protocol Inputs:  
1 ... n measuring variables (m_)  
1..n data points (d_, e_, a_) 
1 ... n parameters (t_) 
Start parameters:  
Interval, e.g. 1  
Unit, e.g. h 
Result:  
At a query period of one day and three hour interval, the protocol module returns eight values 
(in a 3-h pattern). The connected measuring variables, data points and parameters are calculat-
ed at the specified intervals. 

 

Protocol - KPI aggrega-
tion 

Inputs: 
1 ... n measuring variables (m_) 
Start parameter:  
Interval, e.g. 1  
Unit, e.g. h 
Result: 
The "Protocol - KPI aggregation" module is based on the Protocol module. With a query period of 
one day and a one hour interval, the module returns 24 values (in a 1 hour pattern). The mod-
ule aggregates the output of all machines.  

Protocol 10 min 10 max Inputs: 
1 ... n measuring variables (m_) 
Start parameters: 
Interval, e.g. 1 
Unit, e.g. h 
Result: 
The query period of the report is divided into predefined intervals which are set by the user. The 
connected measuring variables are used within the intervals. The 10 lowest and 10 highest 
results are output for each interval, together with the time stamp and status (color). 
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Protocol cumulated Inputs: 
1 ... n measuring variables (m_) 
Start parameters: 
Interval, e.g. 1 
Unit, e.g. h 
Result: 
Similar to a protocol module, the difference being the results of a measuring variable will be 
cumulated (added to the previous). 

Protocol with from/to Inputs:  
1 ... n measuring variables (m_)  
1..n data points (d_, e_, a_) 
1 ... n parameters (t_) 
Start parameters:  
Interval, e.g. 1  
Unit, e.g. h 
Result:  
At a query period of one day and three hour interval, the protocol module returns eight values 
(in a 3-h pattern). The connected measuring variables, data points and parameters are calculat-
ed at the specified intervals. The time stamp is displayed along with the start and end of the 
period. 

 
In the Energy Manager options you can use the MODULE_EINHEIT parameter to define whether 
you want to also output the unit (0 = unit output disabled, 1 = unit output enabled). 
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Protocol transposed Inputs:  
1 ... n measuring variables (m_)  
1..n data points (d_, e_, a_) 
1 ... n parameters (t_) 
Start parameters:  
Interval, e.g. 1  
Unit, e.g. h 
Result:  
At a query period of one day and three hour interval, the protocol module returns eight values 
(in a 3-h pattern). The connected measuring variables, data points and parameters are calculat-
ed at the specified intervals. 

 

Reference Inputs: 
Data point A (d_, e_, a_) 
Data point B (d_, e_, a_) 
Start parameters: 
Interval, e.g. 15 
Unit, e.g. min 
Result: 
The module outputs the measured values including timestamps of data point A and of data 
point B for the specified query period. 

Repair module Inputs: 
1 ... n parameters (t_) 
Start parameters: 
None 
Result: 
The parameter entries for the query period are output in list form. The system calculates and 
displays the duration along with the start, end, and value data. 

Snapshot module Inputs: 
1..n data points (d_, e_, a_) 
Start parameters: 
Interval, e.g. 5 
Result: 
The module returns the value of an exact time that was defined as start parameter. It also out-
puts the value of the same time from the previous day. 
Value 462 has the time stamp 04/19/2005 05:00. (05:00 because 5 was selected as start pa-
rameter). The value 383 has the time stamp 04/18/2005 05:00 (05:00 because 5 was selected 
as start parameter) 

Statistics Inputs: 
1 ... n measuring variables (m_) 
Start parameters: 
Interval, e.g. 15 
Unit, e.g. min 
Result: 
Returns the maximum, minimum, and average of the connected measuring variables. The time 
frame is defined by the "From" and "To" entries. The results of the connected measuring varia-
bles are calculated for every interval in this time frame. Based on these values, the maximum, 
minimum, and average values are calculated and output for each measuring variable. The max-
imum and minimum values are also output with time stamp. 
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Statistics for operating 
data points 

Inputs: 
1..n data points (d_, e_, a_) 
Start parameters: 
None 
Result: 
The unit, sum value, minimum time stamp, minimum value, average, maximum time stamp, 
and maximum value data is calculated and output across the query period, based on the con-
nected operating data points. 

Hour distribution Inputs:  
1..n data points (d_, e_, a_) 
Start parameters:  
Interval, e.g. 10 
Lower limit, e.g. 50 
Upper limit, e.g. 100 
Result:  
The hour distribution module returns seven values for a query period of one day, with a lower 
limit of 50, a upper limit of 100, and an interval of 10 between the upper and lower limit. 

 
Text protocol Inputs: 

1..n data points (d_, e_, a_) 
Start parameters: 
Interval, e.g. 1 
Time unit, e.g. h 
Result: 
The module outputs all texts of a data point for the query period. 

User rights Inputs: 
None 
Start parameters: 
None 
Result: 
All users created in the system are listed. The user groups and functional groups assigned to this 
user are also displayed. 

5.8 Display modes 
 

Display mode Description 
KKS text KKS ID 
Short text Name of the data point 
Short text + long text Name and description of the data point 
Long text Description of the data point 
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5.9 Existing functional groups 

Overview of functional groups 
The following table shows the functional groups available after the installation of Energy 
Manager. In Energy Manager Basic no functional groups can be created or modified. Which 
group has which functional rights is described in the following chapter Available functional 
rights (Page 789). 
 
Functional group Function 
ADMINISTRATOR  This group includes comprehensive functional rights for Energy Manager.  

This group has the right to delete, add or configure all objects.  
CONFIGURATOR This group has the right to configure Energy Manager objects. 
GUEST  This group is permitted to view all objects in the tree.  

This group does not have the right to delete, add or configure objects. The group 
also does not have the right to create new reports and to calculate analyses.  
This grouping is intended to apply simple, temporary restrictions on significant 
operator actions in the system.  
To set up explicit, long-term restrictions on functional rights, you should use a 
combination of the following functional groups.  

OPERATOR This group has the right to operate Energy Manager objects. 

See also 
Navigation (Page 99) 
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5.10 Available functional rights 
In Energy Manager you can restrict functions for unauthorized users. For example, you can 
assign a user the right to start a report and view the result. You can, however, disallow the 
user from configuring the report. You can also merge several users to form several user 
groups. The user Admin or Superadmin sets the user rights for the corresponding users and 
user groups as well as the functional restrictions in the functional user group. Most functional 
restrictions in Energy Manager are based on the following basic principle: 

1. Configuration 

2. Creation, deletion and configuration 

3. View 

Configuration 
The user is authorized to configure objects using the configuration dialog. The user is not 
authorized to delete objects or create new objects. 

Creation, deletion and configuration 
The user is authorized to configure and delete objects and create new objects. 

View 
The user is authorized to open objects and view the contents. The user is not authorized to 
configure or delete objects or create new objects. Some objects such as a MEVA can only be 
viewed by the user in the navigation area without opening a dialog. In the corresponding 
object properties you can find out whether you can open the object and view the contents or 
only see the object in the navigation area.  
The user is also not authorized for the following functions: 

• Copy 

• Clone 

• Delete 

• Cut 

• Disconnect 



Reference  
5.10 Available functional rights 

 SIMATIC Energy Manager PRO V7.2 - Operation 

790 Operating Manual, 12/2020, A5E38952754-AF 

Overview 
The following table provides an overview of the available functional rights: 

The letters in brackets indicate which functional groups have this right after installation of the 
Energy Manager . 

The letters stand for the following functional groups:  

• A: Administrator 

• C: Configurator 

• O: Operator 

• G: Guest 

 
Rights area Assigned rights 
Account Configuration:          

• Create, remove, configure: The user has the right to create, delete and configure 
accounts. 

• View (A, C, G, O): The user has the right to open and view accounts. 

Administration Logging Viewer: 
• View (A, C, O): The user has the right to open and view the Logging Viewer. 
Service Cockpit: 
• View (A, C, O): The user has the right to open and view the Service Cockpit. 

Alarming Configuration:       
• Configure (A, C): The user has the right to open and configure KPI message lists. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure KPI message lists. 
• View (A, C, O): The user has the right to open and view KPI message lists. 
Values: 
• Acknowledge (A, C, G, O): The user has the right to open and confirm messages. 
• View (A, C, G, O): The user has the right to open and view messages. 

Backup Configuration: 
• Configure (A): The user has the right to open and configure the storage location 

of the backup and the schedule for automatic creation of a backup. 
• View (A, C, O): The user has the right to open and view the storage location of 

the backup and the schedule for the automatic creation of a backup. 
Usage (A): 
• Start: The user has the right to create a backup. 

Chart Object Configuration: 
• Configure (A, C, G, O): The user has the right to open and configure charts. 
• Create (A, C, G): The user has the right to open and create charts. 
• Delete (A, C, G): The user has the right to open and delete charts. 
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Rights area Assigned rights 
Client Control To log onto a component, the "Client Control" right is the minimum right for the 

user. 
Acquisition: 
• Configure(A): The user has the right to configure acquisition components. 
Client: 
• Configure (A, C ,G, O): The user has the right to configure the Energy Manager 

PRO Client. 
Web: 
• Configure (A, C, G, O): The user has the right to configure Energy Manager PRO 

Web. 

Domain Configuration: 
• Create, remove, configure: The user has the right to create, delete and configure 

domains. 
• View (A, C, G, O): The user has the right to open and view domains. 
Object Assignment: 
• Modify (A): The user has the right to configure assignments of domains. 
• Share (A): The user has the right to assign domains. 
• View (A, C, G, O): The user has the right to open and view assignments of do-

mains. 

Energy Efficiency Configuration: 
• Configure (A, C, G): The user has the right to open and configure energy efficien-

cy measures. 
• Create, remove, configure (A, C, G): The user has the right to create, delete and 

configure energy efficiency measures. 
• View (A, C, G, O): The user has the right to open and view energy efficiency 

measures. 
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Rights area Assigned rights 
ERP Connector Business Unit: 

• Configure (A, C): The user has the right to open and configure Business Units. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure Business Units. 
• View (A, O): The user has the right to open and view Business Units. 
Cost Center: 
• Configure (A, C): The user has the right to open and configure cost centers. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure cost centers. 
• View (A, C, O): The user has the right to open and view cost centers. 
Cost center relation: 
• Configure (A, C): The user has the right to open and configure the cost center 

relation. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure the cost center relation. 
• View (A, C, O): The user has the right to open and view the cost center relation. 
Cost element: 
• Configure (A, C): The user has the right to open and configure cost elements. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure cost elements. 
• View (A, C, O): The user has the right to open and view cost elements. 

File Common: 
• Configure (A, C, G): The user has the right to open and configure files. 
• Create, remove, configure (A, C, G, O): The user has the right to create, delete 

and configure files. 
Data: 
• Fetch (A, C, G, O): The user has the right to open documents from a file. 
• Modify (A, C, G): The user has the right to upload documents or overwrite exist-

ing documents. 

Folder • Configure (A, C): The user has the right to open and configure folders. 
• Create, delete (A, C): The user has the right to create and delete folders. 
• View (A, C, G, O): The user has the right to open and view folders. 

Import and export Export: 
• Configure (A, C): The user has the right to export subprojects to an XML file. 
Import: 
• Configure (A, C): The user has the right to import subprojects. 

Job • Create, remove, configure (A, C): The user has the right to create, delete and 
configure job queues. 

• View (A, C, O): The user has the right to open and view job queues. 
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Rights area Assigned rights 
Licensing Config: 

• Configure (A): Not relevant for Energy Manager PRO V7.2. 
• Create, remove, configure (A): Not relevant for Energy Manager PRO V7.2. 
• View (A, C, G, O): The user has the right to open and view the license dialog. 

Left • Modify (A, C, G, O): The user has the right to delete links from data points and 
documents. 

Locking Configuration: 
• Configure (A, C): The user has the right to lock objects. 

Loop, Prototype • Configure (A, C): The user has the right to open and configure loops and proto-
types. 

• Create, remove, configure (A, C): The user has the right to create, delete and 
configure loops and prototypes. 

• View (A, C, O): The user has the right to open and view loops and prototypes. 

Master Data • Configure (A, C): The user has the right to open and configure cycle times and 
query types. 

• Create, remove, configure (A, C): The user has the right to create, delete and 
configure cycle times and query types. 

• View (A, C, G, O): The user has the right to open and view cycle times and query 
types. 

Matrix • Create, remove, modify (A, C): The user has the right to create, delete and con-
figure matrices. 

• Modify (A, C, O): The user has the right to configure matrices. 
• View (A, C, G, O): The user has the right to open and view matrices. 

Measured Value • Insert, remove, modify (A, C): The user has the right to enter measured values of 
a data source in the matrix or measured value editor and delete and configure 
them. 

• Modify (A, C): The user has the right to open measured values of a data source 
and enter them in the matrix or measured value editor. 

• View (A, C, G, O): The user has the right to open and view measured values of a 
data source. 

Measurement • Configure (A, C): The user has the right to open and configure data points. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure data points. 
• View (A, C, G, O): The user has the right to open and view data points. 

Measuring Variable • Configure (A, C): The user has the right to open and configure MEVAs. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure MEVAs . 
• View (A, C, G, O): The user has the right to open and view MEVAs. 
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Rights area Assigned rights 
ODBC Connector Configuration: 

• Configure (A, C): The user has the right to open and configure ODBC data 
sources. 

• Create, remove, configure (A, C): The user has the right to create, delete and 
configure ODBC data sources. 

• View (A, C, O): The user has the right to open and view ODBC data sources. 
Import values (A, C): 
The user has the right to import values from an ODBC data source. 

Parameter Common: 
• Configure (A, C): The user has the right to open and configure parameters. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure parameters. 
• View (A, C, G, O): The user has the right to open and view parameters. 
Values: 
• Create, remove, configure (A, C, G): The user has the right to create, delete and 

configure parameter values. 

Permission • Create, remove, configure (A, C): The user has the right to create, delete and 
configure functional groups. 

• View (A, C, O): The user has the right to open and view functional groups. 

Printer • Configure (A, C): The user has the right to open and configure printers. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure printers. 
• View (A, C, O): The user has the right to open and view printers. 

Production Plan This rights group is only relevant if the license "Forecast and planning" exists in the 
ALM.  
• Configure (A, C): The user has the right to open and configure production plans. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

import production plans. 
• View (A, C, G, O): The user has the right to open and view production plans. 

Profiles • Configure (A, C): The user has the right to open and configure profiles. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure profiles. 
• View (A, C, G, O): The user has the right to open and view profiles. 

Quick Chart Comments Configuration: 
• Configure (A, C, G, O): The user has the right to open and configure comments in 

charts. 
• Create (A, C, G, O): The user has the right to open and create comments in 

charts. 
• Delete (A, C, G, O): The user has the right to open and delete comments in 

charts. 
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Rights area Assigned rights 
Report Configuration: 

• Configure (A, C): The user has the right to open and configure reports. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure reports. 
• View (A, C, G, O): The user has the right to open and view reports. 
Report: 
• Open pdf only (A, C, G, O): The user has the right to open and view created re-

ports only in PDF format. 
• Open xls/doc/pdf (A, C, G, O): The user has the right to open and view created 

reports in Excel, Word and PDF format. 
• Restart, start (A, C, G, O): The user has the right to manually start reports and 

restart already created reports via task management. 
• Start, delete (A, C, G, O): The user has the right to manually start reports and 

delete already created reports. 

Task management Configuration: 
• Configure (A, C): The user has the right to open and configure tasks. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure tasks. 
• View (A, C, O): The user has the right to open and view tasks. 
Task management: 
• Start (A, C): The user has the right to start tasks. 

Template Manager You configure reports and machine specifications in the Template Manager.  
Configuration (A, C): 
• Configure (A, C): The user has the right to open and configure templates. 
• Create (A, C): The user has the right to create new templates. 
• Delete (A, C): The user has the right to delete templates. 

Trend Not relevant for Energy Manager PRO V7.2. 
Unique Objects Not relevant for Energy Manager PRO V7.2. 
Unit • Configure (A, C): The user has the right to open and configure units. 

• Create, remove, configure (A, C): The user has the right to create, delete and 
configure units. 

• View (A, C, O): The user has the right to open and view units. 

User • Configure (A, C): The user has the right to open and configure other users. 
• Create, remove, configure (A, C): The user has the right to create, delete and 

configure other users. 
• View (A, C, O): The user has the right to open and view other users. 

Visualization Not relevant for Energy Manager PRO V7.2. 
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Rights area Assigned rights 
Web interface Administration: 

• Configure (A, C): The user has the right to configure the Siemens logo and start 
screen in the Energy Manager PRO Web administration area. 

Menu: 
• View (A, C, O): The user has the right to view the Energy Manager PRO Web 

menu and toggle between the tree structure and the administration area. 
Quicklinks: 
• Configure (A, C, O ): The user has the right to open and configure Quicklinks in 

Energy Manager PRO Web. 
• Create (A, C, O): The user has the right to open and create Quicklinks in Energy 

Manager PRO Web . 
• Delete (A, C, O): The user has the right to open and delete Quicklinks in Energy 

Manager PRO Web. 
• View (A, C, O): The user has the right to open and view Quicklinks in Energy 

Manager PRO Web. 

Widgets/Dashboards • Configure (A, C): The user has the right to configure dashboards and create, 
delete and configure widgets in Energy Manager PRO Web. 

• Create, remove, configure (A, C): The user has the right to create, delete and 
configure dashboards and widgets in Energy Manager PRO Web . 

• View (A, C, O): The user has the right to open and view dashboards and widgets 
in Energy Manager PRO Web. 
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5.11 Operations for generating calculation blocks (prototypes) 

Overview 
This section lists all functions that are available for creating prototypes. 

Requirement 
none 

Mathematical operations 

Table 5- 1 Mathematical functions 

Function Description 
Addition (add) Inputs: 

input1 
input2 
The function returns: 
output:= input1+input2; 

Subtraction (sub) Inputs: 
input1 
input2 
The function returns: 
output:= input1-input2; 

Multiplication (mul) Inputs: 
input1 
input2 
The function returns: 
output:= input1*input2; 

Division (div) Inputs: 
input1 
input2 
The function returns: 
output:= input1/input2; 

Power (pow) Inputs:  
input1 (base) 
input2 (power) 
The function returns: 
output:= pow (input1,input2); 

Square root (sqrt) Inputs:  
input 
The function returns:  
output := sqrt(input); 
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Function Description 
Minus (minus) Inputs:  

input 
The function returns: 
output:= minus(input); 

Exponential function (exp) Inputs:  
input 
The function returns: 
output:= exp(input); 

Natural logarithm (ln) Inputs:  
input 
The function returns: 
output:= ln(input); 

Base 10 logarithm (log10) Inputs:  
Input 
The function returns: 
output:= log10(input); 

Sine (sin) Inputs:  
input 
The function returns: 
output:= sin(input); 

Cosine (cos) Inputs:  
input 
The function returns: 
output:= cos(input); 

Tangent (tan) Inputs:  
input 
The function returns: 
output:= tan(input); 

Arc sine (arcsin) Inputs:  
input 
The function returns: 
output:= arcsin(input); 

Arc cosine (arccos) Inputs:  
input 
The function returns: 
output:= arccos(input); 

Arc tangent (arctan) Inputs:  
input 
The function returns: 
output:= arctan(input); 
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Logical operations 

Table 5- 2 Logical functions 

Function Description 
Logical AND (and) Inputs:  

input1 
input2 
The function returns:  
output:= and(input1,input2); 

Logical OR (or) Inputs:  
input1 
input2 
The function returns: 
output:= or(input1,input2); 

Logical Exclusive OR (xor) Inputs:  
input1 
input2 
The function returns: 
output:= xor(input1,input2); 

Logical inversion (not) Inputs:  
input 
The function returns: 
output:= not(input); 
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Compare operations 

Table 5- 3 Compare functions 

Function Description 
Greater than comparison (gt) Inputs:  

input1 
input2 
The function returns: 
output:= gt(input1,input2); 
output:= 1 as long as input1 > input2; 

Less than comparison (lt) Inputs:  
input1 
input2 
The function returns: 
output:= lt(input1,input2); 
output:= 1 as long as input1 < input2; 

Equal comparison (eq) Inputs:  
input1 
input2 
The function returns: 
output:= eq(input1,input2); 
output = 1 as long as input1 = input2 

Greater than or equal to compar-
ison (gteq) 

Inputs:  
input1 
input2 
The function returns: 
output:= gteq(input1,input2); 
output = 1 as long as input1 ≥ input2 

Less than or equal to comparison 
(lteq) 

Inputs:  
input1 
input2 
The function returns: 
output = lteq(input1,input2); 
output = 1 as long as input1 ≤ input2 

Not equal comparison (noteq) Inputs:  
input1 
input2 
The function returns: 
output:= noteq(input1,input2); 
output = 1 as long as input1 <> input2; 
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Switch operations 

Table 5- 4 Switch functions 

Function Description 
Switch (switch) Inputs:  

input1 
input2 
switch 
The function returns: 
output:= switch(input1,input2,switch); 
output = input1 if switch = 0 
output = input2 if switch = 1 

Switch (interrupter) Inputs:  
input 
switch 
The function returns: 
output = interrupter(input, switch); 
output = input if switch = 1 

Switching delay (sdelay, 
sdelay_up, sdelay_down) 

Inputs:  
input 
delay time in [s] 
The function returns: 
output:= sdelay(input,delaytime); 
output:= sdelay_up(input,delaytime);  
(rising edge) 
output:= sdelay_down(input,delaytime); 
(falling edge)  
output = input on expiration of the delay time 

Value change filter (f_valchng) Inputs:  
input 
The function returns: 
output:= f_valchng(input); 
output = input as soon as the measured input 
no longer matches the last input measured  
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Status memory (fliflo) Inputs:  
input 
res 
The function returns: 
output:= fliflo(input,res); 
input == 0 and res == 0  
ð no new result 
input == 1 and res == 0 
ð if result is not 1, result is set to 1 
input == 0 and res == 1 
ð if result is not 0, result is set to 0 
input == 1 and res == 1 
ð Result is assigned the last result value ('invalid' status) 

Edge memory (fliflo_chng, fli-
flo_up, fliflo_down) 

Inputs:  
input 
res 
The function returns: 
output:= fliflo_chng(input, res); 
output:= fliflo_up(input,res); 
output:= fliflo_down(input, res); 
On change to the value at input, it is determined whether or not to 
trigger a set operation. 
SET and RES == 0 > if result is not 1, result is set to 1. 
RES == 1 > if result is not 0, result is reset to 0. 
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Table operations 

Table 5- 5 Table functions 

Function Description 
2 dimensions (spline2) Inputs: 

table (table with definition of the full path, i.e. Subdirectory of the 
mcl directory) 
input (first column value in the table) 
The function returns: 
output:= spline2(c:\mcl\tables\watercontent.tab,input); 
The table must be available as ASCII file with the following format:  
10.00 2519.98 
20.00 2538.58 
30.00 2557.21 
40.00 2575.88 
50.00 2594.57 
60.00 2613.31 
Note: An empty row (=CR+LF) may not exist after the last row 
containing numbers.  
Explanations:  
ò 1. column input 
ò 2. column input, associated value 

3 dimensions (spline3) Inputs: 
table (table with definition of the full path, i.e. Subdirectory of the 
mcl directory) 
input1 (first column value in the table) 
input2 (second column value in the table) 
The function returns: 
output:= spline3(c:\mcl\tables\energy.tab,input1,input2); 
The table must be available as ASCII file with the following format: 
3/6 0.01 0.03 0.05 
10.00 2519.98 42.00 42.00 
20.00 2538.58 83.86 83.86 
30.00 2557.21 2556.68 125.66 
40.00 2575.88 2575.40 2574.93 
50.00 2594.57 2594.15 2593.73 
60.00 2613.31 2612.93 2612.55 
Note: An empty row (=CR+LF) may not exist after the last row 
containing numbers.  
Explanations:  
ð input1 
ò input2 
3 ... number of result columns 
6 ... number of result rows 
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Interval operations 

Table 5- 6 Interval functions 

Function Description 
Difference (diff) Inputs:  

measured value 
averaging time in [s] 
offset 
The function returns: 
output:= diff(measured value, averaging time, offset); 
(difference or value at the end and start of the mean value calcula-
tion time) 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 

Mean value (avg) Inputs:  
measured value 
averaging time in [s] 
offset 
The function returns: 
output:= avg(measured value, averaging time, offset); 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 

Mean value with status rating 
(avgST) 

Inputs:  
measured value 
status 
percentage 
averaging time in [s] 
offset 
The function returns: 
output:= 
avgST(measuredvalue,status,percentage,averagingtime,offset); 
(output is only valid on the condition that at least n% {percent} of 
the corresponding status values {status} are also valid) 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 
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Minimum (min) Inputs:  
measured value 
averaging time in [s] 
offset 
The function returns: 
output:= min(measured value, averaging time, offset); 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 

Maximum (max) Inputs:  
measured value 
averaging time in [s] 
offset 
The function returns: 
output:= max(measured value, averaging time, offset); 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 

Total (sum) Inputs:  
measured value 
averaging time in [s] 
offset 
The function returns: 
output:= sum(measured value, averaging time, offset); 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 

Sum with status rating (sumST) Inputs:  
measured value 
status 
percentage 
averaging time in [s] 
offset 
The function returns: 
output:= 
sumST(measuredvalue,status,percentage,averagingtime,offset); 
(output is only valid on the condition that at least n% {percent} of 
the corresponding status values {status} are also valid) 
Note:  
offset 01:00:00 ... the value is generated at the start of the full 
hour 
offset 00:00:00 ... the value is generated at the start of the full 
minute 
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Quantity operations 

Table 5- 7 Quantity functions 

Function Description 
Collector (collector) Inputs: 

measured value  
averaging time in [s] 
offset 
The function returns: 
measured value array:= collector(measured value, averaging time, 
offset); 
Note:  
offset 01:00:00 ... the values are in the array at the start of the full 
hour 
offset 00:00:00 ... the values are in the array at the start of the full 
minute 

Quantity sorting (c_sort) Inputs: 
measured value array 
The function returns values in ascending order: 
output array:= collector(measured value array); 

Quantity percentage filter 
(c_perc_filt_first, c_perc_filt_last) 

Inputs: 
measured value array 
x 
The function returns the first x percent of the measured value 
array: 
output array:= c_perc_filt_first(measured value array, x); 
The function returns the last x percent of the measured value ar-
ray: 
output array:= c_perc_filt_last(measured value array, x); 

Quantity mean value (c_avg) Inputs:  
measured value array 
The function returns the mean value of the measured value array: 
output:= c_avg(measured value array); 

Quantity minimum (c_min) Inputs:  
measured value array 
The function returns the minimum value of the measured value 
array: 
output:= c_min(measured value array); 

Quantity maximum (c_max) Inputs:  
measured value array 
The function returns the maximum value of the measured value 
array: 
output:= c_max(measured value array); 
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5.12 Description of MCL 
New prototypes for processing data sets are defined using the special programming language 
MCL (Measurement Configuration Language). 

 

 Note 
As the MCL compiler is case-sensitive, it is necessary to enter all prototype data in lowercase 
letters. 

 

For logical and comparison operations, the value "1" corresponds to logical "TRUE" state and 
the value "0" to logical "FALSE" state. 
The prototype is entered and declared between parentheses "{" and "}"; a simple addition is 
defined as example: 
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Local variable may be defined in the header of the input window. This section is defined by 
entering the "local:" identifier. 
It is necessary to define this "local:" section to declare local variables for interim results; note 
that it is not permitted to include calculations in the declaration line. 
PERMITTED: 
local: 
a; 
Implementation: 
a:=b+c; 
PROHIBITED: 
local: 
a:=b+c; 
The actual mathematical rule is then entered in the "implementation" section. It is permitted 
to use all I/O variables, as well as local variables and implemented functions. 
The "local" and "implementation" sections must be concluded with a colon ":". All other lines 
are concluded with a semicolon (';'). Variables are declared by means of ':='. Start all 
comments with '//'. 
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Use "Enter" to insert line breaks. 

 
For more complex calculations, it is possible to use the "call" command in a prototype to call 
other prototypes. 
Always observe the order of arguments for calling the prototype. 
Example of a p_bsp prototype in which the p_add prototype is used: 
p_add(out output, in input1, in input2) 
p_bsp(out out1, out out2, out out_bsp, in mw1, in mw2, in mw3, in 
mw4, in condition) 
{ 
Implementation: 
   call p_add(out1,mv1,mv2); 
   call p_add(out2,mv3,mv4); 
   out_bsp:=switch(out1,out2,condition); 
} 
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Syntax check: 
After having entered the mathematical rule and defined the various I/Os (parameters) in the 
lower area of the dialog, you can generate the prototype by pressing the "OK" button. The 
syntax is checked during this generation. Syntax errors that were found are reported with 
specification of the relevant line.  

 
Caution: Line 3 is the first line of the text body. Lines not concluded with semicolon are not 
counted. 

A warning is also output if the I/O variables used in the text body were not defined in the 
"Parameters" area. 
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5.13 Functions for measuring variables 

General information 
Energy Manager has implemented a set of standard functions for MEVA processing. Siemens 
AG reserves the right to create any new evaluation algorithms that may be needed, including 
their implementation in the system. As a general rule: 

• The query type determines the observation period. 

• The calculation results relate to the respective observation period that is transferred at the 
start of an evaluation (From, To). 

• The cycle time and the compression level determine the initial interval. 

• The calculation interval determines the interval of the result. 

• Multiple results can be displayed within the observation period for protocol MEVAs. 

• The observation period and the calculation interval are identical for balance MEVAs and 
derived data points. 

• For derived data points, the observation period or the calculation interval is determined by 
the cycle time of the derived data point. 

The following must be observed for the units of the results: 

• If the result of a MEVA function is returned in a specific unit, the result is displayed with 
[unit]. 

• If the result of a MEVA function always returns the value 1, the result is displayed with [1]. 

• If there is no further monitoring regarding the unit of a MEVA function result, the result is 
displayed with [x]. 

 

 Note 

The order of the data points, MEVAs and parameters in the listing under "Inputs:" and in the 
Client (see figures) is mandatory because the functions expect the input values in this order.  

 

Requirement 
Successful installation of all software components. 
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MEVA functions 
The following table shows all the available MEVA functions: 
 
Function Description 
Addition with cross sum Addition with cross sum (ID: 2694) 

Forms the sum of the n data point values for each time stamp. Re-
turns the sum of the sums contained therein for each calculation 
interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
The function returns: 
RESULT[x] = SUM (d_Data_point_1 + d_Data_point_2 + … + 
d_Data_point_n) 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 

 

Addition Addition (ID: 1795) 
Adds the results of the n MEVA/datapoint/parameter inputs. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 
The function returns: 
RESULT[x] =m_MEVA_1 + m_MEVA_2 + ... + m_MEVA_n  
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Number of records Number of data records (ID: 1740) 
Calculates the number of measured values within the calculation 
interval. 
Inputs:  
d_Data_point 
The function returns: 
RESULT[1] = Number of measured values within the calculation 
interval.  

 

Number of starts Number of starts (ID: 1771) 
Calculates the number of changes from 0 to 1 within the calculation 
interval. 
Inputs: 
d_Data_point (contains only 0 and 1) 
The function returns: 
RESULT[1] = Number of changes from 0 to 1 within the calculation 
interval. 

 

Energy rate Energy rate (ID:1775) 
Every value within the calculation interval is multiplied by the profile 
value. All value profile pairs within the calculation interval are added 
together. 
Inputs: 
d_Data_point 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = SUM (value * profile) 

 



 Reference 
 5.13 Functions for measuring variables 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 815 

Energy rate with limit Energy rate with limit (ID: 2691) 
Every value within the calculation interval is multiplied by the value 
from Profile 1 or Profile 2 depending on the limit. All value profile 
pairs within the calculation interval are added together. 
Inputs: 
d_Data_point 
Profile_1 OR MasterProfile_1 
Profile_2 OR MasterProfile_2 
t_Parameter 
The function returns: 
RESULT[x] ={IF value>limit SUM(value * profile_2)} +{IF value≤limit 
SUM(value * profile_1)} 
The replacement value configured in t_Parameter determines the 
limit. 

 

Energy rate with availableness Energy rate with availableness (ID: 2689) 
Every value within the calculation interval is multiplied by the profile 
value, depending on the value of d_Data_point_2. All value profile 
pairs within the calculation interval are added together.  
Inputs: 
d_Data_point_1 
d_Data_point_2 (contains only 0 and 1) 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = IF d_Data_point_2 = 1 = SUM(value* profile) 

 

Observation period in hours Observation period in hours (ID: 1741) 
Calculates the duration of the calculation interval. 
Inputs:  
not necessary. 
The function returns: 
RESULT[h] = Duration of the calculation interval. 
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Inventory change Inventory change (ID: 2904) 
Adds the result of the Meva to the value of the previous period of 
the derived data point and writes the result in the current period of 
the derived data point. The result is also returned as a Meva result 
and can thus be output to a protocol module, for example. 
Inputs: 
a_Data_point 
m_MEVA 

 

Operating hours conditionally Operating hours conditionally (ID: 2688) 
Conditional operating hours 
Inputs: 
d_Data_point 
t_Parameter 
The function returns: 
RESULT[s] = Sum of valid periods of the specified data point within 
the observation period minus the valid periods with data point value 
not exceeding 0 ± parameter value. 

 

Difference from DP Difference from DP (ID: 2812) 
If the value in m_MEVA_1 is not m_MEVA_2, the value in 
m_MEVA_1 is returned. Zero is returned if both MEVAs do not pro-
vide a value. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
The function returns: 
If the value in m_MEVA_1 is not m_MEVA_2, the value in 
m_MEVA_1 is returned. Zero is returned if both MEVAs do not pro-
vide a value. 
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Difference snapshot Difference snapshot (ID: 2875) 
Difference from two measured values of the connected data point. 
The first time is specified by the parameter in decimal notation (e.g.: 
1.5 = 01:30 h). The second measured value is derived from the 
same time of the previous day. An interval shorter than one day 
returns the same result as an interval duration of one day. 
Inputs: 
d_Data_point 
t_Parameter 

 

Division Division (ID: 2853) 
Divides the results of the n MEVA/datapoint/parameter inputs. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 
The function returns: 
RESULT[x] = m_MEVA_1 / m_MEVA_2 / ... / m_MEVA_n 

 

Energy input Energy input (ID: 1731) 
Energy input without inclusion of parameter changes 
Inputs: 
m_MEVA (quantity, e.g. coal supplied [t]) 
t_Parameter (calorific value, for example, calorific value of coal 
[MWh/t]) 
The function returns: 
RESULT[MWh] = Energy input[MWh] = m_MEVA[t] * 
t_Parameter[MWh/t] 
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Energy input oil Energy input oil (ID: 1773) 
Calculation of energy input from oil, temperature compensated with 
inclusion of parameter changes 
Inputs: 
t_Parameter_1 (reference density [t/m³]) 
t_Parameter_2 (reference temperature [°C]) 
t_Parameter_3 (correction factor [1/°C]) 
d_Data_point_1 (operating temperature [°C]) 
d_Data_point_2 (flow [m³/h]) 
t_Parameter_4 (calorific value [MWh/t]) 
The function returns: 
RESULT[t] = Energy input[t] = SUM( d_Data_point_2 * validity peri-
od *( t_Parameter_1 + (( t_Parameter_2 - d_Data_point_1 ) * 
t_Parameter_3 )) * t_Parameter_4 ) / 3600 

 

First value First value (ID: 2764) 
Calculates the first measured value in the calculation interval. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = First value in the calculation interval.  

 

GTZ DTF (daily temperature figures ID: 2912) 
Calculates the DTF. 
Inputs: 
d_Data_point (temperature) 
t_Parameter_1 (heating limit) 
t_Parameter_2 (room temperature) 
The function returns: 
RESULT[x] = SUM(t_Parameter_1 - daily averages)  
If daily average > t_Parameter_2, then difference = 0. 

 



 Reference 
 5.13 Functions for measuring variables 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 819 

GTZ 20/15 GTZ 20/15 (ID: 2862) 
Calculates the GTZ 20/15 (heating limit 20°C). 
Inputs: 
d_Data_point (outdoor temperature)  
The function returns: 
RESULT[x] = SUM (difference of the daily averages to 20 degrees) 
If daily mean value > 15 degrees, then difference = 0.  

 
Additional info: 
The daily average of the outdoor temperature (TA) is calculated. The 
daily temperature figure is calculated as follows: 
Daily average of the outdoor temperature TA  
DTf = (20° - TA) if TA < 15° 
DTf = 0 if TA ≥ 15° 
Monthly value: Total of daily values  
Query period 1 month  
Interval: 1 day 

 
Query period 1 year 
Interval: 1 month 
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Degree days Degree days (ID: 2797) 
Calculation of the heating degree days ( GTZ 15/15) (heating limit 
15°C). 
Inputs: 
 d_Data_point (outdoor temperature) 
 The function returns: 
 RESULT[x] = SUM (difference of the daily averages to 15 degrees) 
 If daily mean value > 15 degrees, then difference = 0. 
 The daily mean is calculated as standard arithmetic mean value. 

 

Heating degree days AT 
(t9+t14+2x t21)/4 

Heating degree days AT (t9+t14+2x t21)/4 (ID: 2819) 
Calculation of degree days AT. 
Inputs: 
d_Data_point (temperature [°C]) 
The function returns: 
RESULT[x] = SUM(difference of daily averages to 15 degrees) 
If daily mean value > 15 degrees, then difference = 0. 
If daily average < 15 degrees, then: 
RESULT[x] = (temperature(9:00) + temperature(14:00) + 2 x tem-
perature(21:00)) / 4 

 

Configurable Meva Configurable Meva (ID: 2883) 
Carries out a user-defined operation of the n 
MEVA/datapoint/parameter inputs. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 

 
The following operators can be used: +, -. *, /, (, ) 
Placeholders for the n MEVA inputs based on their position are de-
fined as follows: 1, 2, n 
Example: (:1 + :2 - :n) * :n / :1  
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Load profile Load profile (ID: 2873) 
Corrects a load profile using a correction value. A load profile is 
recalculated based on a monthly correction value. 
Inputs: 
d_Data_point_1 (load profile) 
d_Data_point_2 (load profile correction) 
The function returns: 
The function first calculates the Real value of the sum (SumRealTo-
tal) as a function of the load profile (d_Data_point_1). It also calcu-
lates the last value for the entire analysis period and applies this as 
correction value (LastCorrValue).  
The following calculation is then performed for each interval: 
Value = SUM REAL as a function of the current query period / Sum-
RealTotal * LastCorrValue 

 

Load forecast generally Load forecast generally (ID: 2709) 
General calculation of the load forecast. 
Inputs: 
Consumer type 
Anlage_1 
Anlage_2 
Anlage_n 
The function returns: 
RESULT[x] = Sum (y[E,t1] = k[E] * Quantity[t1] + d[E]) 

 

Load forecast general relatively Load forecast general relatively (ID: 2800) 
General calculation of the relative load forecast. 
Inputs: 
Consumer type 
Anlage_1 
Anlage_2 
Anlage_n 
The function returns: 
RESULT[x] = Sum (y[E,t1] = k[E] * Quantity per time[t1] + d[E]) 
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Last value Last value (ID: 2765) 
Calculates the last measured value in the calculation interval. 
Inputs: 
d_Data_point  
The function returns: 
RESULT[x] = Last value in the calculation interval. 

 

Gap check Gap check (ID: 2868) 
Returns 1 if one of the connected data points contains gaps or val-
ues <= filter value; otherwise 0 is returned. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
[t_Parameter (filter value)] 
If t_Parameter is not used, then filter value = 0.  

 

Max n Average Max n Average (ID: 2804) 
Calculates the average of the n highest values since the beginning 
of the year. 
Inputs: 
d_Data_point 
t_Parameter 
The function returns: 
RESULT[x] = Average of the n highest values since the beginning of 
the year.  
The replacement value configured in t_Parameter determines n. 
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Maximum Maximum (ID: 1720) 
Calculates the largest value within the calculation interval. 
Inputs: 
d_Data_point  
The function returns: 
RESULT[x] = Largest value within the calculation interval. 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 
MEVA_STER_THRESHOLD can be used to set a percentage limit of 
corrupted values as of which the corrupted result is also rejected. It 
is also permitted to use decimal point values (e.g. 50.5); the func-
tion is disabled with "0". Only active if MEVA_CHECK_LUECKEN is 
disabled (= 0). 

 

Maximum (profile) Maximum (profile) (ID: 2860) 
Calculates the greatest value within the calculation interval depend-
ing on the profile value. 
Inputs: 
d_Data_point 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = Greatest value within the calculation interval if the 
profile value is not 0. Otherwise 0. 

 

Maximum cumulated Maximum cumulated (ID: 2865) 
Returns the cumulative maximum of all measured values within the 
'From' time of the observation period until the 'T'o time of the calcu-
lation interval. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Cumulative maximum of all measured values.  
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Maximum of n data points Maximum of n data points (ID: 2835) 
Calculates the greatest measured value of n data points that lie 
within the calculation interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
The function returns: 
RESULT[x] = Greatest measured value of n data points that lie within 
the calculation interval. 

 

Minimum Minimum (ID: 1718) 
Calculates the smallest value within the calculation interval. 
Inputs: 
d_Data_point  
The function returns: 
RESULT[x] = Smallest value within the calculation interval. 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 
MEVA_STER_THRESHOLD can be used to set a percentage limit of 
corrupted values as of which the corrupted result is also rejected. It 
is also permitted to use decimal point values (e.g. 50.5); the func-
tion is disabled with "0" value. Only active if MEVA_CHECK_LUECKEN 
is disabled (= 0). 

 

Minimum (profile) Minimum (profile) (ID: 2787) 
Calculates the smallest value within the calculation interval depend-
ing on the profile value. 
Inputs: 
d_Data_point 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = Smallest value within the calculation interval if the 
profile value is not 0. Otherwise 0. 
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Minimum over actual year Minimum over actual year (ID: 2786) 
Calculates the smallest value of all measured values within the fol-
lowing interval. 
[Start of current year, To timestamp of the calculation interval] 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Smallest value of all measured values within the inter-
val above. 

 

Minimum of n data points Minimum of n data points (ID: 2834) 
Calculates the smallest measured value of n data points that lie 
within the calculation interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
The function returns: 
RESULT[x] = Smallest measured value of n data points that lie within 
the calculation interval. 

 

Minus Minus (ID: 1735) 
Calculates the difference of two MEVAs. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
The function returns: 
RESULT[x] = m_MEVA_1 - m_MEVA_2 
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Average Average (ID: 1719) 
Calculates the average of all measured values within the calculation 
interval. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Average of all measured values within the calculation 
interval. 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 
MEVA_STER_THRESHOLD can be used to set a percentage limit of 
corrupted values as of which the corrupted result is also rejected. It 
is also permitted to use decimal point values (e.g. 50.5); the func-
tion is disabled with "0". Only active if MEVA_CHECK_LUECKEN is 
disabled (= 0). 

 

Average (profile) Average (profile) (ID: 2762) 
Calculates the average of all measured values within the calculation 
interval depending on the profile value. 
Inputs: 
d_Data_point 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = Average within the calculation interval if the profile 
value is not 0. Otherwise 0. 

 

Floating average x days for 
Meva 

Floating average x days for Meva (ID: 2838) 
Calculation of the floating average of a MEVA. 
Inputs: 
m_MEVA 
t_Parameter (number of days) 
The function returns: 
RESULT[x] = Average of the MEVA over the last n days. 
The replacement value configured in t_Parameter determines the 
number of days.  
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Average cumulated Average cumulated (ID: 2864) 
Returns the cumulative average of all measured values within the 
'From' time of the observation period until the 'To' time of the calcu-
lation interval. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Cumulative average of all measured values.  

 

Average with filter Average with filter (ID: 2861) 
Returns the average of all measured values greater than the filter 
value. 
Inputs: 
d_Data_point 
[t_Parameter (filter value)] 
If t_Parameter is not used, the filter value = 0. 
The function returns: 
RESULT[x] = Average of all measured values greater than the filter 
value. 

 

Average of n data points Average of n data points (ID: 2836) 
Calculates the average of n data points that lie within the calcula-
tion interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
The function returns: 
RESULT[x] = Average of n data points that lie within the calculation 
interval. 
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Average of n MEVAs Average of n MEVAs (ID: 2839) 
Calculates the average of n MEVAs that lie within the calculation 
interval. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 
The function returns: 
RESULT[x] = Average of n MEVAs that lie within the calculation 
interval. 

 

Average previous period Average previous period (ID: 2798) 
Calculation of average of previous period. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = AVG(measured values), whereby the query period is set 
back by one period (from/to). 

 

Multiplication Multiplication (ID: 2708) 
Multiplies the results of the n MEVA/datapoint/parameter inputs. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 
The function returns: 
RESULT[x] = m_MEVA_1 * m_MEVA_2 * … * m_MEVA_n) 
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Multiplication of 2 DPs with 
cross sum 

Multiplication of 2 DPs with cross sum (ID: 2690) 
Forms the product of the data point values for each time stamp. 
Returns the sum of the products contained therein for each calcula-
tion interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
The function returns: 
RESULT[x] = SUM (d_Data_point_1 * d_Data_point_2) 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 

 

Parameter Parameter (ID: 1728) 
Calculates the valid parameter value since the start of the calcula-
tion interval.  
Inputs: 
t_Parameter 
The function returns: 
RESULT[x] = The valid parameter value since the start of the calcula-
tion interval. 

 

Percentile cumulated Percentile cumulated (ID: 2867) 
Returns the cumulative percentile of all measured values within the 
'From' time of the observation period until the 'To' time of the calcu-
lation interval. 
Inputs: 
d_Data_point 
t_Parameter (percentile) 
The function returns: 
RESULT[x] = Cumulative percentile of all measured values. 
The replacement value configured in t_Parameter determines the 
percentile. The percentile must be in the range from 1 to 99.  
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Production plan correction 
factor 

Production plan correction factor (ID: 2660) 
Calculates the sum of the correction values of all connected produc-
tion plans. 
Inputs: 
Plant_1 
Plant_2 
Plant_n 
The function returns: 
RESULT[x] = SUM (correction value of the connected production 
plans within the calculation interval) 

 

Profile sum NLP Profile sum NLP (ID: 2760) 
Calculates the sum of the profile values in the calculation interval. 
Inputs: 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = SUM(profile values) 

 

Profile value Profile value (ID: 2730) 
Calculates the valid profile value since the start of the calculation 
interval. 
Inputs: 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = The valid profile value since the start of the calculation 
interval. 

 

Percent Percent (ID: 2732) 
Calculates the quotient of two data points, multiplied by 100. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
The function returns: 
RESULT[x] = (d_Data_point_1 / d_Data_point_2) * 100 

 



 Reference 
 5.13 Functions for measuring variables 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 831 

Percentage Percentage (ID: 1739) 
Calculates the quotient of two MEVAs, multiplied by 100. 
Inputs: 
m_MEVA_1 
m_MEVA_2 
The function returns: 
RESULT[x] = (m_MEVA_1 / m_MEVA_2) * 100 

 

Repair hours Repair hours (ID: 2770) 
Calculates the total of all values in the validity period of the parame-
ter. 
Inputs: 
t_Parameter (repair hours) 
The function returns: 
RESULT[x] = Sum of all values in the validity period of the parame-
ter. 

 

Rounding to n decimal places Rounding to n decimal places (ID: 2785) 
Calculates rounded MEVA results 
Inputs: 
m_MEVA 
t_Parameter 
The function returns: 
RESULT[x] = MEVA results rounded to the nth decimal place.  
The replacement value configured in t_Parameter determines n.  
n must be in the range from 0 ... 15. 
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Upper threshold element Upper threshold element (ID: 1769) 
Calculates all MEVA values which are below the threshold. Other-
wise, the threshold is returned. 
Inputs: 
m_MEVA 
t_Parameter (threshold) 
The function returns: 
RESULT[x] = IF(m_MEVA < t_Parameter, m_MEVA, t_Parameter) 

 

Lower threshold element Lower threshold element (ID: 2681) 
Calculates all MEVA values which are above the threshold. Other-
wise, the threshold is returned. 
Inputs: 
m_MEVA 
t_Parameter (threshold) 
The function returns: 
RESULT[x] = IF(m_MEVA > t_Parameter, m_MEVA, t_Parameter) 

 

Subtraction Subtraction (ID: 2772) 
Subtracts the results of the n MEVA/datapoint/parameter inputs: 
m_MEVA_1 
m_MEVA_2 
m_MEVA_n 
The function returns: 
RESULT[x] = m_MEVA_1 - m_MEVA_2 - ... - m_MEVA_n 
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Subtraction with cross sum Subtraction with cross sum (ID: 2784) 
Forms the difference of the n data point values for each time stamp. 
Returns the sum of the differences contained therein for each calcu-
lation interval. 
Inputs: 
d_Data_point_1 
d_Data_point_2 
d_Data_point_n 
The function returns: 
RESULT[x] = SUM (d_Data_point_1- d_Data_point_2 - … - 
d_Data_point_n) 
Additional info: 
If MEVA_CHECK_LUECKEN in Energy Manager Options is set to 0, no 
check for gaps in the time series (15 min) is performed. 1 means 
that the check is performed. Only active if MEVA_STER_THRESHOLD 
is disabled (= 0). 

 

Sum Sum (ID: 1721) 
Sum of all measured values scaled to the hour. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Sum (measured value * validity period) / 3600 
Additional info: 
MEVA_STER_THRESHOLD can be used to set a percentage limit of 
corrupted values as of which the corrupted result is also rejected. It 
is also permitted to use decimal point values (e.g. 50.5); the func-
tion is disabled with "0". Only active if MEVA_CHECK_LUECKEN is 
disabled (= 0). 

 

Sum (profile) Sum (profile) (ID: 2761) 
Standardized sum calculation depending on the profile value. 
Inputs: 
d_Data_point 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = Sum(value[t] * validity[t] / 3600) if profile[t] <> 0 
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Sum real Sum real (ID: 1779) 
Calculates the sum of all measured values within the calculation 
interval. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = Sum (measured value) 
Additional info: 
MEVA_STER_THRESHOLD can be used to set a percentage limit of 
corrupted values as of which the corrupted result is also rejected. It 
is also permitted to use decimal point values (e.g. 50.5); the func-
tion is disabled with "0". Only active if MEVA_CHECK_LUECKEN is 
disabled (= 0). 

 

Sum real (profile) Sum real (profile) (ID: 2763) 
Calculates the sum of all measured values within the calculation 
interval depending on the profile value. 
Inputs: 
d_Datenpunkt 
Profile OR MasterProfile 
The function returns: 
RESULT[x] = sum(value[t] if profile[t] <> 0) 

 

Sum_HT Sum_HT (ID: 1763) 
Sum of all measured values scaled to the hour as long as rate = 1. 
Inputs: 
d_Data_point_1 
d_Data_point_2 (H/L rate, represented by 0 and 1) 
The function returns: 
RESULT[x] = SUM(measured value * validity period) / 3600 IF 
d_Data_point_2 = 1 
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Sum_HT_Real Sum_HT_Real (ID: 2733) 
Sum of all measured values as long as rate = 1. 
Inputs: 
d_Data_point_1 
d_Data_point_2 (H/L rate, represented by 0 and 1) 
The function returns: 
RESULT[x] = SUM(measured value) IF d_Data_point_2 = 1 

 

Summe_NT Summe_NT (ID: 1764) 
Sum of all measured values scaled to the hour as long as rate = 0 
Inputs: 
d_Data_point_1 
d_Data_point_2 (H/L rate, represented by 0 and 1) 
The function returns: 
RESULT[x] = SUM(measured value * validity period) / 3600 IF 
d_Data_point_2 = 0 

 

Sum_NT_Real Sum_NT_Real (ID: 2734) 
Sum of all measured values as long as rate = 0. 
Inputs: 
d_Data_point_1 
d_Data_point_2 (H/L rate, represented by 0 and 1) 
The function returns: 
RESULT[x] = SUM(measured value) IF d_Data_point_2 = 0 
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Sum energy input Sum energy input (ID: 1772) 
Calculates the sum of the energy input scaled to hour with inclusion 
of parameter changes. 
Inputs: 
d_Data_point (flow in [m³/h], [Nm³/h]) 
t_Parameter (calorific value in [MWh/t] ,[MWh/Nm³]) 
The function returns: 
RESULT[MWh] =Sum energy input[MWh] = SUM(d_Data_point * 
validity period * t_Parameter)/ 3600 

 

Sum energy input real Sum energy input real (ID: 1778) 
Calculates the sum of the energy input with inclusion of parameter 
changes. 
Inputs: 
d_Data_point (flow in [m³/h], [Nm³/h]) 
t_Parameter (calorific value in [MWh/t] ,[MWh/Nm³]) 
The function returns: 
RESULT[MWh] =Sum energy input real [MWh] = SUM(d_Data_point 
* t_Parameter) 

 

Daily average AT(t9+t14+2x 
t21)/4 

Daily average AT (t9+t14+2x t21)/4 (ID: 2820) 
Calculates the daily average outdoor temperature. 
Inputs: 
d_Data_point 
The function returns: 
RESULT[x] = (temperature(09:00) + temperature(14:00) + 2 x tem-
perature(21:00)) / 4 
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If-Then If-Then ID: 2746 
Calculates the MEVA result of the threshold depending on the logi-
cal expression.  
Inputs: 
m_MEVA_1 
m_MEVA_2 OR t_Parameter 
m_MEVA_3 
m_MEVA_4 
The function returns: 
RESULT[x]=IF (m_MEVA_1 > m_MEVA_2; m_MEVA_1; 0) 
RESULT[x]=IF (m_MEVA_1 > m_MEVA_2; m_MEVA_3; 0) 
RESULT[x]=IF(m_MEVA_1 > m_MEVA_2; m_MEVA_3; m_MEVA_4) 
Argument 2 may be a MEVA or parameter 
Arguments 3 and 4 are optional. 

 

Time window correction Time window correction (ID: 2902) 
Moves the MEVA calculation results to the future or to the past. 
Inputs: 
m_MEVA 
t_Parameter OR query type. 
t_Parameter: with direction ("-": future; "+": past) and number of 
periods, for example, "-1" to shift the data by one period into the 
past. 
Query type: Correction From-time on the basis of duration and off-
set of the query type, To-time remains unchanged. 
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Input oil (incl. corr.) Input oil (incl. corr.) (ID: 1738) 
Temperature compensated calculation of the oil supply. 
Inputs: 
t_Parameter_1 (reference density [t/m³]) 
t_Parameter_2 (reference temperature [°C]) 
t_Parameter_3 (correction factor [1/°C]) 
d_Data_point_1 (operating temperature [°C]) 
d_Data_point_2 (flow [m³/h]) 
The function returns: 
RESULT[t] = oil supply[t] = SUM( d_Data_point_2 * validity period *( 
t_Parameter_1 + (( t_Parameter_2 - d_Data_point_1 ) * 
t_Parameter_3 ))) / 3600 
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5.14 User jobs of the job queue 
The following section specifies the database jobs of the job queue that are available. 

 
Database job Description 
Generate batch 
data 

Generates batch data in the following form: 

 

 

 
Database job Description 
Export forecast 
EDM 

Exports all measured values of a datapoint in CSV format to an ASCII file, starting on the current day 
(00:15:00 h), including available forecast values. The datapoints concerned must be assigned to the 
"EDM forecast" export function. Assign these to the export function in the datapoint configuration of 
the Export dialog. The file name is also specified in this dialog. An optional time stamp with 
"yyyymmddhh24mi" format can be added to the file name. The file name has the extension ".TXT". The 
data are exported to the file successively for each datapoint.  
Format Meaning 
yyyy Year 
mm Month 
dd Day 
hh24 24 hours mode 
mi Minutes 
Entries in Energy Manager options 
EXPORT_PATH Export directory. If this entry is missing, an error 

message is entered in the Logging Viewer. 
EXPORT_FILENAME_MODUS If = 0: File name with date and time. 

If = 1: File name without date and time. 
If exporting is carried out without date and time, a 
file already existing with the same name is overwrit-
ten. 

The following example shows an extract from an exported file that contains the following data: Date, 
time, measured value, and status. Date and time are in UTC time format.  
08.04.2008;23:15:00;100;0 
08.04.2008;23:30:00;99;0 
08.04.2008;23:45:00;98;0 
09.04.2008;00:00:00;97;0 
09.04.2008;00:15:00;96;0 
Note: The user running the Oracle application needs write permissions for the specified directory. 
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Database job Description 
Export SAP R/3 PM 
historical PD 6h 

Exports the counter value history of the PREVIOUS DAY to a file at intervals of 6 hours and in "SAP R/3 
PM" format. The data points concerned must be assigned to the "SAP PM VT historical 6h" export func-
tion. Assign these to the export function in the data point configuration of the Export dialog. The file 
name is also specified in this dialog. A time stamp with "yyyymmddhh24mi" format is added to the file 
name. 
Format Meaning 
yyyy Year 
mm Month 
dd Day 
hh24 24 hours mode 
mi Minutes 
The directory for the export is specified via the entry in the "EXPORT_PATH" in the Energy Manager 
options. If this entry is missing, an error message is entered in the Logging Viewer. 

 

 
Database job Description 
Export SAP R/3 PM 
historical PPD 6h 

Exports the counter value history of the DAY BEFORE YESTERDAY to a file at intervals of 6 hours and 
in "SAP R/3 PM" format. The data points concerned must be assigned to the "SAP PM PPD historical 6h" 
export function. Assign these to the export function in the data point configuration of the Export dia-
log. The file name is also specified in this dialog. A time stamp with "yyyymmddhh24mi" format is 
added to the file name. 
Format Meaning 
yyyy Year 
mm Month 
dd Day 
hh24 24 hours mode 
mi Minutes 
The directory for the export is specified via the entry in the "EXPORT_PATH" in the Energy Manager 
options. If this entry is missing, an error message is entered in the Logging Viewer. 

 

 
Database job Description 
"Export PD as 
ASCII" 

Exports all data point values measured on the PREVIOUS DAY in CSV format to an ASCII file. The data 
points concerned must be assigned to the "Energy Manager Standard" export function. Assign these to 
the export function in the data point configuration of the Export dialog. The file name is also specified 
in this dialog. A optional time stamp with "yyyymmddhh24mi" format can be added to the file name. 
The file name has the extension ".TXT". The data are exported to the file successively for each data-
point.  
Format Meaning 
yyyy Year 
mm Month 
dd Day 
hh24 24 hours mode 
mi Minutes 
Entries in Energy Manager options 
EXPORT_PATH Export directory. If this entry is missing, an error mes-

sage is entered in the Logging Viewer. 
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Database job Description 
EXPORT_FILENAME_MODUS If = 0: File name with date and time. 

If = 1: File name without date and time. 
If exporting is carried out without date and time, a file 
already existing with the same name is overwritten. 

The following example shows an extract from an exported file: 
"COMP_LEVEL";"MSJO_DATE";"TIME_ID";"MEAS_ID";"MSJO_VALUE";"MSJO_INTERVAL";"MSJO_DVALID";"
STER_FLAG";"STKO_FLAG" 
"2100";"07.04.2008 00:15:00";"1002";"127795";"100";"900";"900";"0";"0" 
"2100";"07.04.2008 00:30:00";"1002";"127795";"99";"900";"900";"0";"0" 
"2100";"07.04.2008 00:45:00";"1002";"127795";"98";"900";"900";"0";"0" 
"2100";"07.04.2008 01:00:00";"1002";"127795";"97";"900";"900";"0";"0" 
"2100";"07.04.2008 01:15:00";"1002";"127795";"96";"900";"900";"0";"0" 
Note: The user running the Oracle application needs write permissions for the specified directory. 

 

 
Database job Description 
Export all config-
ured formats 

Exports all the measured values of all the datapoint values at which export functions are configured of 
the PREVIOUS DAY in CSV format to an ASCII file. The values of all the configured export functions are 
exported. The assignment of the export functions is effected in the datapoint configuration of the 
Export dialog. The file name is also specified in this dialog. A optional time stamp with 
"yyyymmddhh24mi" format can be added to the file name. The file name has the extension ".TXT". The 
data are exported to the file successively for each datapoint.  
Format Meaning 
yyyy Year 
mm Month 
dd Day 
hh24 24 hours mode 
mi Minutes 
Entries in Energy Manager options 
EXPORT_PATH Export directory. If this entry is missing, an error mes-

sage is entered in the Logging Viewer. 
EXPORT_FILENAME_MODUS If = 0: File name with date and time. 

If = 1: File name without date and time. 
If exporting is carried out without date and time, a file 
already existing with the same name is overwritten. 

The following example shows an extract from an exported file: 
"COMP_LEVEL";"MSJO_DATE";"TIME_ID";"MEAS_ID";"MSJO_VALUE";"MSJO_INTERVAL";"MSJO_DVALID";"
STER_FLAG";"STKO_FLAG" 
"2100";"07.04.2008 00:15:00";"1002";"127795";"100";"900";"900";"0";"0" 
"2100";"07.04.2008 00:30:00";"1002";"127795";"99";"900";"900";"0";"0" 
"2100";"07.04.2008 00:45:00";"1002";"127795";"98";"900";"900";"0";"0" 
"2100";"07.04.2008 01:00:00";"1002";"127795";"97";"900";"900";"0";"0" 
"2100";"07.04.2008 01:15:00";"1002";"127795";"96";"900";"900";"0";"0" 
Note: The user running the Oracle application needs write permissions for the specified directory. 

See also 
Job queue (Page 731) 
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5.15 Functions for Task Management 

Overview 
The following section specifies the tasks that are available. 
 
Task Function 
ODBD Import 
TskImpor-
tODBC.cmd 
TskImportOD-
BCall.cmd 

Configuration 

 
TskImportODBC.cmd: Imports all active data channels that are assigned to the task. 
TskImportODBCall.cmd: Imports all active data channels. 

 
Select the file to be executed in the command line.  
Define a "Schedule", if applicable. 
Click "Start" to launch a single run of the task.  
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Task Function 
Archiving 
TskArchive.cmd 

Configuration 

 
Select the "TskArchive.cmd" entry from the command line list box when you define 
the task.  

 
Create an interval definition to configure the time window to export.  
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Task Function 
Archiving 
(continued) 

The following example shows the export of data that is older than three years. "Re-
move after export" deletes the data from the database within the specified time 
range. The exported data is written to a file.  

 
You may also export all data points manually or export only selected data points. 

Job starting 
TskStartJob.cm
d 

This task can be used to initiate the database jobs that are available in Energy Man-
ager PRO and which are also used in the job queue. 
Configuration 

 
Connect the object of the database job that is to be executed to the task node. The 
jobs available in the system are listed in the plant tree at "Configuration > Constants 
and definitions" / Functions / Jobs.  
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5.16 ASCII FTP formats 

5.16.1 ASCII FTP import interface 
Using the ASCII FTP import interface, you can import the content of ASCII files of diverse 
formats to Energy Manager.  

The specification for the supported formats is the same in all cases. 

During the installation of Energy Manager, a sample file for each supported format in the 
%Install-DIR%\EnMPRO\GUI\ftp directory is stored on the acquisition system. 

 
 
File format Sample file 
fp_Aprol ChronoLogDataExport_pfil_H_15_03_2010.txt 
fp_bdata 20100627_000000_FribaDP01.txt 
fp_xmlparser d_EL_E_7D_outside_temperature_20100101000000_20100102000000.xm

l 
fp_dalog Dalog_File.txt 
fp_excelcsv Excel_CSV.csv 
fp_excelcsvNODST Excel_CSV_NODST.csv 
fp_freja AVV_000112200_20100328000000_20100329000000.txt 
TextValue TextValues.txt 
fp_Zenon.dll zenOn.txt 

The following chapters contain more information on the various parsers and supplied sample 
files.  

See also 
Data acquisition via the "FTP, sFTP" interface (Page 432) 

Configuring data acquisition via the "File Import" interface (Page 437) 

Creating an ASCII channel (Page 252) 
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5.16.2 APROL 
APROL is a process control system. This system also exports the values as a "*.txt" file with a 
specific HTML format. The structure will look as follows: 

<record date=“YYYY-MM-DD“ time=“hh:mm:ss“ id=“Addressidentifier“> 

<field name=“val“>Value</field>  

<field name=“mode“>0</field>  

</record> 

To assign values to a data point, enter the address identifier of the values in the entry field 
"Address" during configuration. 

Example 
The following figure shows a file with the required structure: 
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5.16.3 BDATA 
You can import "*.txt" files from B.Data with the format BDATA. Do not modify the files of 
B.Data or else the import will no longer work. The separator is the semicolon sign. Each entry 
also features quotation marks at the beginning and the end.  

To assign values to a data point, enter the ID number of the values in the "Address" entry field 
when configuring the data point. You can find the ID number under the entry "MESS_ID". The 
ID number for the first entry in the example below is "00059". 

Example 
The following figure shows a file with the required structure: 

 
 

 Note 

Where applicable, as in Germany, use a comma as the decimal separator for the operating 
system.  

Otherwise use a period as the decimal separator. 

The figure above uses a period as the decimal separator. This file is therefore correct for non 
German-speaking operating systems. 
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5.16.4 BDATA_XML_Format 
In Energy Manager you can export values in an "*.xml" file. You can import these values with 
the BDATA_XML format. Do not modify the "*.xml" files of Energy Manager Pro or the import 
will no longer work. 

To assign values to a data point, enter the ID number of the values in the "Address" entry field 
when configuring the data point. The ID number for the first entry in the example below is 
"110357". 

 

 Note 
Importing XML files with or without line breaks 

If you wish to import an XML file with more than 65533 bytes, the XML file must be 
formatted with line breaks.  

If the XML file does not contain any line breaks, a maximum of 65533 bytes of data is 
imported. 

 

Example 
The following figure shows a file with the required structure: 
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5.16.5 DALOG 
The DALOG system is a data storage system which imports values as a "*.txt" file. The 
structure will look as follows: 

The address identifiers of the individual data points are found in the first line:  

Address label 1@ Address label 2@ Address label 3@ Address label 4 

A "1" stands for each data point in the second line: 

1@1@1@1 

From the third line, the time stamps are listed with the respective values: 

timestamp@Value1@Value2@Value3@Value4 

To assign values to a data point, enter the address identifier of the values in the "Address" 
entry field when configuring the data point. 

The separator in this case is "@". The following structure is required for the time stamp: 
YYYY.MM.DD hh:mm:ss 

Example 
The following figure shows a file with the required structure: 
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5.16.6 EXCELCSV 
You can import CSV files from Excel with the EXCELCSV format.  

In the EXCEL file, the time stamps of the values are listed in the first column (column A). The 
format of the time stamp is the German time and date format: DD.MM.YYYY hh:mm 

You can choose any header of the column with the time stamps. 

From the second column, the values for a time stamp are entered. Every column represents a 
data point. The address label for the values is the column header in the first line. 

To assign values of a column to a data point, enter the address label of the values in the 
"Address" entry field when configuring the data point. 

The separator is the semicolon. However, the separator is only visible outside of Excel. 

Example 
The following figure shows a file with the required structure: 
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5.16.7 EXCELCSVNODST 
The difference between the formats EXELCSV and EXCELCSVNODST is the time basis. The 
time stamps in this format are consistently requested in UTC+1 (standard time).  

Energy Manager adds an hour with this format for representation in daylight saving time.  

The structure of the file is identical to that of a file in the EXCELCSV format. 

Example 
The following figure shows a file with the required structure: 
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5.16.8 FREJA 
The FREJA system is an energy accounting system. The system uses the data format "*.txt". 
The required structure of the file is described in the following table: 
 
Column Column header Contents Example 
1 Year Year value of the timestamp 2018 
2 Month Month value of the 

timestamp 
03 

3 Day Daily value of the timestamp 28 
4 Hour Hour value of the time stamp 09 
5 Minute Minute value of the 

timestamp 
45 

6 TAGname Address label HQK_FJV_ATOF_LEV_EGI_1M 
7 Unit Unit of the value MWh 
8 Value Value of the entry 200 

Columns 9 and 10 with the column headers "Quality" and "Remark" are not used by Energy 
Manager. 

The separator field between the columns is a tabulator. Import is only possible with correct 
column headers. 

To assign values to a data point, enter the address label of the values in the "Address" entry 
field when configuring the data point. 

Example 
The following figure shows a file with the required structure: 
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5.16.9 TextValue 
You can import texts with this format. 

The TextValue format has the following structure: 

Time stamp;address label;text 

The German time and date format is requested for the time stamp: DD.MM.YYYY hh:mm 

The semicolon sign is the separator. 

Example 
The following figure shows a file with the required structure: 

 

5.16.10 ZenOn 
The ZenOn system is a system which saves values in a "*txt" file in CSV format. The required 
structure of the "*.txt" file is described in the following table: 
 
Column Contents  Example 
1 Address label H2_UYC01_CT001 
2 Value of the entry 8.6 
3 Standard or daylight saving time SPONT WINTER 
4 Date of the timestamp 27 January 2018 
5 Time of the timestamp 01:00:00 

Example 
The following figure shows a file with the required structure: 
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5.17 XML stylesheets 

5.17.1 XML export interface 
The XML export interface (DataExport.exe) is used for the export of data point information 
and measured values from Energy Manager to XML format files. The XML data is converted 
into the selected ASCII format by means of a style sheet. 

The entire process is controlled by means of Task Management. For this, the setup installs 
five CMD files in the "%Installations-DIR%\CMD" folder on an acquisition computer. 

 

"TskArchive.cmd" uses "%Installations-DIR%\BData_Archive" as the output folder. 

 

The remaining CMDs employ the "%Installations-DIR%\EDIEL" output folder. The other output 
folders are generated by the respective CMD. 

It is possible to adapt the CMD files or style sheets to enable generation of all necessary ASCII 
formats. 

Setup installs six style sheets in the "%Installations-DIR%\EnMPRO\GUI\Export XML" folder on 
an acquisition computer. 

 

The next chapters provide a short overview of the various style sheets.  
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5.17.2 CSV_localtime.xsl 

XML file 
 
Execution file: TskExportCSV.cmd 
Output folder: C:\EnMRPO\GUI\EDIEL\EXPORT 

5.17.3 CSV_normtime.xsl 

XML file 
 
Execution file: TskExportCSV_local.cmd 
Output folder: C:\EnMRPO\GUI\EDIEL\EXPORT 

5.17.4 CSV_simple.xsl 

XML file 
 
Execution file: TskExportCSV_simple.cmd 
Output folder: C:\EnMRPO\GUI\EDIEL\EXPORT 

5.17.5 CSV_V6Style.xsl 

XML file 
 
Execution file: TskExportCSV_V6.cmd 
Output folder: C:\EnMRPO\GUI\EDIEL\EXPORT 

5.17.6 StandardCSV.xsl 

XML file 
 
Execution file: TskExportXML.cmd 
Output folder: C:\EnMRPO\GUI\EDIEL\EXPORT 
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5.18 SAP interface 

5.18.1 DTD for the ERP interface 

DTD structure 
The following table shows the DTD structure from which the XML file is created. Using this 
DTD you can map the attributes in the ERP system.  

 
DTD Comment 
<?xml version="1.0" encoding="ISO-8859-1" standalone="no" ?> 
<!DOCTYPE bdata-export [ 
<!ELEMENT bdata-export (measurements, measurevalues) > 
<!ATTLIST bdata-export 

  
  
  
Definition of time range to be exported.  

id CDATA #REQUIRED 
from CDATA #REQUIRED 
to CDATA #REQUIRED 
export-id CDATA #REQUIRED 
export-version CDATA #REQUIRED 
> 

ID of interval definition 
Interval start (local time) 
Interval end (local time) 
Unique export ID 
Export version of time range 

> 
<!ELEMENT costcentre-relations (costcentre-relation)+ > 
<!ELEMENT costcentre-relation (description,properties) > 
<!ELEMENT description (#PCDATA) > 
<!ATTLIST costcentre-relation 

  
Definition of cost center relation 

 id CDATA #REQUIRED 
 name CDATA #REQUIRED 
 source-costcentre CDATA #REQUIRED 
 dest-costcentre CDATA #REQUIRED 
 business-unit CDATA #REQUIRED 
 costcentre-relation-extern-label CDATA #REQUIRED 
 source-costcentre-extern-label CDATA #REQUIRED 
 dest-costcentre-extern-label CDATA #REQUIRED 
 business-unit-extern-label CDATA #REQUIRED 
 cost-element-extern-label CDATA #REQUIRED 
 personnel-number CDATA #REQUIRED 
 accounting-day CDATA #IMPLIED 
> 

ID of the Energy Manager cost center relation 
Name of the Energy Manager cost center relation 
Name of the Energy Manager source cost center  
Name of the Energy Manager target cost center 
Name of business unit in ERP system 
Name of cost center relation in ERP system  
Name of source cost center in ERP system 
Name of destination cost center in ERP system 
Name of business unit in ERP system 
Name of service type in ERP system 
Personnel number 
Entry date, e.g. "14" (optional) 

<!ELEMENT properties (property)+> 
<!ELEMENT property (#PCDATA)> 
<!ATTLIST property 

  
  
Properties of the data point 
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DTD Comment 
 id CDATA #REQUIRED 
 name CDATA #REQUIRED 
 value-type CDATA #REQUIRED 
 
 
 
 
 
 
 value CDATA #REQUIRED 
> 

ID of the Energy Manager property 
Name of the Energy Manager property 
Data type of the Energy Manager property;  
Value range from 1 to 5: 
• 1: String; 
• 2: Float; 
• 3: Date/time; 
• 4 Integer; 
• 5: String 
Value of the Energy Manager property 

<!ELEMENT measurements (measurement)+ > 
<!ELEMENT measurement (description, measurevalues) > 
<!ELEMENT description (#PCDATA) > 
<!ATTLIST measurement 

  
  
  
Definition of data point 

 id CDATA #REQUIRED 
 name CDATA #REQUIRED 
 unit CDATA #REQUIRED 
 loggen CDATA #IMPLIED 
 dapu-adr CDATA #IMPLIED 
 ident CDATA #IMPLIED 
> 

ID of data point 
Name of the data point 
Unit of data point 
Logging in database (optional) 
Name of data point in the Energy Manager database 
(optional) 
Additional ID of data point (optional) 

<!ELEMENT measurevalues (val)+> 
<!ELEMENT val (#PCDATA)> 
<!ATTLIST val 

  
  
Definition of data point measured values  

 id CDATA #REQUIRED 
 time CDATA #REQUIRED 
 normtime CDATA #REQUIRED 
 isdst CDATA #REQUIRED 
 comp CDATA #IMPLIED 
 value CDATA #REQUIRED 
 int CDATA #IMPLIED 
 dur CDATA #IMPLIED 
 flag CDATA #IMPLIED 
 korr CDATA #IMPLIED 
 maxdate CDATA #IMPLIED 

ID of data point 
Timestamp in local time 
Timestamp in normal time 
Summer/Winter time (TRUE = summer time) 
Compression level 
Value 
Interval between the values in seconds (optional) 
Validity between the intervals (optional) 
Acquisition quality in Energy Manager (optional) 
Correction quality in Energy Manager (optional) 
Date/Time of value generation; only partially availa-
ble (optional) 

> 
]> 
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Example of an exported XML file 
The following figure shows an XML file exported from Energy Manager via the SAP interface. 
The file name is made up of the following components as standard:  

<Definition in the interval definition>_<ID of interval definition>_<FROM>_<TO>.xml 
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5.19 Dashboard objects 

5.19.1 Configuring the dashboard 
You can configure the Dashboard as follows: 

 

 
 
Settings Description 
Document size Sets the Dashboard size in pixels. 
Background Sets the Dashboard background. 

You may use a background image of the "*.bmp", "*.jpg", "*.gif", or "*.png" format from 
your file system for the Dashboard. 

Line Sets the border style for the Dashboard. 
Grid Sets the Dashboard grid that is used to align the dashboard objects. 
Global document font Sets the font and font size for the Dashboard. 
Global Sankey object configu-
ration 

Sets the update cycle for Sankey objects. 

See also 
Creating the dashboard layout (Page 636) 
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5.19.2 Configuring the time range 
You can configure the time range for dashboard objects as follows: 

 
 

Settings Description 
Dynamic time range Sets a default query type, for example, "Curr. month".  

In this case, the dashboard object evaluates the values of the current month. 
Fixed time range (ad hoc) Sets a customizable time range. 

In this case, the dashboard object evaluates the values of the defined period. 
From time selection object Uses the period from the "Time selection" object with the specified number.  
Display value for last cycle 
(only for "Gauge" dashboard 
object) 

Displays the value of the last cycle. 

Compression level filter Sets the type of values to display in the dashboard object, for example, "Daily values". 
In this case, the dashboard object displays the daily values of a measured value series. Re-
quirement: The daily values must be available in the system. 

Object update Defines the update interval for the dashboard object. 

See also 
Configuring dashboard objects (Page 640) 



 Reference 
 5.19 Dashboard objects 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 861 

5.19.3 Rounded rectangle 

Function 
Inserts a rounded rectangle into the Dashboard. 

Usage 
Use the "Rounded rectangle" dashboard object for your Dashboard style. 

Example 

 
① Rounded rectangle with text caption for a group of dashboard objects 
② Rounded rectangle as group of dashboard objects to form a picture 

Necessary settings 
None 
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Optional settings 

 

• Set the size of the dashboard object. 

• Set the border style. 

• Set the fill color. 

• Set the caption, the text style and the text alignment for the dashboard object. 
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5.19.4 Ellipsis 

Function 
Inserts an ellipsis into the Dashboard. 

Usage 
Use the "Ellipsis" dashboard object for your Dashboard style. 

Example 

 

Necessary settings 
None 

Optional settings 

 
• Set the size of the dashboard object. 

• Set the border style. 

• Set the fill color. 

• Set the caption and text style for the dashboard object. 
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5.19.5 Line 

Function 
Inserts a line into the Dashboard. 

Usage 
Use the "Line" dashboard object for your Dashboard style. 

Example 

 

Necessary settings 
None 

Optional settings 

 
• Set the line style. 

• Set a separate arrow style for the start and end of the line. 



 Reference 
 5.19 Dashboard objects 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 865 

5.19.6 Polyline 

Function 
Inserts a polyline into the Dashboard. 

Usage 
Use the "Polyline" dashboard object for your Dashboard style. 

Example 

 

Necessary settings 
none 

Optional settings 

 

• Add a new point if you want to add an extra line to the polyline. 

• Set the line style. 

• Set a separate arrow style for the start and end of the polyline. 
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5.19.7 Image 

Function 
Inserts a graphic image into the Dashboard. 

Application 
Use the "Image" dashboard object to insert a graphic image from your file system into the 
Dashboard. 

Example 

 

Necessary settings 

 
• Go to "Image" to select a graphic object in "*.bmp", "*.jpg", "*.gif", or "*.png" format from 

your file system. 

The selected graphic image is saved to the Energy Manager database. 

Optional settings 
• Set the border style. 

• Set the size of the graphic image. 



 Reference 
 5.19 Dashboard objects 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 867 

5.19.8 Traffic light 

Function 
Inserts a traffic light object into the Dashboard to visualize the status of data point values. 

This dashboard object evaluates the limit configured in the data point and displays the status 
of the values with color code. The following states are possible: 

• Green: The data point values do not exceed the range of the configured limit. 

• Red: The configured data point limit is exceeded. 

In the dashboard object configuration, you may define an additional warning limit that is 
indicated by the following state: 

• Yellow: The data point values are still in the valid range but are approaching the 
configured limit. 

 

 Note 
Configuring data points 

Configure the plausibility settings of the data point to use this dashboard object in the 
Dashboard. 

These plausibility settings are activated in the dashboard object configuration. 
 

Usage 
Use the "Traffic light" dashboard object, for example, to visualize the status of the values of a 
measured value series in the form of a traffic light. 

Example 

 
① The traffic light is red: The specified limit of a measured value series was exceeded. 
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Necessary settings 
• Go to the "Data acquisition" field to select the data point that contains the values to be 

evaluated using the traffic light. 

 
• Go to "Plausibility" to activate the limit to which the dashboard object has to respond. 
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  Note 

The dashboard object returns the "Red" status if only one of the limits you activated in the 
"Plausibility" setting is exceeded. The evaluation is not particularly helpful in this situation. 

For this reason, evaluate only one limit per dashboard object. Create additional dashboard 
objects for further evaluations. 

 

Optional settings 
• Go to "Plausibility" to activate the comparison set in the data point with the same data 

point in a different time period or with a different data point. 

• Select the "Alignment" tab to set the size, border and background color for the dashboard 
object. 

See also 
Configuring the time range (Page 860) 
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5.19.9 Value 

Function 
Displays the current data point value in the Dashboard. 

This dashboard object is also capable of evaluating the limit configured in the data point and 
of visualizing the values with color code. The following states are possible: 

• Configured background color: The data point values do not exceed the range of the 
configured limit. 

• Red: The configured data point limit is exceeded. 

In the dashboard object configuration, you may define an additional warning limit that is 
indicated by the following state: 

• Yellow: The data point values are still in the valid range but are approaching the 
configured limit. 

 

 Note 
Configuring data points 

Configure the plausibility settings of the data point to use this dashboard object in the 
Dashboard. 

These plausibility settings are applied during configuration of the dashboard object. 
 

Usage 
Use the "Value" dashboard object to display the actual value of the most recent period of a 
measured value series. 

Example 
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Necessary settings 
• Go to the "Data acquisition" field to select the data point that contains the value to be 

displayed. 

 

Optional settings 
• Display the unit of the data point by selecting the "Show unit" check box. 

• Set the update cycle for the dashboard object. 

The update cycle is set to five seconds by default. 
 

  Note 
Specifying the update cycle 

You cannot set an update cycle that is shorter than five seconds. 

These plausibility settings are activated in the dashboard object configuration. 
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• Go to "Plausibility" to activate the limit to which the dashboard object has to respond and 
to visualize the values with color code. 

 
 

  Note 

The dashboard object returns the "Red" status if only one of the limits you activated in the 
"Plausibility" setting is exceeded. The evaluation is not particularly helpful in this situation. 

For this reason, evaluate only one limit per dashboard object. Create additional dashboard 
objects for further evaluations. 

 

• Go to "Plausibility" to activate the comparison set in the data point with the same data 
point in a different time period or with a different data point. 

• Select the "Layout" tab to set the size, fill color, border style and text style for the 
dashboard object. 
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5.19.10 Value difference 

Function 
This dashboard object displays the status of the values with color code and evaluates the 
plausibility setting "Comparison with" configured in the data point. The following states and 
comparison types are possible: 

• Status: 

– Configured background color: The data point values do not exceed the range of the 
configured limit. 

– Yellow: The data point values are still in the valid range but are approaching the 
configured limit. 

– Red: The configured data point limit is exceeded. 

• Comparison type: 

– "Another Time Period": Compares the current value of a data point with a time-shifted 
value of the same data point. 

– "Reference Object": Compares the current value of a data point with the value of a 
reference data point. 

 

 Note 
Configuring data points 

Configure the plausibility settings of the data point to use this dashboard object in the 
Dashboard. 

These plausibility settings are activated in the dashboard object configuration. 
 

Usage 
Use the "Value difference" dashboard object to display the comparison of the values of two 
measured value series. 

Example 

 



Reference  
5.19 Dashboard objects 

 SIMATIC Energy Manager PRO V7.2 - Operation 

874 Operating Manual, 12/2020, A5E38952754-AF 

Necessary settings 
• Go to the "Data acquisition" field to select the data point that contains the values to be 

visualized. 

 
• Under "Plausibility" activate the limits to which the dashboard object has to respond. 

• Under "Compare With", activate the comparison type set in the configuration of the data 
point. 
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Optional settings 
• Display the unit of the data point by activating the "Show unit" check box. 

• Select the "Alignment" tab to set the size, fill color, border style and text style for the 
dashboard object. 

See also 
Configuring the time range (Page 860) 
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5.19.11 Time selection 

Function 
Changes the time range for dashboard object assigned to the "Time selection" object.  

You can assign the "Time selection" dashboard object to several dashboard objects. But you 
can only assign a dashboard object to exactly one "Time selection" dashboard object.  

Usage 
Use the "Time selection" dashboard object if you want to adapt the time range for one or 
more dashboard objects during runtime of the dashboard.  

Example 
The figure below shows the "Line chart" dashboard object with the "Time selection" 
dashboard object positioned underneath.  

 
① Scrolls back or forth one period. 
② Specifies the query type, e.g., "Ad hoc" 
③ Defines the time range depending on the selected query type. 
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Necessary settings 
Define the query type and time range in the "Time selection" dashboard object that are 
displayed in the assigned dashboard object when the dashboard is started: 

 
Assign the "Time selection" dashboard object to the dashboard object using its ID:  
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5.19.12 Status 

Function 
Displays the state of values of a data point in the Dashboard. 

This dashboard object evaluates the limit configured in the data point and displays the status 
of the values with color code. The following states are possible: 

• Green: The data point values do not exceed the range of the configured limit. 

• Red: The configured data point limit is exceeded. 

In the dashboard object configuration, you may define an additional warning limit that is 
indicated by the following state: 

• Yellow: The data point values are still in the valid range but are approaching the 
configured limit. 

 

 Note 
Configuring data points 

Configure the plausibility settings of the data point to use this dashboard object in the 
Dashboard. 

These plausibility settings are activated in the dashboard object configuration. 
 

Usage 
You can use the "Status" dashboard object to visualize the value states of a measured value 
series in the Dashboard. 

Example 

 
① Status of a plant 
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Necessary settings 
• Go to the "Data acquisition" field to select the data point with the status to be visualized. 

 
• Go to "Plausibility" to activate the limit to which the dashboard object has to respond. 

 
 

  Note 

The dashboard object returns the "Red" status if only one of the limits you activated in the 
"Plausibility" setting is exceeded. The evaluation is not particularly helpful in this situation. 

For this reason, evaluate only one limit per dashboard object. Create additional dashboard 
objects for further evaluations. 
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Optional settings 
• Go to "Plausibility" to activate the comparison set in the data point with the same data 

point in a different time period or with a different data point. 

• Select the "Alignment" tab to set the size and border style for the dashboard object. 

See also 
Configuring the time range (Page 860) 
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5.19.13 Bar chart 

Function 
Inserts a bar chart into the Dashboard. 

Usage 
Use the "Bar chart" dashboard object to visualize the values of one or several measured value 
series in the form of a bar chart. 

Example 
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Necessary settings 

 
• Select "New" to set the number of measured value series to display in the bar chart. 

• Assign a data point to each measured value series in the "Data source information" field. 

• Set the time range to display in the bar chart. 

Optional settings 
• Activate the bar chart caption in the "Parameters" tab. 

• Set the caption text for the bar chart in the "Datapoints" tab. 

– Activate "Use" and enter your caption text. 

– Activate "Description" if you want to use the description of the data point for the 
caption text. 

– Activate "Name" if you want to use the name of the data point for the caption text. 

• Set the bar colors in the "Datapoints" tab. 

• Set the diagram and text styles in the "Parameters" tab. 

See also 
Configuring the time range (Page 860) 
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5.19.14 Pie chart 

Function 
Inserts a pie chart into the Dashboard. 

Usage 
Use the "Pie Chart" dashboard object to visualize the values of one or several measured value 
series in the form of a pie chart. 

Example 
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Necessary settings 

 
• Select "New" to set the number of measured value series to display in the pie chart. 

• Assign a data point to each measured value series in the "Data source information" field. 

• Set the unit for displaying data point values in the pie chart, for example, "percent". 

• Specify the period that you want to evaluate in the pie chart. 

Optional settings 
• Activate the pie chart caption in the "Parameters" tab. 

• Set the caption text for the pie chart in the "Datapoints" tab. 

– Activate "Use" and enter your caption text. 

– Activate "Description" if you want to use the description of the data point for the 
caption text. 

– Activate "Name" if you want to use the name of the data point for the caption text. 

• Set the bar colors in the "Datapoints" tab. 

• Set the diagram and text styles in the "Parameters" tab. 

See also 
Configuring the time range (Page 860) 
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5.19.15 Line chart 

Function 
Inserts a line chart into the Dashboard. 

Usage 
Use the "Line Chart" dashboard object to visualize the values of one or several measured 
value series in the form of a line chart. 

Example 

 

Necessary settings 
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• Select "New" to set the number of measured value series to display in the line chart. 

• Assign a data point to each measured value series in the "Data source information" field. 

• Set the time range to display in the bar chart. 

Optional settings 
• Activate the line chart caption in the "Parameters" tab. 

• Set the caption text for the line chart in the "Datapoints" tab. 

– Activate "Use" and enter your caption text. 

– Activate "Description" if you want to use the description of the data point for the 
caption text. 

– Activate "Name" if you want to use the name of the data point for the caption text. 

• Set the line colors and display width in the "Datapoints" tab. 

• Set the diagram and text styles in the "Parameters" tab. 

See also 
Configuring the time range (Page 860) 
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5.19.16 Gauge 

Function 
Inserts a display instrument into the Dashboard to visualize the status of data point values. 

Usage 
Use the "Gauge" dashboard object to visualize the sum of the measured value series for the 
defined time period. Alternatively, you can also visualize the value of the last cycle.  

Example 

 
① Consumption status 

Necessary settings 
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• Go to the "Data source information" field to select the data point that contains the values 
to be evaluated. 

• Specify the period that you want to evaluate. 

Optional settings 
• Set the pointer color. 

• Set the fill color and border style in the "Parameters" tab. 

• Set the scale for the display instrument in the "Scale Parameter" section. 

• Set the scale range in the "Scale Sections" section. 

See also 
Configuring the time range (Page 860) 
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5.19.17 Panel switch 

Function 
Inserts a button into the Dashboard that you can use to switch to another Dashboard . 

Usage 
Use the "Panel switch" dashboard object to distribute selected data to several dashboards. Use 
the new button to switch between these dashboards. 

Example 
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① Dashboard 1: Represents the annual consumption of a company in kWh. The "Green Production Monitor" button 

returns you to dashboard 2 to show the monthly consumption.  
② Dashboard 2: The "Green Production Monitor II" button returns you to dashboard 1. 
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Necessary settings 

 

• At "Switch to...", select the Dashboard to which you want to switch using this button. 

• Enter a caption text for the button in the "Alignment" field. 

Optional settings 
• Set the border and text styles. 
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5.19.18 Data table 

Function 
Inserts a table object into the Dashboard to visualize the values of one or several data points. 

Usage 
Use the "Data Table" dashboard object to display the values and time stamp of a measured 
value series of a specific time period in the form of a table. 

Example 

 

Necessary settings 

 
• Select "New" to set the number of data points to display in the table. 

• Assign a data point to each entry in the "Data source information" field. 

• Specify the period that you want to evaluate. 
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Optional settings 
• Create the "Legend name". 

– Enter a text for the table header if you activate "Description". 

– The data point name is used for the table header if you activate "Name". 

• Set the column color. 

• Set the table style in the "Parameters" tab. 

See also 
Configuring the time range (Page 860) 



Reference  
5.19 Dashboard objects 

 SIMATIC Energy Manager PRO V7.2 - Operation 

894 Operating Manual, 12/2020, A5E38952754-AF 

5.19.19 Line for Sankey chart 

Function 
Inserts a line into the Sankey chart. 

Usage 
Use the "Line" dashboard object to visualize a quantity flow in the Sankey chart. 

The line width is proportional to the quantity. 

Example 

 
① Power flow of a company 
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Necessary settings 

 

• Name the dashboard object. 

• Go to the "Data acquisition" field to select the data point that contains the values to be 
visualized by the line. 

• Select the flow type for the line in the "Flow selection" field, for example, "Electricity". 

Optional settings 
• You can create a new flow type in the "Flow selection" field and set the scaling. 

• Specify the update cycle for the Sankey objects by entering the selected value in the 
Dashboard configuration. This value is activated for all Sankey objects. 

The update cycle is set to five seconds by default. 
 

  Note 
Specifying the update cycle 

You cannot set an update cycle that is shorter than five seconds. 
 

See also 
Configuring the dashboard (Page 859) 
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5.19.20 Polyline for Sankey chart 

Function 
Inserts a polyline into the Sankey chart. 

Usage 
Use the "Polyline" dashboard object to visualize a quantity flow in the Sankey chart. 

The line width is proportional to the quantity. 

Example 

 
① Power flow of a company 
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Necessary settings 

 

• Name the dashboard object. 

• Go to the "Data acquisition" field to select the data point that contains the values to be 
visualized by the line. 

• Select the flow type for the line in the "Flow selection" field. 

Optional settings 
• You can create a new flow type in the "Flow selection" field and set the scaling. 

• Add a new point if you want to add an extra line to the polyline. 

• Specify the update cycle for the Sankey objects by entering the selected value in the 
Dashboard configuration. This value is activated for all Sankey objects. 

The update cycle is set to five seconds by default. 
 

  Note 
Specifying the update cycle 

You cannot set an update cycle that is shorter than five seconds. 
 

See also 
Configuring the dashboard (Page 859) 
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5.19.21 Flow info 

Function 
Inserts a line or polyline into the Sankey chart. 

Usage 
You can use the "Flow info" dashboard object to display the name and value of a line or 
polyline in the Sankey chart. 

Example 
 

 
① Flow quantity name 
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Necessary settings 

 

• Name the dashboard object. 

• Go to "Flow connections" and select the line you want to describe using the "Flow info" 
dashboard object. 

Optional settings 
• Set the border and text styles for the dashboard object. 

• Activate the corresponding check box to display the value or unit in addition to the line 
name. 

See also 
Configuring the dashboard (Page 859) 
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5.19.22 Process 

Function 
Inserts a process step into the Sankey chart. 

Usage 
Use the "Process" dashboard object to visualize a process step for a quantity flow in the 
Sankey chart.  

Example 

 
① Process step "Transformer 10 kV" for the power and gas supply 
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Necessary settings 

 

• Name the dashboard object. 

• Enter a caption text for the dashboard object in the "Label" field. 

Optional settings 
• Set the size of the dashboard object. 

• Set the border and text styles for the dashboard object. 

• Set the fill color for the dashboard object. 

• Adapt the ports list to define additional points for the line. 
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5.19.23 Process overview 

Function 
Calculates the difference between the inputs and outputs of a process step (delta 
calculation). The value "0" is the ideal result of this calculation. Other results indicate 
irregularities. 

Example of two inputs and one output: Input 1 + Input 2 - Output = 0 

Usage 
Use the "Process overview" dashboard object to verify the result in the Sankey chart. 

Necessary settings 

 

• Name the dashboard object. 

• Select the process step and the associated line at "Flow connection". 

Optional settings 
• Set the border and text styles for the dashboard object. 

• Activate the corresponding check box to include the display of the unit or line color along 
with the process name. 
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5.20 Log files 
The log files for all components except the tasks are stored in the "Installation 
directory\EnMPRO\GUI\mcl\trace". 

The log files for the tasks are stored in the "Installation directory\EnMPRO\GUI\Logdateien". 

 

5.20.1 Kernel 
 

Structure of the messages 
All messages in the kernel log file are structured as follows: Date|Time|Number: Alarm 

The type of message is expressed by the number: 
 
Number Message type 
1000 Information 
2000 Warning 
3000 Error 

Starting the kernel 
When the kernel is started, the following informational message is written to the log file 
when booting starts: 

20190211|10:26:02:455|1000: ---------------------------------------- 

20190211|10:26:02:455|1000: Email Error Reporter started with user 
defined warning level 'Severe'. Sending all messages >= 'Severe' to 
operator. 

20190211|10:26:02:455|1000: MessageReporter Settings 

20190211|10:26:02:455|1000: MaxSize = 50000 

20190211|10:26:02:455|1000: Files = 1000 

20190211|10:26:02:455|1000: LastUsed = 85 

20190211|10:26:02:455|1000: BaseName = 
C:\EnMPRO\GUI\mcl\trace\Kernel\tr 

20190211|10:26:02:455|1000: ---------------------------------------- 

20190211|10:26:02:471|1000: B.Data Kernel v702.00.500.53, Feb 1 2019 
(23:14:25)... 
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20190211|10:26:02:486|1000: © Siemens AG, 2016. All rights reserved. 

20190211|10:26:02:486|1000: Start Update-Subscription Worker 

20190211|10:26:02:486|1000: no external startup processes configured 

20190211|10:26:02:486|1000: Update-Subscription: poll interval 10000 

20190211|10:26:02:486|1000: Please note: Daylight saving is on. 

We are in time zone "W. Europe Standard Time"/"W. Europe Daylight 
Time", this means 3600 offset of GMT.  

Please don't forget to get up on last Sun of Mar at 02:00:00 and 
advance your clock 3600 secs. 

Never mind, you can sleep longer on last Sun of Oct. 

On that day at 03:00:00 time changes back.  

The kernel is then configured. At each data point, the kernel checks whether "Log to DB" is 
active.  

The following message is written to the log file: 

20190211|10:26:04:049|1000: create dblog d_PAC2200_E_Wh_T1_imp 
"5151" mode 1 

The meaning of the important sections of the message can be found in the following table: 
 
Message section Meaning 
create dblog Check where "Log to DB" is enabled 
d_PAC2200_e_Wh_T1_imp Data point name 
mode Test result: 

• mode 0 = "Log to DB" not active 
• mode 1 = "Log to DB" active 

The acquired values are only forwarded to the Acquisition service when "Log to DB" is 
enabled. 

Once the kernel is ready to acquire values, the following message is written to the log file: 

20181212|20:34:48:132|1000: sending all constants... 
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Kernel update event 
When the configuration of a data point or interface changes, a kernel update event occurs. 

The following events cause a kernel update event: 

• Changing the cycle time of a data point or interface 

• Changing the data point name 

• Changing the data point address 

When a kernel update event occurs, the following message is written to the log file: 

20190205|10:34:38:755|1000: Kernel: Update Event received! 

The kernel then checks at each data point, as described above, whether "Log to DB" is active. 

After the check, the changed data point and the corresponding interface are re-configured. 
The following message is written to the log file: 

20190205|10:34:41:220|1000: Begin - Reconfiguration ----------------
---------------- 

20190205|10:34:41:226|1000: Update Tags in Buffer (11026) 

20190205|10:34:41:232|1000: changes -> Update-Tag (11027) 

20190205|10:34:41:243|1000: Linkin 11027->11027 : Parameter 0 
already linked. Replacing it. 

20190205|10:34:41:248|1000: Create Tag: Id= 11027 (BufferId= 11026) 

20190205|10:34:41:254|1000: OPC-UA: Configured cycle time for Opc-Ua 
buffer 'EnergySuite_IO' is 60 seconds 

20190205|10:34:41:299|1000: Lastio of '11027' at 12.12.2018 20:29:00 

20190205|10:34:41:344|1000: OPC-UA: Last IO for buffer was at 
12.12.2018 20:29:00 

20190205|10:34:41:391|1000: OPC-UA: WARNING: Creation of address 
'ns=1;s=v|EnS_EnergyArchive\Ventilation_power' for 11027 was not 
successful 

20190205|10:34:41:437|1000: End - Reconfiguration-------------------
--------------- 
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Information on acquisition components 
If values are transferred from an acquisition component, the following message is written to 
the log file: 

20190206|10:04:25:170|1000: 2019-02-06 10:04:25 0-02:13:55 7296600 
908.102/s (0s) 82 

The meaning of the important sections of the message can be found in the following table: 
 
Message section Meaning 
2019-02-06 10:04:25 Time stamp of acquisition 
0-02:13:55  Time since the acquisition runs in the following format: 

Days-Hours:Minutes:Seconds 
7296600 Number of measured values acquired since the acquisition 

component has been running. 
908.102/s Number of acquired values per second 
(0s) Time elapsed since the last measured value acquisition. 
82 Number of measured values in the cache 

Number of inserted values 
If values are forwarded to the acquisition service, the following message is written to the log 
file: 

20190205|13:34:41:437|1000: 500 numeric records inserted (32000 
bytes) 

In this example, "500" is the number of transmitted values and "32000 bytes" is the amount 
of data. 

Process ID 
Each channel has a unique process ID. Each message about a channel starts with the process 
ID of the channel in square brackets, as in the following example: 

20190708|13:40:51:237|1000: [12508] ModBusDevice: OpenDevice: TCP/IP 
connection error 

In this example, 12508 is the process ID. 

If you filter the log file by the process ID in square brackets, only the messages of the 
corresponding channel are displayed. 
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Shutting down the kernel 
When the kernel is stopped or restarted, the following message is written to the log file: 

20190211|10:21:04:189|1000: Sending answer 'OK|Shutdown in progress' 
to client '' 

20190211|10:21:04:194|1000: exit DELTAMANAGER 

20190211|10:21:04:198|1000: Final Service Shutdown entered... 

20190211|10:21:04:199|1000: Kernel: Update - Termination Event 
receive! 

20190211|10:21:04:199|1000: Kernel: Update Thread stopped! 

20190211|10:21:04:199|1000: Stop Requester (4632) (bfs_modbus) ... 

20190211|10:21:04:204|1000: Requester (4632) (bfs_modbus) - 
stopped... 

20190211|10:21:04:222|1000: Shut down database logger... 

20190211|10:21:04:222|1000: Total Number of records stored: 82628 

20190211|10:21:04:253|1000: Database Insertion thread stopped. 

20190211|10:21:04:675|1000: shutdown ORA listener 

20190211|10:21:04:768|1000: InsertionThread done. 

20190211|10:21:04:768|1000: Wait for shutdown of database inserter 
succeeded 

20190211|10:21:04:768|1000: flush 
C:\EnMPRO\GUI\mcl\sink\Kernel\sink00000n.bfs ... 

20190211|10:21:04:768|1000: Wrote 128 records (8192 bytes) to file 
C:\EnMPRO\GUI\mcl\sink\Kernel\sink00000n.bfs 

20190211|10:21:04:768|1000: File Flush thread stopped. 

20190211|10:21:05:284|1000: Wait for file flush thread succeeded 

20190211|10:21:05:284|1000: Shut down command listener... 

20190211|10:21:05:284|1000: SubscriptionWorkerThread stopped! 

See also 
Kernel fault (Page 350) 
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5.20.2 Acquisition service 
The acquisition service is part of the acquisition component. There are several log files for the 
acquisition service. The acquisition service consists of several components, for each of which 
there is a log file. 

The following table shows the various log files of the acquisition service and the tasks of the 
corresponding components. 
 
Log file Tasks 
Compression Compression, plausibility, gap detection 
Synchronization Synchronization of the local database of acquisition with the SQL 

server on the application server. 
Raw File Provider "Raw" files 
Sink Data Importer Imported "SINK" files 
Data Deletion Utilization of the local database, deletion of synchronized data 
Acquisition Component Host Management of acquisition service components 
SQL Provider Access to the local database of the acquisition 
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5.20.2.1 Compression 
The "Compression" log file has a maximum size of 150 KB. The maximum number of log files 
is 100. 

Startup of the component 
The compression component is initialized after the acquisition service is started. The number 
of compression levels for each data point is logged as follows in the "Compression" log file: 
2019-02-11 11:13:05,412 [ 5] [COP] - INFO - Initialize Compression 
Component 
2019-02-11 11:13:05,450 [ 5] [COP] - INFO - Load registry 
settings... 
2019-02-11 11:13:05,482 [ 5] [COP] - INFO - Load BData DB 
settings... 
2019-02-11 11:13:05,714 [21] [(null)] - INFO - LoginAccepted: 
UserInfo= User ADMIN (505) 
2019-02-11 11:13:06,969 [ 5] [COP] - INFO - Component Initialization 
finished... 
2019-02-11 11:13:06,971 [14] [COP] - INFO - Waiting until initial 
configuration synchronisation is finished... 
2019-02-11 11:13:11,973 [14] [COP] - INFO - Starting initialization 
of compression configuration... 
2019-02-11 11:13:12,173 [38] [(null)] - INFO - (PLSI) - 
PlausibilityResult worker process started. 
2019-02-11 11:13:12,178 [14] [COP] - INFO - Build Measurement list 
2019-02-11 11:13:13,333 [14] [COP] - INFO - (SINK) - Cycle for open 
sink data recalculation : 30000 [msec] 
2019-02-11 11:13:13,480 [14] [COP] - INFO - [5621] - Compression 
configuration ended. Measurement contains 3 compression levels to 
calculate. 
2019-02-11 11:13:13,491 [14] [COP] - INFO - [5623] - Compression 
configuration ended. Measurement contains 3 compression levels to 
calculate. 
2019-02-11 11:13:13,507 [14] [COP] - INFO - [5624] - Compression 
configuration ended. Measurement contains 3 compression levels to 
calculate. 

Reception of the acquired measured values 
When measured values are acquired, the reception of the values from the kernel is confirmed 
with the following entry in the "Compression" log file: 

2019-02-06 11:21:58,231 [13] [(null)] - INFO - Handle MemoryStream 
time : 06.02.2019 10:21:58 length : 32000 starting 
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Calculation of the compression (RCAL) 
If a compressed interval is calculated, the interval and the number of compressed values are 
specified: 

2019-02-14 10:30:14,031 [34] [(null)] - INFO - (RCAL) - [13230]* - 
tCLevel:2105 ENDTIME:14.02.2019 09:30:00 in recalculation... 

2019-02-14 10:30:14,048 [34] [(null)] - INFO - (RCAL) - [13230] 1 
recalculation orders found 

2019-02-14 10:30:14,059 [34] [(null)] - INFO - (RCAL) - [13230] 
fCLevel:2100 tCLevel:2105 fDT:14.02.2019 09:15:00 tDT:14.02.2019 
09:30:00 in recalculation... 

2019-02-14 10:30:14,138 [34] [(null)] - INFO - (RCAL) - [13230] - 
467 msjoValues for fCLevel:2100 and range: fDT:14.02.2019 09:15:00 
tDT:14.02.2019 09:30:00 found 

2019-02-14 10:30:14,183 [34] [(null)] - INFO - (RCAL) - [13230]** - 
tCLevel:2105 ENDTIME:14.02.2019 09:30:00 (fDT:14.02.2019 09:15:00) 
recalculation finished... 

Calculation for the defined compression levels (CMPR) 
If compressions calculated by the acquisition service were written to the local database, the 
write operation is logged in the log file as follows with the following message: 

2019-02-14 10:30:06,210 [35] [(null)] - INFO - (CMPR) - 1 open items 
to handle 

2019-02-14 10:30:06,267 [35] [(null)] - INFO - 1 measurement numeric 
values inserted successfully 

The acquisition service calculates all compressions up to the "Daily values" compression level. 

Checking the plausibility limits (PLSI) 
If limits of a data point are active, the acquired measured values are checked. If a limit is 
violated, an alarm is generated. In this case, the following message is written to the log file: 

2019-02-14 10:36:42,157 [37] [(null)] - INFO - (PLSI) [13230] - 
Alarm Upper Limit violation: PlausiResult: ID:13230 DT:1550136970 
DV:0,866025403852806 ST:1 ME:17 CL:2 

Gap detection (PLSI) 
If a gap occurs and an alarm is generated, this generation is logged in the log file as follows: 

2019-02-14 12:17:00,196 [32] [(null)] - INFO - (PLSI) GAP violation: 
PlausiResult: ID:13230 DT:1550142952 DV:0 ST:1 ME:12 CL:2  
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Changes in the tables of the local database (SYNC) 
If one of the tables in the local database is changed, the following entry is written to the log 
file: 

2019-02-14 10:12:05,175 [ 6] [(null)] - INFO - (SYNC) - TB_MESSUNG 
changed: 1 items to Insert 

2019-02-14 10:12:05,240 [ 6] [(null)] - INFO - [13230] - Compression 
configuration ended. Measurement contains 3 compression levels to 
calculate. 

2019-02-14 10:12:05,255 [ 6] [(null)] - INFO - (SYNC) - [13230] 
measurement Insert 

2019-02-14 10:12:05,265 [ 6] [(null)] - INFO - (SYNC) - 
TB_COMPRESSION changed: 2 items to Insert2019-02-14 10:22:08,387 
[31] [(null)] - INFO - (SYNC) - TB_MESSUNG changed: 1 items to 
Update2019-02-14 10:22:08,398 [31] [(null)] - INFO - (SYNC) - 
[13230] measurement Update 

2019-02-14 10:36:12,795 [17] [(null)] - INFO - (SYNC) - TB_MESSUNG 
changed: 1 items to Update 

2019-02-14 10:36:12,802 [17] [(null)] - INFO - (SYNC) - [13230] 
measurement Update 

2019-02-14 10:36:12,809 [17] [(null)] - INFO - (SYNC) - 
TB_MESS_PLAUSI_LIMIT changed: 1 items to Insert  

Shutting down the component 
When the component is stopped, the following message is written to the log file: 

2019-02-11 11:12:28,397 [12] [(null)] - INFO - Shutdown compression 
component. 

2019-02-11 11:12:28,398 [12] [(null)] - INFO - Stop initialization 
process 

2019-02-11 11:12:28,574 [48] [(null)] - INFO - (MSTR) - Exit 
MeasurementStringData worker process. 

2019-02-11 11:12:28,576 [47] [(null)] - INFO - (CMPR) - Exit 
CompressionResult worker process. 

2019-02-11 11:12:28,604 [41] [(null)] - INFO - (PLSI) - Exit 
PlausibilityResult worker process. 

2019-02-11 11:12:28,604 [46] [(null)] - INFO - (RCAL) - Exit 
Recalculation worker process. 
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5.20.2.2 Raw file provider 
This log file is usually empty. 

A "Raw" file with the acquired measured values is created for each day and each data point.  

If an error occurs while creating or writing the values, this is logged in this log file.  

5.20.2.3 SinkDataImporter 
If the kernel cannot forward the acquired values to the Acquisition service, the values are 
written to "SINK" files. SinkDataImporter checks if new "SINK" files are available once every 
minute. 

If there are no new "SINK" files, the following message is written to the log file: 

2019-02-06 11:11:17,507 [28] [(null)] - INFO - (DATASINNK) - 
Datasink Importer SearchFolders -> C:\EnMPRO\mcl\sink\Kernel | 
C:\EnMPRO\mcl\sink\FTP 

2019-02-06 11:11:17,508 [28] [(null)] - INFO - (DATASINNK) - Watch 
for new sink files -> C:\EnMPRO\mcl\sink\Kernel 

2019-02-06 11:11:17,509 [28] [(null)] - INFO - (DATASINNK) - Watch 
for new sink files -> C:\EnMPRO\mcl\sink\FTP 

When there are new "SINK" files, the SinkDataImporter tries to import the new files. 

In this case, the following message is written to the log file: 

2019-02-06 11:12:17,972 [28] [(null)] - INFO - (DATASINNK) - Import 
-> sink00024n.bfs succeeded 

2019-02-06 11:12:17,974 [28] [(null)] - INFO - (DATASINNK) - Move 
File from C:\EnMPRO\mcl\sink\Kernel\sink00024n.bfs to 
C:\EnMPRO\mcl\sink\Kernel\Imported\20190206_111217973_sink00024n.bfs 

The imported values are written to the "Raw" files. 

5.20.2.4 Data deletion 
An overview is written to the "Data deletion" log file once every minute. The overview shows 
the size of the local database and information about the deleted values of the local database. 
The following figure shows the overview:  

 
 

5.20.2.5 Acquisition component Host 
This log file is empty by default. 

If an error occurs when initializing components of the acquisition service, this error is logged 
in the log file. 
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5.20.2.6 SQL provider 
This log file is empty by default. 

If it is not possible to access to the local database, a corresponding error message is written to 
the log file. 
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5.20.3 Calculation service 

5.20.3.1 Calculation service 
The calculation service is part of the application server. There are several log files for the 
calculation service. The calculation service consists of several components, for each of which 
there is a log file.  

The following table shows the various log files of the acquisition service and the tasks of the 
corresponding components. 
 
Log file Tasks 
Recalculation Calculation and recalculation of compressions and data points 
MEVA calculation Calculation of MEVAs/KPIs 
Counter calculation Calculation of counter differences of acquired values 
Machine calculation Calculation of the consumers 
Calculation component host Management of calculation service components 

5.20.3.2 Recalculation 
The "Recalculation" log file is for messages related to the compression of the acquired 
measured values. The log file has a maximum size of 151 KB. The maximum number of log 
files is 100. 

Calculation of compressions (RCAL) 
If a compressed interval is calculated by the Acquisition service, the interval and the number 
of compressed values are specified: 

2019-02-14 12:31:34,348 [31] [(null)] - INFO - (RCAL) - [9887] 1 
recalculation orders found 

2019-02-14 12:31:34,352 [31] [(null)] - INFO - (RCAL) - [9887] 
fCLevel:2105 tCLevel:2110 fDT:23.11.2019 02:00:00 tDT:23.11.2019 
03:00:00 in recalculation... 

2019-02-14 12:31:34,367 [31] [(null)] - INFO - (RCAL) - [9887] - 4 
msjoValues for fCLevel:2105 and range: fDT:23.11.2019 02:00:00 
tDT:23.11.2019 03:00:00 found 

2019-02-14 12:31:34,378 [31] [(null)] - INFO - (RCAL) - [9887]** - 
tCLevel:2110 ENDTIME:23.11.2019 03:00:00 (fDT:23.11.2019 02:00:00) 
recalculation finished... 
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Retroactive billing of derived data points (DCAL) 
When a derived data point is re-calculated, the interval and the number of compressed values 
is specified:  

2019-03-12 12:17:00,582 [39] [(null)] - INFO - (DCAL) - ## Begin 
automatic recalculation of derived recalculation entrys... 

2019-03-12 12:17:00,587 [39] [(null)] - INFO - (DCAL) - Search for 
open derived datapoints to (re)calculate 

2019-03-12 12:17:00,623 [39] [(null)] - INFO - (DCAL) - 140 open 
derived datapoints to (re)calculate 

2019-03-12 12:17:00,629 [39] [(null)] - INFO - (DCAL) - [13732] - 
Autom. Calculate f:12/31/2018 11:00:00 PM t:3/11/2019 11:00:00 PM 

2019-03-12 12:17:01,016 [39] [(null)] - INFO - (DCAL) - [13733] - 
Autom. Calculate f:12/31/2018 11:00:00 PM t:3/11/2019 11:00:00 PM 

2019-03-12 12:17:01,549 [39] [(null)] - INFO - (DCAL) - 140 open 
derived measurement orders recalculated 

2019-03-12 12:17:01,554 [39] [(null)] - INFO - (DCAL) - ## End 
automatic recalculation of derived recalculation entrys... 

Substitute values (REPV) 
The Calculation service cyclically checks whether new gaps must be filled and fills these gaps 
if necessary. For each cyclic check for missing replacement values, an entry is written to the 
log file: 

2019-02-14 13:52:31,762 [35] [(null)] - INFO - (REPV) - Missing Gaps 
filled for 13235; set last corr timestamp to 14.02.2019 12:51:00 

Extrapolation and interpolation (EXPA) 
The Calculation service cyclically checks whether new interpolations or extrapolations must 
be calculated and calculates these interpolations and extrapolations. For each cyclic check for 
missing interpolations and extrapolations, an entry is written to the log file: 

2019-02-14 14:03:23,110 [37] [(null)] - INFO - (EXPA) - ** Begin 
search of complevel configuration for expansion... 

2019-02-14 14:03:23,129 [37] [(null)] - INFO - (EXPA) - Found 0 rows 
to check for expansion 

2019-02-14 14:03:23,135 [37] [(null)] - INFO - (EXPA) - ** End 
search for expansion values... 

2019-02-14 14:03:23,140 [37] [(null)] - INFO - (EXPA) - ** Begin 
search of complevel configuration for interpolation... 

2019-02-14 14:03:23,158 [37] [(null)] - INFO - (EXPA) - Found 0 rows 
to check for interpolation 

2019-02-14 14:03:23,164 [37] [(null)] - INFO - (EXPA) - ** End 
search for interpolation values  
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Calculation of compressions on the application server (NLCO) 
With the following exceptions, the Acquisition service calculates all compressions up to daily 
values. If values are entered in a matrix or values are transferred directly to the SQL server 
(compression of acquisition values to acquisition values), the Calculation service calculates 
the corresponding compressions. The Calculation service cyclically checks whether a 
calculation of such compressions is available: 

2019-02-14 13:52:39,485 [36] [(null)] - INFO - (NLCO) - Check 
compression level: 2120 

2019-02-14 13:52:39,505 [36] [(null)] - INFO - (NLCO) - Check 
compression level: 2105 

2019-02-14 13:52:39,538 [36] [(null)] - INFO - (NLCO) - Check 
compression level: 2110 

2019-02-14 13:52:39,561 [36] [(null)] - INFO - (NLCO) - Check 
compression level: 2101 

In the same interval, the Calculation service checks the counter value filter: 

2019-02-14 13:47:52,365 [36] [(null)] - INFO - (NLCO) - Start 
Counter filter check... 

2019-02-14 13:47:52,624 [36] [(null)] - INFO - (NLCO) - Update 14 
compression until dates 

2019-02-14 13:47:52,691 [36] [(null)] - INFO - (NLCO) - End of 
Counter filter check... 

Automatic compression 
ACOP messages indicate the number of compression intervals for which a recalculation is 
due. When the recalculation of a compression interval is pending, a RCAL message is written 
to the log file. 

2019-02-14 14:03:32,912 [32] [(null)] - INFO - (ACOP) - Search for 
pending compression calculation... 

2019-02-14 14:03:32,949 [32] [(null)] - INFO - (ACOP) - No pending 
automatic compressions found 

2019-02-14 14:03:32,956 [32] [(null)] - INFO - (ACOP) - Search for 
past changes to recalculate compression calculation... 

2019-02-14 14:03:33,901 [32] [(null)] - INFO - (ACOP) - No pending 
past changes recalculations found 
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5.20.3.3 MEVA calculation 
If the calculation of a MEVA/KPI is triggered, a message is written to this log file. 

The following objects can trigger the calculation of a MEVA/KPI : 

• Report 

• Chart 

• Dashboard 

• Derived data point 

5.20.3.4 Counter calculation 
If values of a counter are entered directly via the matrix, the Calculation service calculates the 
counter differences. The Calculation service cyclically checks whether calculation counter 
differences are available. The number of counter differences the Calculation service 
calculates is written to this log file: 

2019-02-11 11:43:36,458 [35] [(null)] - INFO - (CRCL) - ** Begin 
search for open counter recalculation... 

2019-02-11 11:43:36,473 [35] [(null)] - INFO - (CRCL) - Cleanup of 
closed counter recalculation items performed successfully 

2019-02-11 11:43:36,475 [35] [(null)] - INFO - (CRCL) - Read counter 
recalculation rows to handle 

2019-02-11 11:43:36,506 [35] [(null)] - INFO - (CRCL) - Calcuation 
ended; no values for DB saving calculated 

2019-02-11 11:43:36,516 [35] [(null)] - INFO - (CRCL) - Counter 
recalc ended; Update 0 recalc items in DB 

2019-02-11 11:43:36,517 [35] [(null)] - INFO - (CRCL) - 
intMainObjektReaderCnt: 0 

2019-02-11 11:43:36,518 [35] [(null)] - INFO - (CRCL) - 0 open 
counter recalculation items merged 

2019-02-11 11:43:36,519 [35] [(null)] - INFO - (CRCL) - ** End 
search for open counter recalculation... 

5.20.3.5 Machine calculation 
The calculation of consumers is recorded in the "Machine calculation" log file. 

5.20.3.6 Calculation component host 
The Calculation component host component manages the components of the Report service. 

If an error occurs when initializing components of the Acquisition service, this error is 
recorded in the log file. 

Otherwise this log file is empty. 
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5.20.4 Report Server 
The server of the Report service is on the same system as the SQL server. 

The reporting service performs the following tasks: 

• Report generation 

• Conversion of EXEL files into PDF files 

• Sending reports 

• Saving reports 

• Printing reports 

The "Report Server" log file has a maximum size of 200 KB. The maximum number of log files 
is 1000. 

Starting a report 
When a report is started manually or automatically, the actions are logged during report 
generation. 

The main actions are as follows: 

• Loading the template 

• Filling the template 

• Executing macros 

Report automation 
The following automated actions are logged:  

• Sending the report 

• Saving the report 

• Print the report 

See also 
Reporting service error (Page 354) 



 Reference 
 5.20 Log files 

SIMATIC Energy Manager PRO V7.2 - Operation 

Operating Manual, 12/2020, A5E38952754-AF 919 

5.20.5 MindUpload 
The "MindUpload" log file has a maximum size of 121 KB. 

A new log file is created for each day. 

The following events are logged in this log file: 

• Onboarding 

The onboarding of the Energy Manager in the MindSphere is recorded in this log file. 

If onboarding does not work, an error message is written to the log file. 

• Data transfer 

The number of uploaded values is written to the log file for each data transfer cycle to 
MindSphere. 

5.20.6 Tasks 
When a task is executed, a "Tasks" log file is created. The log file consists of the following 
three entries: 

2019-01-16 10:19:04,892 - INFO - Start Task "Export measurement 
values" for Node "Export values as xml_h_Local_PC" (NodeID: 4737). 

This entry enables you to find which task is executed. 

2019-01-16 10:19:05,683 - INFO - Export file 
"Export_000004737_20190114000000_20190116000000.xml" written. 

This entry contains the name of the file with the exported values. 

2019-01-16 10:19:05,740 - INFO - End Task after runtime of 
00:00:02.100: 3 entries have been exported. 

This entry enables you to find the time in which the task was executed and the number of 
exported values. 
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5.21 Cipher Suites 
If you are hosting the web server yourself, do not configure insecure connections. 

Configure the connection with a Cipher Suite from the following list. Prioritize a Cipher Suite 
with a security rating of 5 over a Cipher Suite with a security rating of 4. 

List of recommended Cipher Suites 
Cipher Suites are registered in TLS up to version 1.2 for the Internet Assigned Numbers 
Authority (IANA). The following table is based on the Cipher Suites registered with IANA and 
has been extended with a Siemens security rating. The following table lists only Cipher Suites 
that have a security rating of at least 4. 
 
Cipher Suite Value for IANA Siemens security 

assessment 
TLS_RSA_WITH_AES_128_CBC_SHA256 0x00, 0x3C 4 
TLS_RSA_WITH_AES_256_CBC_SHA256 0x00, 0x3D 4 
TLS_DH_DSS_WITH_AES_128_CBC_SHA256 0x00, 0x3E 4 
TLS_DH_RSA_WITH_AES_128_CBC_SHA256 0x00, 0x3F 4 
TLS_DHE_DSS_WITH_AES_128_CBC_SHA256 0x00, 0x40 5 
TLS_DHE_RSA_WITH_AES_128_CBC_SHA256 0x00, 0x67 5 
TLS_DH_DSS_WITH_AES_256_CBC_SHA256 0x00, 0x68 4 
TLS_DH_RSA_WITH_AES_256_CBC_SHA256 0x00, 0x69 4 
TLS_DHE_DSS_WITH_AES_256_CBC_SHA256 0x00, 0x6A 5 
TLS_DHE_RSA_WITH_AES_256_CBC_SHA256 0x00, 0x6B 5 
TLS_RSA_WITH_AES_128_GCM_SHA256 0x00, 0x9C 4 
TLS_RSA_WITH_AES_256_GCM_SHA384 0x00, 0x9D 4 
TLS_DHE_RSA_WITH_AES_128_GCM_SHA256 0x00, 0x9E 5 
TLS_DHE_RSA_WITH_AES_256_GCM_SHA384 0x00, 0x9F 5 
TLS_DH_RSA_WITH_AES_128_GCM_SHA256 0x00, 0xA0 4 
TLS_DH_RSA_WITH_AES_256_GCM_SHA384 0x00, 0xA1 4 
TLS_DHE_DSS_WITH_AES_128_GCM_SHA256 0x00, 0xA2 5 
TLS_DHE_DSS_WITH_AES_256_GCM_SHA384 0x00, 0xA3 5 
TLS_DH_DSS_WITH_AES_128_GCM_SHA256 0x00, 0xA4 4 
TLS_DH_DSS_WITH_AES_256_GCM_SHA384 0x00, 0xA5 4 
TLS_RSA_WITH_CAMELLIA_128_CBC_SHA256 0x00, 0xBA 4 
TLS_DH_DSS_WITH_CAMELLIA_128_CBC_SHA256 0x00, 0xBB 4 
TLS_DH_RSA_WITH_CAMELLIA_128_CBC_SHA256 0x00, 0xBC 4 
TLS_DHE_DSS_WITH_CAMELLIA_128_CBC_SHA256 0x00, 0xBD 4 
TLS_DHE_RSA_WITH_CAMELLIA_128_CBC_SHA256 0x00, 0xBE 4 
TLS_RSA_WITH_CAMELLIA_256_CBC_SHA256 0x00, 0xC0 4 
TLS_DH_DSS_WITH_CAMELLIA_256_CBC_SHA256 0x00, 0xC1 4 
TLS_DH_RSA_WITH_CAMELLIA_256_CBC_SHA256 0x00, 0xC2 4 
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TLS_DHE_DSS_WITH_CAMELLIA_256_CBC_SHA256 0x00, 0xC3 5 
TLS_DHE_RSA_WITH_CAMELLIA_256_CBC_SHA256 0x00, 0xC4 5 
TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256 0xC0, 0x23 5 
TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA384 0xC0, 0x24 5 
TLS_ECDH_ECDSA_WITH_AES_128_CBC_SHA256 0xC0, 0x25 4 
TLS_ECDH_ECDSA_WITH_AES_256_CBC_SHA384 0xC0, 0x26 4 
TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256 0xC0, 0x27 5 
TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA384 0xC0, 0x28 5 
TLS_ECDH_RSA_WITH_AES_128_CBC_SHA256 0xC0, 0x29 4 
TLS_ECDH_RSA_WITH_AES_256_CBC_SHA384 0xC0, 0x2A 4 
TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 0xC0, 0x2B 5 
TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384 0xC0, 0x2C 5 
TLS_ECDH_ECDSA_WITH_AES_128_GCM_SHA256 0xC0, 0x2D 4 
TLS_ECDH_ECDSA_WITH_AES_256_GCM_SHA384 0xC0, 0x2E 4 
TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256 0xC0, 0x2F 5 
TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384 0xC0, 0x30 5 
TLS_ECDH_RSA_WITH_AES_128_GCM_SHA256 0xC0, 0x31 4 
TLS_ECDH_RSA_WITH_AES_256_GCM_SHA384 0xC0, 0x32 4 
TLS_ECDHE_ECDSA_WITH_CAMELLIA_128_CBC_SHA256 0xC0, 0x72 5 
TLS_ECDHE_ECDSA_WITH_CAMELLIA_256_CBC_SHA384 0xC0, 0x73 5 
TLS_ECDH_ECDSA_WITH_CAMELLIA_128_CBC_SHA256 0xC0, 0x74 4 
TLS_ECDH_ECDSA_WITH_CAMELLIA_256_CBC_SHA384 0xC0, 0x75 4 
TLS_ECDHE_RSA_WITH_CAMELLIA_128_CBC_SHA256 0xC0, 0x76 5 
TLS_ECDHE_RSA_WITH_CAMELLIA_256_CBC_SHA384 0xC0, 0x77 5 
TLS_ECDH_RSA_WITH_CAMELLIA_128_CBC_SHA256 0xC0, 0x78 4 
TLS_ECDH_RSA_WITH_CAMELLIA_256_CBC_SHA384 0xC0, 0x79 4 
TLS_RSA_WITH_AES_128_CCM 0xC0, 0x9C 4 
TLS_RSA_WITH_AES_256_CCM 0xC0, 0x9D 4 
TLS_DHE_RSA_WITH_AES_128_CCM 0xC0, 0x9E 5 
TLS_DHE_RSA_WITH_AES_256_CCM 0xC0, 0x9F 5 
TLS_ECDHE_ECDSA_WITH_AES_128_CCM 0xC0, 0xAC 5 
TLS_ECDHE_ECDSA_WITH_AES_256_CCM 0xC0, 0xAD 5 
TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305_ 0xCC, 0xA8 5 
TLS_ECDHE_ECDSA_WITH_CHACHA20_POLY1305_ 0xCC, 0xA9 5 
TLS_DHE_RSA_WITH_CHACHA20_POLY1305_SHA256 0xCC, 0xAA 5 
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Key length 
Use a recommended Cipher Suite with a recommended key length for the encryption 
algorithm. 
The following table lists the recommended key lengths: 
 
Algorithm Minimum key length 
Key length for signature key for certificates and key agreement 
ECDSA 250 bit 
DSS 2000 - 3000 bit* 
RSA 2000 - 3000 bit* 
Key length for Diffe-Hellmann 
ECDH/ECDHE 250 bit 
DHE 2000 - 3000 bit* 

*Starting in 2023, use a key length of at least 3000 bits. 
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5.22 Counter value filtering 
Energy Manager filters values of data points for which a counter is configured differently to 
values of other data points. You configure this filter at the configuration of the counter.  

The following representation shows the possible error cases that are detected by the counter 
value filter and how they are corrected. A constant consumption of 10 kWh is used in this 
example. 

 
① One to three negative deviations 
② One to three positive deviations 
③ Offset downwards with subsequent constant values 
④ Gaps 
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⑤ Offset downwards 
⑥ Offset upwards 
⑦ Blue line: Counter values before counter value correction 
⑧ Green, dashed line: Counter values after counter value correction 
⑨ Black, dashed line: Upper and lower limit of the counter value that results from the consumption limits 

Figure 5-1 Diagram of counter value filtering 

Filtering options 
• Counter value filtering 

Invalid counter values are deleted. 

• Counter value difference filtering 

Consumption values that are outside of the valid range are corrected. 

• Gap recognition 

Missing counter values filled in automatically and subsequent calculation of consumption. 

The following table specifies through which criteria the different error cases are detected and 
how the error cases are corrected: 

 
Error case Detection of the error case Correction of the error case 
One to three negative deviations Through counter value filtering or 

through the low limit of counter value 
difference filtering 

With invalid counter values, the counter 
value is deleted and the resulting gap is 
filled in through linear interpolation. 
With invalid consumption values, the 
consumption value is deleted and the 
resulting gap is filled in through linear 
interpolation.  

One to three positive deviations Through the high limit of the counter 
value difference filtering 

With invalid counter values, the counter 
value is deleted and the resulting gap is 
filled in through linear interpolation. 
With invalid consumption values, the 
consumption value is deleted and the 
resulting gap is filled in through linear 
interpolation. 

Offset downwards with subsequent 
constant values 

Counter value difference - lower limit 
and constant values 

Correction of the constant values 
through linear interpolation. The num-
ber of constant values after the offset is 
not limited. 
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Error case Detection of the error case Correction of the error case 
Gaps in the counter values Gap recognition If the counter value after the gap ≥ the 

counter value before the gap, the gap is 
filled in through linear interpolation.  
If the counter value after the gap < the 
counter value before the gap, a counter 
overflow is assumed. There are the two 
following overflow options: 
• With a cyclic (triggered) reset, inter-

polation takes place between the 
start value of the counter and the 
counter value after the gap. 

• With a normal overflow, interpola-
tion takes place between the last 
value before the gap and the first 
value after the gap. 

Offset of the counter values down-
wards 

Counter value difference - lower limit 
and as a result increasing values 

Correction of negative consumption to 
zero. 

Offset of the counter values upwards Counter value difference - upper limit 
and as a result increasing values 

Correction of excessive consumption to 
zero. 
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Linear interpolation 
Linear interpolation is used to fill in gaps. The duration of the gap is not limited. 
With linear interpolation, the counter value difference between the last valid counter value 
and the current counter value is calculated. This counter value difference is then divided by 
the number of intervals between the two values. 
In the Energy Manager, a distinction is made between the following cases: 
• Current counter value ≥ last valid counter value 

No overflow of the counter is assumed. 
• Current counter value < last valid counter value 

An overflow of the counter is assumed. There are the two following overflow options: 

– Cyclic reset activated 

 

– Normal overflow 

 
 

 Note 
Entry of counter values via the matrix 

If you enter an invalid counter value in the matrix and the filters are activated, the entered 
value is removed and is not visible. Linear interpolation is applied with the input of the next 
value. 
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5.23 Manual acquisition with Energy Manager PRO Mobile 

5.23.1 Configuring a mobile device in Energy Manager 

Overview 
 

 NOTICE 

Secure connection between the Energy Manager PRO Mobile and the web server 

If you configure the connection between Energy Manager PRO Mobile and the web server, 
use only secure Cipher Suites. 

A list of secure Cipher Suites can be found in the reference under "Cipher Suites". 
 

In Energy Manager assign the data points that you want to acquire on the mobile device to 
the hardware object. Improve the overview by setting up a two-layer folder structure that you 
can use, for example, to reproduce the production site.  

in addition, you may define an existing folder structure as route for a read operation.  

The following figure highlights the mapping of a folder structure in Energy Manager to the 
mobile device:  

 
① Folders of the first hierarchy level are organized on the mobile device under "Route".  
② Folders of the second hierarchy level are organized on the mobile device under "Area". The 

content of the selection list depends on the "Route" selected under ①.  

Requirements 
• The mobile device is configured and interconnected with the PC. 

For more information on this topic, refer to the "Energy Manager - Installation" manual, 
keyword "Installing Energy Manager PRO Mobile and configuring it on the mobile device". 

• The data points are set up in Energy Manager. 
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Procedure 
1. Create a hardware object in Energy Manager for the mobile device, for example, 

"h_MobileDevice01". 

 
2. Set up a folder structure that consists of no more than two layers if you want to use routing 

for reading the meters. 
3. Copy the data points to acquire with the mobile device to the folder structure below the 

hardware object. Assign the data points to the folder structure: 

 
4. Add the "Job for route synchronization" to the job queue to generate one or several routes 

based on a folder structure. 
 

  Note 

"Job for route synchronization" prepares the route for the synchronization process. Run 
this job whenever you have made changes to the folder structure.  

 
5. Start synchronization on the mobile device for the initial transfer of the data points to the 

mobile device. 

Result 
The data points are inserted in Energy Manager below the hardware object of the mobile 
device. On completion of this initial synchronization, the measured values of the data points 
are available on the mobile device as well.  
When you connect the mobile device after the first synchronization to the Energy Manager 
PRO Client, the measurement values are synchronized automatically.  

See also 
Creating hardware (Page 398) 
Synchronizing data (Page 46) 
Cipher Suites (Page 920) 
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5.23.2 Generating barcode 

Overview 
Provided your mobile device supports scanner functionality, you can use the scanner of the 
mobile device to identity the meters of your plant by means of barcode. You need to 
generate this barcode for each meter that you have configured in Energy Manager. 

 

 Note 
Configuring meters for barcode generation 

Observe the following naming conventions when configuring meters: 
• You may only use uppercase letters from "A" to "Z" and numbers from "0" to "9". 
• Use the hyphen "-" as delimiter. 

 

Requirement 
• The "Free 3 of 9 Extended" font is installed on the PC. 

• Microsoft Excel is installed and opened on the PC. 

• The meter is configured in Energy Manager. 

Procedure 
1. Enter the name of the meter in Microsoft Excel. 

2. Use the "Free 3 of 9 Extended" font to assign the barcode to the meter name, for example: 

 
 

  Note 
Font size for the barcode 

The font size of the barcodes you generate may not be smaller than 12 pt. 
 

3. Print the generated barcode and attach it to the selected meter. 

Result 
You can now identify the meter by its generated barcode using the scanner of the mobile 
device. 
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5.24 Importing data 

5.24.1 ODBC connector 

5.24.1.1 Basics on the ODBC interface 

Overview 
The ODBC Connector represents an interface that you can use to transfer process data from 
ODBC-capable data sources to Energy Manager . The process data may be transferred 
manually or automatically. ODBC-capable data sources are, for example, Oracle, SQL Server, 
MySQL, Access, or Excel.  

The next chapters cover the following contents: 

• Manual import 

• Automatic import 

• Restrictions of the files to transfer 

Requirement 
Successful installation of all software components. 

The data must be available in a suitable structure in Excel (always ensured in a database). 

• Variant 1 - one column per data point, identification by column name 

 
Time stamp Data point 1 Data point 2 
01.01.2008 00:15 125.36 220 
01.01.2008 00:30 225.23 151 

• Variant 2 - Data point identification by means of a separate column 

 
Time stamp Datapoint_ID Value 
01.01.2008 00:15 125 125.36 
01.01.2008 00:15 200 220 
01.01.2008 00:30 125 225.23 
01.01.2008 00:30 200 151 

The date must be available in "DD.MM.JJ HH24:MI" format (hours in 24-hour format). The 
date and value columns need a column header that may not contain special characters. 
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It must be possible to address the table (values, including column headings) by name. Open 
the table in Excel and enter a name on the top left. Confirm with <return>. Do not use special 
characters and mutated vowels.  

 
The data point to which the data is to be written must have been created and activated in the 
system. 

 

 Note 

The ODBC Connector must be created below the datapoint in which the values are to be 
imported.  

 

DSN-related properties, such as the DSN, table, or columns, can only be modified if the client 
is running on the PC that is set up by means of the hardware reference. 

Always use system DSN types. 

You can run imports on the client or portal, depending on the PC that is set up by means of 
the hardware reference. 

If the client is running on a PC that is also used as portal host, the import is carried out using 
the portal application. 

Data flow 
The ODBC Connector can only detect unidirectional data flows, i.e. from the ODBC-capable 
data source to Energy Manager. 
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5.24.1.2 Configuring manual data import 

Requirement 
The data and data point are available in a suitable format. New objects can only be created on 
a PC that is set up as active application hardware. 

Creating the ODBC data channel and data source 
1. Mark the data point under which the ODBC Connector is going to be created. 

 
2. Click the "Insert ODBC Connector" button in the menu bar under "Insert > Import measured 

values". 

 
The "Select Data Source" dialog opens. 
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3. On the "Machine Data Source" tab, click "New". 

The "Create New Data Source" dialog opens. 

 
4. Activate "System Data Source" and click "Next". 

5. Select the Excel driver and click "Next". 
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6. Click "Finish". 

 
7. Enter a meaningful data source name and an optional description. Click Select Workbook. 

 
8. Select the Excel file that contains the load profile and click "OK". 
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9. The MS Excel version is pre-assigned in accordance with the version of the MS Excel file. The 
path and selected worksheet are displayed below the "Workbook". Confirm with OK. 

 
10.You have successfully created the system data source and you can now save your entries 

with "OK". 
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Configuring an ODBC data source for Energy Manager 
The configuration dialog of the ODBC data source opens in Energy Manager.  

1. Enter a "Name" and an optional "Description". 

 

2. Select the correct table from the areas that have been marked and named in Excel. 

3. Assign the correct column header to the "Time stamp" and "Value" fields. 

4. As a rule activate "Date in local time". 

– Activated: The time stamps are available in the local time and are accepted without 
change. 

– Deactivated: The time stamps are available in the UTC time format and are converted 
into the local time. 

5. Confirm your settings with "OK". 

6. Double-click the object you created to re-open the configuration dialog. 
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7. Click "Import" to launch the data import. The data point and ODBC data source must be 
active accordingly. 

 
8. Select the desired connection in the "ODBC Connections" dialog. Select "Show trace 

information" if you want to verify successful completion of the data import. Then click 
"Import marked" or "Import active" depending on whether you want to import the 
connections marked in color or those activated by a check mark. 

 
On completion of the import, the data is displayed in the application that is associated with 
the *.txt files. The dialog also displays the path, the file name, and the storage location for 
the output data. 

5.24.1.3 Configuring automatic data import 

Overview 
If you want to cyclically import data from an ODBC data source to Energy Manager, define 
data channels for automatic data transfer using the Client. 

Requirement 
B.Data Task Management is installed. 

Procedure 
Two tasks are available in the Task Manager folder with which data can be transferred 
automatically by means of ODBC Connector. 

The task called with "ODBC Import" imports all active data channels connected to the task 
node. The task "ODBC Import all" imports all active data channels in the system. 
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5.24.1.4 Configuring restrictions for the files to transfer 

Overview 
The data import volume should be restricted in the following scenarios: 

• Cyclic data transfer to Energy Manager 

• Table contains several data points 

Requirement 
The ODBC data channels have been created. 

Procedure 
1. To import only the latest values to Energy Manager, select the "Check last date" check box. 

With this setting, only values that have a more recent time stamp than the oldest value 
present in Energy Manager are imported to Energy Manager. 

 
2. If you need to apply restrictions on the import data source, define a restriction in the 

"Where" field. 

The following examples show the procedure for external systems: 
 
External sys-
tem 

Where condition 

ORACLE DAT_KANALID=12533 AND MWP_GMT > SYSDATE-2 AND MWP_GMT < SYSDATE+2 
Restriction to measurement data generated in a period from the previous two days to 
the next two days, starting at the transmission date.  

 

SQL Server MESS_ID=1263 AND ZEIT > GETDATE()-2 
Restriction to measurements and measured values that are no older than two days, 
starting at the transfer date. 

Access "DATUM" > DATE()-21 
Restriction to measured values that are no older than three weeks, starting at the 
transfer date. 

MySQL DB='620-.SAN-01-.-03ZW' 
Restriction to the data of one measurement. 

Excel Time > 39479 
Restriction to measured values newer than 01.02.2008. 39479 is equivalent to 
01.02.2008 (days since 01.01.1900) and is calculated using the Excel function 
=DATUM(2008;2;1). 
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